# Cuprins

## 1 Curs Introductiv
1.1 Cuvânt înainte .......................................................... 1
    1.1.1 Why QGIS? ......................................................... 1
    1.1.2 Fundal ............................................................. 2
    1.1.3 Licență ............................................................ 2
    1.1.4 Capitole Sponsorizate .......................................... 3
    1.1.5 Autori ............................................................. 3
    1.1.6 Contribuții Individuale ........................................ 3
    1.1.7 Sponsori .......................................................... 3
    1.1.8 Fisiere sursă și rapoarte despre probleme .................. 3
    1.1.9 Ultima versiune ................................................ 3
1.2 About the exercises ................................................ 4
    1.2.1 How to use this tutorial ....................................... 4
    1.2.2 Tiered course objectives ..................................... 4
    1.2.3 Data ............................................................. 5

## 2 Module: Creating and Exploring a Basic Map
2.1 Lesson: O Privire de Ansamblu asupra Interfeței .................. 7
    2.1.1 Try Yourself: Notiuni de Bază ................................ 8
    2.1.2 Try Yourself 1 .................................................. 10
    2.1.3 Try Yourself 2 .................................................. 10
    2.1.4 What’s Next? .................................................... 10
2.2 Lesson: Adding your first layers .................................... 11
    2.2.1 Follow Along: Pregătirea unei hărți ........................ 11
    2.2.2 Try Yourself .................................................... 14
    2.2.3 Follow Along: Loading vector data from a GeoPackage Database ........................................... 14
    2.2.4 Follow Along: Loading vector data from a SpatiaLite Database with the Browser ............................ 15
    2.2.5 Try Yourself Load More Vector Data .......................... 16
    2.2.6 Follow Along: Reordonarea Straturilor ...................... 17
    2.2.7 In Conclusion .................................................... 18
    2.2.8 What’s Next? .................................................... 18
2.3 Lesson: Navigația pe Canevasul Hărții ............................. 18
    2.3.1 Follow Along: Instrumente Fundamentale de Navigație 18
    2.3.2 In Conclusion .................................................... 22
2.4 Lesson: Simbologia ..................................................... 22
    2.4.1 Follow Along: Schimbarea Culorilor ......................... 23
    2.4.2 Try Yourself ...................................................... 24
    2.4.3 Follow Along: Schimbă Structura Simbolului .......... 24
    2.4.4 Try Yourself ...................................................... 25
    2.4.5 Follow Along: Vizibilitate în funcție de scară .......... 25
    2.4.6 Follow Along: Adăugarea Straturilor Simbolului ....... 26
3 Module: Clasificarea Datelor Vectoriale

3.1 Lesson: Vector Attribute Data ................................................... 55
  3.1.1 Follow Along: Vizualizarea Atributelor Straturilor .................. 55
  3.1.2 Try Yourself Exploring Vector Data Attributes ..................... 59
  3.1.3 In Conclusion .......................................................... 59
  3.1.4 What's Next? .......................................................... 59

3.2 Lesson: Labels .............................................................................. 60
  3.2.1 Follow Along: Folosirea Etichetelor .................................. 60
  3.2.2 Follow Along: Opțiuniile de Schimbare a Etichetelor ........... 62
  3.2.3 Follow Along: Utilizarea Etichetelor în locul Simbolologiei Stratului 66
  3.2.4 Try Yourself Personalizarea Etichetelor ............................... 69
  3.2.5 Follow Along: Etichetarea Liniilor .................................... 70
  3.2.6 Follow Along: Setările Definite cu ajutorul Datelor ............... 74
  3.2.7 Try Yourself Utilizarea Setărilor Definite cu ajutorul Datelor .... 76
  3.2.8 Alte Posibilități de Etichetare ........................................ 77
  3.2.9 In Conclusion .......................................................... 77
  3.2.10 What's Next? ........................................................... 77

3.3 Lesson: Clasificarea ..................................................................... 77
  3.3.1 Follow Along: Clasificarea Datelor Nominale ....................... 78
  3.3.2 Try Yourself Mai Multe Clasificări .................................... 83
  3.3.3 Follow Along: Rația Clasificării ......................................... 83
  3.3.4 Try Yourself Răfinarea Clasificării .................................... 91
  3.3.5 Follow Along: Clasificarea Bază pe Reguli ......................... 91
  3.3.6 In Conclusion .......................................................... 95
  3.3.7 What's Next? ........................................................... 95

4 Module: Laying out the Maps ................................................................. 97

4.1 Lesson: Using Print Layout ............................................................ 97
  4.1.1 Follow Along: The Layout Manager ................................... 97
  4.1.2 Follow Along: Crearea Hărții de Bază ................................. 99
  4.1.3 Follow Along: Adăugarea unui Titlu .................................. 101
  4.1.4 Follow Along .......................................................... 104
  4.1.5 Follow Along: Personalizarea Articolelor din Legendă ........... 105
  4.1.6 Follow Along: Exportarea Hărții Dvs. ................................. 107
  4.1.7 In Conclusion .......................................................... 109

4.2 Lesson: Creating a Dynamic Print Layout ..................................... 109
  4.2.1 Follow Along: Creating the dynamic map canvas .................. 109
  4.2.2 Follow Along: Creating the dynamic header ....................... 110
  4.2.3 Follow Along: Creating labels for the dynamic header .......... 111
  4.2.4 Follow Along: Adding pictures to the dynamic header .......... 113
  4.2.5 Follow Along: Creating the scalebar of the dynamic header ..... 114
  4.2.6 What's Next? ........................................................... 115

4.3 Exercițiul 1 .................................................................................. 115
  4.3.1 In Conclusion .......................................................... 115

5 Module: Crearea Datelor Vectoriale ..................................................... 117

5.1 Lesson: Crearea unui Nou Set de Date Vectoriale ......................... 117
7 Module: Rastere

7.1 Lesson: Lucrul cu Datele Raster

7.1.1 Follow Along: Încărcarea Datelor Raster

7.1.2 Follow Along: Crearea unui Raster Virtual

7.1.3 Transformarea Datelor Raster

7.1.4 In Conclusion

7.1.5 What’s Next?

7.2 Lesson: Schimbarea Simbologiei Raster

7.2.1 Try Yourself

7.2.2 Follow Along: Schimbarea Simbologiei Straturilor Raster

7.2.3 Follow Along: Singleband gray

7.2.4 Follow Along: Singleband pseudocolor

7.2.5 Follow Along: Changing the transparency

7.2.6 In Conclusion

7.2.7 Referință

7.2.8 What’s Next?

7.3 Lesson: Analiza Terenului

7.3.1 Follow Along: Calculul Umbrei Versanților

7.3.2 Follow Along: Folosirea Umbrei Versanților pentru Suprapunere

7.3.3 Follow Along: Finding the best areas

7.3.4 Follow Along: Calculul Pantelui

7.3.5 Try Yourself Calculating the aspect

7.3.6 Follow Along: Finding the north-facing aspect

7.3.7 Try Yourself More criteria

7.3.8 Follow Along: Combinarea Rezultatelor Analizei Raster

7.3.9 Follow Along: Simplificarea Rasterului

7.3.10 Follow Along: Reclassifying the Raster

7.3.11 Follow Along: Querying the raster

7.3.12 In Conclusion

7.3.13 What’s Next?

8 Module: Finalizarea analizei

8.1 Lesson: Conversia din Raster în Vector

8.1.1 Follow Along: Instrumentul Raster to Vector
8.1.2 Try Yourself .................................................. 260
8.1.3 Follow Along: Instrumentul Vector to Raster .................. 261
8.1.4 In Conclusion .................................................. 262
8.1.5 What’s Next? .................................................. 262

8.2 Lesson: Combinarea Analizelor .................................. 262
8.2.1 Try Yourself .................................................. 262
8.2.2 Try Yourself Inspectarea Rezultatelor ....................... 263
8.2.3 Try Yourself Rafinarea Analizei ................................ 263
8.2.4 In Conclusion .................................................. 263
8.2.5 What’s Next? .................................................. 264

8.3 Exercițiul ...................................................... 264
8.4 Lesson: Exercițiul Suplimentar .................................. 264
8.4.1 Definirea Problemei ........................................... 264
8.4.2 Conturarea unei Solutii ...................................... 265
8.4.3 Follow Along: Setting up the Map .......................... 265
8.4.4 Încărcarea Datelor în Hartă .................................. 265
8.4.5 Modificarea ordinii straturilor ................................ 266
8.4.6 Găsirea Districtelor Corecte .................................. 266
8.4.7 Decuparea Rasterelor .......................................... 267
8.4.8 Schimbarea simbologiei straturilor vectoriale .............. 268
8.4.9 Schimbarea simbologiei straturilor raster .................... 268
8.4.10 Curătarea hârtii .............................................. 269
8.4.11 Crearea reliefului ............................................. 269
8.4.12 Panta .......................................................... 270
8.4.13 Try Yourself Aspect .......................................... 270
8.4.14 Reclasificarea rasterelor .................................... 270
8.4.15 Combinarea rasterelor ....................................... 271
8.4.16 Găsirea zonele rurale ....................................... 271
8.4.17 Crearea unui tampon negativ ................................ 272
8.4.18 Vectorizarea rasterului ...................................... 272
8.4.19 Fixing geometry .............................................. 273
8.4.20 Determining the Intersection of vectors ................... 273
8.4.21 Calculați aria pentru fiecare poligon ...................... 273
8.4.22 Selectarea zonelor cu o dimensiune dată ................. 274
8.4.23 Digitize the University of Cape Town ..................... 274
8.4.24 Find the locations that are closest to the University of Cape Town .................................................. 275

9 Module: Plugin-uri .................................................. 277
9.1 Lesson: Instalarea şi Gestionarea Plugin-urilor .................. 277
9.1.1 Follow Along: Gestionarea Plugin-urilor ..................... 277
9.1.2 Follow Along: Instalarea Noilor Plugin-uri .................. 278
9.1.3 Follow Along: Configurarea Depozitelor Adiționale de Plugin-uri .................................................. 280
9.1.4 In Conclusion .................................................. 282
9.1.5 What’s Next? .................................................. 282

9.2 Lesson: Plugin-uri QGIS Utile .................................. 282
9.2.1 Follow Along: The QuickMapServices Plugin .............. 282
9.2.2 Follow Along: The QuickOSM Plugin ........................ 283
9.2.3 Follow Along: The QuickOSM Query engine ............... 284
9.2.4 Follow Along: The DataPlotly Plugin ........................ 286
9.2.5 In Conclusion .................................................. 291
9.2.6 What’s Next? .................................................. 291

10 Module: Resurse Online .............................................. 293
10.1 Lesson: Serviciile Web Mapping .................................. 293
10.1.1 Follow Along: Încărcarea unui strat WMS .................. 293
10.1.2 Try Yourself .................................................. 302
10.1.3 Try Yourself .................................................. 303
10.1.4 Try Yourself .................................................. 303
14.2 Lesson: Georeferentierea unei Hărți ................................. 358
14.2.1 Scanarea hărții .................................................. 358
14.2.2 Follow Along: Georeferentierea hărții scanate ............. 359
14.2.3 In Conclusion .................................................... 363
14.2.4 What’s Next? ..................................................... 363

14.3 Lesson: Digitizarea Arborotelui Forestier ....................... 363
14.3.1 Follow Along: Extragerea Limitelor Arborotelui Forestier 363
14.3.2 Try Yourself Georeferentierea Imaginii Pixelor Verzi ..... 366
14.3.3 Follow Along: Crearea Punctelor de Sprijin pentru Digitizare 366
14.3.4 Follow Along: Digitizarea Pâlcilor de Pădure .......... 368
14.3.5 Try Yourself Încheierea Digitizării Pâlcilor de Pădure 373
14.3.6 Follow Along: Îmbinarea Datelor pentru Pâlcile de Pădure 374
14.3.7 Try Yourself Redenumirea Numelor pentru Atribut, și Adăugarea Suprafeței și a Perimetrului 375
14.3.8 In Conclusion .................................................... 377
14.3.9 What’s Next? ..................................................... 377

14.4 Lesson: Actualizarea Pâlcilor de Pădure .......................... 377
14.4.1 Comparând Pâlcile Vechi de Pădure pentru Fotografiile Aeriene Actuale ........................................... 377
14.4.2 Interpretarea Imaginii CIR ..................................... 378
14.4.3 Try Yourself Încheierea Digitizării Pâlcilor, pornind de la Imaginile CIR .................................................. 380
14.4.4 Follow Along: Actualizarea Pâlcilor de Pădure cu Informații de Conservare ........................................... 381
14.4.5 Try Yourself Actualizarea Pâlcilor de Pădure folosind Distanța până la Flux ........................................... 386
14.4.6 In Conclusion .................................................... 387
14.4.7 What’s Next? ..................................................... 387

14.5 Lesson: Planul de Eșantionare Sistematică ...................... 387
14.5.1 Inventarierea Pădurii ............................................. 387
14.5.2 Lesson: Implementarea unui Plan Sistematic al Suprafețelor de Probă ................................................... 388
14.5.3 Follow Along: Exportări Suprafețele de Probă în format GPX .......................................................... 392
14.5.4 In Conclusion .................................................... 393
14.5.5 What’s Next? ..................................................... 393

14.6 Lesson: Crearea hărților detaliate folosind instrumentul Atlas 393
14.6.1 Follow Along: Preparing the Print Layout .................. 393
14.6.2 Follow Along: Adăugarea Fundalului Hărții ............. 395
14.6.3 Try Yourself Schimbarea Simbologiei Straturilor ...... 396
14.6.4 Try Yourself Crearea unui sablon pentru Harta de Bază ................................................................. 398
14.6.5 Follow Along: Adding More Elements to the Print Layout ................................................................. 399
14.6.6 Follow Along: Crearea unei Acoperiri de Atlas .......... 401
14.6.7 Follow Along: Configurarea Instrumentului Atlas .... 403
14.6.8 Follow Along: Editarea Stratului de Acoperire ........ 405
14.6.9 Follow Along: Tipărirea Hărților ................................ 408
14.6.10 In Conclusion .................................................... 408
14.6.11 What’s Next? ..................................................... 409

14.7 Lesson: Calcularea Parametrilor Forestieri ..................... 409
14.7.1 Follow Along: Adăugarea Rezultatelor Inventarului ...... 409
14.7.2 Follow Along: Parametrii de Evaluare a Întregii Păduri ................................................................. 410
14.7.3 Follow Along: Estimarea Parametrilor Zonali .......... 410
14.7.4 In Conclusion .................................................... 414
14.7.5 What’s Next? ..................................................... 415

14.8 Lesson: Crearea unui DEM din datele LiDAR ................... 415
14.8.1 Follow Along: Instalarea Lastools .......................... 415
14.8.2 Follow Along: Calcularea unui DEM, cu ajutorul LASTools ................................................................. 417
14.8.3 Follow Along: Crearea unui Teren Reliefat ............. 422
14.8.4 In Conclusion .................................................... 424
14.8.5 What’s Next? ..................................................... 425

14.9 Lesson: Prezentarea Hărții ......................................... 425
14.9.1 Follow Along: Pregătirea Datelor Hărții .................. 425
14.9.2 Try Yourself Încercați Diferite Moduri de Amestecare 427
14.9.3 Try Yourself Using a Layout Template to Create the Map result .......................................................... 428
14.9.4 In Conclusion .................................................... 431
15 Noțiuni despre Bazele de date folosind PostgreSQL

<table>
<thead>
<tr>
<th>15.1 Lesson: Introducere în Baze de date</th>
<th>433</th>
</tr>
</thead>
<tbody>
<tr>
<td>15.1.1 Ce este o bază de date?</td>
<td>433</td>
</tr>
<tr>
<td>15.1.2 Tabele</td>
<td>433</td>
</tr>
<tr>
<td>15.1.3 Coloane / Câmpuri</td>
<td>434</td>
</tr>
<tr>
<td>15.1.4 Înregistrări</td>
<td>434</td>
</tr>
<tr>
<td>15.1.5 Tipuri de date</td>
<td>434</td>
</tr>
<tr>
<td>15.1.6 Modelarea unei Baze de Date cu Adrese</td>
<td>435</td>
</tr>
<tr>
<td>15.1.7 Teoria Bazelor de Date</td>
<td>435</td>
</tr>
<tr>
<td>15.1.8 Normalizarea</td>
<td>435</td>
</tr>
<tr>
<td>15.1.9 Try Yourself</td>
<td>436</td>
</tr>
<tr>
<td>15.1.10 Indecsi</td>
<td>436</td>
</tr>
<tr>
<td>15.1.11 Secvențe</td>
<td>436</td>
</tr>
<tr>
<td>15.1.12 Diagrama Relațiilor dintre Entități</td>
<td>437</td>
</tr>
<tr>
<td>15.1.13 Constrângeri, Chei Primare și Chei Externe</td>
<td>438</td>
</tr>
<tr>
<td>15.1.14 Tranzacții</td>
<td>438</td>
</tr>
<tr>
<td>15.1.15 In Conclusion</td>
<td>438</td>
</tr>
<tr>
<td>15.1.16 What’s Next?</td>
<td>439</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>15.2 Lesson: Implementarea Modelului de Date</th>
<th>439</th>
</tr>
</thead>
<tbody>
<tr>
<td>15.2.1 Instalare PostgreSQL</td>
<td>439</td>
</tr>
<tr>
<td>15.2.2 Ajutor</td>
<td>439</td>
</tr>
<tr>
<td>15.2.3 Crearea unui utilizator pentru baza de date</td>
<td>440</td>
</tr>
<tr>
<td>15.2.4 Verificați noul cont</td>
<td>440</td>
</tr>
<tr>
<td>15.2.5 Crearea unei baze de date</td>
<td>440</td>
</tr>
<tr>
<td>15.2.6 Pornirea unei sesiuni către baza de date, din linia de comandă</td>
<td>441</td>
</tr>
<tr>
<td>15.2.7 Crearea Tabelelor SQL</td>
<td>441</td>
</tr>
<tr>
<td>15.2.8 Crearea Cheilor în SQL</td>
<td>442</td>
</tr>
<tr>
<td>15.2.9 Crearea de indecși în SQL</td>
<td>443</td>
</tr>
<tr>
<td>15.2.10 Stergerea Tabelelor în SQL</td>
<td>444</td>
</tr>
<tr>
<td>15.2.11 Câteva cuvinte despre pgAdmin III</td>
<td>444</td>
</tr>
<tr>
<td>15.2.12 In Conclusion</td>
<td>444</td>
</tr>
<tr>
<td>15.2.13 What’s Next?</td>
<td>444</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>15.3 Lesson: Adăugarea de date în Model</th>
<th>444</th>
</tr>
</thead>
<tbody>
<tr>
<td>15.3.1 Inserarea instrucțiunilor</td>
<td>445</td>
</tr>
<tr>
<td>15.3.2 Secvențierea Adăugării Datelor, Conform Constrângerilor</td>
<td>445</td>
</tr>
<tr>
<td>15.3.3 Try Yourself</td>
<td>445</td>
</tr>
<tr>
<td>15.3.4 Selectarea datelor</td>
<td>446</td>
</tr>
<tr>
<td>15.3.5 Actualizarea datelor</td>
<td>446</td>
</tr>
<tr>
<td>15.3.6 Stergere Dată</td>
<td>446</td>
</tr>
<tr>
<td>15.3.7 Try Yourself</td>
<td>447</td>
</tr>
<tr>
<td>15.3.8 In Conclusion</td>
<td>447</td>
</tr>
<tr>
<td>15.3.9 What’s Next?</td>
<td>447</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>15.4 Lesson: Interogări</th>
<th>447</th>
</tr>
</thead>
<tbody>
<tr>
<td>15.4.1 Ordonarea Rezultatelor</td>
<td>447</td>
</tr>
<tr>
<td>15.4.2 Filtrare</td>
<td>448</td>
</tr>
<tr>
<td>15.4.3 Îmbinări</td>
<td>449</td>
</tr>
<tr>
<td>15.4.4 Sub-Selectarea</td>
<td>449</td>
</tr>
<tr>
<td>15.4.5 Agregarea Îmbinărilor</td>
<td>450</td>
</tr>
<tr>
<td>15.4.6 In Conclusion</td>
<td>451</td>
</tr>
<tr>
<td>15.4.7 What’s Next?</td>
<td>451</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>15.5 Vederile Lesson:</th>
<th>451</th>
</tr>
</thead>
<tbody>
<tr>
<td>15.5.1 Crearea unei Vederi</td>
<td>451</td>
</tr>
<tr>
<td>15.5.2 Modificarea unei Vederi</td>
<td>452</td>
</tr>
<tr>
<td>15.5.3 Eliminarea unei Vederi</td>
<td>452</td>
</tr>
<tr>
<td>15.5.4 In Conclusion</td>
<td>452</td>
</tr>
<tr>
<td>15.5.5 What’s Next?</td>
<td>452</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>15.6 Regulile Lesson:</th>
<th>452</th>
</tr>
</thead>
<tbody>
<tr>
<td>15.6.1 Creating a logging rule</td>
<td>453</td>
</tr>
<tr>
<td>15.6.2</td>
<td>In Conclusion</td>
</tr>
<tr>
<td>15.6.3</td>
<td>What's Next?</td>
</tr>
</tbody>
</table>

16 Module: Noțiuni despre Bazele de date folosind PostgreSQL

| 16.1 | Lesson: Instalare PostGIS | 455 |
| 16.1.1 | Instalarea sub Ubuntu | 455 |
| 16.1.2 | Instalare sub Windows | 456 |
| 16.1.3 | Instalarea pe Alte Platforme | 456 |
| 16.1.4 | Configurarea Bazei de Date pentru a utiliza PostGIS | 456 |
| 16.1.5 | Funcțiile PostGIS instalate | 457 |
| 16.1.6 | Sistemele de Referință Spațială | 458 |
| 16.1.7 | In Conclusion | 458 |
| 16.1.8 | What’s Next? | 459 |

| 16.2 | Lesson: Modelul Entității Simple | 459 |
| 16.2.1 | Ce este OGC | 459 |
| 16.2.2 | Ce este Modelul SFS | 459 |
| 16.2.3 | Adăugări un câmp geometric la tabelă | 460 |
| 16.2.4 | Adăugări o constrângere bazată pe tipul geometrici | 460 |
| 16.2.5 | Try Yourself | 460 |
| 16.2.6 | Popularea tabelei geometry_columns | 460 |
| 16.2.7 | Adăugări o înregistrare geometrică la tabelă, utilizând SQL | 461 |
| 16.2.8 | In Conclusion | 464 |
| 16.2.9 | What’s Next? | 464 |

| 16.3 | Lesson: Importul și Exportul | 464 |
| 16.3.1 | shp2pgsql | 464 |
| 16.3.2 | pgsql2shp | 465 |
| 16.3.3 | ogr2ogr | 465 |
| 16.3.4 | DB Manager | 465 |
| 16.3.5 | In Conclusion | 465 |
| 16.3.6 | What’s Next? | 465 |

| 16.4 | Lesson: Interogări Spațiale | 465 |
| 16.4.1 | Operatori Spațiali | 466 |
| 16.4.2 | Indecși Spațiali | 466 |
| 16.4.3 | Try Yourself | 467 |
| 16.4.4 | Demo Funcții Spațiale PostGIS | 467 |
| 16.4.5 | In Conclusion | 473 |
| 16.4.6 | What’s Next? | 473 |

| 16.5 | Lesson: Construirea Geometriei | 473 |
| 16.5.1 | Crearea Sirurilor de Linii | 473 |
| 16.5.2 | Try Yourself | 473 |
| 16.5.3 | Crearea Poligoanelor | 474 |
| 16.5.4 | Exercitiu: Learea Oraselor de Persoane | 474 |
| 16.5.5 | Analiziți Schema Noastră | 475 |
| 16.5.6 | Try Yourself | 475 |
| 16.5.7 | Accesul la Sub-Obiecte | 475 |
| 16.5.8 | Procesarea Datelor | 475 |
| 16.5.9 | Decuparea | 476 |
| 16.5.10 | Construirea de Geometrii pornind de la Alte Geometrii | 477 |
| 16.5.11 | Curătarea Geometriilor | 479 |
| 16.5.12 | Diferențele dintre tabele | 479 |
| 16.5.13 | Spațiile tabelelor | 480 |
| 16.5.14 | In Conclusion | 480 |

17 Ghidul de procesare al QGIS

| 17.1 | Introducere | 481 |
| 17.2 | Câteva lucruri importante de reținut, înainte de a începe | 482 |
| 17.3 | Inițierea cadrului de procesare | 483 |
| 17.4 | Rularea primului nostru algoritm. Setul de instrumente | 485 |
18 Module: Folosirea Bazelor de Date Spațiale în QGIS

18.1 Lesson: Lucrul cu Baze de Date în Navigațorul QGIS
18.1.1 Follow Along: Adăugarea Tabelelor Bazei de Date în QGIS folosind Navigațorul
18.1.2 Follow Along: Adăugarea unui set filtrat de înregistrări sub forma unui Strat
18.1.3 In Conclusion
18.1.4 What’s Next?

18.2 Lesson: Utilizarea DB Manager din QGIS, în lucrul cu bazele de date spațiale
18.2.1 Follow Along: Gestionarea Bazelor de date PostGIS cu ajutorul DB Manager
18.2.2 Inhardi Follow Along: Crearea unei Noi Tabele
18.2.3 Follow Along: Tehnici de bază pentru administrarea bazei de date
18.2.4 Follow Along: Executarea Interrogărilor SQL cu ajutorul DB Manager
18.2.5 Importarea datelor dintr-o Bază de date cu ajutorul DB Manager
18.2.6 Exportul datelor cu DB Manager dintr-o Bază de date
18.2.7 In Conclusion
18.2.8 What’s Next?

18.3 Lesson: Working with SpatialLite databases in QGIS
18.3.1 Follow Along: Creating a SpatialLite database with the Browser
18.3.2 In Conclusion

19 Anexă: Contribuții La Acest Manual
19.1 Descărcare resurse
19.2 Formatul Manualului
19.3 Adăugarea unui Modul
19.4 Adăugarea unei Lecti
19.5 Adăugarea unei Secțiuni
  19.5.1 Adăugăți o secțiune „procedați în mod similar”
  19.5.2 Adăugăți o secțiune „încercați singuri”
19.6 Adăugarea unei Concluzii
19.7 Adăugarea unei Secțiuni de Lecturi suplimentare
19.8 Adăugarea Seciunii „Ce Urmează”
19.9 Utilizarea Marcajelor
  19.9.1 Noi concepte
  19.9.2 Atenție specială
  19.9.3 Imagini
  19.9.4 Legături interne
  19.9.5 Legături externe
  19.9.6 Utilizați text monospațiat
  19.9.7 Etichetarea elementelor GUI
  19.9.8 Selectia meniului
  19.9.9 Adăugarea notelor
  19.10 Adăugarea o notă de sponsorizare/drepturi de autor
19.10 Mulțumiri!

20 Pregătirea Datelor pentru Exerciții
20.1 Try Yourself Create OSM based vector Files
20.2 Try Yourself Crearea Fișierelor SRTM DEM tiff
20.3 Try Yourself Crearea Fișierelor tiff
20.4 Try Yourself Replace Tokens

21 Fișă de răspunsuri
21.1 Results For O privire de ansamblu asupra interfeței
  21.1.1 Vedere Generală (Partea 1)
  21.1.2 Vedere Generală (Partea a 2-a)
21.2 Results For Adăugarea Primului Dvs. Strat
  21.2.1 Pregătire
  21.2.2 Data loading
21.3 Results For Symbologie
  21.3.1 Culori
  21.3.2 Structura Simbolului
  21.3.3 Straturile Simbolului
  21.3.4 Nivelurile Simbolului
  21.3.5 Nivelurile Simbolului
21.4 Outline Markers
  21.4.1 Geometry generator symbology
21.5 Results For Vector Attribute Data
  21.5.1 Exploring Vector Data Attributes
21.6 Results For Labels
  21.6.1 Personalizarea Etichetelor (Partea 1)
  21.6.2 Personalizarea Etichetelor (Partea a 2-a)
  21.6.3 Utilizarea Setărilor Definite cu ajutorul Datelor
21.7 Results For Clasificare
  21.7.1 Rafinarea Clasificării
21.8 Results For Crearea unui Nou Set de Date Vectoriale
  21.8.1 Digitizare
  21.8.2 Topologia: Adăugarea Instrumentului Inel
21.8.3 Topologia: Adăugarea Instrumentului Parte .................................................. 675
21.8.4 Îmbinare Entități ..................................................................................... 676
21.8.5 Formulare ................................................................................................. 676
21.9 Results For Analiza Vectorială ................................................................. 678
21.9.1 Distanța față de Licee .............................................................................. 678
21.9.2 Distanța față de Restaurante .................................................................. 680
21.10 Results For Network Analysis ................................................................. 683
21.11 Fastest path ............................................................................................... 683
21.12 Results For Analiza Raster ...................................................................... 684
21.12.1 Calculare Aspect ................................................................................... 684
21.12.2 Calculează Panta (mai puțin de 2 sau de 5 grade) ................................ 685
21.13 Results For Completarea Analizei .......................................................... 688
21.13.1 Din Raster în Vector ............................................................................... 688
21.13.2 Inspectarea Rezultatelor .................................................................... 689
21.13.3 Rafinarea Analizei ............................................................................... 690
21.14 Results For WMS ..................................................................................... 694
21.14.1 Adăugarea Altui Strat WMS .................................................................. 694
21.14.2 Adăugarea unui Nou Server WMS ....................................................... 695
21.14.3 Găsirea unui Server WMS .................................................................. 697
21.15 Results For GRASS Integration .............................................................. 697
21.15.1 Add Layers to Mapset .......................................................................... 697
21.15.2 Reclassify raster layer ......................................................................... 697
21.16 Results For Notiunii despre Bazele de date .......................................... 698
21.16.1 Adresarea Tabelei de Proprietăți .......................................................... 698
21.16.2 Normalizarea Tabelei de Personal .......................................................... 699
21.16.3 Normalizarea Suplimentară a Tabelei de Personal ............................... 699
21.16.4 Crearea Tabelei de Personal .................................................................. 700
21.16.5 Commanda DROP ............................................................................... 701
21.16.6 Inserearea unei Noi Străzi .................................................................... 701
21.16.7 Adăugarea unei Noi Persoane Cu Relatia Cheii Externe ...................... 701
21.16.8 Returnează Numele Străzilor ................................................................ 701
21.17 Results For Interogări spațiale ................................................................. 702
21.17.1 Unitățile Folosite în Interogările Spațiale .............................................. 702
21.17.2 Crearea unui Index Spatial .................................................................... 702
21.18 Results For Construirea Geometriei ....................................................... 702
21.18.1 Crearea Sirurilor de Linii ....................................................................... 702
21.18.2 Legarea Tabelelor ................................................................................. 703
21.19 Results For Modelul Entității Simple ...................................................... 703
21.19.1 Popularea Tabelelor .............................................................................. 703
21.19.2 Popularea Tabelei Geometry_Columns ............................................... 704
21.19.3 Adăugarea Geometriei ......................................................................... 704
Welcome to our course! We will be showing you how to use QGIS easily and efficiently. If you are new to GIS, we will tell you what you need to get started. If you are an experienced user, you will see how QGIS fulfills all the functions you expect from a GIS program, and more!

1.1 Why QGIS?

As information becomes increasingly spatially aware, there is no shortage of tools able to fulfill some or all commonly used GIS functions. Why should anyone be using QGIS over some other GIS software package?

Here are only some of the reasons:

- **It's free, as in lunch.** Installing and using the QGIS program costs you a grand total of zero money. No initial fee, no recurring fee, nothing.

- **It's free, as in liberty.** If you need extra functionality in QGIS, you can do more than just hope it will be included in the next release. You can sponsor the development of a feature, or add it yourself if you are familiar with programming.

- **It's constantly developing.** Because anyone can add new features and improve on existing ones, QGIS never stagnates. The development of a new tool can happen as quickly as you need it to.

- **Extensive help and documentation is available.** If you're stuck with anything, you can turn to the extensive documentation, your fellow QGIS users, or even the developers.

- **Cross-platform.** QGIS can be installed on MacOS, Windows and Linux.

Now that you know why you want to use QGIS, these exercises will make you know how.
1.1.2 Fundal

In 2008 we launched the Gentle Introduction to GIS, a completely free, open content resource for people who want to learn about GIS without being overloaded with jargon and new terminology. It was sponsored by the South African government and has been a phenomenal success, with people all over the world writing to us to tell us how they are using the materials to run University Training Courses, teach themselves GIS and so on. The Gentle Introduction is not a software tutorial, but rather aims to be a generic text (although we used QGIS in all examples) for someone learning about GIS. There is also the QGIS manual which provides a detailed functional overview of the QGIS application. However, it is not structured as a tutorial, but rather as a reference guide. At Linfiniti Consulting CC, we frequently run training courses and have realised that a third resource is needed - one that leads the reader sequentially through learning the key aspects of QGIS in a trainer-trainee format - which prompted us to produce this work.

Acest manual de instruire pune la dispoziție toate materialele necesare desfășurării unui curs de 5 zile despre QGIS, PostgreSQL și PostGIS. Cursul are un conținut structurat, fiind deopotrivă adecvat începătorilor, utilizatorilor intermediari sau avansați, și având multe exerciții cu răspunsuri complete adnotate.

1.1.3 Licență

The Free Quantum GIS Training Manual by Linfiniti Consulting CC is based on an earlier version from Linfiniti and is licensed under a Creative Commons Attribution 4.0 International. Permissions beyond the scope of this license may be available at below.

We have published this QGIS training manual under a liberal license that allows you to freely copy, modify and redistribute this work. A complete copy of the license is available at the end of this document. In simple terms, the usage guidelines are as follows:

- Nu puteți prezenta acest material ca fiind scris de dvs., sau să eliminați textele de acreditare din această lucrare.
- Nu aveți dreptul să redistribuiți această lucrare sub permisiuni mai restrictive decât cele pe baza cărora v-a fost furnizată dumneavoastră.
- If you add a substantive portion to the work and contribute it back to the project (at least one complete module) you may add your name to the end of the authors list for this document (which will appear on the front page)
- Dacă efectuați modificări minore și corecturi vă puteți adăuga în lista de contribuitori de mai jos.
- Dacă ați tradus acest document în întregime, vă puteți adăuga nume în lista autorilor, în felul următor „Traducere efectuată de Joe Bloggs”.
- În cazul în care sponsorizați un modul sau o lecție, puteți solicita autorului să includă o informație despre acest lucru, la începutul fiecărei lecții la care ați contribuit, cum ar fi:

Notă: Această lecție a fost sponsorizată de MegaCorp.

- Dacă aveți nelămuriri cu privire la ceea ce se poate face sub această licență, vă rugăm să ne contactați la office@linfiniti.com, pentru a vă informa dacă ceea ce intenționați să faceți este acceptabil.
- If you publish this work under a self publishing site such as https://www.lulu.com we request that you donate the profits to the QGIS project.
- You may not commercialise this work, except with the expressed permission of the authors. To be clear, by commercialisation we mean that you may not sell for profit, create commercial derivative works (e.g. selling content for use as articles in a magazine). The exception to this is if all the profits are given to the QGIS project. You may (and we encourage you to do so) use this work as a text book when conducting training courses, even if the course itself is commercial in nature. In other words, you are welcome to make money by running a
training course that uses this work as a text book, but you may not profit off the sales of the book itself - all such profits should be contributed back to QGIS.

1.1.4 Capitole Sponsorizate

This work is by no means a complete treatise on all the things you can do with QGIS and we encourage others to add new materials to fill any gaps. Linfiniti Consulting CC. can also create additional materials for you as a commercial service, with the understanding that all such works produced should become part of the core content and be published under the same license.

1.1.5 Autori

• Rüdiger Thiede (rudi@linfiniti.com) - Rudi a scris materialele de instruire QGIS și părți din materialele PostGIS.
• Tim Sutton (tim@linfiniti.com) - Tim a supravegheat și îndrumat proiectul, fiind co-autorul părților de PostgreSQL și PostGIS. Tim este, de asemenea, autorul temei sfinx, personalizate, folosită pentru acest manual.
• Horst Dürster (horst.duester@kappasys.ch) - Horst este co-autor al părților de PostgreSQL și PostGIS
• Marcelle Sutton (marcelle@linfiniti.com) - Marcelle s-a ocupat de lectura și consilierea editorială, pe durata creării acestei lucrări.

1.1.6 Contribuții Individuale

Introduceti numele dvs. aici!

1.1.7 Sponsori

• Universitatea de Tehnologie din Cape Peninsula

1.1.8 Fișiere sursă și rapoarte despre probleme

Sursa acestui document se poate găsi în Depozitul Documentației QGIS de pe GitHub. Consultați GitHub.com pentru instrucționările de folosire a sistemului de versionare git.


1.1.9 Ultima versiune

You can always obtain the latest version of this document by visiting the online version which is part of the QGIS documentation website (https://docs.qgis.org).

Notă: The documentation website contains links to both online and PDF versions of the Training manual and other parts of the QGIS documentation.
1.2 About the exercises

Now that you know why you want to use QGIS, we can show you how.

**Atenciónare:** This course includes instructions on adding, deleting and altering GIS datasets. We have provided training datasets for this purpose. Before using the techniques described here on your own data, always ensure you have proper backups!

1.2.1 How to use this tutorial

Any text that looks like this refers to something that you can see in the QGIS user interface.

Text that looks like this directs you through menus.

This kind of text refers to something you can type, such as a command.

This/kind/of/text refers to a path or filename.

This+That refers to a keyboard shortcut comprised of two buttons.

1.2.2 Tiered course objectives

This course caters to different user experience levels. Depending on which category you consider yourself to be in, you can expect a different set of course outcomes. Each category contains information that is essential for the next one, so it’s important to do all exercises that are at or below your level of experience.

**Basic**

In this category, the course assumes that you have little or no prior experience with theoretical GIS knowledge or the operation of GIS software.

Limited theoretical background will be provided to explain the purpose of an action you will be performing in the program, but the emphasis is on learning by doing.

When you complete the course, you will have a better concept of the possibilities of GIS, and how to harness their power via QGIS.

**Intermediate**

In this category, it is assumed that you have working knowledge and experience of the everyday uses of GIS software.

Building on the instructions for the beginner level will provide you with familiar ground, as well as to make you aware of the cases where QGIS does things slightly differently from other software you may be used to. You will also learn how to use analysis functions in QGIS.

When you complete the course, you should be comfortable with using QGIS for all of the functions you usually need for everyday use.
In this category, the assumption is that you are experienced with GIS software, have knowledge of and experience with spatial databases, using data on a remote server, perhaps writing scripts for analysis purposes, etc.

Building on the instructions for the other two levels will familiarize you with the approach that the QGIS interface follows, and will ensure that you know how to access the basic functions that you need. You will also be shown how to make use of the QGIS plugin system, database access, and so on.

When you complete the course, you should be well-acquainted with the everyday operation of QGIS, as well as its more advanced functions.

1.2.3 Data

The sample data that accompanies this resource is freely available and comes from the following sources:

- Streets and Places datasets from OpenStreetMap ([https://www.openstreetmap.org/](https://www.openstreetmap.org/))
- Property boundaries (urban and rural), water bodies from NGI ([http://www.ngi.gov.za/](http://www.ngi.gov.za/))
- SRTM DEM from the CGIAR-CGI ([http://srtm.csi.cgiar.org/](http://srtm.csi.cgiar.org/))

Download the prepared dataset from the Training data repository and unzip the file. All the necessary data are provided in the exercise_data folder.

If you are an instructor, and would like to use more relevant data, you will find instructions for creating local data in the Pregătirea Datelor pentru Exerciții appendix.
Module: Creating and Exploring a Basic Map

In this module, you will create a basic map which will be used later as a basis for further demonstrations of QGIS functionality.

2.1 Lesson: O Privire de Ansamblu asupra Interfeței

Vom explora interfața cu utilizator QGIS, pentru a vă familiariza cu meniurile, barele de instrumente, canevasul hărții și lista de straturi care formează structura de bază a interfeței.

Scopul acestei lecții: De a înțelege noțiunile de bază ale interfeței QGIS.
2.1.1 Try Yourself: Noțiuni de Bază

Elementele identificate în figura de mai sus sunt:

1. Lista Straturilor/Panoul Navigatorului
2. Bare de instrumente
3. Canevasul hărții
4. Bara de Stare
5. Bara Laterală de Instrumente
6. Locator bar

**Lista Straturilor**

În lista Straturi, puteți vedea o listă, în orice moment, a tuturor straturilor disponibile pentru dvs.

Extinderea obiectelor restrânse (făcând clic pe sâgeata sau pe simbolul plus de lângă ei) vă va oferi mai multe informații despre aspectul stratului actual.

Hovering over the layer will give you some basic information: layer name, type of geometry, coordinate reference system and the complete path of the location on your device.

Un clic-dreapta pe un strat vă va oferi un meniu cu o mulțime de opțiuni suplimentare. Veți folosi unele dintre ele mult timp de acum înainte, așa că haideti să aruncăm o privire asupra lor!

**Notă:** Un strat vectorial este un set de date, de obicei, al unui anumit tip de obiect, cum ar fi drumuri, copaci, etc. Un strat vectorial poate consta fie în puncte, în linii sau poligoane.
The QGIS Browser is a panel in QGIS that lets you easily navigate in your database. You can have access to common vector files (e.g. ESRI Shapefile or MapInfo files), databases (e.g. PostGIS, Oracle, SpatiaLite, GeoPackage or MSSQL Spatial) and WMS/WFS connections. You can also view your GRASS data.

If you have saved a project, the Browser Panel will also give you quick access to all the layers stored in the same path of the project file under in the Project Home item.

Moreover, you can set one or more folder as Favorites: search under your path and once you have found the folder, right click on it and click on Add as a Favorite. You should then be able to see your folder in the Favorites item.

**Sfat:** It can happen that the folders added to Favorite item have a really long name: don't worry right-click on the path and choose Rename Favorite... to set another name.

Your most often used sets of tools can be turned into toolbars for basic access. For example, the File toolbar allows you to save, load, print, and start a new project. You can easily customize the interface to see only the tools you use most often, adding or removing toolbars as necessary via the View Toolbars menu.

Chiar dacă acestea nu sunt vizibile în bara de instrumente, toate instrumentele vor rămâne accesibile prin intermediul meniurilor. De exemplu, dacă scoateți bara de instrumente File (care conține butonul Save), puteți salva în continuare harta făcând clic pe meniul Project și făcând clic pe Save.

This is where the map itself is displayed and where layers are loaded. In the map canvas you can interact with the visible layers: zoom in/out, move the map, select features and many other operations that we will deeply see in the next sections.

Shows you information about the current map. Also allows you to adjust the map scale, the map rotation and see the mouse cursor's coordinates on the map.

By default the Side toolbar contains the buttons to load the layer and all the buttons to create a new layer. But remember that you can move all the toolbars wherever it is more comfortable for you.
The Locator Bar

Within this bar you can access to almost all the objects of QGIS: layers, layer features, algorithms, spatial bookmarks, etc. Check all the different options in the locator_options section of the QGIS User Manual.

Sfat: With the shortcut Ctrl+K you can easily access the bar.

2.1.2 Try Yourself 1

Încercați să identificați cele patru elemente enumerate pe ecranul dvs., fără a face referire la diagrama de mai sus. Vedeti dacă puteți identifica numele și funcțiile lor. Vă veți familiariza cu aceste elemente, pe măsură ce le veți folosi în următoarele zile.

Check your results

2.1.3 Try Yourself 2

Încercați să identificați fiecare dintre aceste instrumente pe ecran. Care este scopul lor?

1.  ➤
2.  ➤
3.  ➤
4.  ➤ Render
5.  ➤

Notă: Dacă nici unul dintre aceste instrumente nu este vizibil pe ecran, încercați să activați unele bare de instrumente care sunt în prezent ascunse. De asemenea, rețineți că, dacă nu există suficient spațiu pe ecran, o bară de instrumente poate fi redusă prin ascunderea unora dintre instrumentele sale. Puteți vedea instrumentele ascunse, făcând clic pe butonul cu două săgeți îndreptate în dreapta, de pe oricare bară de instrumente restrânsă. Puteți vedea un balon cu numele oricărui instrument, prin trecerea un pic a mouse-ului pe deasupra unui instrument.

Check your results

2.1.4 What’s Next?

Now that you are familiar with the basics of the QGIS interface, in the next lesson we will see how to load some common data types.
2.2 Lesson: Adding your first layers

Vom porni aplicația, și vom crea o hartă de bază, pentru utilizarea în exemple și exerciții.

Scopul acestei lecții: De a începe cu un exemplu de hârtă.

Notă: Before starting this exercise, QGIS must be installed on your computer. Also, you should have downloaded the sample data to use.

Lansați QGIS cu ajutorul scurtăturii de pe ecran, din meniul de strat, etc., în funcție de modul în care ați efectuat instalarea.

Notă: The screenshots for this course were taken in QGIS 3.4 running on Linux. Depending on your setup, the screens you encounter may well appear somewhat different. However, all the same buttons will still be available, and the instructions will work on any OS. You will need QGIS 3.4 (the latest version at time of writing) to use this course.

Să începem imediat!

2.2.1 Follow Along: Pregătirea unei hărți

1. Deschideți QGIS. Veți avea o hârtă nouă, albă.

2. The Data Source Manager dialog allows you to choose the data to load depending on the data type. We’ll use it to load our dataset: click the Open Data Source Manager button.

If you can’t find the icon, check that the Data Source Manager toolbar is enabled in the View ➤ Toolbars menu.
3. **Load the protected_areas.shp vector dataset:**
   
   1. Click on the *Vector* tab.
   
   2. Enable the *File* source type.
   
   3. Press the … button next to *Vector Dataset(s)*.
   
   4. Select the exercise_data/shapefile/protected_areas.shp file in your training directory.
   
   5. Click *Open*. You will see the original dialog, with the file path filled in.
6. Click *Add* here as well. The data you specified will now load: you can see a *protected_areas* item in the *Layers* panel (bottom left) with its features shown in the main map canvas.
Felicitări! Aveți o hartă de bază. Acum ar fi un moment bun pentru a vă salva munca.

1. Clic pe butonul **Save As**:
2. Save the map under a solution folder next to exercise_data and call it basic_map.qgz.

### 2.2.2 Try Yourself

Repeat the steps above to add the places.shp and rivers.shp layers from the same folder (exercise_data/shapefile) to the map.

*Check your results*

### 2.2.3 Follow Along: Loading vector data from a GeoPackage Database

Databases allow you to store a large volume of associated data in one file. You may already be familiar with a database management system (DBMS) such as Libreoffice Base or MS Access. GIS applications can also make use of databases. GIS-specific DBMSes (such as PostGIS) have extra functions, because they need to handle spatial data.

The **GeoPackage** open format is a container that allows you to store GIS data (layers) in a single file. Unlike the ESRI Shapefile format (e.g. the protected_areas.shp dataset you loaded earlier), a single GeoPackage file can contain various data (both vector and raster data) in different coordinate reference systems, as well as tables without spatial information; all these features allow you to share data easily and avoid file duplication.

In order to load a layer from a GeoPackage, you will first need to create the connection to it:

1. Click on the **Open Data Source Manager** button.
2. On the left click on the **GeoPackage** tab.
3. Click on the **New** button and browse to the **training_data.gpkg** file in the **exercise_data** folder you downloaded before.
4. Select the file and press **Open**. The file path is now added to the Geopackage connections list, and appears in the drop-down menu.

You are now ready to add any layer from this GeoPackage to QGIS.

1. Click on the **Connect** button. In the central part of the window you should now see the list of all the layers contained in the GeoPackage file.
2. Select the **roads** layer and click on the **Add** button.
A roads layer is added to the Layers panel with features displayed on the map canvas.

3. Click on Close.

Congratulations! You have loaded the first layer from a GeoPackage.

2.2.4 Follow Along: Loading vector data from a SpatiaLite Database with the Browser

QGIS provides access to many other database formats. Like GeoPackage, the SpatiaLite database format is an extension of the SQLite library. And adding a layer from a SpatiaLite provider follows the same rules as described above: Create the connection → Enable it → Add the layer(s).

While this is one way to add SpatiaLite data to your map, let’s explore another powerful way to add data: the Browser.

1. Click the 📚 icon to open the Data Source Manager window.

2. Click on the 📁 Browser tab.

3. In this tab you can see all the storage disks connected to your computer as well as entries for most of the tabs in the left. These allow quick access to connected databases or folders.

   For example, click on the drop-down icon next to the 📘 GeoPackage entry. You’ll see the training-data.gpkg file we previously connected to (and its layers, if expanded).

4. Right-click the 📘 SpatiaLite entry and select New Connection....

5. Navigate to the exercise_data folder, select the landuse.sqlite file and click Open.

   Notice that a 📁 landuse.sqlite folder has been added under the SpatiaLite one.

6. Expand the 📁 landuse.sqlite entry.
7. Double-click the `landuse` layer or select and drag-and-drop it onto the map canvas. A new layer is added to the *Layers* panel and its features are displayed on the map canvas.

![Data Source Manager](image)

**Sfat:** Enable the *Browser* panel in *View ➤ Panels ➤* and use it to add your data. It’s a handy shortcut for the *Data Source Manager ➤ Browser* tab, with the same functionality.

**Notă:** Remember to save your project frequently! The project file doesn’t contain any of the data itself, but it remembers which layers you loaded into your map.

### 2.2.5 🏛️ Try Yourself Load More Vector Data

Load the following datasets from the *exercise_data* folder into your map using any of the methods explained above:

- `buildings`
- `water`

*Verificați-vă rezultatele*
2.2.6 Follow Along: Reordonarea Straturilor

Straturile din lista de straturi sunt desenate pe hartă într-o anumită ordine. Stratul cel mai jos în listă este desenat primul, iar stratul de la vârful listei este desenat ultimul. Schimbând ordinea în care sunt prezentate în listă puteți schimba ordinea în care sunt desenate.

Notă: You can alter this behavior using the Control rendering order checkbox beneath the Layer Order panel. We will however not discuss this feature yet.

Ordinea în care straturile au fost încărcate în hartă probabil că nu este logică în acest moment. Este posibil ca stratul de străzi să fie complet ascuns deoarece alte straturi sunt deasupra lui.

De exemplu, această ordine a straturilor…

… would result in roads and places being hidden as they run underneath the polygons of the landuse layer.

Pentru a rezolva această problemă:

1. Clic apoi glășiți pe un strat din Lista straturilor.
2. Reordoniți-le, pentru a arăta în felul următor:

Veți vedea că harta are mai mult sens, cu străziile și clădirile desenate deasupra regiunilor.
2.2.7 In Conclusion

Now you’ve added all the layers you need from several different sources and created a basic map!

2.2.8 What’s Next?

Now you’re familiar with the basic function of the Open Data Source Manager button, but what about all the others? How does this interface work? Before we go on, let’s take a look at some basic interaction with the QGIS interface. This is the topic of the next lesson.

2.3 Lesson: Navigația pe Canevasul Hărții

Această secțiune se va concentra asupra instrumentelor de navigație principale, folosite la navigarea pe Canevasul Hărții din QGIS. Aceste instrumente vă vor permite explorarea vizuală a straturilor, la diverse scări.

**Scopul acestei lecții:** Întelegerea noțiunilor despre scara hărții și utilizarea instrumentelor Deplasare și Zoom din QGIS.

2.3.1 Follow Along: Instrumente Fundamentale de Navigație

Before learning how to navigate within the Map Canvas, let’s add some layers that we can explore during this tutorial.

1. Open a new blank project and using the steps learnt in *Create a Map*, load the previously seen protected_areas, roads and buildings layers to the project. The result view should look similar to the snippet in Fig. 2.1 below (colors do not matter):
Let's first learn how to use the Pan Tool.

1. In the Map Navigation Toolbar, make sure the Pan button is activated.
2. Move the mouse to the center of the Map Canvas area.
3. Left-click and hold, and drag the mouse in any direction to pan the map.

Next, let's zoom in and take a closer look at the layers we imported.

1. In the Map Navigation Toolbar, click on the Zoom In button.
2. Move your mouse to approximately the top left area of where there is the highest density of buildings and roads.
3. Left click and hold.
4. Then drag the mouse, which will create a rectangle, and cover the dense area of buildings and roads (Fig. 2.2).

Fig. 2.1: Protected areas, roads and buildings added
5. Release the left click. This will zoom in to include the area that you selected with your rectangle.
6. To zoom out, select the Zoom Out button and perform the same action as you did for zooming in. As you pan, zoom in, or zoom out, QGIS saves these views in a history. This allows you to backtrack to a previous view.

1. In the Map Navigation Toolbar, click on the Zoom Last button to go to your previous view.

2. Click on the Zoom Next button to proceed to move forward in your history.

Sometimes after exploring the data, we need to reset our view to the extent of all the layers. Instead of trying to use the Zoom Out tool multiple times, QGIS provides us with a button to do that action for us.

1. Click on the Zoom Full Extent button.

As you zoomed in and out, notice that the Scale value in the Status Bar changes. The Scale value represents the Map Scale. In general, the number to the right of : represents how many times smaller the object you are seeing in the Map Canvas is to the actual object in the real world.
You can also use this field to set the Map Scale manually.

1. In the Status Bar, click on the Scaletextfield.

2. Type in 50000 and press Enter. This will redraw the features in the Map Canvas to reflect the scale you typed in.

3. Alternatively, click on the options arrow of the Scale field to see the preset map scales.

4. Select 1:5000. This will also update the map scale in the Map Canvas.

Now you know the basics of navigating the Map Canvas. Check out the User Manual on Zooming and Panning to learn about alternative ways of navigating the Map Canvas.

2.3.2 In Conclusion

Knowing how to navigate the Map Canvas is important, as it allows one to explore and visually inspect the layers. This could be done for initial data exploration, or to validate output of a spatial analysis.

2.4 Lesson: Simbologia

Simbolistica unui strat reprezintă aspectul său vizual pe hartă. Abilitățile de bază ale GIS, comparativ cu alte moduri de reprezentare a datelor cu aspecte spațiale, constă în faptul că, în GIS, aveți o reprezentare vizuală dinamică a datelor cu care lucrați.

Prin urmare, aspectul vizual al hărții (care depinde de simbolistica straturilor individuale) este foarte important. Utilizatorul final a hărților pe care le produceți, va trebui să fie capabil de a înțelege cu ușurință ceea ce reprezintă harta. La fel de important, dvs. trebuie să fiți în măsura să explorați datele cu care lucrați, iar o bună simbolistică ajută foarte mult.

Cu alte cuvinte, a avea propria simbolologie nu reprezintă un lux sau doar o notiune frumoasă. De fapt, este esențial să utilizați un GIS în mod corespunzător, pentru a produce hărți și informații pe care oamenii să le poată folosi.

Scopul acestei lecții: De a putea crea simbolistica dorită pentru orice strat vectorial.
2.4.1  Follow Along: Schimbarea Culoorilor

Pentru a schimba simbolistica unui strat, deschideți Layer Properties. Să începem prin schimbarea culorii stratului landuse.

1. Right-click on the landuse layer in the layers list.
2. Select the menu item Properties… in the menu that appears.

Notă: De asemenea, în mod implicit, puteți accesa proprietățile unui strat făcând un dublu clic pe acesta, în lista Straturilor.

Sfat: The 🖌 button at the top of the Layers panel will open the Layer Styling panel. You can use this panel to change some properties of the layer: by default, changes will be applied immediately!

3. In the Layer Properties window, select the Symbology tab:

4. Click the color select button next to the Color label. A standard color dialog will appear.
5. Alegeți o culoare gri, apoi faceti clic pe OK.

2.4. Lesson: Simbologia
2.4.2 Try Yourself

Change the color of the water layer to light blue. Try to use the Layer Styling panel instead of the Layer Properties menu.

Check your results

2.4.3 Follow Along: Schimba Structura Simbolului

This is good stuff so far, but there’s more to a layer’s symbology than just its color. Next we want to eliminate the lines between the different land use areas so as to make the map less visually cluttered.

1. Deschideți fereastra Proprietăților Stratului pentru stratul landuse.

   Under the Symbology tab, you will see the same kind of dialog as before. This time, however, you’re doing more than just quickly changing the color.

2. In the symbol layers tree, expand the Fill dropdown and select the Simple fill option.

3. Click on the Stroke style dropdown. At the moment, it should be showing a short line and the words Solid Line.

4. Schimbați-o pe No Pen.

   ![Symbology settings](image)

   5. Clic pe OK
Acum, stratul *landuse* nu va avea nici o linie între arii.

### 2.4.4 Try Yourself

- Change the *water* layer’s symbology again so that it has a darker blue outline.
- Schimbați simbolistica stratului *rivers*, într-o reprezentare mai sensibilă a căilor de apă

Remember: you can use the **Open the Layer Styling panel** button and see all the changes instantly. That panel also allows you to undo individual changes while symbolizing a layer.

*Check your results*

### 2.4.5 Follow Along: Vizibilitate în funcție de scară

Sometimes you will find that a layer is not suitable for a given scale. For example, a dataset of all the continents may have low detail, and not be very accurate at street level. When that happens, you want to be able to hide the dataset at inappropriate scales.

In our case, we may decide to hide the buildings from view at small scales. This map, for example…

… nu este foarte utilă. Clădirile sunt greu de distins la acea scară.

Pentru a activa randarea în funcție de scară:

1. Deschideți dialogul *Proprietăților Stratului* pentru stratul *buildings*.
2. Activate the **Rendering** tab.
3. Enable scale-based rendering by clicking on the checkbox labeled *Scale dependent visibility*:
4. Change the *Minimum* value to 1:10000.
5. Click **OK**

Test the effects of this by zooming in and out in your map, noting when the *buildings* layer disappears and reappears.

**Nota:** You can use your mouse wheel to zoom in increments. Alternatively, use the zoom tools to zoom to a window:

---

### 2.4.6 Follow Along: Adăugarea Straturilor Simbolului

Now that you know how to change simple symbology for layers, the next step is to create more complex symbology. QGIS allows you to do this using symbol layers.

1. Go back to the *landuse* layer’s symbol properties panel (by clicking *Simple fill* in the symbol layers tree).

   In this example, the current symbol has no outline (i.e., it uses the *No Pen* border style).
2. Select the Fill level in the tree and click the Add symbol layer button. The dialog will change to look something like this, with a new symbol layer added:
It may appear somewhat different in color, for example, but you’re going to change that anyway.

Now there’s a second symbol layer. Being a solid color, it will of course completely hide the previous kind of symbol. Plus, it has a Solid Line border style, which we don’t want. Clearly this symbol has to be changed.

Notă: It’s important not to get confused between a map layer and a symbol layer. A map layer is a vector (or raster) that has been loaded into the map. A symbol layer is part of the symbol used to represent a map layer. This course will usually refer to a map layer as just a layer, but a symbol layer will always be called a symbol layer, to prevent confusion.

With the new Simple Fill symbol layer selected:

1. Setăti stilul bordurii la No Pen, ca mai înainte.

2. Change the fill style to something other than Solid or No brush. For example:
3. Click OK

Now you can see your results and tweak them as needed. You can even add multiple extra symbol layers and create a kind of texture for your layer that way.

It's fun! But it probably has too many colors to use in a real map…

2.4.7 **Try Yourself**

Remembering to zoom in if necessary, create a simple, but not distracting texture for the *buildings* layer using the methods above.

*Check your results*
2.4.8 Follow Along: Ordonarea Nivelurilor Simbolului

When symbol layers are rendered, they are also rendered in a sequence, similar to the way the different map layers are rendered. This means that in some cases, having many symbol layers in one symbol can cause unexpected results.

1. Give the roads layer an extra symbol layer (using the method for adding symbol layers demonstrated above).
2. Give the base line a Stroke width of 1.5 and a black color.
3. Give the new, uppermost layer a thickness of 0.8 and a white color.

Veți observa că se întâmplă acest lucru:

Well, roads have now a street like symbology, but you see that lines are overlapping each others at each cross. That’s not what we want at all!

To prevent this from happening, you can sort the symbol levels and thereby control the order in which the different symbol layers are rendered.

To change the order of the symbol layers:

1. Select the topmost Line layer in the symbol layers tree.
2. Click Advanced ► Symbol levels… in the bottom right-hand corner of the window.
3. Check **Enable symbol levels**. You can then set the layer order of each symbol by entering the corresponding level number. 0 is the bottom layer.
In our case, we just want to activate the option, like this:

![Symbol Levels dialog](image)

This will render the white line above the thick black line borders:

4. Faceți clic pe Ok pentru a reveni la hartă.

Harta va arăta acum în modul următor:

![Map example](image)

When you're done, remember to save the symbol itself so as not to lose your work if you change the symbol again in the future. You can save your current symbol style by clicking the Save Style... button at the bottom of the Layer Properties dialog. We will be using the **QGIS QML Style File** format.
Save your style in the `solution/styles/better_roads.qml` folder. You can load a previously saved style at any time by clicking the *Load Style*... button. Before you change a style, keep in mind that any unsaved style you are replacing will be lost.

2.4.9 **Try Yourself**

Schimbați iarăși aspectul stratului *roads*.

Make the roads narrow and yellow, with a thin, pale gray outline and a thin black line in the middle. Remember that you may need to change the layer rendering order via the *Advanced ➤ Symbol levels*... dialog.

Check your results

2.4.10 **Try Yourself**

Symbol levels also work for classified layers (i.e., layers having multiple symbols). Since we haven’t covered classification yet, you will work with some rudimentary pre-classified data.

1. Creați o nouă hartă și adăugați doar setul de date *roads*.
2. Load the style file `advanced_levels_demo.qml` provided in `exercise_data/styles`.
3. Focalizați în aria Swellendam.
4. Using symbol layers, ensure that the outlines of layers flow into one another as per the image below:
In addition to setting fill colors and using predefined patterns, you can use different symbol layer types entirely. The only type we’ve been using up to now was the *Simple Fill* type. The more advanced symbol layer types allow you to customize your symbols even further.

Each type of vector (point, line and polygon) has its own set of symbol layer types. First we will look at the types available for points.

**Tipurile de Straturi pentru Simbolurile de tip Punct**

1. Uncheck all the layers except for *places*.
2. Modifică proprietățile simbolului pentru stratul *places*.
3. You can access the various symbol layer types by selecting the *Simple marker* layer in the symbol layers tree, then click the *Symbol layer type* dropdown:
4. Investigate the various options available to you, and choose a symbol with styling you think is appropriate.

5. If in doubt, use a round Simple marker with a white border and pale green fill, with a Size of 3.00 and a Stroke width of 0.5.

Tipurile de Straturi pentru Simbolurile de tip Linie

Pentru a vedea diferitele optiuni disponibile pentru datele de tip linie:

1. Change the Symbol layer type for the roads layer’s topmost symbol layer to Marker line:
2. Select the *Simple marker* layer in the symbol layers tree. Change the symbol properties to match this dialog:
3. Select the *Marker line* layer and change the interval to 1.00:
4. Ensure that the symbol levels are correct (via the Advanced ► Symbol levels dialog we used earlier) before applying the style.

Once you have applied the style, take a look at its results on the map. As you can see, these symbols change direction along with the road but don’t always bend along with it. This is useful for some purposes, but not for others. If you prefer, you can change the symbol layer in question back to the way it was before.

**Tipurile de Straturi pentru Simbolurile de tip Poligon**

Pentru a vedea diferitele opțiuni disponibile pentru datele poligonale:

1. Change the Symbol layer type for the water layer, as before for the other layers.
2. Investigați ce pot face diferitele opțiuni din listă.
3. Alegeți una dintre ele, pe care o găsiți potrivită.
4. Dacă aveti îndoieni, utilizați Umplere cu model din puncte, având următoarele opțiuni:
5. Adăugați un nou simbol, cu o Umplere simplă, normală.
6. Faceti-l în același albastru deschis, cu un chenar albastru mai închis.
7. Mutati-l sub stratul simbol cu modelul din puncte, cu ajutorul butonului Move down:
As a result, you have a textured symbol for the water layer, with the added benefit that you can change the size, shape and distance of the individual dots that make up the texture.

2.4.12 **Try Yourself**

Apply a green transparent fill color to the *protected_areas* layer, and change the outline to look like this:
2.4.13 Follow Along: Geometry generator symbology

You can use the Geometry generator symbology with all layer types (points, lines and polygons). The resulting symbol depends directly on the layer type.

Very briefly, the Geometry generator symbology allows you to run some spatial operations within the symbology itself. For example, you can run a real centroid spatial operation on a polygon layer without creating a point layer.

Moreover, you have all the styling options to change the appearance of the resulting symbol.

Let’s give it a try!

1. Select the *water* layer.

2. Click on *Simple fill* and change the *Symbol layer type* to *Geometry generator*. 
3. Before to start writing the spatial query we have to choose the Geometry Type in output. In this example we are going to create centroids for each feature, so change the Geometry Type to **Point / Multipoint**.

4. Now let's write the query in the query panel:

```sql
centroid(@geometry)
```
5. When you click on OK you will see that the water layer is rendered as a point layer! We have just run a spatial operation within the layer symbology itself, isn’t that amazing?
With the Geometry generator symbology you can really go over the edge of *normal* symbology.

---

**Try Yourself**

Geometry generator are just another symbol level. Try to add another *Simple fill* underneath the *Geometry generator* one.

Change also the appearance of the Simple marker of the Geometry generator symbology.

The final result should look like this:
Verificați-vă rezultatele

2.4.14 Try Yourself Crearea unei Umpleri pentru SVG Personalizată

Notă: To do this exercise, you will need to have the free vector editing software Inkscape installed.

1. Start the Inkscape program. You will see the following interface:
Ar trebui să vi se pară familiar dacă ați folosit alte programe de editare a imaginilor vectoriale, cum ar fi Corel.

În primul rând, vom schimba canevasul la o dimensiune adecvată pentru o mică textură.

2. Click on the menu item File ➤ Document Properties. This will give you the Document Properties dialog.
3. Schimbați Unitățile în px.
4. Change the Width and Height to 100.
5. Închideți dialogul, după încheiere.
6. Faceti clic pe elementul de meniu View ➤ Zoom ➤ Page pentru a vedea pagina la care lucrați.
7. Selectați instrumentul Circle:
8. Mentineţi apăsat butonul mouse-ului şi trasati pe pagină o elipsă. Pentru a transforma o elipsă într-un cerc, mentineţi apăsat şi butonul Ctrl pe durata desenării.

9. Right-click on the circle you just created and open its Fill and Stroke options. You can modify its rendering, such as:
   1. Stabiliţi pentru culoarea de Umplere o culoare albastru spre gri pal,
   2. Assign to the border a darker color in Stroke paint tab,
   3. And reduce the border thickness under Stroke style tab.
10. Draw a line using the *Pencil* tool:

1. Click once to start the line. Hold Ctrl to make it snap to increments of 15 degrees.
2. Deplasati indicatorul pe orizontală și puneti un punct cu un simplu click.
3. Click and snap to the vertex of the line and trace a vertical line, ended by a simple click.
4. Now join the two end vertices.
5. Change the color and width of the triangle symbol to match the circle’s stroke and move it around as necessary, so that you end up with a symbol like this one:
11. If the symbol you get satisfies you, then save it as `landuse_symbol` under the directory that the course is in, under `exercise_data/symbols`, as SVG file.

In QGIS:

1. Open the *Layer Properties* for the `landuse` layer.

2. In the `Symbology` tab, change the symbol structure by changing the `Symbol Layer Type` to `SVG Fill`` shown below.

3. Click the … button and then `Select File…` to select your SVG image.

   It's added to the symbol tree and you can now customize its different characteristics (colors, angle, effects, units…).
Once you validate the dialog, features in *landuse* layer should now be covered by a set of symbols, showing a texture like the one on the following map. If textures are not visible, you may need to zoom in the map canvas or set in the layer properties a bigger *Texture width*. 
2.4.15 In Conclusion

Changing the symbology for the different layers has transformed a collection of vector files into a legible map. Not only can you see what’s happening, it’s even nice to look at!

2.4.16 Further Reading

Examples of Beautiful Maps

2.4.17 What’s Next?

Changing symbols for whole layers is useful, but the information contained within each layer is not yet available to someone reading these maps. What are the streets called? Which administrative regions do certain areas belong to? What are the relative surface areas of the farms? All of this information is still hidden. The next lesson will explain how to represent this data on your map.

Notă: V-ați amintit recent să efectuați o salvare a hărții?
Clasificarea datelor vectoriale vă permite să atribuiți diferite simboluri entităților (diverse obiecte din acelasi strat), în funcție de atributelor lor. Acest lucru permite celui care folosește harta, să vadă cu ușurință atributele feluritelor entități.

3.1 Lesson: Vector Attribute Data

Vector data is arguably the most common kind of data in the daily use of GIS. The vector model represents the location and shape of geographic features using points, lines and polygons (and for 3D data also surfaces and volumes), while their other properties are included as attributes (often presented as a table in QGIS).

Până în prezent, nici una dintre schimbările pe care le-am adus hărții nu au fost influențate de obiectele afisate. Cu alte cuvinte, toate zonele de utilizare a terenurilor și toate drumurile arată la fel. Atunci când văd o hârtie, privitorii nu știu nimic despre drumurile pe care le observă; doar faptul că există un drum de o anumită formă, într-o anumită zonă.

Adevărata putere a GIS-ului constă în faptul că toate obiectele care sunt vizibile pe harta au, la rândul lor, attribute. Hărțile dintr-un GIS nu sunt doar imagini. Ele reprezintă nu numai obiectele din locații, dar, ci și informații despre aceste obiecte.

The goal for this lesson: To learn about the structure of vector data and explore the attribute data of an object

3.1.1 Follow Along: Vizualizarea Atributelor Straturilor

De asemenea, este important de știut că datele cu care lucrați nu reprezintă doar locul „unde” se află obiectele în spațiul, dar vă spun și ce sunt acele obiecte.

From the previous exercise, you should have the protected_areas layer loaded in your map. If it is not loaded, then you can find the protected_areas.shp ESRI Shapefile format dataset in directory exercise_data/shapefile.

The polygons representing the protected areas constitute the spatial data, but we can learn more about the protected areas by exploring the attribute table.

1. In the Layers panel, click on the protected_areas layer to select it.
2. In the Attributes Toolbar click the Open Attribute Table button. This will open a new window showing the attribute table of the protected_areas layer.

A row is called a record and is associated with a feature in the Canvas Map, such as a polygon. A column is called a field (or an attribute), and has a name that helps describe it, such as name or id. Values in the cells are known as attribute values. These definitions are commonly used in GIS, so it is good to become familiar with them.

In the protected_areas layer, there are two features, which are represented by the two polygons we see on the Map Canvas.

Nota: In order to understand what the fields and attribute values represent, one may need to find documentation (or metadata) describing the meaning of the attribute values. This is usually available from the creator of the data set.

Next, let’s see how a record in the attribute table is linked to a polygon feature that we see on the Map Canvas.

1. Go back to the main QGIS window.

2. In the Attributes Toolbar, click on the Select Feature button.

3. Make sure the protected_areas layer is still selected in the Layers panel.

4. Move your mouse to the Map Canvas and left click on the smaller of the two polygons. The polygon will turn yellow indicating it is selected.
5. Go back to the Attribute Table window, and you should see a record (row) highlighted. These are the attribute values of the selected polygon.
You can also select a feature using the Attribute Table.

1. In the Attribute Table window, on the far left, click on the row number of the record that is currently not selected.

2. Go back to the main QGIS window and look at the Map Canvas. You should see the larger of the two polygons colored yellow.

3. To deselect the feature, go to the Attribute Table window and click on \( \text{Deselect all features from the layer} \) button.

Sometimes there are many features shown on the Map Canvas and it might be difficult to see which feature is selected from the Attribute Table. Another way to identify the location of a feature is to use the Flash Feature tool.

1. In the Attribute Table, right-click on any cell in the row that has the attribute value r2855697 for the field full_id.

2. In the context menu, click on Flash Feature and watch the Map Canvas.

You should see the polygon flash red a few times. If you missed it, try it again.

Another useful tool is the Zoom to Feature tool, that tells QGIS to zoom to the feature of interest.

1. In the Attribute Table, right-click on any cell in the row that has the attribute value r2855697 for the field full_id.

2. In the context menu, click on Zoom to Feature.
Look at the Map Canvas. The polygon should now occupy the extent of the Map Canvas area.

Acum, puteți închide tabelul de atribute.

### 3.1.2 Try Yourself Exploring Vector Data Attributes

1. How many fields are available in the rivers layer?
2. Tell us a bit about the town places in your dataset.
3. Open the attribute table for the places layer. Which field would be the most useful to represent in label form, and why?

*Verificați-vă rezultatele*

### 3.1.3 In Conclusion

Acum știi cum să folosiți tabelul de atribute pentru a vedea ceea ce se află, de fapt, în datele pe care îl utilizați. Orice set de date va fi util pentru dvs. numai dacă are atributele care vă interesează. Dacă știi de care atribute aveți nevoie, puteți decide rapid dacă puteți utiliza un anumit set de date, sau dacă trebuie să căutați un altul care are datele cerute.

### 3.1.4 What's Next?

Diferite atribute sunt utile pentru diferite scopuri. Unele dintre ele pot fi reprezentate direct sub formă de text, pentru ca utilizatorul să le poată vedea. Veți afla cum să faceți acest lucru în lecția următoare.
3.2 Lesson: Labels

Etichetele pot fi adăugate pe o hartă, pentru a afișa informații despre un obiect. Orice strat vectorial poate avea etichete asociate cu el. Conținutul acestor etichete se bazează pe datele atributului unui strat.

Scopul acestei lecții: De a aplica etichete folositoare și plăcute unui strat.

3.2.1 Follow Along: Folosirea Etichetelor

First, ensure that the button is visible in the GUI:

1. Go to the menu item View ▶ Toolbars
2. Ensure that the Label Toolbar item has a check mark next to it. If it doesn’t, click on the Label Toolbar item to activate it.
3. Click on the places layer in the Layers panel so that it is highlighted
4. Click on the toolbar button to open the Labels tab of the Layer Styling panel
5. Switch from No Labels to Single Labels

You’ll need to choose which field in the attributes will be used for the labels. In the previous lesson, you decided that the name field was the most suitable one for this purpose.

6. Select name from the Value list:
7. Click **Apply**

Etichetele hărții ar trebui să arate astfel:
3.2.2 Follow Along: Optiunile de Schimbare a Etichetelor

Depending on the styles you chose for your map in earlier lessons, you might find that the labels are not appropriately formatted and either overlap or are too far away from their point markers.

**Notă:** Above, you used the button in the Label Toolbar to open the Layer Styling panel. As with Symbology, the same label options are available via both the Layer Styling panel and the Layer Properties dialog. Here, you'll use the Layer Properties dialog.

1. Open the Layer Properties dialog by double-clicking on the places layer
2. Select the Labels tab
3. Make sure Text is selected in the left-hand options list, then update the text formatting options to match those shown here:
4. Click Apply

That font may be larger and more familiar to users, but its readability is still dependent on what layers are rendered beneath it. To solve this, let’s take a look at the Buffer option.

5. Select Buffer from the left-hand options list

6. Select the checkbox next to Draw text buffer, then choose options to match those shown here:
7. Click *Apply*

You’ll see that this adds a colored buffer or border to the place labels, making them easier to pick out on the map:
Now we can address the positioning of the labels in relation to their point markers.

8. Select Placement from the left-hand options list

9. Select Around point and change the value of Distance to 2.0 Millimeters:
10. Click **Apply**

   You’ll see that the labels are no longer overlapping their point markers.

### 3.2.3 Adjusting Labels for Better Clarity

In many cases, the location of a point doesn’t need to be very specific. For example, most of the points in the `places` layer refer to entire towns or suburbs, and the specific point associated with such features is not that specific on a large scale. In fact, giving a point that is too specific is often confusing for someone reading a map.

To name an example: on a map of the world, the point given for the European Union may be somewhere in Poland, for instance. To someone reading the map, seeing a point labeled *European Union* in Poland, it may seem that the capital of the European Union is therefore in Poland.

So, to prevent this kind of misunderstanding, it’s often useful to deactivate the point symbols and replace them completely with labels.

In QGIS, you can do this by changing the position of the labels to be rendered directly over the points they refer to.

1. Open the **Labels** tab of the **Layer Properties** dialog for the `places` layer
2. Select the **Placement** option from the options list
3. Click on the Offset from point button

This will reveal the Quadrant options which you can use to set the position of the label in relation to the point marker. In this case, we want the label to be centered on the point, so choose the center quadrant:

![Image of QGIS Layer Properties window with Quadrant settings]

4. Hide the point symbols by editing the layer Symbology as usual, and setting the size of the Marker size to 0.0:

![Image of QGIS Layer Properties window with Symbology settings]
5. Click **Apply** and you’ll see this result:
If you were to zoom out on the map, you would see that some of the labels disappear at larger scales to avoid overlapping. Sometimes this is what you want when dealing with datasets that have many points, but at other times you will lose useful information this way. There is another possibility for handling cases like this, which we’ll cover in a later exercise in this lesson. For now, zoom out and click on the [button in the toolbar and see what happens.

3.2.4 Try Yourself Personalizarea Etichetelor

- Reset the label and symbol settings to have a point marker and a label offset of 2.0 Millimeters.

Check your results

- Set the map to the scale 1:100000. You can do this by typing it into the Scale box in the Status Bar. Modify your labels to be suitable for viewing at this scale.

Check your results
3.2.5 Follow Along: Etichetarea Liniilor

Acum, după ce ştim cum funcționează etichetarea, remarcăm o problemă suplimentară. Punctele și poligoanele sunt ușor de etichetat, dar ce spuneți despre linii? Dacă le etichetăm în același mod ca și pe puncte, rezultatele ar arăta astfel:

We will now reformat the roads layer labels so that they are easy to understand.

1. Hide the places layer so that it doesn’t distract you
2. Activate Single Labels for the roads layer as you did above for places
3. Set the font Size to 10 so that you can see more labels
4. Zoom in on the Swellendam town area
5. In the Labels tab’s Placement tab, choose the following settings:
You’ll probably find that the text styling has used default values and the labels are consequently very hard to read. Update the Text to use a dark-grey or black Color and the Buffer to use a light-yellow Color.

Harta va arăta aproximativ în modul următor, în funcție de scară:
You’ll see that some of the road names appear more than once and that’s not always necessary. To prevent this from happening:

6. In the Labels tab of the Layer Properties dialog, choose the Rendering option and select *Merge connected lines to avoid duplicate labels* as shown:
7. Click OK

Another useful function is to prevent labels being drawn for features too short to be of notice.

8. In the same Rendering panel, set the value of Suppress labeling of features smaller than to 5.00 mm and note the results when you click Apply.

Try out different Placement settings as well. As we’ve seen before, the Horizontal option is not a good idea in this case, so let’s try the Curved option instead.

9. Select the Curved option in the Placement panel of the Labels tab

Iată rezultatul:
As you can see, this hides some labels that were previously visible, because of the difficulty of making some of them follow twisting street lines while still being legible. It makes other labels much more useful since they track the roads rather than float in space between them. You can decide which of these options to use, depending on what you think seems more useful or what looks better.

### 3.2.6 Follow Along: Setărilor Definite cu ajutorul Datelor

1. Deactivate labeling for the **roads** layer
2. Reactivate labeling for the **places** layer
3. Open the attribute table for **places** via the button
   
   It has one **field** which is of interest to us now: **place** which defines the type of urban area for each **record**. We can use this data to influence the label styles.
4. Navigate to the **Text** panel in the **places Labels** panel
5. Click the button next to the Italic text button beneath **Style** and select **Edit…** to open the **Expression String Builder**.
6. Under *Fields and Values*, double click on `place` and then click *All Unique*. This will list all unique values of the `place` field of this layer. Add a = in the text editor and then double click on `town`.

   Alternatively, you can type: "place" = 'town' directly in the text editor.

7. Click OK twice:

   Notice that the labels for all places whose `place` field matches `town` are displayed in italics.
3.2.7 Try Yourself Utilizarea Setărilor Definite cu ajutorul Datelor

**Nota:** We’re jumping ahead a bit here to demonstrate some advanced labeling settings. At the advanced level, it’s assumed that you’ll know what the following means. If you don’t, feel free to leave out this section and come back later when you’ve covered the requisite materials.

1. Open the Attribute Table for places
2. Enter edit mode by clicking the button
3. Add a new column with the button
4. Configurați-l astfel:
5. Use this to set custom font sizes for each different type of place (each key in the place field) 

Check your results

3.2.8 Alte Posibilități de Etichetare

We can’t cover every option in this course, but be aware that the Label tab has many other useful functions. You can set scale-based rendering, alter the rendering priority for labels in a layer, and set every label option using layer attributes. You can even set the rotation, XY position, and other properties of a label (if you have attribute fields allocated for the purpose), then edit these properties using the tools adjacent to the main Layer Labeling Options button:

(Aceste instrumente vor fi active dacă există câmpurile de atribute obligatorii și vă aflați în modul de editare.)

Sîntți-vă liberi să explorați mai multe posibilități ale sistemului de etichetare.

3.2.9 In Conclusion

Ati învățat cum să folosiți atributele stratului, pentru a crea în mod dinamic etichetele. Acest lucru poate face harta mult mai informativă și mai elegantă!

3.2.10 What’s Next?

Now that you know how attributes can make a visual difference for your map, how about using them to change the symbology of objects themselves? That’s the topic for the next lesson!

3.3 Lesson: Clasificarea

Labels are a good way to communicate information such as the names of individual places, but they can’t be used for everything. For example, let us say that someone wants to know what each landuse area is used for. Using labels, you would get this:
Acest lucru face etichetarea hărții dificil de înțeles, și chiar coplesitoare atunci când există suprafețe de teren cu numeroase utilizări.

**Scopul acestei lectii:** De a afla cum se pot clasifica în mod eficient datele vectoriale.

### 3.3.1 Follow Along: Clasificarea Datelor Nominale

1. Open the *Layer Properties* dialog for the *landuse* layer
2. Go to the *Symbology* tab
3. Faceți clic, în meniul cu derulare verticală, pe *Simbol Unic* și schimbați-l în *Categorisit*:
4. In the new panel, change the Value to landuse and the Color ramp to Random colors.

5. Click the button labeled Classify.

6. Clic pe OK
   Veți vedea ceva de genul următor:
7. Click the arrow (or plus sign) next to landuse in the Layers panel, you'll see the categories explained:
Now our landuse polygons are colored and are classified so that areas with the same land use are the same color.

8. If you wish to, you can change the symbol of each landuse area by double-clicking the relevant color block in the Layers panel or in the Layer Properties dialog:
Observați că există o categorie necompletată:
This empty category is used to color any objects which do not have a landuse value defined or which have a NULL value. It can be useful to keep this empty category so that areas with a NULL value are still represented on the map. You may like to change the color to more obviously represent a blank or NULL value.

Amintiți-vă să salvați harta dvs. acum, astfel încât să nu pierdeți toate modificările greu efectuate!

3.3.2 Try Yourself Mai Multe Clasificări

Use the knowledge you gained above to classify the buildings layer. Set the categorisation against the building field and use the Spectral color ramp.

Notă: Amintiți-vă să focusați într-o zonă urbană, pentru a vedea rezultatele.

3.3.3 Follow Along: Rația Clasificării

Există patru tipuri de clasificare: nominal, ordinal, interval și raport.

In nominal classification, the categories that objects are classified into are name-based; they have no order. For example: town names, district codes, etc. Symbols that are used for nominal data should not imply any order or magnitude.

- For points, we can use symbols of different shape.
- For polygons, we can use different types of hatching or different colours (avoid mixing light and dark colours).
- For lines, we can use different dash patterns, different colours (avoid mixing light and dark colours) and different symbols along the lines.
In **ordinal** classification, the categories are arranged in a certain order. For example, world cities are given a rank depending on their importance for world trade, travel, culture, etc. Symbols that are used for ordinal data should imply order, but not magnitude.

- For points, we can use symbols with light to dark colours.
- For polygons, we can use graduated colours (light to dark).
- For lines, we can use graduated colours (light to dark).

In **interval** classification, the numbers are on a scale with positive, negative and zero values. For example: height above/below sea level, temperature in degrees Celsius. Symbols that are used for interval data should imply order and magnitude.

- For points, we can use symbols with varying size (small to big).
- For polygons, we can use graduated colours (light to dark) or add diagrams of varying size.
- For lines, we can use thickness (thin to thick).

In **ratio** classification, the numbers are on a scale with only positive and zero values. For example: temperature above absolute zero (0 degrees Kelvin), distance from a point, the average amount of traffic on a given street per month, etc. Symbols that are used for ratio data should imply order and magnitude.

- For points, we can use symbols with varying size (small to big).
- For polygons, we can use graduated colours (light to dark) or add diagrams of varying size.
- For lines, we can use thickness (thin to thick).

In the example above, we used nominal classification to color each record in the landuse layer based on its landuse attribute. Now we will use ratio classification to classify the records by area.

We are going to reclassify the layer, so existing classes will be lost if not saved. To store the current classification:

1. Open the layer’s properties dialog
2. Click the Save Style ... button in the Style drop-down menu.
3. Select Rename Current..., enter land usage and press OK.
   
   The categories and their symbols are now saved in the layer’s properties.

4. Click now on the Add... entry of the Style drop-down menu and create a new style named ratio. This will store the new classification.

5. Close the Layer Properties dialog

We want to classify the landuse areas by size, but there is a problem: they don’t have a size field, so we’ll have to make one.

1. Open the Attributes Table for the landuse layer.
2. Enter edit mode by clicking the Toggle editing button
3. Add a new column of decimal type, called AREA, using the New field button:
4. Click OK

The new field will be added (at the far right of the table; you may need to scroll horizontally to see it). However, at the moment it is not populated, it just has a lot of NULL values.

To solve this problem, we will need to calculate the areas.

1. Open the field calculator with the button.

   You will get this dialog:

   ![Field Calculator Dialog](image)

2. Check the Update existing fields

3. Select AREA in the fields drop-down menu
4. Under the Expression tab, expand the Geometry functions group in the list and find $area$
5. Double-click on it so that it appears in the Expression field

6. Click OK

7. Scroll to the AREA field in the attribute table and you will notice that it is populated with values (you may need to click the column header to refresh the data).

Notă: These areas respect the project’s area unit settings, so they may be in square meters or square degrees.

5. Press to save the edits and exit the edit mode with Toggle editing
6. Close the attribute table

Now that we have the data, let’s use them to render the landuse layer.

1. Open the Layer properties dialog’s Symbology tab for the landuse layer
2. Change the classification style from Categorized to Graduated
3. Change the Value to AREA
4. Under Color ramp, choose the option Create New Color Ramp…:

5. Choose Gradient (if it’s not selected already) and click OK. You will see this:
Veți folosi acest lucru pentru a desemna *Color 1* pentru suprafetele mici și *Color 2* pentru suprafetele mari.

6. Choose appropriate colors

În acest exemplu, rezultatul arată în felul următor:
7. Click **OK**

8. You can save the colour ramp by selecting **Save Color Ramp**... under the **Color ramp** tab. Choose an appropriate name for the colour ramp and click **Save**. You will now be able to select the same colour ramp easily under **All Color Ramps**.

9. Click **Classify**

   Now you will have something like this:
Lăsați totul așa cum este.

10. Click OK:
3.3.4 Try Yourself Rafinarea Clasificării

- Modificați valoarea pentru Mod și Clase până când obțineți o clasificare care are sens.

Check your results

3.3.5 Follow Along: Clasificarea Bazată pe Reguli

Adesea este utilă combinarea mai multor criterii pentru o clasificare, dar, din păcate, clasificarea normală ia în considerare doar un singur atribut. Acesta este cazul în care este utilă clasificarea bazată pe reguli.

In this lesson, we will represent the landuse layer in a way to easily identify Swellendam city from the other residential area, and from the other types of landuse (based on their area).

1. Open the Layer Properties dialog for the landuse layer
2. Switch to the Symbology tab
3. Switch the classification style to Rule-based

QGIS will automatically show the rules that represent the current classification implemented for this layer. For example, after completing the exercise above, you may see something like this:

4. Click and drag to select all the rules
5. Use the Remove selected rules button to remove all of the existing rules

Let's now add our custom rules.

1. Click the Add rule button
2. The Edit rule dialog then appears
3. Enter Swellendam city as Label
4. Click the button next to the Filter text area to open the Expression String Builder
5. Enter the criterion "name" = 'Swellendam' and validate
6. Back to the *Edit rule* dialog, assign it a darker grey-blue color in order to indicate the town's importance in the region and remove the border.

7. Press *OK*

8. Repeat the steps above to add the following rules:

1. **Other residential** label with the criterion "landuse" = 'residential' AND "name" <> 'Swellendam' (or "landuse" = 'residential' AND "name" != 'Swellendam'). Choose a pale blue-grey *Fill color*.

2. **Big non residential areas** label with the criterion "landuse" <> 'residential' AND "AREA" >= 605000. Choose a mid-green color.
These filters are exclusive, in that they exclude areas on the map (non-residential areas which are smaller than 605000 (square meters) are not included in any of the rules).

3. We will catch the remaining features using a new rule labeled **Small non residential areas**. Instead of a filter expression, Check the Else. Give this category a suitable pale green color.

Your rules should now look like this:
9. Apply this symbology

Harta dvs. va arăta în felul următor:

Acum aveți o hartă cu cele mai notabile zone rezidențiale din Swellendam și cu alte zone, non-rezidențiale, colorate în funcție de dimensiunea lor.
3.3.6 In Conclusion

Simbologia ne permite să reprezentăm atribuțele unui strat într-un mod ușor de citit. Ne facilitează atât nouă, cât și înțelegerea semnificației entităților, utilizând atribuțele relevante alese. În funcție de problemele cu care ne confruntăm, vom aplica diferite tehnici de clasificare pentru a le rezolva.

3.3.7 What's Next?

Acum avem o hârtă cu un aspect plăcut, dar oare cum o vom exporta din QGIS, într-un format tipăribil, ca imagine sau ca PDF? Asta e tema următoarei lecții!
Module: Laying out the Maps

In this module, you’ll learn how to use the QGIS print layout to produce quality maps with all the requisite map components.

4.1 Lesson: Using Print Layout

Now that you’ve got a map, you need to be able to print it or to export it to a document. The reason is, a GIS map file is not an image. Rather, it saves the state of the GIS program, with references to all the layers, their labels, colors, etc. So for someone who doesn’t have the data or the same GIS program (such as QGIS), the map file will be useless. Luckily, QGIS can export its map file to a format that anyone’s computer can read, as well as printing out the map if you have a printer connected. Both exporting and printing is handled via the Print Layout.

The goal for this lesson: To use the QGIS Print Layout to create a basic map with all the required settings.

4.1.1 Follow Along: The Layout Manager

QGIS allows you to create multiple maps using the same map file. For this reason, it has a tool called the Layout Manager.

1. Click on the Project ➤ Layout Manager... menu entry to open this tool. You’ll see a blank Layout manager dialog appear.
2. Under *New from Template*, select *Empty layout* and press the *Create...* button.

3. Give the new layout the name of Swellendam and click *OK*.

4. You will now see the *Print Layout* window:

You could also create this new layout via the *Project ➤ New Print Layout...* menu.

Whichever route you take, the new print layout is now accessible from the *Project ➤ Layouts ➤* menu, as in the image below.
4.1.2 Follow Along: Crearea Hârtii de Bază

În acest exemplu, compoziția arată deja în modul dorit. Asigurați-vă că și a dvs. arată așa cum ați intenționat.

1. Right-click on the sheet in the central part of the layout window and choose Page properties… in the context menu.

2. Check that the values in the Item Properties tab are set to the following:
   - Size: A4
   - Orientation: Landscape

Acum aveți aspectul paginii pe care l-ați dorit, dar această pagină este în continuare neagră. Îi lipsese în mod clar o hârtă. Haideți să reparăm asta!

3. Click on the Add Map button.

   With this tool activated, you will be able to place a map on the page.

4. Faceți clic și trasăți un dreptunghi pe pagina albă:

---

4.1. Lesson: Using Print Layout

---

99
Harta va apărea pe pagină.

5. Deplasați harta făcând clic și mișcând-o după dorință:

6. Resize it by clicking and dragging the boxes on the edges:
Notă: Harta poate să prezinte un lot diferit, desigur! Acest lucru depinde de modul în care este configurat propriul proiect. Dar nu vă faceți grijii! Aceste instrucțiuni sunt generale, astfel încât ele vor lucra la fel, indiferent de ceea ce se afișează pe hartă.

7. Asigurați-vă că lăsați marginile în jurul conturului, și un spațiu în partea de sus pentru titlu.

8. Mâriți și micsorați pagina (dar nu și harta!) folosind aceste butoane:

9. Zoom and pan the map in the main QGIS window. You can also pan the map using the Move item content tool.

   The map view updates as you zoom in or zoom out.

10. If, for any reason, the map view does not refresh correctly, you can force the map to refresh by clicking the Refresh view button.

   Remember that the size and position you’ve given the map doesn’t need to be final. You can always come back and change it later if you’re not satisfied. For now, you need to ensure that you’ve saved your work on this map. Because a Print Layout in QGIS is part of the main map file, you must save your project.

11. Go to the Layout ➤ Save Project. This is a convenient shortcut to the one in the main dialog.

### 4.1.3 Follow Along: Adăugarea unui Titlu

Now your map is looking good on the page, but your readers/users are not being told what’s going on yet. They need some context, which is what you’ll provide for them by adding map elements. First, let us add a title.

1. Click on the Add Label button

2. Click on the page, above the map, accept the suggested values in the New Item Properties dialog, and a label will appear at the top of the map.

3. Redimensionați-o și puneti-o în partea centrală, de sus, a paginii. Aceasta poate fi redimensionată și mutată în același mod în care se redimensionează și se mută harta.
Pe măsură ce mutați titlul, veți observa că liniile directoare apar pentru a vă ajuta să-l poziționați în centrul paginii.

However, there is also a tool in the Actions Toolbar to help position the title relative to the map (not the page):

4. Click the map to select it
5. Hold in Shift on your keyboard and click on the label so that both the map and the label are selected.

6. Look for the Align selected items left button and click on the dropdown arrow next to it to reveal the positioning options and click Align center:

Now the label frame is centered on the map, but not the contents. To center the contents of the label:

1. Selectați eticheta făcând clic pe ea.
2. Click on the Item Properties tab in the side panel of the layout window.
3. Modificați textul etichetei în „Swellendam“:
4. Use this interface to set the font and alignment options under the Appearance section:

1. Choose a large but sensible font (the example will use the default font with a size of 36)

2. Set the Horizontal Alignment to Center.

De asemenea, puteți schimba culoarea fontului, dar probabil că cel mai bine este să-l păstrați negru, așa cum este în mod implicit.

5. Setarea implicită nu adăugă un cadru caselei de text a titlului. Cu toate acestea, dacă doriți să adăugați un cadru, puteți proceda astfel:

1. În fila Proprietăților elementului, deruți caseta verticală până veți vedea opțiunea Frame.

2. Clic pe caseta Frame pentru a activa cadrul. Puteți schimba culoarea cadrului și lățimea.

În acest exemplu, nu vom activa rama, așa că aceasta este pagina noastră de până acum:

---

**4.1. Lesson: Using Print Layout**
To make sure that you don’t accidentally move these elements around now that you’ve aligned them, you can lock items into place:

1. Select both the label and the map items
2. Click the Lock Selected Items button in the Actions Toolbar.

**Nota:** Click the Unlock All Items button in the Actions Toolbar to be able to edit the items again.

### 4.1.4 Follow Along:

The map reader also needs to be able to see what various things on the map actually mean. In some cases, like the place names, this is quite obvious. In other cases, it’s more difficult to guess, like the colors of the forests. Let’s add a new legend.

1. Click the Add Legend button
2. Click on the page to place the legend, accept the suggested values in the New Item Properties dialog.
3. A legend is added to the layout page, showing layers symbology as set in the main dialog.
4. As usual, you can click and move the item to where you want it:
4.1.5  🍃 Follow Along: Personalizarea Articolelor din Legendă

Nu este chiar totul necesar în legendă, deci, să eliminăm unele elemente nedorite.

1. In the Item Properties tab, you'll find the Legend items group.

2. Uncheck the Auto update box, allowing you to directly modify the legend items

3. Select the entry with buildings

4. Delete it from the legend by clicking the button

Puteți redenumi, de asemenea, elementele.

1. Selectați un strat din aceeași listă.

2. Click the Edit selected item properties button.

3. Rename the layers to Places, Roads and Streets, Surface Water, and Rivers.

You can also reorder the items:
Pe măsură ce legenda va fi probabil extinsă cu noile nume de straturi, ati putea dori să mutați și să redimensionați legenda și/sau harta. Acesta este rezultatul:
Finally the map is ready for export! You'll see the export buttons near the top left corner of the layout window:

- **Print Layout**: interfaces with a printer. Since the printer options will differ depending on the model of printer that you're working with, it's probably better to consult the printer manual or a general guide to printing for more information on this topic.

  The other buttons allow you to export the map page to a file.

- **Export as Image**: gives you a selection of various common image formats to choose from. This is probably the simplest option, but the image it creates is „dead“ and difficult to edit.

- **Export as SVG**: If you're sending the map to a cartographer (who may want to edit the map for publication), it's best to export as an SVG. SVG stands for „Scalable Vector Graphic”, and can be imported to programs like Inkscape or other vector image editing software.

- **Export as PDF**: If you need to send the map to a client, it's most common to use a PDF, because it's easier to set up printing options for a PDF. Some cartographers may prefer PDF as well, if they have a program that allows them to import and edit this format.

Pentru scopurile noastre, vom folosi PDF.

1. Click the **Export as PDF** button

2. Choose a save location and a file name as usual. The following dialog will show up.
3. You can safely use the default values now and click **Save**.
   QGIS will proceed to the map export and push a message on top of the print layout dialog as soon as it finishes.

4. Click the hyperlink in the message to open the folder in which the PDF has been saved in your system’s file manager.

5. Open it and see how your layout looks.
   Everything is OK? Congratulations on your first completed QGIS map project!

6. Anything unsatisfying? Go back to the QGIS window, do the appropriate modifications and export again.

7. Remember to save your project file.
4.1.7 In Conclusion

Now you know how to create a basic static map layout. We can go a step further and create a map layout that adapts dynamically, with more layout items.

4.2 Lesson: Creating a Dynamic Print Layout

Now that you have learned to create a basic map layout we go a step further and create a map layout that adapts dynamically to our map extent and to the page properties, e.g. when you change the size of the page. Also, the date of creation will adapt dynamically.

4.2.1 Follow Along: Creating the dynamic map canvas

1. Load the ESRI Shapefile format datasets protected_areas.shp, places.shp, rivers.shp and water.shp into the map canvas and adapt its properties to suit your own convenience.

2. After everything is rendered and symbolized to your liking, click the New Print Layout icon in the toolbar or choose File ► New Print Layout. You will be prompted to choose a title for the new print layout.

3. We want to create a map layout consisting of a header and a map of the region near Swellendam, South Africa. The layout should have a margin of 7.5 mm and the header should be 36mm high.

4. Create a map item called main map on the canvas and go to the Layout panel. Scroll down to the Variables section and find the Layout part. Here we set some variables you can use all over the dynamic print layout. Go to the Layout panel and scroll down to the Variables section. The first variable will define the margin. Press the button and type in the name sw_layout_margin. Set the value to 7.5. Press the button again and type in the name sw_layout_height_header. Set the value to 36.

5. Now you are ready to create the position and the size of the map canvas automatically by means of the variables. Make sure that your map item is selected, go to the Item Properties panel, scroll down to and open the Position and Size section. Click the Data defined override for X and from the Variables entry, choose @sw_layout_margin.

6. Click the Data defined override for Y, choose Edit… and type in the formula:

\[ \text{to_real}(@sw_layout_margin) + \text{to_real}(@sw_layout_height_header) \]

7. You can create the size of the map item by using the variables for Width and Height. Click the Data defined override for Width and choose Edit … again. Fill in the formula:

\[ @layout_pagewidth - @sw_layout_margin \times 2 \]

Click the Data defined override for Height and choose Edit …. Here fill in the formula:

\[ @layout_pageheight - @sw_layout_height_header - @sw_layout_margin \times 2 \]

8. We will also create a grid containing the coordinates of the main canvas map extent. Go to Item Properties again and choose the Grids section. Insert a grid by clicking the button. Click on Modify grid … and set the Interval for X, Y and Offset according to the map scale you chose in the QGIS main canvas. The Grid type Cross is very well suited for our purposes.
4.2.2 Follow Along: Creating the dynamic header

1. Insert a rectangle which will contain the header with the Add Shape button. In the Items panel enter the name header.

2. Again, go to the Item Properties and open the Position and Size section. Using Data defined override, choose the sw_layout_margin variable for X as well as for Y. Width shall be defined by the expression:

\[
\text{@layout_pagewidth} - \text{@sw_layout_margin} \times 2
\]

and Height by the sw_layout_height_header variable.

3. We will insert a horizontal line and two vertical lines to divide the header into different sections using the Add Node Item. Create a horizontal line and two vertical lines and name them Horizontal line, Vertical line 1, Vertical line 2.

   1. For the horizontal line:
      1. Set X to the variable sw_layout_margin
      2. Set the expression for Y to:
         \[
         \text{sw_layout_margin} + 8
         \]
      3. Set the expression for Width to:
         \[
         \text{@layout_pagewidth} - \text{@sw_layout_margin} \times 3 - 53.5
         \]

   2. For the first vertical line:
      1. Set the expression for X to:
         \[
         \text{@layout_pagewidth} - \text{@sw_layout_margin} \times 2 - 53.5
         \]
      2. Set Y to the variable sw_layout_margin
      3. The height must be the same as the header we created, so set Height to the variable sw_layout_height_header.

   3. The second vertical line is placed to the left of the first one.
      1. Set the expression for X to:
         \[
         \text{@layout_pagewidth} - \text{@sw_layout_margin} \times 2 - 83.5
         \]
      2. Set Y to the variable sw_layout_margin
      3. The height shall be the same as the other vertical line, so set Height to the variable sw_layout_height_header.

The figure below shows the structure of our dynamic layout. We will fill the areas created by the lines with some elements.
Follow Along: Creating labels for the dynamic header

1. The title of your QGIS project can be included automatically. The title is set in the Project Properties. Insert a label with the Add Label button and enter the name `project title (variable)`. In the Main Properties of the Items Properties Panel enter the expression:

```
[@project title%]
```

Set the position of the label.

1. For X, use the expression:

```
@sw_layout_margin + 3
```

2. For Y, use the expression:

```
@sw_layout_margin + 0.25
```

3. For Width, use the expression:

```
@layout_pagewidth - @sw_layout_margin *2 - 90
```

4. Enter 11.25 for Height

Under Appearance set the Font size to 16 pt.

2. The second label will include a description of the map you created. Again, insert a label and name it `map description`. In the Main Properties enter the text `map description`. In the Main Properties we will also include:

```
printed on: [%format_date(now(),'dd.MM.yyyy')%]
```

Here we used two Date and Time functions (now and format_date).

Set the position of the label.

1. For X, use the expression:
2. For Y, use the expression:
\[ \text{@sw_layout_margin} + 11.5 \]

3. The third label will include information about your organisation. First we will create some variables in the Variables menu of the Item Properties. Go to the Layout menu, click the \[ \text{button each time and enter the } \text{names o_department, o_name, o_adress and o_postcode. In the second row enter the information about your organisation. We will use these variables in the Main Properties section.} \]

In Main Properties enter:
\[
[\% @o_name \%] \\
[\% @o_department \%] \\
[\% @o_adress \%] \\
[\% @o_postcode \%]
\]

Set the position of the label.

1. For X, use the expression:
\[ \text{@layout_pagewidth} - \text{@sw_layout_margin} - 49.5 \]

2. For Y, use the expression:
\[ \text{@sw_layout_margin} + 15.5 \]

3. For Width, use 49.00

4. For Height, use the expression:
\[ \text{@sw_layout_height_header} - 15.5 \]
4.2.4 Follow Along: Adding pictures to the dynamic header

1. Use the Add Picture button to place a picture above your label organisation information. After entering the name organisation logo define the position and size of the logo:

   1. For $X$, use the expression:
      \[
      \text{@layout_pagewidth} - \text{@sw_layout_margin} - 49.5
      \]

   2. For $Y$, use the expression:
      \[
      \text{@sw_layout_margin} + 3.5
      \]

   3. For Width, use 39.292
   4. For Height, use 9.583

To include a logo of your organisation you have to save your logo under your home directory and enter the path under Main Properties ▶ Image Source.

2. Our layout still needs a north arrow. This will also be inserted by using Add North Arrow. We will use the default north arrow. Define the position:

   1. For $X$, use the expression:
      \[
      \text{@layout_pagewidth} - \text{@sw_layout_margin} \times 2 - 78
      \]

   2. For $Y$, use the expression:
Follow Along: Creating the scalebar of the dynamic header

1. To insert a scalebar in the header click on Add Scale Bar and place it in the rectangle above the north arrow. In Map under the Main Properties choose your main map (Map 1). This means that the scale changes automatically according to the extent you choose in the QGIS main canvas. Choose the Style Numeric. This means that we insert a simple scale without a scalebar. The scale still needs a position and size.

   1. For X, use the expression:
      \[ @\text{layout\_pagewidth} - @\text{sw\_layout\_margin} \times 2 - 78 \]

   2. For Y, use the expression:
      \[ @\text{sw\_layout\_margin} + 1 \]

   3. For Width, use 25
   4. For Height, use 8
   5. Place the Reference point in the center.

Congratulations! You have created your first dynamic map layout. Take a look at the layout and check if everything looks the way you want it! The dynamic map layout reacts automatically when you change the page properties. For example, if you change the page size from DIN A4 to DIN A3, click the Refresh view button and the page design is adapted.
4.2.6 What’s Next?

On the next page, you will be given an assignment to complete. This will allow you to practice the techniques you have learned so far.

4.3 Exercițiul 1

Deschideți proiectul existent al hârtii și revizuïști-l bine. Dacă ați observat mici erori sau lucruri pe care v-ar fi plăcut să le remediați mai devreme, faceți acest lucru acum.

În timp ce personalizați harta, puneti-vă întrebări. Este usor de citit și de înțeles această hârtă pentru cineva care nu este familiarizat cu datele respective? Dacă ați vedea această hârtă pe Internet, pe un poster sau într-o revistă, v-ar capta atenția? V-ar interesa această hârtă în cazul în care nu v-ar apări?

Dacă urmați acest curs la nivel de Bază sau Intermediar, citiți despre tehnici din secțiunile mai avansate. Dacă ați văzut vreun lucru anume care ați dori să apară și în harta dvs., de ce nu încercați să-l puneti în aplicare?

Dacă acest curs vă este prezentat, lectorul cursului vă poate cere să prezentați o versiune finală a hârtii dvs., exportate în format PDF, pentru evaluare. Dacă urmați acest curs în mod individual, este recomandabil să vă evaluați propria hârtă utilizând aceleași criterii. Harta dvs. va fi evaluată pentru aspectul general și simbolistica proprie, precum și pentru aspectul și așezarea în pagină a hârtii și a elementelor. Amintiți-vă că, la evaluarea hârtilor, accentul se va pune întotdeauna pe usurința în utilizare. Cu cât este mai frumoasă harta, cu atât este mai ușor să o înțelegeți dintr-o privire.

Personalizare plăcută!

4.3.1 In Conclusion

Primele patru module v-au învățat cum să creați și să utilizați o hârtă vectorială. În următoarele patru module, veți învăța cum să folosiți QGIS pentru o analiză completă GIS. Aceasta va include crearea și editarea datelor vectoriale; analiza lor; utilizarea și analiza datelor raster; și utilizarea GIS pentru a rezolva o problemă de la început până la sfârșit, utilizând atât surse de date raster cât și vectoriale.
Module: Crearea Datelor Vectoriale

Crearea hârtiilor folosind datele existente este doar începutul. În acest modul, veți afla cum să modificați datele vectoriale existente, și cum să creați noi seturi de date.

5.1 Lesson: Crearea unui Nou Set de Date Vectoriale

Datele pe care le utilizați trebuie să vină de undeva. Pentru aplicațiile uzuale, datele există deja; dar cu cât proiectul este mai aparte și mai specializat, cu atât scad șansele ca datele să fie disponibile. În asemenea cazuri va fi nevoie să va creați propriile date.

Scopul acestei lecții: De a crea un nou set de date vectoriale.

5.1.1 Follow Along: Dialogul de Creare a unui Strat

Înainte de a adăuga date vectoriale noi veți avea nevoie de un set de date la care să le adăugați. În cazul nostru veți începe prin a crea date complet noi, mai degrabă decât să editați un set de date existent. În concluzie, va trebui să începeți prin a crea propriul set de date.

1. Open QGIS and create a new blank project.

2. Navigate to and click on the menu entry Layer ➤ Create Layer ➤ New Shapefile Layer. You’ll be presented with the New Shapefile Layer dialog, which will allow you to define a new layer.
3. Click … for the File name field. A save dialog will appear.

4. Navigate to the exercise_data directory.

5. Save your new layer as school_property.shp.

Este important să decideti ce fel de set de date doriti. Fiecare tip de strat vectorial este „construit diferit” în fundal, deci odată ce ati creat un strat, nu il puteți schimba tipul.

For the next exercise, we’re going to create new features which describe areas. For such features, you’ll need to create a polygon dataset.

6. For Geometry Type, select Polygon from the drop down menu:

Aceasta nu are nici un impact asupra restului dialogului, dar va determina folosirea tipului corect de geometrie
care să fie utilizat la crearea setului de date vectorial.

The next field allows you to specify the Coordinate Reference System, or CRS. CRS is a method of associating numerical coordinates with a position on the surface of the Earth. See the User Manual on Working with Projections to learn more.

For this example we will use the default CRS associated with this project, which is WGS84.

Next there is a collection of fields grouped under New Field. By default, a new layer has only one attribute, the id field (which you should see in the Fields list) below. However, in order for the data you create to be useful, you actually need to say something about the features you'll be creating in this new layer. For our current purposes, it will be enough to add one field called name that will hold Text data and will be limited to text length of 80 characters.

7. Replicate the setup below, then click the Add to Fields List button:

8. Verificați dacă dialogul dvs. arată acum astfel:
9. Click OK

The new layer should appear in your Layers panel.

5.1.2 Follow Along: Sursele de Date

Când creați date noi, este evident necesar să se rețină obiecte care există într-adevăr pe teren. De aceea, va fi nevoie să obțineți informația de undeva.

Există multe moduri de a obține date despre obiecte. De exemplu, ați putea folosi un GPS pentru a capătă puncte din lumea reală, după care să importați datele în QGIS. Sau ați putea să identificați punctele folosind un teodolit, după care să introduceți manual coordonatele pentru a crea noi entități.

Pentru exemplul nostru, veți folosi digitizarea. Eșantioanele seturilor de date raster vă sunt puse la dispoziție, așa că va trebui să le importați după nevoie.
1. Click on the **Data Source Manager** button.
2. Select **Raster** on the left side.
3. In the Source panel, click on the … button:
5. Select the file `3420C_2010_327_RGB_LATLNG.tif`.
6. Click Open to close the dialogue window.

7. Click Add and Close. An image will load into your map.
8. If you don’t see an aerial image appear, select the new layer, right click, and choose *Zoom to Layer* in the context menu.
9. Click on the \( \text{Zoom In} \) button, and zoom to the area highlighted in blue below:
Now you are ready to digitize these three fields:
Before starting to digitize, let's move the school_property layer above the aerial image.

1. Select school_property layer in the Layers pane and drag it to the top.

Pentru a începe digitizarea trebuie să intrați în modul editare. Aplicațiile GIS cer asta în mod curent pentru a preveni
To enter edit mode for the school_property layer:

1. Click on the school_property layer in the Layers panel to select it.

2. Click on the Toggle Editing button.

   Dacă nu puteți găsi acest buton, verificați dacă bara de instrumente Digitizing este activată. Ar trebui să existe un semn de selectare lângă elementul de meniu View ➤ Toolbars ➤ Digitizing.

As soon as you are in edit mode, you’ll see that some digitizing tools have become active:

- Capture Polygon
- Vertex Tool

Other relevant buttons are still inactive, but will become active when we start interacting with our new data.

Notice that the layer school_property in the Layers panel now has the pencil icon, indicating that it is in edit mode.

3. Click on the Capture Polygon button to begin digitizing our school fields.

   You’ll notice that your mouse cursor has become a crosshair. This allows you to more accurately place the points you’ll be digitizing. Remember that even when you’re using the digitizing tool, you can zoom in and out on your map by rolling the mouse wheel, and you can pan around by holding down the mouse wheel and dragging around in the map.

   Prima entitate pe care o veți digitaliza este athletics field:

   ![Image of athletics field]

4. Începeți digitizarea făcând clic pe un punct, de-a lungul marginii câmpului.

5. Plasați mai multe puncte, făcând clic în continuare de-a lungul marginii, până când forma desenată acoperă complet câmpul.
6. After placing your last point, right click to finish drawing the polygon. This will finalize the feature and show you the Attributes dialog.

7. Completati valorile, așa cum se arată mai jos:

```
school_property - Feature Attributes

id     1
name   Athletics Field
```

---

5.1. Lesson: Crearea unui Nou Set de Date Vectoriale
8. Click OK, and you have created a new feature!

9. In the Layers panel select the school_property layer.

10. Right click and choose Open Attribute Table in the context menu.
In the table you will see the feature you just added. While in edit mode you can update the attributes data by double click on the cell you want to update.
11. Închideți tabelul de atribute.

12. To save the new feature we just created, click on `Save Edits` button.

Amințiți-vă că dacă ați făcut o greselă în timp ce digitizați o entitate, o puteți edita oricând după ce ați definitivat crearea ei. Dacă ați făcut o greselă, continuați digitizarea până ați terminat crearea entității de mai sus. Apoi:

1. Click on `Vertex Tool` button.
2. Hover the mouse over a vertex you want to move and left click on the vertex.
3. Move the mouse to the correct location of the vertex, and left click. This will move the vertex to the new location.
5.1. Lesson: Crearea unui Nou Set de Date Vectoriale
The same procedure can be used to move a line segment, but you will need to hover over the midpoint of the line segment.

If you want to undo a change, you can press the **Undo** button or **Ctrl+Z**.

4. Remember to save your changes by clicking the **Save Edits** button.

5. When done editing, click the **Toggle Editing** button to get out of edit mode.
5.1.3 Try Yourself Digitizing Polygons

Digitizing school propriu-zise și a câmpului de sus. Utilizați această imagine pentru a vă ajuta:

Remember that each new feature needs to have a unique id value!

Notă: După ce ați terminat de adăugat entitățile într-un strat, nu uitați să salvați modificările și să iesiți din modul de editare.

Notă: You can style the fill, outline and label placement and formatting of the school_property using techniques learnt in earlier lessons.
5.1.4  Follow Along: Using Vertex Editor Table

Another way to edit a feature is to manually enter the actual coordinate values for each vertex using the Vertex Editor table.

1. Make sure you are in edit mode on layer `school_property`.

2. If not already activated, click on the Vertex Tool button.

3. Move the mouse over one of the polygon features you created in the `school_property` layer and right click on it. This will select the feature and a Vertex Editor pane will appear.

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>20.4456</td>
<td>-34.0225</td>
</tr>
<tr>
<td>1</td>
<td>20.4459</td>
<td>-34.0238</td>
</tr>
<tr>
<td>2</td>
<td>20.4457</td>
<td>-34.0251</td>
</tr>
<tr>
<td>3</td>
<td>20.4453</td>
<td>-34.0247</td>
</tr>
<tr>
<td>4</td>
<td>20.4450</td>
<td>-34.0250</td>
</tr>
<tr>
<td>5</td>
<td>20.4441</td>
<td>-34.0241</td>
</tr>
<tr>
<td>6</td>
<td>20.4456</td>
<td>-34.0225</td>
</tr>
</tbody>
</table>

**Nota:** This table contains the coordinates for the vertices of the feature. Notice there are seven vertices for this feature, but only six are visually identified in the map area. Upon closer inspection, one will notice that row 0 and 6 have identical coordinates. These are the start and end vertices of the feature geometry, and are required in order to create a closed polygon feature.

4. Click and drag a box over a vertex, or multiple vertices, of the selected feature.
The selected vertices will change to a color blue and the Vertex Editor table will have the corresponding rows highlighted, which contain the coordinates of the vertices.
To update a coordinate, double left click on the cell in the table that you want to edit and enter the updated value. In this example, the x coordinate of row 4 is updated from 20.4450 to 20.4444.
6. After entering the updated value, hit the enter key to apply the change. You will see the vertex move to the new location in the map window.

7. When done editing, click the \textit{Toggle Editing} button to get out of edit mode, and save your edits.

5.1.5 \textbf{Try Yourself Digitizing Lines}

We are going to digitize two routes which are not already marked on the roads layer; one is a path, the other is a track. Our path runs along the southern edge of the suburb of Railton, starting and ending at marked roads:
Piste este situată un pic mai departe de sud:
1. If the *roads* layer is not yet in your map, then add the *roads* layer from the GeoPackage file *training-data.gpkg* included in the *exercise_data* folder of the training data you downloaded. You can read *Follow Along: Loading vector data from a GeoPackage Database* for a how-to.

2. Create a new ESRI Shapefile line dataset called *routes.shp* in the *exercise_data* directory, with attributes *id* and *type* (use the approach above to guide you.)

3. Activate edit mode on the *routes* layer.

4. Since you are working with a line feature, click on the *Add Line* button to initiate line digitizing mode.

5. One at a time, digitize the path and the track on the *routes* layer. Try to follow the routes as accurately as possible, adding additional points along corners or turns.

6. Set the *type* attribute value to *path* or *track*.

7. Use the *Layer Properties* dialog to add styling to your routes. Feel free to use different styles for paths and tracks.

8. Save your edits and toggle off editing mode by pressing the *Toggle Editing* button.
Check your results

5.1.6 In Conclusion

Acum știți cum să creați entități! Acest curs nu acoperă adăugarea entităților de tip punct, deoarece nu este neapărat necesară după ce ați lucrat cu entități mai complexe (linii și poligoane). Funcționează exact la fel, cu excepția faptului că dată clic doar o singură dată unde doriți să plasați punctul, îi completați atribuțele ca de obicei, după care entitatea este creată.

Cunoașterea digitizării este importantă deoarece reprezintă o activitate frecventă în aplicațiile GIS.

5.1.7 What’s Next?

Features in a GIS layer aren’t just pictures, but objects in space. For example, adjacent polygons know where they are in relation to one another. This is called topology. In the next lesson you’ll see an example of why this can be useful.

5.2 Lesson: Topologia Entității

Topologia reprezintă un aspect util de straturi de date vectoriale, deoarece minimizează erorile, cum ar fi suprapunerile sau lacunele.

De exemplu: dacă două entități au o frontieră comună, și editați granița cu ajutorul topologiei, atunci nu va trebui să editați mai întâi un element, apoi pe celălalt, și ulterior să aliniați cu atenție frontierele, astfel încât acestea să se potrivesc. În schimb, puteți edita bordurile lor comune, ambele entități schimbându-se în același timp.

Scopul acestei lecții: De a înțelege topologia, cu ajutorul exemplului.

5.2.1 Follow Along: Acroșarea

Snapping makes topological editing easier. This will allow your mouse cursor to snap to other objects while you digitize. To set snapping options:

1. Navigate to the menu entry Project ▶ Snapping Options…
2. Set up your Snapping options dialog to activate the landuse layer with Type vertex and tolerance 12 pixels:

   ![Snapping Settings Dialog](image)

3. Make sure that the box in the Avoid overlap column is checked.
4. Leave the dialog.
5. Select the *landuse* layer and enter edit mode (✏)

6. Check (under View ► Toolbars) that the Advanced Digitizing toolbar is enabled.

7. Focalizați această arie (activând straturile și etichetele, dacă este necesar):

![Image of QGIS interface with selected landuse layer and tools enabled]

8. Digitize this new (fictional) area:
9. When prompted, give it an OGC_FID of 999, but feel free to leave the other values unchanged.

If you are careful while digitizing, and allow the cursor to snap to the vertices of adjoining areas, you'll notice that there won’t be any gaps between your new area and the existing adjacent areas.

10. Note the undo and redo tools in the Advanced Digitizing toolbar.

5.2.2 **Follow Along: Caracteristicile Topologice Corecte**

Topology features can sometimes need to be updated. In our study area, an area has been turned into forest, so the landuse layer need an update. We will therefore expand and join some forest features in this area:
Instead of creating new polygons to join the forest areas, we are going to use the Vertex Tool to edit and join existing polygons.

1. Enter edit mode (if it is not active already)
2. Select the Vertex Tool tool.
3. Choose an area of forest, select a vertex, and move it to an adjoining vertex so that the two forest features meet:
4. Click on the other vertices and snap them into place.

Limitele topologic corecte vor arăta astfel:
Go ahead and join a few more areas using the Vertex Tool.

You can also use the Add Polygon Feature tool to fill the gap between the two forest polygons. If you have enabled Avoid overlap, you don’t have to add every single vertex - they will be added automatically if your new polygon overlaps the existing ones.

If you are using our example data, you should have a forest area looking something like this:

Nu vă faceți grijă dacă ați îmbinat mai multe, mai puține sau zone diferite de pădure.

5.2.3 🔴 Follow Along: Instrumentul: Simplificarea Entităților

Continuing on the same layer, we will test the Simplify Feature tool:

1. Faceți clic pe el pentru a-l activa.
2. Click on one of the areas which you joined using either the Vertex Tool or Add Feature tool. You will see this dialog:
3. Modify the Tolerance and watch what happens:

This allows you to reduce the number of vertices.

4. Clic pe OK
The advantage of this tool is that it provides you with a simple and intuitive interface for generalization. But notice what the tool ruins topology. The simplified polygon no longer shares boundaries with its adjacent polygons, as it should. So this tool is better suited for stand-alone features.

Înainte de a merge mai departe, setați poligonul înapoi la starea inițială, prin anularea ultimei modificări.

### 5.2.4 Try Yourself Instrument: Adăugarea Inelului

The Add Ring tool allows you to add an interior ring to a polygon feature (cut a hole in the polygon), as long as the hole is completely contained within the polygon (touching the boundary is OK). For example, if you have digitized the outer boundaries of South Africa and you need to add a hole for Lesotho, you would use this tool.

If you experiment with the tool, you may notice that the snapping options can prevent you from creating a ring inside a polygon. So you are advised to turn off snapping before cutting a hole.

1. Disable snapping for the landuse layer using the Enable Snapping button (or use the shortcut s).
2. Use the Add Ring tool to create a hole in the middle of a polygon geometry.
3. Draw a polygon over the target feature, as if you were using the Add polygon tool.
4. When you right-click, the hole will be visible.
5. Remove the hole you just created using the Delete Ring tool.

**Nota:** Click inside the hole to delete it.

### 5.2.5 Try Yourself Instrumentul: Adăugare Parte

The Add Part tool allows you to add a new part to a feature, that is not directly connected to the main feature. For example, if you have digitized the boundaries of mainland South Africa, but you haven’t yet added the Prince Edward Islands, you would use this tool to create them.

1. Select the polygon to which you wish to add the part by using the Select Features by area or single click tool.
2. Use the Add Part tool to add an outlying area.
3. Delete the part you just created using the Delete Part tool.

**Nota:** Click inside the part to delete it.

### Check your results

### 5.2. Lesson: Topologia Entității

147
5.2.6 Follow Along: Instrumentul: Remodelarea Entităților

The tool is used to extend a polygon feature or cut away a part of it (along the boundary).

Extending:

1. Select the polygon using the Select Features by area or single click tool.
2. Left-click inside the polygon to start drawing.
3. Draw a shape outside the polygon. The last vertex should be back inside the polygon.
4. Right-click to finish the shape:

![Image of QGIS interface with selected polygon and reshape features tool]

Acest lucru va genera un rezultat similar cu:
Cut away a part:

1. Select the polygon using the Select Features by area or single click tool.
2. Faceți clic în afara poligonului.
3. Draw a shape inside the polygon. The last vertex must be back outside the polygon.
4. Right-click outside the polygon:
Iată rezultatul:

5.2.7 Try Yourself Instrumentul: Divizare Entități

The Split Features tool is similar to the Reshape Features tool, except that it does not delete either of the two parts. Instead, it keeps them both.

We will use the tool to split a corner from a polygon.

1. First, select the landuse layer and re-enable snapping for it.

2. Select the Split Features tool and click on a vertex to begin drawing a line.

3. Draw the bounding line.

4. Click a vertex on the „opposite” side of the polygon you wish to split and right-click to complete the line:
5. At this point, it may seem as if nothing has happened. But remember that the **landuse** layer is rendered without border lines, so the new division line will not be shown.

6. Use the **Select Features by area or single click** tool to select the part you just split out; the new feature will now be highlighted:
5.2.8 Try Yourself Instrumentul: Îmbinare Entități

Now we will re-join the feature you just split out to the remaining part of the polygon:

1. Experiment with the Merge Selected Features and Merge Attributes of Selected Features tools.
2. Notați diferențele.

Check your results

5.2.9 In Conclusion

Editarea topologică este un instrument puternic, care vă permite să creați și să modificați obiectele rapid și ușor, asigurându-vă în același timp că ele rămân corekte din punct de vedere topologic.

5.2.10 What’s Next?

Now you know how to digitize the shape of the objects easily, but adding attributes is still a bit of a headache! Next we will show you how to use forms, making attribute editing simpler and more effective.

5.3 Lesson: Formulare

Atunci când adăugați prin digitizare noi date, vi se prezintă o fereastră de dialog care vă permite să completați atribuțele entităților. Totuși, acest dialog nu este, în mod implicit, prea aspectuos. Acest lucru poate cauza o problemă de uzabilitate, mai ales dacă aveți de creat seturi de date de mari dimensiuni, sau dacă doriți ca alte persoane să vă ajute la digitizare, acești descoperind repede că formularele implicite sunt confuze.

Din fericire, QGIS vă permite să creați propriile dialoguri personalizate pentru un strat. Această lectie vă arată cum.

Scopul acestei lecții: De a crea un formular pentru un strat.

5.3.1 Follow Along: Utilizarea Funcționalității de Proiectare a Formularelor din QGIS

1. Select the roads layer in the Layers panel
2. Enter Edit Mode as before
3. Open the roads layer’s attribute table
4. Right-click on any cell in the table. A short menu will appear, that includes the Open form entry.
5. Click on it to see the form that QGIS generates for this layer

Evident, ar fi frumos să fiți în măsură să faceti acest lucru, mai degrabă, în timp ce vă uitați la hartă, decât să fie nevoie să căutați tot timpul o stradă specifică în Tabela de Atribute.

1. Select the roads layer in the Layers panel
2. Using the Identify Features tool, click on any street in the map.
3. The Identify Results panel opens and shows a tree view of the fields values and other general information about the clicked feature.
4. At the top of the panel, check theAuto open form for single feature results checkbox in the Identify Settings menu.
5. Now, click again on any street in the map. Along the previous Identify Results dialog, you’ll see the now-familiar form:

![Form Example](image)

6. Each time you click on a single feature with the Identify tool, its form pops up as long as the Auto open form is checked.

### 5.3.2 Try Yourself Folosirea Formularului pentru Editarea Valorilor

Dacă sunteți în modul de editare, puteți utiliza acest formular pentru a edita atributele unei entități.

1. Activați modul de editare (dacă nu este deja activat).

2. Using the Identify Features tool, click on the main street running through Swellendam:
3. Edit its *highway* value to be *secondary*

4. Exit edit mode and save your edits

5. Open the *Attribute Table* and note that the value has been updated in the attributes table and therefore in the source data

### 5.3.3 Follow Along: Setarea Tipurilor de Câmpuri ale Formularelor

E frumos să editați lucruri folosind un formular, dar tot trebuie să introduceți manual totul. Din fericire, formele au așa-numitele *widgets*, care vă permit să editați datele în diverse moduri.

1. Open the *roads* layer’s *Properties*…

2. Mergeti la fila *Câmpuri*. Veți vedea următoarele:
3. Switch to the Attributes Form tab. You'll see this:

4. Click on the one way row and choose Checkbox as Widget Type in the list of options:
5. Click OK

6. Enter edit mode (if the roads layer is not already in edit mode)

7. Click on the Identify Features tool

8. Click on the same main road you chose earlier

You will now see that the oneway attribute has a checkbox next to it denoting True (checked) or False (unchecked).

5.3.4 **Try Yourself**

Set a widget in a new field for the highway.

*Check your results*

5.3.5 **Try Yourself Crearea Datelor de Test**

Aveți posibilitatea să proiectați, de asemenea, formularul propriu complet de la zero.

1. Create a simple point layer named test-data with two attributes:
   - name (text)
   - age (integer)
2. Capturați câteva puncte de pe noul strat folosind instrumentele de digitizare, așa că veți avea un pic de date cu care să operați. Ar trebui să vedeti în continuare formularul implicit, generat de QGIS, de fiecare dată când capturați un nou punct.

**Notă:** Este posibil să trebuiască să dezactivați Acroșarea, dacă este activată în urma acțiunilor anterioare.
5.3.6  Follow Along: Crearea unui Nou Formular

Now we want to create our own custom form for the attribute data capture phase. To do this, you need to have QT Designer installed (only needed for the person who creates the forms).

1. Start QT Designer.
2. În caseta de dialog care apare, creați un nou dialog:

5. Având selectat noul element de linie de editare, îi veți vedea proprietățile de-a lungul părții laterale a ecranului (din partea dreaptă, în mod implicit):
6. Set its name to name.

7. Using the same approach, create a new Spin Box and set its name to age.

8. Add a Label with the text Add a New Person in a bold font (look in the object properties to find out how to set this). Alternatively, you may want to set the title of the dialog itself (rather than adding a label).

9. Add a Label for your Line Edit and your Spin Box.

10. Arrange the elements to your own desire.

11. Faceți clic oriunde, în fereastra de dialog.

12. Find the Lay Out in a Form Layout button (in a toolbar along the top edge of the screen, by default). This lays out your dialog automatically.

13. Set the dialog’s maximum size (in its properties) to 200 (width) by 150 (height).

14. Your form should now look similar to this:
15. Save your new form as `exercise_data/forms/add_people.ui`

16. When it’s done saving, you can close Qt Designer

5.3.7 Follow Along: Asocierea Formularului cu Stratul Dvs.

1. Go back to QGIS
2. Dublu clic pe stratul `test-data` din legenda, pentru a-i accesa proprietatile.
3. Click on the `Attributes Form` tab in the `Layer Properties` dialog
4. În caseta derulantă `Attribute editor layout`, selectați `Provide ui-file`.
5. Click the ellipsis button and choose the `add_people.ui` file you just created:

6. Click OK on the `Layer Properties` dialog
7. Enter edit mode and capture a new point
8. Când faceți acest lucru, vă va fi prezentat dialogul personalizat (în loc de cel generic, pe care îl creează de obicei QGIS).

9. If you click on one of your points using the Identify Features tool, you can now bring up the form by right clicking in the identify results window and choosing View Feature Form from the context menu.

10. If you are in edit mode for this layer, that context menu will show Edit Feature Form instead, and you can then adjust the attributes in the new form even after initial capture.

5.3.8 In Conclusion

Folosind formularele, vă puteți face viața mai ușoară, atunci când editați sau când creați date. Prin editarea tipurilor de widget sau pin crearea unui formular cu totul nou, de la zero, puteți controla experiența cuiva care digitalizează date noi, minimizând, astfel, neînțelegerile și erorile inutile.

5.3.9 Further Reading

If you completed the advanced section above and have knowledge of Python, you may want to check out this blog entry about creating custom feature forms with Python logic, which allows advanced functions including data validation, autocompletion, etc.

5.3.10 What’s Next?

Deschiderea unui formular o dată cu identificarea unei entități este una dintre actiunile standard, pe care o poate efectua QGIS. Cu toate acestea, puteți efectua direct acțiunile personalizate pe care le definiți. Acesta este subiectul lecției următoare.

5.4 Lesson: Acțiuni

Now that you have seen a default action in the previous lesson, it is time to define your own actions.

An action is something that happens when you click on a feature. It can add a lot of extra functionality to your map, allowing you to retrieve additional information about an object, for example. Assigning actions can add a whole new dimension to your map!

Scopul acestei lecții: De a afla cum să adăugați acțiuni particularizate.

In this lesson you will use the school_property layer you created previously. The sample data include photos of each of the three properties you digitized. What we are going to do is to associate each property with its image. Then we will create an action that will open the image for a property when clicking on the property.

5.4.1 Follow Along: Adăugarea unui Câmp pentru Imagini

The school_property layer has no way to associate an image with a property yet. First we will create a field for this purpose.

1. Deschideți dialogul Layer Properties.
2. Dați clic pe fila Fields.
3. Comutați în modul de editare:
4. Adăugați o nouă coloană:

5. Introduceți valorile de mai jos:
6. After the field has been created, move to the Attributes Form tab and select the **image** field.

7. Set Widget Type to Attachment:

8. Click **OK** in the Layer Properties dialog.

9. Folosiți instrumentul Identify pentru a faceți clic pe una dintre cele trei entități din stratul `school_property`.

   Since you are still in edit mode, the dialog should be active and look like this:
10. Clic pe butonul de răsfoire (… de lângă câmpul imagine).

11. Select the path for your image. The images are in `exercise_data/school_property_photos/` and are named the same as the features they should be associated with.

12. Clic pe OK


### 5.4.2  Follow Along: Crearea unei Acțiuni

1. Open the Actions tab for the `school_property` layer, and click on the `Add a new action` button.

2. In the Add New Action dialog, enter the words `Show Image` into the Description field:
Ceea ce veți face în continuare diferă în funcție de sistemul de operare, asa că alegeți un curs adecvat:

- Windows
Dată clic pe meniul vertical *Type* și alegeți *Open*.

- Ubuntu Linux
  
  Under *Action*, write `eog` for the *Gnome Image Viewer*, or write `display` to use *ImageMagick*. Remember to put a space after the command!

- MacOS
  
  1. Clic pe caseta *Type*, apoi alegeți *Mac*.
  2. Under *Action*, write `open`. Remember to put a space after the command!

Now you can continue writing the command.

Vrei să deschideți imaginea, și QGIS știe unde se află. Tot ce rămâne de făcut este să îi spuiți *Action* unde se află imaginea.

3. Selectați *image* din listă:
4. Click the *Insert field* button. QGIS will add the phrase [% "image" %] in the *Action Text* field.

5. Click the *OK* button to close the *Add New Action* dialog.
6. Click OK to close the Layer Properties dialog

Now it is time to test the new action:

1. Click on the school_property layer in the Layers panel so that it is highlighted.

2. Find the Run feature action button (in the Attributes Toolbar).

3. Click on the down arrow to the right of this button. There is only one action defined for this layer so far, which is the one you just created.

4. Apăsați butonul pentru a activa instrumentul.

5. Folosind acest instrument, faceți clic pe oricare din cele trei proprietăți școlare.

   The image for that property should open.

### 5.4.3 Follow Along: Căutarea pe Internet

Let’s say we are looking at the map and want to know more about the area that a farm is in. Suppose you know nothing of the area in question and want to find general information about it. Your first impulse, considering that you’re using a computer right now, would probably be to Google the name of the area. So let’s tell QGIS to do that automatically for us!

1. Deschideți tabela de attribute a stratului landuse.

   We will be using the name field for each of our landuse areas to search Google.

2. Închideți tabelul de attribute.


4. Click on the Create Default Actions button to add a number of pre-defined actions.

5. Remove all the actions but the Open URL action with the short name Search Web using the Remove the selected action button below.

6. Double-click on the remaining action to edit it

7. Change the Description to Google Search, and remove the content of the Short Name field.

8. Make sure that Canvas is among the checked Action scopes.

   Ceea ce veți face în continuare diferă în funcție de sistemul de operare, asa că alegeți un curs adecvat:

   - **Windows**
     
     Sub Tip, alegeți Deschidere. Acest lucru va spune Windows-ului să deschidă o adresă de Internet din browser-ul implicit, cum ar fi Internet Explorer.

   - **Ubuntu Linux**
     
     Under Action, write xdg-open. This will tell Ubuntu to open an Internet address in your default browser, such as Chrome or Firefox.

   - **MacOS**
     
     Under Action, write open. This will tell MacOS to open an Internet address in your default browser, such as Safari.
Now you can continue writing the command

Orice comandă ați folosit mai sus, trebuie să îi spuneți ce adresă să deschidă în continuare. Vreți să accesați Google și să căutați automat o expresie.

Usually when you use Google, you enter your search phrase into the Google Search bar. But in this case, you want your computer to do this for you. The way you tell Google to search for something (if you don’t want to use its search bar directly) is by giving your Internet browser the address https://www.google.com/search?q=SEARCH_PHRASE, where SEARCH_PHRASE is what you want to search for. Since we don’t know what phrase to search for yet, we will just enter the first part (without the search phrase).

9. In the Action field, write https://www.google.com/search?q=. Remember to add a space after your initial command before writing this in!

Now you want QGIS to tell the browser to tell Google to search for the value of name for any feature that you could click on.

10. Selectăți câmpul name.

11. Click Insert button:
What this means is that QGIS is going to open the browser and send it to the address \texttt{https://www.google.com/search?q=[%name%]}. [% name %] tells QGIS to use the contents of the name field as the phrase to search for.
So if, for example, the landuse area you click on is named Marloth Nature Reserve, QGIS is going to send the browser to https://www.google.com/search?q=Marloth%20Nature%20Reserve, which will cause your browser to visit Google, which will in turn search for „Marloth Nature Reserve“.

12. If you have not done so already, set everything up as explained above.
13. Click the OK button to close the Add New Action dialog
14. Click OK to close the Layer Properties dialog

Acum vom testa noua versiune.

1. With the landuse layer active in the Layers panel, click on the down arrow to the right of the button, and select the only action (Google Search) defined for this layer.
2. Click on any landuse area you can see on the map. Your browser will now open, and will start a Google search for the place that is recorded as that area’s name value.

Nota: În cazul în care acțiunea nu funcționează, verificați dacă totul a fost introdus corect; erorile de introducere sunt comune pentru această activitate!

5.4.4 Follow Along: Deschiderea unei Pagini Web Direct din QGIS

Above, you’ve seen how to open a webpage in an external browser. There are some shortcomings with this approach in that it adds an unknowable dependency – will the end-user have the software required to execute the action on their system? As you’ve seen, they don’t necessarily even have the same kind of base command for the same kind of action, if you don’t know which OS they will be using. With some OS versions, the above commands to open the browser might not work at all. This could be an insurmountable problem.

However, QGIS sits on top of the incredibly powerful and versatile Qt library. Also, QGIS actions can be arbitrary, tokenized (i.e. using variable information based on the contents of a field attribute) Python commands!

Now you will see how to use a python action to show a web page. It is the same general idea as opening a site in an external browser, but it requires no browser on the user’s system since it uses the Qt QWebView class (which is a webkit based html widget) to display the content in a pop-up window.

Let us use Wikipedia this time. So the URL you request will look like this:
https://wikipedia.org/wiki/SEARCH_PHRASE

Pentru a crea acțiunea stratului:

1. Deschideți dialogul Proprietăților Stratului și mergeți la fila Actions.
2. Setați o nouă acțiune, folosind următoarele proprietăți pentru acțiune:

   • **Type:** Python
   • **Description:** Wikipedia
   • **Action Text** (all on one line):

```
from qgis.QtCore import QUrl; from qgis.QtWebKitWidgets import QWebView; myWV = QWebView(None); myWV.load(QUrl('https://wikipedia.org/wiki/%name%')); myWV.show()
```

5.4. Lesson: Acţiuni
Aici se întâmplă mai multe lucruri:

- Tot codul Python este într-o singură linie, comenzi fiind separate prin punct și virgulă (în loc de linii noi, modul uzuial de separare a comenzilor Python).
- \[%name\%\] will be replaced by the actual attribute value when the action is invoked (as before).
- The code simply creates a new QWebView instance, sets its URL, and then calls show() on it to make it visible as a window on the user’s desktop.

De remarcat este că acesta este un exemplu foartă. Python funcționează cu indentare cu semnificație semantică, deci separarea lucrurilor cu punct și virgulă nu este cea mai bună variantă de scriere. Deci, în aplicațiile reale, ar fi mai plauzibil ca logica să fie importată dintr-un modul Python și apoi să se apeleze o funcție care să primească un câmp ca și parametru.

You could also use this approach to display an image without requiring that the users have a particular image viewer on their system.

3. Try to use the methods described above to load a Wikipedia page using the Wikipedia action you just created.

### 5.4.5 In Conclusion

Actions allow you to give your map extra functionality, useful to the end-user who views the same map in QGIS. Due to the fact that you can use shell commands for any operating system, as well as Python, the sky is the limit in terms of the functions you could incorporate!

### 5.4.6 What’s Next?

Now that you’ve done all kinds of vector data creation, you will learn how to analyze the data to solve problems. That is the topic of the next module.
Acum, după ce ați editat câteva entități, trebui să știți ce altceva se poate face cu ele. Având entități cu attribute este frumos, dar, în final, aceasta nu reprezintă chiar ceva care să se detasseze net față de o hartă non-GIS.

Avantajul cheie al unui GIS este: un GIS poate răspunde întrebărilor.

Pentru următoarele trei module, ne vom strădui să răspundem la o întrebare de cercetare folosind funcții GIS. De exemplu, dacă sunteți un agent imobiliar și vă aflați în căutarea unei proprietăți rezidențiale în Swellendam, care trebuie să respecte următoarele criterii:

1. Să fie situată în Swellendam.
2. Trebuie să fie la distanță de conducere rezonabilă, față de o școală (de exemplu, 1 km).
3. Trebuie să aibă mai mult de 100m pătrați în dimensiune.
4. Să fie situată sub 50m față de un drum principal.
5. Să fie situată la maximum 500m față de un restaurant.

În următoarele câteva module, vom valorifica puterea instrumentelor de analiză GIS, pentru a localiza proprietățile agricole potrivite pentru această nouă dezvoltare rezidențială.

6.1 Lesson: Reprojectarea și Transformarea Datelor

Let us talk about Coordinate Reference Systems (CRSs) again. We have touched on this briefly before, but haven’t discussed what it means practically.

**Scopul acestei lecții:** De a reproiecta și transforma seturile de date vectoriale.
6.1.1 Follow Along: Proiectii

The CRS that all the data, as well as the map itself are in right now is called WGS84. This is a very common Geographic Coordinate System (GCS) for representing data. But there’s a problem, as we will see.

1. Save your current map
2. Then open the map of the world which you will find under exercise_data/world/world.qgs
3. Zoom in to South Africa by using the Zoom In tool
4. Try setting a scale in the Scale field, which is in the Statusbar along the bottom of the screen. While over South Africa, set this value to 1:5 000 000 (one to five million).
5. Pan around the map while keeping an eye on the Scale field

Notice the scale changing? That’s because you are moving away from the one point that you zoomed into at 1:5 000 000, which was at the center of your screen. All around that point, the scale is different.

Pentru a înțelege de ce, gânditi-vă la un glob al Pământului. Acesta are linii care pornesc de la Nord înspre Sud. Acesteliniilongitudinalesuntsituatedeparteunadealtalaecuator,darseîntâlnesclapoli.

In a GCS, you are working on this sphere, but your screen is flat. When you try to represent the sphere on a flat surface, distortion occurs, similar to what would happen if you cut open a tennis ball and tried to flatten it out. What this means on a map is that the longitude lines stay equally far apart from each other, even at the poles (where they are supposed to meet). This means that, as you travel away from the equator on your map, the scale of the objects that you see gets larger and larger. What this means for us, practically, is that there is no constant scale on our map!

To solve this, let’s use a Projected Coordinate System (PCS) instead. A PCS „projects” or converts the data in a way that makes allowance for the scale change and corrects it. Therefore, to keep the scale constant, we should reproject our data to use a PCS.

6.1.2 Follow Along: Reproiectarea „Din-Zbor”

By default, QGIS reprojects data „on the fly”. What this means is that even if the data itself is in another CRS, QGIS can project it as if it were in a CRS of your choice.

You can change the CRS of the project by clicking on the button in the bottom right corner of QGIS.

1. In the dialog that appears, type the word global into the Filter field. A few CRSs should appear in the Predefined Reference Systems field below.
2. Select WGS 84 / NSIDC EASE-Grid 2.0 Global | EPSG:6933 entry by clicking on it, and then click OK.

Observați modul în care forma Africii de Sud se schimbă. Toate proiecțiile lucrează prin schimbarea formelor aparente ale obiectelor de pe Terra.

3. Zoom to a scale of 1:5 000 000 again, as before.
4. Deplasati un pic harta.

Observați că scara rămâne la fel!

Reproiectarea „din zbor” este folosită, de asemenea, pentru a combina seturile de date aflate în diverse CRS-uri

1. Add another vector layer to your map which has the data for South Africa only. You will find it as exercise_data/world/RSA.shp.
2. Load it. A quick way to see its CRS is by hovering the mouse over the layer in the legend. It is EPSG:3410.

Ce observați?

The layer is visible even if it has a different CRS from the continents one.
Follow Along: Salvarea unui Set de Date într-un Alt CRS

Sometimes you need to export an existing dataset with another CRS. As we will see in the next lesson, if you need to make distance calculations on layer, it is always better to have the layer in a projected coordinate system.

Be aware that the «on the fly» reprojection is related to the project and not to single layers. This means that a layer can have a different CRS from the project even if you see it in the correct position.

You can easily export the layer with another CRS.

1. Add the buildings dataset from training_data.gpkg
2. Right-click on the buildings layer in the Layers panel.
3. Select Export ► Save Features As… in the menu that appears. You will be shown the Save Vector Layer as… dialog.
4. Click on the Browse button next to the File name field.
5. Navigate to exercise_data/ and specify the name of the new layer as buildings_reprojected.shp.
6. Change the value of the CRS. Only the recent CRSs used will be shown in the drop-down menu. Click on the Select projection button next to the drop-down menu.
7. The Coordinate Reference System Selector dialog will appear. In its Filter field, search for 34S.
8. Select WGS 84 / UTM zone 34S | EPSG:32734 from the list.
9. Leave the other options unchanged. The Save Vector Layer as… dialog now looks like this:
10. Clic pe OK

You can now compare the old and new projections of the layer and see that they are in two different CRS but they are still overlapping.
6.1.4 Follow Along: Crearea Propriei Dvs. Proiecții

Există mai multe proiecții decât cele incluse în QGIS în mod implicit. De asemenea, puteți crea propriile proiecții.

1. Start a new map
2. Load the world/oceans.shp dataset
3. Go to Settings ➤ Custom Projections... and you will see this dialog.

4. Click on the Add new CRS button to create a new projection
5. An interesting projection to use is called Van der Grinten I. Enter its name in the Name field.
   Această proiecție reprezintă Pământul pe un teren circular, în locul uneia dreptunghiulară, la fel ca majoritatea celorlalte proiecții.
6. In Format, select WKT (Recommended)
7. Add the following string in the Parameters field:

```plaintext
PROJCS["unknown",
    BASEGEOGCRS["unknown",
        DATUM["unknown",
            ELLIPSOID["unknown",6371000,0,
                LENGTHUNIT["metre",1,
                    ID["EPSG",9001]]],
            PRIMEM["Greenwich",0,
                ANGLEUNIT["degree",0.0174532925199433,
                    ID["EPSG",8901]]],
            CONVERSION["unknown",
                METHOD["Van Der Grinten"],
                PARAMETER["longitude of natural origin",0],
```
6.1. Lesson: Reprojectarea și Transformarea Datelor

8. Clic pe OK

9. Click on the Current CRS button at the right of the status bar to change the project CRS

10. Choose your newly defined projection (search for its name in the Filter field)

11. După aplicarea acestei proiecții, harta va fi reprojectată astfel:
6.1.5 In Conclusion

Diferite proiecții sunt utile pentru scopuri diferite. Prin alegerea proiecția corectă, vă puteți asigura că entitățile de pe harta sunt reprezentate cu precizie.

6.1.6 Further Reading

Materials for the Advanced section of this lesson were taken from this article. Read further information on Coordinate Reference Systems.

6.1.7 What’s Next?

In the next lesson you will learn how to analyze vector data using QGIS various vector analysis tools.

6.2 Lesson: Analiza Vectorială

Vector data can also be analyzed to reveal how different features interact with each other in space. There are many different analysis-related functions, so we won’t go through them all. Rather, we will pose a question and try to solve it using the tools that QGIS provides.

Scopul acestei lecții: De a pune o întrebare și de a o rezolva folosind instrumentele de analiză.
6.2.1 Procesul GIS

Before we start, it would be useful to give a brief overview of a process that can be used to solve a problem. The way to go about it is:

1. Definirea Problemei
2. Obtinerea Datelor
3. Analiza Problemei
4. Prezentarea Rezultatelor

6.2.2 The Problem

Let’s start off the process by deciding on a problem to solve. For example, you are an estate agent and you are looking for a residential property in Swellendam for clients who have the following criteria:

1. It needs to be in Swellendam
2. It must be within reasonable driving distance of a school (say 1km)
3. It must be more than 100m squared in size
4. Closer than 50m to a main road
5. Closer than 500m to a restaurant

6.2.3 The Data

To answer these questions, we are going to need the following data:

1. The residential properties (buildings) in the area
2. The roads in and around the town
3. The location of schools and restaurants
4. The size of buildings

These data are available through OSM, and you should find that the dataset you have been using throughout this manual also can be used for this lesson.

If you want to download data from another area, jump to the Introduction Chapter to read how to do it.

Notă: Although OSM downloads have consistent data fields, the coverage and detail does vary. If you find that your chosen region does not contain information on restaurants, for example, you may need to chose a different region.
6.2.4 Follow Along: Start a Project and get the Data

We first need to load the data to work with.

1. Start a new QGIS project
2. If you want, you can add a background map. Open the Browser and load the OSM background map from the XYZ Tiles menu.

3. In the training_data.gpkg Geopackage database, you will find most the datasets we will use in this chapter:
   1. buildings
   2. roads
   3. restaurants
   4. schools

Load them, and also landuse.sqlite.

4. Zoom to the layer extent to see Swellendam, South Africa

Before proceeding we will filter the roads layer, in order to have only some specific road types to work with.

Some roads in OSM datasets are listed as unclassified, tracks, path and footway. We want to exclude these from our dataset and focus on the other road types, more suitable for this exercise.

Moreover, OSM data might not be updated everywhere, and we will also exclude NULL values.

5. Right click on the roads layer and choose Filter....

6. In the dialog that pops up we filter these features with the following expression:
The concatenation of the two operators \texttt{NOT} and \texttt{IN} excludes all the features that have these attribute values in the \texttt{highway} field.

\texttt{IS NOT NULL} combined with the \texttt{AND} operator excludes roads with no value in the \texttt{highway} field.

Note the \texttt{!} icon next to the \textit{roads} layer. It helps you remember that this layer has a filter activated, so some features may not be available in the project.

The map with all the data should look like the following one:

---

6.2.5 \textbf{Try Yourself Convertiți CRS-ul Straturilor}

Because we are going to be measuring distances within our layers, we need to change the layers' CRS. To do this, we need to select each layer in turn, save the layer to a new one with our new projection, then import that new layer into our map.

You have many different options, e.g. you can export each layer as an ESRI Shapefile format dataset, you can append the layers to an existing GeoPackage file, or you can create another GeoPackage file and fill it with the new reprojected layers. We will show the last option, so the \texttt{training_data.gpkg} will remain clean. Feel free to choose the best workflow for yourself.

\textbf{Notă:} In this example, we are using the \texttt{WGS 84 / UTM zone 34S} CRS, but you should use a UTM CRS which is more appropriate for your region.

1. Right click the \textit{roads} layer in the \textit{Layers} panel
2. Click \textit{Export} \rightarrow \textit{Save Features As}...
3. In the *Save Vector Layer As* dialog choose *GeoPackage as Format*

4. Click on … for the *File name*, and name the new GeoPackage *vector_analysis*

5. Change the *Layer name* to *roads_34S*

6. Change the *CRS* to *WGS 84 / UTM zone 34S*

7. Click on *OK*:

   ![Save Vector Layer as... dialog](image)

   This will create the new GeoPackage database and add the *roads_34S* layer.

8. Repeat this process for each layer, creating a new layer in the *vector_analysis.gpkg* GeoPackage file with _34S appended to the original name and removing each of the old layers from the project.

   **Nota:** When you choose to save a layer to an existing GeoPackage, QGIS will append that layer to the
GeoPackage.

9. Once you have completed the process for all the layers, right click on any layer and click *Zoom to layer extent* to focus the map to the area of interest.

Now that we have converted OSM data to a UTM projection, we can begin our calculations.

### 6.2.6 Follow Along: Analiza Problemei: Distanțele Dintre Școli și Drumuri

QGIS allows you to calculate distances between any vector object.

1. Make sure that only the *roads_34S* and *buildings_34S* layers are visible (to simplify the map while you're working)

2. Click on the *Processing ➤ Toolbox* to open the analytical core of QGIS. Basically, all algorithms (for vector and raster analysis) are available in this toolbox.

3. We start by calculating the area around the *roads_34S* by using the *Buffer* algorithm. You can find it in the *Vector Geometry* group.
Or you can type `buffer` in the search menu in the upper part of the toolbox:

4. Double click on it to open the algorithm dialog

5. Select `roads_34S` as *Input layer*, set *Distance* to 50 and use the default values for the rest of the parameters.
6. The default Distance is in meters because our input dataset is in a Projected Coordinate System that uses meter as its basic measurement unit. You can use the combo box to choose other projected units like kilometers, yards, etc.

Notă: If you are trying to make a buffer on a layer with a Geographical Coordinate System, Processing will warn you and suggest to reproject the layer to a metric Coordinate System.

7. By default, Processing creates temporary layers and adds them to the Layers panel. You can also append the result to the GeoPackage database by:

1. Clicking on the … button and choose Save to GeoPackage…
2. Naming the new layer roads_buffer_50m
3. Saving it in the vector_analysis.gpkg file
8. Click on Run, and then close the Buffer dialog

Acum, harta dvs. va arăta în felul următor:
If your new layer is at the top of the Layers list, it will probably obscure much of your map, but this gives you all the areas in your region which are within 50m of a road.

Notice that there are distinct areas within your buffer, which correspond to each individual road. To get rid of this problem:

1. Uncheck the `roads_buffer_50m` layer and re-create the buffer with `Dissolve results` enabled.
2. Save the output as *roads_buffer_50m_dissolved*

3. Click *Run* and close the *Buffer* dialog

Once you have added the layer to the *Layers* panel, it will look like this:
Acum, nu mai există subdiviziuni inutile.

Nota: The Short Help on the right side of the dialog explains how the algorithm works. If you need more information, just click on the Help button in the bottom part to open a more detailed guide of the algorithm.

6.2.7 Try Yourself Distanță față de școli

Utilizați aceeași abordare de mai sus, și creați un tampon pentru școlile dumneavoastră.

It shall to be 1 km in radius. Save the new layer in the vector_analysis.gpkg file as schools_buffer_1km_dissolved.

Check your results

6.2.8 Follow Along: Suprapunerea zonelor

Now we have identified areas where the road is less than 50 meters away and areas where there is a school within 1 km (direct line, not by road). But obviously, we only want the areas where both of these criteria are satisfied. To do that, we will need to use the Intersect tool. You can find it in Vector Overlay group in the Processing Toolbox.

1. Use the two buffer layers as Input layer and Overlay layer, choose vector_analysis.gpkg GeoPackage in Intersection with Layer name road_school_buffers_intersect. Leave the rest as suggested (default).
2. Click Run

In the image below, the blue areas are where both of the distance criteria are satisfied.
3. You may remove the two buffer layers and only keep the one that shows where they overlap, since that’s what we really wanted to know in the first place:
Now you've got the area that the buildings must overlap. Next, you want to extract the buildings in that area.

1. Look for the menu entry Vector Selection ➤ Extract by location within the Processing Toolbox.

2. Select buildings_34S in Extract features from. Check intersect in Where the features (geometric predicate). Select the buffer intersection layer in By comparing to the features from. Save to the vector_analysis.gpkg, and name the layer well_located_houses.

3. Click Run and close the dialog.

4. You will probably find that not much seems to have changed. If so, move the well_located_houses layer to the top of the layers list, then zoom in.
The red buildings are those which match our criteria, while the buildings in green are those which do not.

5. Now you have two separated layers and can remove `buildings_34S` from the layer list.

6.2.10  **Try Yourself Filtrarea în Continuare a Clădirilor noastre**

We now have a layer which shows us all the buildings within 1km of a school and within 50m of a road. We now need to reduce that selection to only show buildings which are within 500m of a restaurant.

Using the processes described above, create a new layer called `houses_restaurants_500m` which further filters your `well_located_houses` layer to show only those which are within 500m of a restaurant.

*Check your results*

6.2.11  **Follow Along: Selectarea Clădirilor de Mărimea Potrivită**

To see which buildings are of the correct size (more than 100 square meters), we need to calculate their size.

1. Select the `houses_restaurants_500m` layer and open the Field Calculator by clicking on the `Open Field Calculator` button in the main toolbar or in the attribute table window.

2. Select Create a new field, set the Output field name to `AREA`, choose Decimal number (real) as Output field type, and choose `$area` from the Geometry group.
The new field **AREA** will contain the area of each building in square meters.

3. Click **OK**. The **AREA** field has been added at the end of the attribute table.

4. Click the **Toggle Editing** button to finish editing, and save your edits when prompted.

5. In the **Source** tab of the layer properties, set the **Provider Feature Filter** to "**AREA >= 100**."
6. Click OK

Your map should now only show you those buildings which match our starting criteria and which are more than 100 square meters in size.

6.2.12 Try Yourself

Save your solution as a new layer, using the approach you learned above for doing so. The file should be saved within the same GeoPackage database, with the name solution.

6.2.13 In Conclusion

Using the GIS problem solving approach together with QGIS vector analysis tools, you were able to solve a problem with multiple criteria quickly and easily.
6.2.14 What’s Next?

In the next lesson, we will look at how to calculate the shortest distance along roads from one point to another.

6.3 Lesson: Analiza Rețelelor

Calculating the shortest distance between two points is a common GIS task. Tools for this can be found in the Processing Toolbox.

**The goal for this lesson:** learn to use Network analysis algorithms.

6.3.1 Follow Along: The Tools and the Data

You can find all the network analysis algorithms in the Processing ➤ Network Analysis menu. You can see that there are many tools available:

You can add more algorithms to the toolbox, enable additional providers. [close]
Open the project exercise_data/network_analysis/network.qgz. It contains two layers:

- network_points
- network_lines

The network_lines layer has already a style that helps to understand the road network.

The shortest path tools provide ways to calculate either the shortest or the fastest path between two points of a network, given:

- start and end points selected on the map
- start point selected on the map and end points taken from a point layer
- start points taken from a point layer and end point selected on the map

Let’s start.

### 6.3.2 Calculate the shortest path (point to point)

The Network analysis ➤ Shortest path (point to point) allows you to calculate the shortest distance between two manually selected points on the map.

In this example we will calculate the shortest (not fastest) path between two points.

1. Open the Shortest path (point to point) algorithm
2. Select network_lines for Vector layer representing network
3. Use Shortest for Path type to calculate

Use these two points as starting and ending points for the analysis:
4. Click on the … button next to Start point (x, y) and choose the location tagged with Starting Point in the picture. The coordinates of the clicked point are added.

5. Do the same thing, but choosing the location tagged with Ending point for End point (x, y)

6. Click on the Run button:
7. A new line layer is created representing the shortest path between the chosen points. Uncheck the network_lines layer to see the result better.

8. Open the attribute table of the output layer. It contains three fields, representing the coordinates of the start and end points and the cost.

We chose Shortest as Path type to calculate, so the cost represent the distance, in layer units, between the two locations.

In our case, the shortest distance between the chosen points is around 1000 meters:

Now that you know how to use the tool, feel free to test other locations.
6.3.3 Try Yourself Fastest path

With the same data of the previous exercise, try to calculate the fastest path between the two points. How much time do you need to go from the start to the end point?

Verificați-vă rezultatele

6.3.4 Follow Along: Advanced options

Let us explore some more options of the Network Analysis tools. In the previous exercise we calculated the fastest route between two points. As you can imagine, the time depends on the travel speed.

We will use the same layers and starting and ending points of the previous exercises.

1. Open the Shortest path (point to point) algorithm
2. Fill the Input layer, Start point (x, y) and End point (x, y) as we did before
3. Choose Fastest as the Path type to calculate
4. Open the Advanced parameter menu
5. Change the Default speed (km/h) from the default 50 value to 4

6. Click on Run
7. Once the algorithm is finished, close the dialog and open the attribute table of the output layer.

The cost field contains the value according to the speed parameter you have chosen. We can convert the cost field from hours with fractions to the more readable minutes values.

8. Open the field calculator by clicking on the icon and add the new field minutes by multiplying the cost field by 60:

That’s it! Now you know how many minutes it will take to get from one point to the other one.
6.3.5 Shortest path with speed limit

The Network analysis toolbox has other interesting options. Looking at the following map:

we would like to know the fastest route considering the speed limits of each road (the labels represent the speed limits in km/h). The shortest path without considering speed limits would of course be the purple path. But in that road the speed limit is 20 km/h, while in the green road you can go at 100 km/h!

As we did in the first exercise, we will use the Network analysis ➤ Shortest path (point to point) and we will manually choose the start and end points.

1. Open the Network analysis ➤ Shortest path (point to point) algorithm
2. Select network_lines for the Vector layer representing network parameter
3. Choose Fastest as the Path type to calculate
4. Click on the … button next to the Start point (x, y) and choose the start point.
5. Do the same thing for End point (x, y)
6. Open the Advanced parameters menu
7. Choose the speed field as the Speed Field parameter. With this option the algorithm will take into account the speed limits for each road.
8. Click on the Run button

9. Turn off the network_lines layer to better see the result
As you can see the fastest route does not correspond to the shortest one.

6.3.6 Service area (from layer)

The Network Analysis ➤ Service area (from layer) algorithm can answer the question: given a point layer, what are all the reachable areas given a distance or a time value?

Notă: The Network Analysis ➤ Service area (from point) is the same algorithm, but it allows you to manually choose the point on the map.

Given a distance of 250 meters we want to know how far we can go on the network from each point of the network_points layer.

1. Uncheck all the layers except network_points
2. Open the Network Analysis ➤ Service area (from layer) algorithm
3. Choose network_lines for Vector layer representing network
4. Choose network_points for Vector layer with start points
5. Choose Shortest in Path type to calculate
6. Enter 250 for the Travel cost parameter
7. Click on Run and close the dialog
The output layer represents the maximum path you can reach from the point features given a distance of 250 meters:
Cool isn’t it?

6.3.7 In Conclusion

Now you know how to use Network analysis algorithm to solve shortest and fastest path problems.

We are now ready to perform some spatial statistic on vector layer data. Let’s go!

6.3.8 What’s Next?

Mai departe, veți vedea cum să rulați algoritmii statisticilor spațiale asupra seturilor de date vectoriale.

6.4 Lesson: Statistici Spațiale

Notă: Leția a fost dezvoltată de Linfiniti și S Motala (Cape Peninsula University of Technology)

Spatial statistics allows you to analyze and understand what is going on in a given vector dataset. QGIS includes many useful tools for statistical analysis.

The goal for this lesson: To know how to use QGIS’s spatial statistics tools within the Processing Toolbox.

6.4.1 Follow Along: Crearea unui Set de Date de Test

We will create a random set of points, to get a dataset to work with.

To do so, you will need a polygon dataset to define the area you want to create the points in.

We will use the area covered by streets.

1. Start a new project

2. Add your roads dataset, as well as srtm_41_19 (elevation data) found in exercise_data/raster/SRTM/.

   Notă: You might find that the SRTM DEM layer has a different CRS to that of the roads layer. QGIS is reprojecting both layers in a single CRS. For the following exercises this difference does not matter, but feel free to reproject (as shown earlier in this module).

3. Open Processing toolbox

4. Use the Vector Geometry ▶ Minimum bounding geometry tool to generate an area enclosing all the roads by selecting Convex Hull as the Geometry Type.
As you know, if you don’t specify the output, Processing creates temporary layers. It is up to you to save the layers immediately or at a later stage.

**Crearea de puncte aleatorii**

- Create 100 random points in this area using the tool at Vector Creation ➤ Random points in layer bounds, with a minimum distance of 0.0:
**Notă:** The yellow warning sign tells you that that parameter concerns distances. The *Bounding geometry* layer is in a Geographical Coordinate System and the algorithm is just reminding you this. For this example we won’t use this parameter so you can ignore it.

If needed, move the generated random point to the top of the legend to see them better:
To create a sample dataset from the raster, you’ll need to use the Raster Analysis ► Sample raster values algorithm. This tool samples the raster at the locations of the points and adds the raster values in new field(s) depending on the number of bands in the raster.

1. Open the Sample raster values algorithm dialog

2. Select Random points as the layer containing sampling points, and the SRTM raster as the band to get values from. The default name of the new field is rvalue_N, where N is the number of the raster band. You can change the name of the prefix if you want.

3. Press Run

Now you can check the sampled data from the raster file in the attribute table of the Sampled Points layer. They will be in a new field with the name you have chosen.

Un posibil strat eşantion este prezentat aici:
The sample points are classified using the `rvalue_1` field such that red points are at a higher altitude. You will be using this sample layer for the rest of the statistical exercises.

6.4.2 Follow Along: Statistici de Bază

Obține statisticile de bază pentru acest strat.

1. Click on the \(\sum\) icon in the Attributes Toolbar. A new panel will pop up.
2. In the dialog that appears, specify the Sampled Points layer as the source.
3. Select the `rvalue_1` field in the field combo box. This is the field you will calculate statistics for.
4. The Statistics Panel will be automatically updated with the calculated statistics:
### Statistics

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count</td>
<td>100</td>
</tr>
<tr>
<td>Sum</td>
<td>14148</td>
</tr>
<tr>
<td>Mean</td>
<td>141.48</td>
</tr>
<tr>
<td>Median</td>
<td>122.5</td>
</tr>
<tr>
<td>St dev (pop)</td>
<td>89.4792</td>
</tr>
<tr>
<td>St dev (sample)</td>
<td>89.93</td>
</tr>
<tr>
<td>Minimum</td>
<td>18</td>
</tr>
<tr>
<td>Maximum</td>
<td>737</td>
</tr>
<tr>
<td>Range</td>
<td>719</td>
</tr>
<tr>
<td>Minority</td>
<td>18</td>
</tr>
<tr>
<td>Majority</td>
<td>120</td>
</tr>
<tr>
<td>Variety</td>
<td>78</td>
</tr>
<tr>
<td>Q1</td>
<td>97</td>
</tr>
<tr>
<td>Q3</td>
<td>163.5</td>
</tr>
<tr>
<td>IQR</td>
<td>66.5</td>
</tr>
<tr>
<td>Missing (null) values</td>
<td>0</td>
</tr>
</tbody>
</table>

[Image of a statistics window]
5. Close the Statistics Panel when done

Many different statistics are available:

**Număr** The number of samples/values.

**Sum** The values added together.

**Media** The mean (average) value is simply the sum of the values divided by the number of values.

**Mediana** If you arrange all the values from smallest to greatest, the middle value (or the average of the two middle values, if N is an even number) is the median of the values.

**St Dev (pop)** Abaterea standard. Oferă o indicație despre cât de strâns sunt grupate valorile în jurul mediului. Cu cât este mai mică deviația standard, cu atât mai apropiată tinde să fie media.

**Minimum** Valoarea minimă.

**Maximum** Valoarea maximă.

**Intervalul** Diferența dintre valorile minime și maxime.

**Q1** First quartile of the data.

**Q3** Third quartile of the data.

**Missing (null) values** The number of missing values.

### 6.4.3 Follow Along: Compute statistics on distances between points

1. Create a new temporary point layer.
2. Enter edit mode, and digitize three points somewhere among the other points.
   Alternatively, use the same random point generation method as before, but specify only three points.
3. Save your new layer as distance_points in the format you prefer.

To generate statistics on the distances between points in the two layers:

1. Open the Vector Analysis ➤ Distance matrix tool.
2. Select the distance_points layer as the input layer, and the Sampled Points layer as the target layer.
3. Setți-l astfel:
4. If you want you can save the output layer as a file or just run the algorithm and save the temporary output layer later.

5. Click Run to generate the distance matrix layer.

6. Open the attribute table of the generated layer: values refer to the distances between the distance_points features and their two nearest points in the Sampled Points layer:

<table>
<thead>
<tr>
<th>InputID</th>
<th>MEAN</th>
<th>STDDEV</th>
<th>MIN</th>
<th>MAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>401.87013</td>
<td>235.74757</td>
<td>166.12256</td>
<td>637.61770</td>
</tr>
<tr>
<td>2</td>
<td>653.19728</td>
<td>229.72430</td>
<td>423.47299</td>
<td>882.92158</td>
</tr>
<tr>
<td>3</td>
<td>1005.87036</td>
<td>296.03133</td>
<td>709.83903</td>
<td>1301.90169</td>
</tr>
</tbody>
</table>

With these parameters, the Distance Matrix tool calculates distance statistics for each point of the input layer with respect to the nearest points of the target layer. The fields of the output layer contain the mean, standard deviation, minimum and maximum for the distances to the nearest neighbors of the points in the input layer.
6.4.4 Follow Along: Nearest Neighbor Analysis (within layer)

To do a nearest neighbor analysis of a point layer:

1. Choose Vector analysis ➤ Nearest neighbor analysis.
2. In the dialog that appears, select the Random points layer and click Run.
3. The results will appear in the Processing Result Viewer Panel.

4. Click on the blue link to open the html page with the results:
6.4.5 Follow Along: Coordonatele Medii

Pentru a obține coordonatele medii ale unui set de date:

1. Start Vector analysis ► Mean coordinate(s)
2. In the dialog that appears, specify Random points as Input layer, and leave the optional choices unchanged.
3. Clic pe Run

Let us compare this to the central coordinate of the polygon that was used to create the random sample.

1. Start Vector geometry ► Centroids
2. In the dialog that appears, select Bounding geometry as the input layer.

As you can see, the mean coordinates (pink point) and the center of the study area (in green) don’t necessarily coincide.

The centroid is the barycenter of the layer (the barycenter of a square is the center of the square) while the mean coordinates represent the average of all node coordinates.
6.4.6 Follow Along: Histogramele de tip Imagine

The histogram of a dataset shows the distribution of its values. The simplest way to demonstrate this in QGIS is via the image histogram, available in the Layer Properties dialog of any image layer (raster dataset).

1. In your Layers panel, right-click on the srtm_41_19 layer
2. Select Properties
3. Choose the Histogram tab. You may need to click on the Compute Histogram button to generate the graphic.
   You will see a graph that shows the frequency distribution for the raster values.
4. The graph can be exported as an image with the Save plot button.

5. You can see more detailed information about the layer in the Information tab (the mean and max values are estimated, and may not be exact).

The mean value is 332.8 (estimated to 324.3), and the maximum value is 1699 (estimated to 1548)! You can zoom in the histogram. Since there are a lot of pixels with value 0, the histogram looks compressed vertically. By zooming in to cover everything but the peak at 0, you will see more details:
**Notă:** If the mean and maximum values are not the same as above, it can be due to the min/max value calculation. Open the Symbology tab and expand the *Min / Max Value Settings* menu. Choose `Min / max` and click on *Apply*.

Keep in mind that a histogram shows you the distribution of values, and not all values are necessarily visible on the graph.
Follow Along: Interpolarea Spațială

Let’s say you have a collection of sample points from which you would like to extrapolate data. For example, you might have access to the Sampled points dataset we created earlier, and would like to have some idea of what the terrain looks like.

1. To start, launch the GDAL ► Raster analysis ► Grid (IDW with nearest neighbor searching) tool in the Processing Toolbox.
2. For Point layer select Sampled points
3. Set Weighting power to 5.0
4. In Advanced parameters, set Z value from field to rvalue_1
5. Finally click on Run and wait until the processing ends
6. Close the dialog

Here is a comparison of the original dataset (left) to the one constructed from our sample points (right). Yours may look different due to the random nature of the location of the sample points.

As you can see, 100 sample points aren’t really enough to get a detailed impression of the terrain. It gives a very general idea, but it can be misleading as well.

Try Yourself Different interpolation methods

1. Use the processes shown above to create a set of 10 000 random points

   **Nota:** If the number of points is really big, the processing time can take a long time.

2. Use these points to sample the original DEM
3. Use the Grid (IDW with nearest neighbor searching) tool on this dataset.
4. Set Power and Smoothing to 5.0 and 2.0, respectively.

   Rezultatele (în funcție de poziționarea punctelor aleatorii) va arata mai mult, sau mai puțin, ca aceasta:
This is a better representation of the terrain, due to the greater density of sample points. Remember, larger samples give better results.

### 6.4.9 In Conclusion

QGIS has a number of tools for analyzing the spatial statistical properties of datasets.

### 6.4.10 What’s Next?

Now that we have covered vector analysis, why not see what can be done with rasters? That is what we will do in the next module!
Am folosit rastere pentru digitizarea anterioară, dar datele raster pot fi folosite, de asemenea, și în mod direct. În acest modul, veți vedea cum se face acest lucru în QGIS.

7.1 Lesson: Lucrul cu Datele Raster

Raster data is quite different from vector data. Vector data has discrete features with geometries constructed out of vertices, and perhaps connected with lines and/or areas. Raster data, however, is like any image. Although it may portray various properties of objects in the real world, these objects don’t exist as separate objects. Rather, they are represented using pixels with different values.

During this module you are going to use raster data to supplement your existing GIS analysis.

The goal for this lesson: To learn how to work with raster data in QGIS.

7.1.1 Follow Along: Încărcarea Datelor Raster

Raster data can be loaded with the same methods we used for vector data. However we suggest to use the Browser Panel.

1. Open the Browser Panel and expand the exercise_data/raster folder.
2. Load all the data in this folder:
   - 3320C_2010_314_RGB_LATLNG.tif
   - 3320D_2010_315_RGB_LATLNG.tif
   - 3420B_2010_328_RGB_LATLNG.tif
   - 3420C_2010_327_RGB_LATLNG.tif

You should see the following map:
There we have it - four aerial images covering our study area.

### 7.1.2 Follow Along: Crearea unui Raster Virtual

Now as you can see from this, your solution layer lies across all four images. What this means is that you are going to have to work with four rasters all the time. That’s not ideal. It would be better to have one file to work with.

Luckily, QGIS allows you to do exactly this, and without needing to actually create a new raster file. You can create a **Virtual Raster**. This is also often called a **Catalog**, which explains its function. It’s not really a new raster. Rather, it is a way to organize your existing rasters into one catalog: one file for easy access.

To make a catalog we will use the **Processing Toolbox**.

1. Open the **Build virtual raster** algorithm from the **GDAL ➤ Raster miscellaneous**;
2. In the dialog that appears, click on the … button next to the **Input layers** parameter and check all the layers or use the **Select All** button;
3. Uncheck **Place each input file into a separate band**. Notice the text field below. What this dialog is actually doing is that it is writing that text for you. It is a long command that QGIS is going to run.

**Nota:** Keep in mind that you can copy and paste the text in the **OSGeo Shell** (Windows user) or **Terminal** (Linux and OSX users) to run the command. You can also create a script for each GDAL command. This is very handy when the procedure is taking a long time or when you want to schedule specific tasks. Use the **Help** button to get more help on the syntax of the command.

4. Finally click on **Run**.

**Nota:** As you know from the previous modules, **Processing** creates temporary layers by default. To save the file click on the … button.
You can now remove the original four rasters from the Layers Panel and leave only the output virtual catalog raster.
7.1.3 Transformarea Datelot Raster

The above methods allow you to virtually merge datasets using a catalog, and to reproject them „on the fly“. However, if you are setting up data that you’ll be using for quite a while, it may be more efficient to create new rasters that are already merged and reprojected. This improves performance while using the rasters in a map, but it may take some time to set up initially.

Reproiectare rasterelor

Open Warp (reproject) from GDAL ➤ Raster projections.

You can also reproject virtual rasters (catalogs), enable multithreaded processing, and more.
If you need to create a new raster layer and save it to disk you can use the merge algorithm.

**Notă:** Depending on how many raster files you are merging and their resolution, the new raster file created can be really big. Consider instead to create a raster catalog as described in the *Create a Virtual Raster* section.

1. Click on the *Merge* algorithm from the *GDAL ➤ Raster miscellaneous* menu.
2. As we did for the *Create a Virtual raster*, use the … button to choose which layers you want to merge.
You can also specify a Virtual raster as input, and then all of the rasters that it consists of will be processed.

3. If you know the GDAL library, you can also add your own options by opening the Advanced parameters menu.

7.1.4 In Conclusion

QGIS face mai ușoară includerea datelor raster în proiectele existente.
7.1.5 What’s Next?

Next, we’ll use raster data that isn’t aerial imagery, and see how symbolization is useful in the case of rasters as well.

7.2 Lesson: Schimbarea Simbologiei Raster

Not all raster data are aerial photos. There are many other forms of raster data, and in many of those cases, it is essential to symbolize the them so that they becomes properly visible and useful.

Scopul acestei lecții: De a schimba simbolistica pentru un strat raster.

7.2.1 Try Yourself

1. Use the Browser Panel to load srtm_41_19.tif, found under exercise_data/raster/SRTM/
2. Zoom to the extent of this layer by right-clicking on it in the Layers panel and selecting Zoom to Layer.

This dataset is a Digital Elevation Model (DEM). It is a map of the elevation (altitude) of the terrain, allowing us to see where the mountains and valleys are, for example.

While each pixel of the dataset of the previous section contained color information, in a DEM, each pixel contains elevation values.

Once the DEM is loaded, you will notice that it is a grayscale representation:
QGIS has automatically applied a stretch to the pixel values of the image for visualization purposes, and we will learn more about how this works as we continue.

7.2.2 Follow Along: Schimbarea Simbologiei Straturilor Raster

You have two different options to change the raster symbology:

1. Within the Layer Properties dialog, by right-clicking on the layer in the Layer tree and selecting the Properties option. Then switch to the Symbology tab

2. By clicking on the Open the Layer Styling panel button right above the Layers panel (shortcut F7). This will open the Layer Styling panel, where you can switch to the Symbology tab.

Choose the method you prefer to work with.

7.2.3 Follow Along: Singleband gray

When you load a raster file, if it is not a photo image like the ones of the previous section, the default style is set to a grayscale gradient.

Let’s explore some of the features of this renderer.
The default Color gradient is set to Black to white, meaning that low pixel values are black and while high values are white. Try to invert this setting to White to black and see the results.

Very important is the Contrast enhancement parameter: by default it is set to Stretch to MinMax meaning that the pixel values are stretched to the minimum and maximum values.

Look at the difference with the enhancement (left) and without (right):

7.2. Lesson: Schimbarea Simbologiei Raster 233
But what are the minimum and maximum values that should be used for the stretch? The ones that are currently under *Min / Max Value Settings*. There are many ways to calculate the minimum and maximum values and use them for the stretch:

1. **User Defined**: you enter the *Min* and *Max* values manually
2. **Cumulative count cut**: this is useful when you have some extreme low or high values. It *cuts* the 2% (or the value you choose) of these values
3. **Min / max**: the *Real or Estimated* minimum and maximum values of the raster
4. **Mean +/- standard deviation**: the values will be calculated according to the mean value and the standard deviation

### 7.2.4 Follow Along: Singleband pseudocolor

Grayscale is not always great styles for raster layers. Let’s try to make the DEM more colorful.

- Change the *Render type* to *Singleband pseudocolor*. If you don’t like the default colors loaded, select another *Color ramp*
- Click the *Classify* button to generate a new color classification
- If it is not generated automatically click on the *OK* button to apply this classification to the DEM
Veți vedea un raster care arată în felul următor:
This is an interesting way of looking at the DEM. You will now see that the values of the raster are again properly displayed, going from blue for the lower areas to red for the higher ones.

### 7.2.5 Follow Along: Changing the transparency

Sometimes changing the transparency of the whole raster layer can help you to see other layers covered by the raster itself and better understand the study area.

To change the transparency of the whole raster switch to the *Transparency* tab and use the slider of the *Global Opacity* to lower the opacity:
More interesting is changing the transparency for some pixel values. For example in the raster we used you can see a homogeneous color at the corners. To set these pixels as transparent, go to **Custom Transparency Options** in the **Transparency** tab.

- **By clicking on the **Add values manually** button, you can add a range of values and set their transparency percentage**

- **For single values the **Add values from display** button is more useful**

- **Click on the **Add values from display** button. The dialog disappears, and you can interact with the map.**

- **Click on the homogeneous color in a corner of the DEM**

- **You will see that the transparency table will be filled with the clicked values:**
Click on OK to close the dialog and see the changes.

See? The corners are now 100% transparent.
7.2.6 In Conclusion

These are some the basic functions to get you started with raster symbology. QGIS also gives you many other options, such as symbolizing a layer using paletted/unique values, representing different bands with different colors in a multispectral image, or making an automatic hillshade effect (useful only with DEM raster files).

7.2.7 Referință

Setul de date SRTM a fost obținut de la http://srtm.csi.cgiar.org/

7.2.8 What’s Next?

Acum, că putem vedea datele noastre afișate corect, să investigăm modul în care putem analiza mai departe.

7.3 Lesson: Analiza Terenului

Anumite tipuri de rastere vă permit să căștigați o perspectivă mai largă asupra terenului pe care îl reprezintă. Modelele Digitale ale Elevației (DEMs) sunt deosebit de utile în această privință. În această lecție veti folosi anumite instrumente pentru analiză terenului, pentru a afla mai multe despre zona de studiu, în scopul dezvoltării rezidențiale propuse de mai devreme.

Scopul acestei școli: De a utiliza instrumentele de analiză a terenului pentru a extrage mai multe informații despre teren.

7.3.1 Follow Along: Calculul Umbrei Versanților

We are going to use the same DEM layer as in the previous lesson. If you are starting this chapter from scratch, use the Browser panel and load the raster/SRTM/srtm_41_19.tif.

The DEM layer shows you the elevation of the terrain, but it can sometimes seem a little abstract. It contains all the 3D information about the terrain that you need, but it doesn’t look like a 3D object. To get a better impression of the terrain, it is possible to calculate a hillshade, which is a raster that maps the terrain using light and shadow to create a 3D-looking image.

We are going to use algorithms in the Raster ➤ Raster terrain analysis menu.

1. Click on the Hillshade menu

2. The algorithm allows you to specify the position of the light source: Azimuth has values from 0 (North) through 90 (East), 180 (South) and 270 (West), while the Vertical angle sets how high the light source is (0 to 90 degrees).

3. We will use the following values:
   • Z factor at 1.0
   • Azimuth (horizontal angle) at 300.0°
   • Vertical angle at 40.0°
4. Save the file in a new folder `exercise_data/raster_analysis/` with the name `hillshade`.

5. Finally click on `Run`.

Aveți acum un nou strat denumit `hillshade`, care arată astfel:
That looks nice and 3D, but can we improve on this? On its own, the hillshade looks like a plaster cast. Can’t we use it together with our other, more colorful rasters somehow? Of course we can, by using the hillshade as an overlay.

### 7.3.2 Follow Along: Folosirea Umbrei Versanților pentru Suprapunere

Umbra versanților poate furniza informații foarte utile despre lumina solară, la un moment dat al zilei. Ea poate fi, de asemenea, utilizată în scopuri estetice, pentru a face harta să arate mai bine. Cheia pentru acest lucru este setarea reliefului de a fi în cea mai mare parte transparent.

1. Change the symbology of the original *srtm_41_19* layer to use the *Pseudocolor* scheme as in the previous exercise
2. Hide all the layers except the *srtm_41_19* and *hillshade* layers
3. Click and drag the *srtm_41_19* to be beneath the *hillshade* layer in the *Layers* panel
4. Set the *hillshade* layer to be transparent by clicking on the *Transparency* tab in the layer properties
5. Set the *Global opacity* to 50%.

You’ll get a result like this:

6. Switch the *hillshade* layer off and back on in the *Layers* panel to see the difference it makes.

Using a hillshade in this way, it’s possible to enhance the topography of the landscape. If the effect doesn’t seem strong enough to you, you can change the transparency of the *hillshade* layer; but of course, the brighter the hillshade becomes, the dimmer the colors behind it will be. You will need to find a balance that works for you.
Remember to save the project when you are done.

### 7.3.3 Follow Along: Finding the best areas

Think back to the estate agent problem, which we last addressed in the Vector Analysis lesson. Let us imagine that the buyers now wish to purchase a building and build a smaller cottage on the property. In the Southern Hemisphere, we know that an ideal plot for development needs to have areas on it that:

- are north-facing
- with a slope of less than 5 degrees
- But if the slope is less than 2 degrees, then the aspect doesn’t matter.

Let’s find the best areas for them.

### 7.3.4 Follow Along: Calculul Pantei

Slope informs about how steep the terrain is. If, for example, you want to build houses on the land there, then you need land that is relatively flat.

To calculate the slope, you need to use the Slope algorithm of the Processing ► Raster terrain analysis.

1. Open the algorithm
2. Choose srtm_41_19 as the Elevation layer
3. Keep the Z factor at 1.0
4. Save the output as a file with the name slope in the same folder as the hillshade
5. Click on Run

Now you’ll see the slope of the terrain, each pixel holding the corresponding slope value. Black pixels show flat terrain and white pixels, steep terrain:
7.3.5 **Try Yourself Calculating the aspect**

Aspect is the compass direction that the slope of the terrain faces. An aspect of 0 means that the slope is North-facing, 90 East-facing, 180 South-facing, and 270 West-facing.

Since this study is taking place in the Southern Hemisphere, properties should ideally be built on a north-facing slope so that they can remain in the sunlight.

Use the Aspect algorithm of the Processing ► Raster terrain analysis to get the aspect layer saved along with the slope.

*Check your results*

7.3.6 **Follow Along: Finding the north-facing aspect**

Now, you have rasters showing you the slope as well as the aspect, but you have no way of knowing where ideal conditions are satisfied at once. How could this analysis be done?

Răspunsul se află cu ajutorul: *Calculatorului raster*.

QGIS has different raster calculators available:

- *Raster ► Raster Calculator*
- In processing:
  - *Raster Analysis ► Raster calculator*
Each tool is leading to the same results, but the syntax may be slightly different and the availability of operators may vary.

We will use Raster Analysis ► Raster calculator in the Processing Toolbox

1. Open the tool by double clicking on it.
   - The upper left part of the dialog lists all the loaded raster layers as name@N, where name is the name of the layer and N is the band.
   - In the upper right part you will see a lot of different operators. Stop for a moment to think that a raster is an image. You should see it as a 2D matrix filled with numbers.

2. North is at 0 (zero) degrees, so for the terrain to face north, its aspect needs to be greater than 270 degrees or less than 90 degrees. Therefore the formula is:

   \[
   \text{aspect@1} < 90 \text{ OR aspect@1} > 270
   \]

3. Now you have to set up the raster details, like the cell size, extent and CRS. This can be done manually or it can be automatically set by choosing a Reference layer. Choose this last option by clicking on the … button next to the Reference layer(s) parameter.

4. In the dialog, choose the aspect layer, because we want to obtain a layer with the same resolution.

5. Save the layer as aspect_north.

   The dialog should look like:
6. Finally click on Run.

Rezultatul va fi acesta:

The output values are 0 or 1. What does it mean? For each pixel in the raster, the formula we wrote returns whether it matches the conditions or not. Therefore the final result will be False (0) and True (1).

7.3.7 Try Yourself More criteria

Now that you have done the aspect, create two new layers from the DEM.

- The first shall identify areas where the slope is less than or equal to 2 degrees
- The second is similar, but the slope should be less than or equal to 5 degrees.
- Save them under exercise_data/raster_analysis as slope_lte2.tif and slope_lte5.tif.

Check your results
Follow Along: Combinarea Rezultatelor Analizei Raster

Now you have generated three raster layers from the DEM:

- \textit{aspect\_north}: terrain facing north
- \textit{slope\_lte2}: slope equal to or below 2 degrees
- \textit{slope\_lte5}: slope equal to or below 5 degrees

Where the condition is met, the pixel value is 1. Elsewhere, it is 0. Therefore, if you multiply these rasters, the pixels that have a value of 1 for all of them will get a value of 1 (the rest will get 0).

The conditions to be met are:

- at or below 5 degrees of slope, the terrain must face north
- at or below 2 degrees of slope, the direction that the terrain faces does not matter.

Therefore, you need to find areas where the slope is at or below five degrees \textit{AND} the terrain is facing north, \textit{OR} the slope is at or below 2 degrees. Such terrain would be suitable for development.

Pentru a calcula zonele care îndeplinesc aceste criterii:

1. Open the \textit{Raster calculator} again
2. Use this expression in \textit{Expression}:

\[
( \text{aspect\_north} = 1 \ \text{AND} \ \text{slope\_lte5} = 1 ) \ \text{OR} \ \text{slope\_lte2} = 1
\]

3. Set the \textit{Reference layer(s)} parameter to \textit{aspect\_north} (it does not matter if you choose another - they have all been calculated from \textit{srtm\_41\_19})

4. Save the output under \textit{exercise\_data/raster\_analysis/ as all\_conditions.tif}

5. Click \textit{Run}

Rezultatul:
Sugestie: The previous steps could have been simplified using the following command:

```
((aspect@1 <= 90 OR aspect@1 >= 270) AND slope@1 < 5) OR slope@1 <= 2
```

7.3.9 Follow Along: Simplificarea Rasterului

As you can see from the image above, the combined analysis has left us with many, very small areas where the conditions are met (in white). But these aren’t really useful for our analysis, since they are too small to build anything on. Let us get rid of all these tiny unusable areas.

1. Open the Sieve tool (GDAL ➤ Raster Analysis in the Processing Toolbox)

2. Set the Input file to all_conditions, and the Sieved to all_conditions_sieve.tif (under exercise_data/raster_analysis/).

3. Set the Threshold to 8 (minimum eight contiguous pixels), and check Use 8-connectedness.
Once processing is done, the new layer will be loaded.
What is going on? The answer lies in the new raster file’s metadata.

4. View the metadata under the Information tab of the Layer Properties dialog. Look the STATISTICS_MINIMUM value:
This raster, like the one it is derived from, should only feature the values 1 and 0, but it has also a very large negative number. Investigation of the data shows that this number acts as a null value. Since we are only after areas that weren’t filtered out, let us set these null values to zero.

5. Open the Raster Calculator, and build this expression:

\[(\text{all_conditions_sieve@1} \leq 0) = 0\]

This will maintain all non-negative values, and set the negative numbers to zero, leaving all the areas with value 1 intact.

6. Save the output under exercise_data/raster_analysis/ as all_conditions_simple.tif.

Rezultatul dvs. arată în felul următor:

This is what was expected: a simplified version of the earlier results. Remember that if the results you get from a tool aren’t what you expected, viewing the metadata (and vector attributes, if applicable) can prove essential to solving the problem.

7.3.10 Follow Along: Reclassifying the Raster

We have used the Raster calculator to do calculations on raster layers. There is another powerful tool that we can use to extract information from existing layers.

Back to the aspect layer. We know now that it has numerical values within a range from 0 through 360. What we want to do is to reclassify this layer to other discrete values (from 1 to 4), depending on the aspect:

- 1 = North (from 0 to 45 and from 315 to 360);
- 2 = East (from 45 to 135)
- 3 = South (from 135 to 225)
This operation can be achieved with the raster calculator, but the formula would become very very large.

The alternative tool is the *Reclassify by table* tool in *Raster analysis* in the *Processing Toolbox*.

1. Open the tool
2. Choose *aspect* as the *Input raster layer*
3. Click on the … of *Reclassification table*. A table-like dialog will pop up, where you can choose the minimum, maximum and new values for each class.
4. Click on the *Add row* button and add 5 rows. Fill in each row as the following picture and click *OK*:

![Fixed table](image)

The method used by the algorithm to treat the threshold values of each class is defined by the *Range boundaries*.

5. Save the layer as *reclassified.tif* in the *exercise_data/raster_analysis/* folder
6. Click on Run

If you compare the native aspect layer with the reclassified one, there are not big differences. But by looking at the legend, you can see that the values go from 1 to 4.

Let us give this layer a better style.

1. Open the Layer Styling panel
2. Choose Paletted/Unique values, instead of Singleband gray
3. Click on the *Classify* button to automatically fetch the values and assign them random colors:

The output should look like this (you can have different colors given that they have been randomly generated):
With this reclassification and the paletted style applied to the layer, you can immediately differentiate the aspect areas.

### 7.3.11 Follow Along: Querying the raster

Unlike vector layers, raster layers don’t have an attribute table. Each pixel contains one or more numerical values (singleband or multiband rasters).

All the raster layers we used in this exercise consist of just one band. Depending on the layer, pixel values may represent elevation, aspect or slope values.

How can we query the raster layer to get the value of a pixel? We can use the Identify Features button!

1. Select the tool from the Attributes toolbar.
2. Click on a random location of the `srtm_41_19` layer. Identify Results will appear with the value of the band at the clicked location:
3. You can change the output of the Identify Results panel from the current tree mode to a table one by selecting Table in the View menu at the bottom of the panel:

Clicking each pixel to get the value of the raster could become annoying after a while. We can use the Value Tool plugin to solve this problem.

1. Go to Plugins ➤ Manage/Install Plugins…
2. In the All tab, type value t in the search box
3. Select the Value Tool plugin, press Install Plugin and then Close the dialog.
The new **Value Tool** panel will appear.

**Sfat:** If you close the panel you can reopen it by enabling it in the *View ➤ Panels ➤ Value Tool* or by clicking on the icon in the toolbar.

4. To use the plugin just check the *Enable* checkbox and be sure that the *srtm_41_19* layer is active (checked) in the *Layers* panel.

5. Move the cursor over the map to see the value of the pixels.
6. But there is more. The Value Tool plugin allows you to query all the active raster layers in the Layers panel. Set the aspect and slope layers active again and hover the mouse on the map:

![Value Tool plugin](image)

7.3.12 In Conclusion

You’ve seen how to derive all kinds of analysis products from a DEM. These include hillshade, slope and aspect calculations. You’ve also seen how to use the raster calculator to further analyze and combine these results. Finally you learned how to reclassify a layer and how to query the results.

7.3.13 What’s Next?

Now you have two analyses: the vector analysis which shows you the potentially suitable plots, and the raster analysis that shows you the potentially suitable terrain. How can these be combined to arrive at a final result for this problem? That’s the topic for the next lesson, starting in the next module.
Module: Finalizarea analizei

Aveți acum două jumătăți ale unei analize: o parte vector și o parte raster. În acest modul, veți afla cum să le combinați. Veți încheia analiza și veți prezenta rezultatele finale.

8.1 Lesson: Conversia din Raster în Vector

Conversia între formatele raster și cele vectoriale, vă permite să faceti uz atât de datele raster cât și de cele vectoriale, atunci când rezolvați o problemă GIS, precum și utilizarea diferitelor metode unice de analiză, pentru aceste două forme de date geografice. Acest lucru crește flexibilitatea atunci când luați în calcul sursele de date și metodele de procesare pentru rezolvarea unei probleme GIS.

Pentru a combina analiza raster cu cea vectorială, trebuie să convertiți un tip de date în altul. Haideți să convertim rasterul rezultat din lectia anterioară într-un vector.

**Scopul acestei lecții:** De a obține rezultatul raster într-un vector, care să poată fi utilizat pentru a completa analiza.

8.1.1 ▶ Follow Along: Instrumentul Raster to Vector

Începeți cu harta de la ultimul modul, raster_analysis.qgs. Ar trebui să aveți all_conditions_simple.tif calculat în timpul exercițiilor anterioare.

- Clic pe Raster ➤ Conversion ➤ Polygonize (Raster to Vector). Va apărea fereastra de dialog a instrumentului.
- Setați-l astfel:
• Change the field name (describing the values of the raster) to **suitable**.

• Save the layer under `exercise_data/residential_development` as `all_terrain.shp`.

Now you have a vector file which contains all the values of the raster, but the only areas you’re interested in are those that are suitable; i.e., those polygons where the value of `suitable` is 1. You can change the style of this layer if you want to have a clearer visualization of it.

### 8.1.2 Try Yourself

Consultați înapoi la modulul de analiză vectorială.

• Create a new vector file that contains only the polygons where `suitable` has the value of 1.

• Save the new file under `exercise_data/residential_development/` as `suitable Terrain.shp`.

*Check your results*
8.1.3 Follow Along: Instrumentul Vector to Raster

Although unnecessary for our current problem, it’s useful to know about the opposite conversion from the one performed above. Convert to raster the suitableTerrain.shp vector file you just created in previous step.

- Clic pe Raster ➤ Conversion ➤ Rasterize (Vector to Raster) pentru a lansa acest instrument, apoi setați-l ca în imaginea de mai jos:

- **Input layer** is allTerrain.
- **Field name** is suitable.
- **Output raster size units** is Pixels.
- **Width and Height** are 837 and 661, respectively.
- Get the **Output extent** from the allTerrain layer.
- Set output file Rasterized to exercise_data/residential_development/raster_conversion.tif.
8.1.4 In Conclusion

Conversia între formatele raster și cele vectoriale vă permite să extindeți aplicabilitatea datelor, și nu trebuie să ducă la degradarea datelor.

8.1.5 What’s Next?

Acum, că avem rezultatele analizei de teren disponibile în format vectorial, ele pot fi folosite pentru a rezolva problema clădirii pe care ar trebui să o propunem în scopul dezvoltării rezidențiale.

8.2 Lesson: Combinarea Analizelor

Folosind rezultatele vectorizate ale analizei raster, veți putea selecta numai acele clădiri de pe terenul potrivit.

Scopul acestei lecții: De a utiliza terenul vectorizat rezultat la selectarea terenurilor adecvate.

8.2.1 Try Yourself

1. Save your current map (raster_analysis.qgs).

2. Open the map which you created during the vector analysis earlier (you should have saved the file as analysis.qgs).

3. In the Layers panel, enable these layers:
   - relieful,
   - soluția (or buildings_over_100)

4. In addition to these layers, which should already be loaded in the map from when you worked on it before, also add the suitable_terrain.shp dataset.

5. If you are missing some layers, you should find them in exercise_data/residential_development/

6. Use the Intersection tool (Vector ➤ Geoprocessing Tools) to create a new vector layer called new_solution.shp which contains only those buildings which intersect the suitable_terrain layer.

Ar trebui să aveți de acum un strat care prezintă anumite clădiri din soluția dvs., cum ar fi:
8.2.2 Try Yourself Inspectarea Rezultatelor

Uitați-vă la fiecare dintre clădirile dumneavoastră din stratul \textit{new\_solution}. Comparați-le cu stratul \textit{suitable\_terrain}, prin schimbarea simbologiei stratului \textit{new\_solution}, astfel încât acesta să aibă numai are contur. Ce părere aveți despre observa unele dintre clădiri? Sunt toate acestea potrivite doar pentru că se intersectează cu stratul \textit{suitable\_terrain}? De ce sau de ce nu? Pe care dintre ele le-ai considera ca fiind necorespunzătoare?

\textit{Check your results}

8.2.3 Try Yourself Rafinarea Analizei

PUTEȚI vedea din rezultate, că unele clădirile care au fost incluse nu au fost cu adevărat adecvate, astfel încât să putem rafina acum analiza.

We want to ensure that our analysis returns only those buildings which fall entirely within the \textit{suitable\_terrain} layer. How would you achieve this? Use one or more Vector Analysis tools and remember that our buildings are all over 100m squared in size.

\textit{Check your results}

8.2.4 In Conclusion

Ati răspuns acum la întrebarea de cercetare originală, și v-ati conturat deja o opțiune (argumentată și susținută de o analiză) care poate sta la baza unei recomandări cu privire la proprietatea de dezvoltat.
8.2.5 What’s Next?

Mai departe, vom prezenta aceste rezultate ca parte a celei de-a doua dvs. misiuni.

8.3 Exercițiu

Using the print layout, make a new map representing the results of your analysis. Include these layers:

- locuri (cu etichete),
- umbriire relief,
- soluție (sau noua_soluție),
- drumuri și
- fie aerial_photos, fie DEM.

Scrieți un scurt text explicativ, însoțitor. Includeți în acest text criteriile care au fost luate în considerare pentru achiziția și dezvoltarea ulterioară a casei, precum și recomandările dvs. de utilizare a clădirilor.

8.4 Lesson: Exercițiu Suplimentar

În această lecție, veți efectua o analiză GIS completă în QGIS.

Notă: Lesson developed by Linfiniti Consulting (South Africa) and Siddique Motala (Cape Peninsula University of Technology)

8.4.1 Definirea Problemei

You are tasked with finding areas in and around the Cape Peninsula that are suitable habitats for a rare fynbos plant species. The extent of your area of investigation covers Cape Town and the Cape Peninsula between Melkbosstrand in the north and Strand in the south. Botanists have provided you with the following preferences exhibited by the species in question:

- It grows on east facing slopes
- It grows on slopes with a gradient between 15% and 60%
- It grows in areas that have a total annual rainfall of > 1000 mm
- It will only be found at least 250 m away from any human settlement
- The area of vegetation in which it occurs should be at least 6000 $m^2$ in area

As a student at the University, you have agreed to search for the plant in four different suitable areas of land. You want those four suitable areas to be the ones that are closest to the University of Cape Town where you live. Use your GIS skills to determine where you should go to look.
8.4.2 Conturarea unei Soluții

The data for this exercise can be found in the exercise_data/more_analysis folder.

You are going to find the four suitable areas that are closest to the University of Cape Town.

The solution will involve:

1. Analysing a DEM raster layer to find the east facing slopes and the slopes with the correct gradients
2. Analysing a rainfall raster layer to find the areas with the correct amount of rainfall
3. Analysing a zoning vector layer to find areas that are away from human settlement and are of the correct size

8.4.3 Follow Along: Setting up the Map

1. Click on the Current CRS button in the lower right corner of the screen. Under the CRS tab of the dialog that appears, use the „Filter” tool to search for „33S”. Select the entry WGS 84 / UTM zone 33S (with EPSG code 32733).
2. Clic pe OK
3. Save the project file by clicking on the Save Project toolbar button, or use the File ➤ Save As… menu item. Save it in a new directory called Rasterprac, that you should create somewhere on your computer. You will save whatever layers you create in this directory as well. Save the project as your_name_fynbos.qgs.

8.4.4 Încărcarea Datelor în Hartă

In order to process the data, you will need to load the necessary layers (street names, zones, rainfall, DEM, districts) into the map canvas.

For vectors...

1. Click on the Open Data Source Manager button in the Data Source Manager Toolbar, and enable the Vector tab in the dialog that appears, or use the Layer ➤ Add Layer ➤ Add Vector Layer… menu item
2. Ensure that File is selected
3. Click on the … button to browse for vector dataset(s)
4. In the dialog that appears, open the exercise_data/more_analysis/Streets directory
5. Select the file Street_Names_UTM33S.shp
6. Clic pe Deschidere.

The dialog closes and shows the original dialog, with the file path specified in the text field next to Vector dataset(s). This allows you to ensure that the correct file is selected. It is also possible to enter the file path in this field manually, should you wish to do so.

7. Click Add. The vector layer will be loaded into your map. Its color is automatically assigned. You will change it later.
8. Rename the layer to Streets
    1. Right-click on it in the Layers panel (by default, the pane along the left-hand side of the screen)
    2. Click Rename in the dialog that appears and rename it, pressing the Enter key when done
9. Repeat the vector adding process, but this time select the Generalised_Zoning_Dissolve_UTM33S.shp file in the Zoning directory.
10. Rename it to Zoning.
11. Load also the vector layer `admin_boundaries/Western_Cape_UTM33S.shp` into your map.
12. Rename it to Districts.

For rasters...

1. Click on the [Open Data Source Manager] button and enable the [Raster] tab in the dialog that appears, or use the `Layer ➤ Add Layer ➤ Add Raster Layer...` menu item.
2. Ensure that [File] is selected.
3. Navigate to the appropriate file, select it, and click `Open`.
4. Do this for each of the following two raster files, `DEM/SRTM.tif` and `rainfall/reprojected/rainfall.tif`.
5. Rename the SRTM raster to `DEM` and the rainfall raster to `Rainfall` (with an initial capital).

8.4.5 Modificarea ordinii straturilor

Click and drag layers up and down in the Layers panel to change the order they appear in on the map so that you can see as many of the layers as possible.

Now that all the data is loaded and properly visible, the analysis can begin. It is best if the clipping operation is done first. This is so that no processing power is wasted on computing values in areas that are not going to be used anyway.

8.4.6 Găsirea Districtelor Corecte

Due to the aforementioned area of investigation, we need to limit our districts to the following ones:

- Bellville
- Cape
- Goodwood
- Kuils River
- Mitchells Plain
- Simon Town
- Wynberg

1. Right-click on the Districts layer in the Layers panel.
2. In the menu that appears, select the `Filter...` menu item. The `Query Builder` dialog appears.
3. You will now build a query to select only the candidate districts:
   1. In the Fields list, double-click on the `NAME_2` field to make it appear in the SQL where clause text field below.
   2. Click the `IN` button to append it to the SQL query.
   3. Open the brackets.
   4. Click the `All` button below the (currently empty) Values list.
      After a short delay, this will populate the Values list with the values of the selected field (`NAME_2`).
   5. Double-click the value `Bellville` in the Values list to append it to the SQL query.
   6. Add a comma and double-click to add Cape district.
7. Repeat the previous step for the remaining districts

8. Close the brackets

   The final query should be (the order of the districts in the brackets does not matter):

   "NAME_2" in ('Bellville', 'Cape', 'Goodwood', 'Kuils River',
   'Mitchells Plain', 'Simon Town', 'Wynberg')

   **Nota:** You can also use the OR operator; the query would look like this:

   "NAME_2" = 'Bellville' OR "NAME_2" = 'Cape' OR
   "NAME_2" = 'Goodwood' OR "NAME_2" = 'Kuils River' OR
   "NAME_2" = 'Mitchells Plain' OR "NAME_2" = 'Simon Town' OR
   "NAME_2" = 'Wynberg'

9. Click OK twice.

   The districts shown in your map are now limited to those in the list above.

### 8.4.7 Decuparea Rasterelor

Acum, că aveți o zonă de interes, puteți decupa rasterele după ea.

1. Open the clipping dialog by selecting the menu item Raster ➤ Extraction ➤ Clip Raster by Mask Layer...

2. In the Input layer dropdown list, select the DEM layer

3. In the Mask layer dropdown list, select the Districts layer

4. Scroll down and specify an output location in the Clipped (mask) text field by clicking the … button and choosing Save to File...

   1. Navigate to the Rasterprac directory
   2. Enter a file name - DEM_clipped.tif
   3. Save

5. Make sure that ✔ Open output file after running algorithm is checked

6. Click Run

   After the clipping operation has completed, leave the Clip Raster by Mask Layer dialog open, to be able to reuse the clipping area

7. Select the Rainfall raster layer in the Input layer dropdown list and save your output as Rainfall_clipped.tif

8. Do not change any other options. Leave everything the same and click Run.

9. After the second clipping operation has completed, you may close the Clip Raster by Mask Layer dialog

10. Save the map
Align the rasters

For our analysis we need the rasters to have the same CRS and they have to be aligned.

First we change the resolution of our rainfall data to 30 meters (pixel size):

1. Right-click on the Rainfall_clipped layer and select Export► Save As… in the context menu.
2. Under Resolution, set the Horizontal and Vertical resolutions to 30 (meters).
3. Save the file as Rainfall30.tif in rainfall/reprojected (File name)

Then we align the DEM:

1. Right-click on the DEM_clipped layer and select Export► Save As… in the context menu
2. For CRS, choose WGS 84 / UTM zone 33S (EPSG code 32733)
3. Under Resolution, set the Horizontal and Vertical resolutions to 30 (in meters).
4. Under Extent, click on Calculate from Layer and choose Rainfall30
5. Save the file as DEM30.tif in DEM/reprojected (File name)

Pentru a vedea în mod corespunzător ce se întâmplă, simbolistica pentru straturi trebuie să fie schimbată.

8.4.8 Schimbarea simbologiei straturilor vectoriale

1. In the Layers panel, right-click on the Streets layer
2. Select Properties from the menu that appears
3. Switch to the Symbology tab in the dialog that appears
4. Click on the Fill entry in the top widget
5. Select a symbol in the list below or set a new one (color, transparency, …)
6. Click OK to close the Layer Properties dialog. This will change the rendering of the Streets layer.
7. Follow a similar process for the Zoning layer and choose an appropriate color for it

8.4.9 Schimbarea simbologiei straturilor raster

Simbologia straturilor raster este oarecum diferită.

1. Open the Properties dialog for the Rainfall30 raster layer
2. Switch to the Symbology tab. You’ll notice that this dialog is very different from the version used for vector layers.
3. Expand Min/Max Value Settings
4. Ensure that the button Mean +/- standard deviation is selected
5. Make sure that the value in the associated box is 2.00
6. For Contrast enhancement, make sure it says Stretch to MinMax
7. For Color gradient, change it to White to Black
8. Clic pe OK
   The Rainfall30 raster, if visible, should change colors, allowing you to see different brightness values for each pixel
9. Repeat this process for the DEM30 layer, but set the standard deviations used for stretching to 4.00
8.4.10 Curățarea hărții

1. Remove the original Rainfall and DEM layers, as well as Rainfall_clipped and DEM_clipped from the Layers panel:
   • Clic-dreapta pe aceste straturi apoi selectați Remove.

   **Nota:** Acest lucru nu va elimina datele de pe dispozitivul de stocare, doar le va scoate din harta dvs.

2. Save the map
3. You can now hide the vector layers by unchecking the box next to them in the Layers panel. This will make the map render faster and will save you some time.

8.4.11 Crearea reliefului

In order to create the hillshade, you will need to use an algorithm that was written for this purpose.

1. In the Layers panel, ensure that DEM30 is the active layer (i.e., it is highlighted by having been clicked on)
2. Click on the Raster ➤ Analysis ➤ Hillshade… menu item to open the Hillshade dialog
3. Scroll down to Hillshade and save the output in your Rasterprac directory as hillshade.tif
4. Make sure that Open output file after running algorithm is checked
5. Click Run
6. Așteptați să se termine prelucrarea.

The new hillshade layer has appeared in the Layers panel.

1. Right-click on the hillshade layer in the Layers panel and bring up the Properties dialog
2. Click on the Transparency tab and set the Global Opacity slider to 20%
3. Clic pe OK
4. Note the effect when the transparent hillshade is superimposed over the clipped DEM. You may have to change the order of your layers, or click off the Rainfall30 layer in order to see the effect.

8.4.12 Panta

1. Click on the Raster ➤ Analysis ➤ Slope… menu item to open the Slope algorithm dialog
2. Select DEM30 as Input layer
3. Check Slope expressed as percent instead of degrees. Slope can be expressed in different units (percent or degrees). Our criteria suggest that the plant of interest grows on slopes with a gradient between 15% and 60%. So we need to make sure our slope data is expressed as a percent.
4. Specify an appropriate file name and location for your output.
5. Make sure that Open output file after running algorithm is checked
6. Click Run

The slope image has been calculated and added to the map. As usual, it is rendered in grayscale. Change the symbology to a more colorful one:

1. Open the layer Properties dialog (as usual, via the right-click menu of the layer)
2. Click on the Symbology tab
3. Where it says Singleband gray (in the Render type dropdown menu), change it to Singleband pseudocolor
4. Choose Mean +/- standard deviation $x$ for Min / Max Value Settings with a value of 2.0
5. Select a suitable Color ramp
6. Click Run

8.4.13 Try Yourself Aspect

Use the same approach as for calculating the slope, choosing Aspect… in the Raster ► Analysis menu.
Remember to save the project periodically.

8.4.14 Reclasificarea rasterelor

1. Choose Raster ► Raster calculator…
2. Specify your Rasterprac directory as the location for the Output layer (click on the … button), and save it as slope15_60.tif
3. Ensure that the Open output file after running algorithm box is selected.
   In the Raster bands list on the left, you will see all the raster layers in your Layers panel. If your Slope layer is called slope, it will be listed as slope@1. Indicating band 1 of the slope raster.
4. The slope needs to be between 15 and 60 degrees.
   Using the list items and buttons in the interface, build the following expression:
   \[(slope@1 > 15) \text{ AND } (slope@1 < 60)\]
5. Alegeți o locație pentru câmpul Output layer și numele de fișier corespunzător.
6. Clic pe Run

Now find the correct aspect (east-facing: between 45 and 135 degrees) using the same approach.
1. Build the following expression:
   \[(aspect@1 > 45) \text{ AND } (aspect@1 < 135)\]

You will know it worked when all of the east-facing slopes are white in the resulting raster (it’s almost as if they are being lit by the morning sunlight).

Find the correct rainfall (greater than 1000 mm) the same way. Use the following expression:
\[\text{Rainfall130}@1 > 1000\]

Now that you have all three criteria each in separate rasters, you need to combine them to see which areas satisfy all the criteria. To do so, the rasters will be multiplied with each other. When this happens, all overlapping pixels with a value of 1 will retain the value of 1 (i.e. the location meets the criteria), but if a pixel in any of the three rasters has the value of 0 (i.e. the location does not meet the criteria), then it will be 0 in the result. In this way, the result will contain only the overlapping areas that meet all of the appropriate criteria.
8.4.15 Combinarea rasterelor

1. Open the Raster Calculator (Raster ► Raster Calculator…)

2. Build the following expression (with the appropriate names for your layers):

   \[\text{[aspect45_135]} \times \text{[slope15_60]} \times \text{[rainfall_1000]}\]

3. Set the output location to the Rasterprac directory

4. Name the output raster aspect_slope_rainfall.tif

5. Ensure that Open output file after running algorithm is checked

6. Click Run

The new raster now properly displays the areas where all three criteria are satisfied.

Save the project.

The next criterion that needs to be satisfied is that the area must be 250 m away from urban areas. We will satisfy this requirement by ensuring that the areas we compute are inside rural areas, and are 250 m or more from the edge of the area. Hence, we need to find all rural areas first.

8.4.16 Găsirea zonelelorurale

1. Hide all layers in the Layers panel

2. Unhide the Zoning vector layer

3. Right-click on it and bring up the Attribute Table dialog. Note the many different ways that the land is zoned here. We want to isolate the rural areas. Close the Attribute table.

4. Right-click on the Zoning layer and select Filter… to bring up the Query Builder dialog

5. Build the following query:

   \["\text{Gen_Zoning} = 'Rural'\]

See the earlier instructions if you get stuck.

6. Click OK to close the Query Builder dialog. The query should return one feature.

You should see the rural polygons from the Zoning layer. You will need to save these.

   1. In the right-click menu for Zoning, select Export ► Save Features As....

   2. Save your layer under the Rasterprac directory

   3. Name the output file rural.shp

   4. Click OK

   5. Save the project

Now you need to exclude the areas that are within 250m from the edge of the rural areas. Do this by creating a negative buffer, as explained below.
8.4.17 Crearea unui tampon negativ

1. Click the menu item Vector ► Geoprocessing Tools ► Buffer…
2. In the dialog that appears, select the rural layer as your input vector layer (Selected features only should not be checked)
3. Set Distance to –250. The negative value means that the buffer will be an internal buffer. Make sure that the units are meters in the dropdown menu.
4. Check Dissolve result
5. In Buffered, place the output file in the Rasterprac directory, and name it rural_buffer.shp
6. Click Save
7. Click Run and wait for the processing to complete
8. Închideti dialogul Buffer.
   
   Make sure that your buffer worked correctly by noting how the rural_buffer layer is different from the rural layer. You may need to change the drawing order in order to observe the difference.
9. Remove the rural layer
10. Save the project

Now you need to combine your rural_buffer vector layer with the aspect_slope_rainfall raster. To combine them, we will need to change the data format of one of the layers. In this case, you will vectorize the raster, since vector layers are more convenient when we want to calculate areas.

8.4.18 Vectorizarea rasterului

1. Click on the menu item Raster ► Conversion ► Polygonize (Raster to Vector)…
2. Select the aspect_slope_rainfall raster as Input layer
3. Set Name of the field to create to suitable (the default field name is DN - Digital number data)
4. Save the output. Under Vectorized, select Save file as. Set the location to Rasterprac and name the file aspect_slope_rainfall_all.shp.
5. Ensure that Open output file after running algorithm is checked
6. Click Run
7. Close the dialog when processing is complete

All areas of the raster have been vectorized, so you need to select only the areas that have a value of 1 in the suitable field. (Digital Number.

1. Open the Query Builder dialog (right-click - Filter…) for the new vector layer
2. Build this query:

   "suitable" = 1

3. Clica pe OK
4. After you are sure the query is complete (and only the areas that meet all three criteria, i.e. with a value of 1 are visible), create a new vector file from the results, using the Export –> Save Features As… in the layer’s right-click menu
5. Save the file in the Rasterprac directory
6. Name the file aspect_slope_rainfall_1.shp
7. Remove the aspect_slope_rainfall_all layer from your map
8. Save your project

When we use an algorithm to vectorize a raster, sometimes the algorithm yields what is called „Invalid geometries“, i.e. there are empty polygons, or polygons with mistakes in them, that will be difficult to analyze in the future. So, we need to use the „Fix Geometry“ tool.

### 8.4.19 Fixing geometry

1. In the Processing Toolbox, search for „Fix geometries“, and Execute… it
2. For the Input layer, select aspect_slope_rainfall_1
3. Under Fixed geometries, select Save file as, and save the output to Rasterprac and name the file fixed_aspect_slope_rainfall.shp.
4. Ensure that Open output file after running algorithm is checked
5. Click Run
6. Close the dialog when processing is complete

Now that you have vectorized the raster, and fixed the resulting geometry, you can combine the aspect, slope, and rainfall criteria with the distance from human settlement criteria by finding the intersection of the fixed_aspect_slope_rainfall layer and the rural_buffer layer.

### 8.4.20 Determining the Intersection of vectors

1. Click the menu item Vector ► Geoprocessing Tools ► Intersection…
2. In the dialog that appears, select the rural_buffer layer as Input layer
3. For the Overlay layer, select the fixed_aspect_slope_rainfall layer
4. In Intersection, place the output file in the Rasterprac directory
5. Name the output file rural_aspect_slope_rainfall.shp
6. Click Save
7. Click Run and wait for the processing to complete
8. Close the Intersection dialog.

Make sure that your intersection worked correctly by noting that only the overlapping areas remain.

9. Save the project

The next criteria on the list is that the area must be greater than 6000 \(m^2\). You will now calculate the polygon areas in order to identify the areas that are the appropriate size for this project.

### 8.4.21 Calculați aria pentru fiecare poligon

1. Open the new vector layer’s right-click menu
2. Select Open attribute table
3. Click the Toggle editing button in the top left corner of the table, or press Ctrl+e
4. Click the Open field calculator button in the toolbar along the top of the table, or press Ctrl+i
5. In the dialog that appears, make sure that Create new field is checked, and set the Output field name to area The output field type should be a decimal number (real). Set Precision to 1 (one decimal).
6. In the Expression area, type:
This means that the field calculator will calculate the area of each polygon in the vector layer and will then populate a new integer column (called \texttt{area}) with the computed value.

7. Clic pe \texttt{OK}

8. Do the same thing for another new field called \texttt{id}. In Field calculator expression, type:

\begin{verbatim}
$\texttt{id}
\end{verbatim}

Acest lucru ne asigură că fiecare poligon are un ID unic, în scop de identificare.

9. Click \texttt{Toggle editing} again, and save your edits if prompted to do so

### 8.4.22 Selectarea zonelor cu o dimensiune dată

Acum, că ariile sunt cunoscute:

1. Build a query (as usual) to select only the polygons that are larger than 6000 m$^2$. The query is:

\begin{verbatim}
"area" > 6000
\end{verbatim}

2. Save the selection in the Rasterprac directory as a new vector layer called \texttt{suitable_areas.shp}.

You now have the suitable areas that meet all of the habitat criteria for the rare fynbos plant, from which you will pick the four areas that are nearest to the University of Cape Town.

### 8.4.23 Digitize the University of Cape Town

1. Create a new vector layer in the Rasterprac directory as before, but this time, use \texttt{Point} as Geometry type and name it \texttt{university.shp}

2. Ensure that it is in the correct CRS (Project CRS:EPSG:32733 - WGS 84 / UTM zone 33S)

3. Finish creating the new layer (click \texttt{OK})

4. Hide all layers except the new \texttt{university} layer and the \texttt{Streets} layer.

5. Add a background map (OSM):
   1. Go to the \texttt{Browser} panel and navigate to \texttt{XYZ Tiles \textasciitilde OpenStreetMap}
   2. Drag and drop the \texttt{OpenStreetMap} entry to the bottom of the \texttt{Layers} panel

   Using your internet browser, look up the location of the University of Cape Town. Given Cape Town’s unique topography, the university is in a very recognizable location. Before you return to QGIS, take note of where the university is located, and what is nearby.

6. Ensure that the \texttt{Streets} layer clicked on, and that the \texttt{university} layer is highlighted in the \texttt{Layers} panel

7. Navigate to the \texttt{View \textasciitilde Toolbars} menu item and ensure that \texttt{Digitizing} is selected. You should then see a toolbar icon with a pencil on it (\texttt{Toggle editing}). This is the \texttt{Toggle Editing} button.

8. Click the \texttt{Toggle editing} button to enter edit mode. This allows you to edit a vector layer

9. Click the \texttt{Add Point Feature} button, which should be nearby the \texttt{Toggle editing} button

10. With the \texttt{Add feature} tool activated, left-click on your best estimate of the location of the University of Cape Town

11. Supply an arbitrary integer when asked for the \texttt{id}

12. Clic pe \texttt{OK}
13. Click the \(\text{Save Layer Edits}\) button
14. Click the \(\text{Toggle editing}\) button to stop your editing session
15. Save the project

### 8.4.24 Find the locations that are closest to the University of Cape Town

1. Go to the \(\text{Processing Toolbox}\), locate the \(\text{Join Attributes by Nearest}\) algorithm (\(\text{Vector general} \rightarrow \text{Join Attributes by Nearest}\)) and execute it
2. \(\text{Input layer}\) should be \(\text{university}\), and \(\text{Input layer 2}\) \(\text{suitable_areas}\)
3. Set an appropriate output location and name (\(\text{Joined layer}\))
4. Set the \(\text{Maximum nearest neighbors}\) to 4
5. Ensure that \(\text{Open output file after running algorithm}\) is checked
6. Leave the rest of the parameters with their default values
7. Click \(\text{Run}\)

The resulting point layer will contain four features - they will all have the location of the university and its attributes, and in addition, the attributes of the nearby suitable areas (including the \(\text{id}\), and the distance to that location.

1. Open the attribute table of the result of the join
2. Note the \(\text{id}\) of the four nearest suitable areas, and then close the attribute table
3. Open the attribute table of the \(\text{suitable_areas}\) layer
4. Build a query to select the four suitable areas closest to the university (selecting them using the \(\text{id}\) field)

Acesta este răspunsul final la întrebarea.

For your submission, create a fully labeled layout that includes the semi-transparent hillshade layer over an appealing raster of your choice (such as the DEM or the slope raster, for example). Also include the university and the \(\text{suitable_areas}\) layer, with the four suitable areas that are closest to the university highlighted. Follow all the best practices for cartography in creating your output map.

---

8.4. Lesson: Exercițiul Suplimentar
Module: Plugin-uri

Plugin-uri vă permit extinderea funcționalității QGIS. În acest modul, vi se arată cum să activeți și să utilizați plugin-uri.

9.1 Lesson: Instalarea și Gestionarea Plugin-urilor

Pentru a începe să utilizați plugin-uri, trebuie să știți cum să le descărcați, să le instalați și să le activeți. Pentru a face acest lucru, veți învăța cum să utilizați Instalatorul de Plugin-uri și Managerul de Plugin-uri.

Scopul acestei lecții: Pentru a întelege și pentru a utiliza sistemul de plugin-uri QGIS.

9.1.1 Follow Along: Gestionarea Plugin-urilor

1. Pentru a deschide Plugin Manager, faceți clic pe elementul de meniu Plugins ➤ Manage and Install Plugins.
2. În fereastra de dialog care apare, identificați plugin-ul Processing:
3. Click in the box next to this plugin and uncheck it to deactivate it.

4. Click Close.

5. Looking at the menu, you will notice that the Processing menu is is now gone. This means that many of the processing functions you have been using before have disappeared! For example look at the Vector► and Raster► menus. This is because they are part of the Processing plugin, which needs to be activated to use them.

6. Open the Plugin Manager again and reactivate the Processing plugin by clicking in the checkbox next to it.

7. Close the dialog. The Processing menu and functions should be available again.

9.1.2 Follow Along: Instalarea Noilor Plugin-uri

The list of plugins that you can activate and deactivate draws from the plugins that you currently have installed. To install new plugins:

1. Select the Not Installed option in the Plugin Manager dialog. The plugins available for you to install will be listed here. This list will vary depending on your existing system setup.
2. Find information about the plugin by selecting it in the list.

3. Install the one(s) you are interested in by clicking the **Install Plugin** button below the plugin information panel.

**Nota:** if the plugin has some error it will be listed in the **Invalid** tab. You can then contact the plugin owner to fix the problem.
9.1.3 Follow Along: Configurarea Depozitelor Adiționale de Plugin-uri

Plugin-urile care sunt disponibile pentru instalare depind de depozitele configurate pentru utilizare.

QGIS plugins are stored online in repositories. By default, only the official repository is active, meaning that you can only access plugins that are published there. Given the diversity of available tools, this repository should meet most of your needs.

Este posibil, totuși, să încercai mai multe plugin-uri decât cele implicite. În primul rând, ați vrea să configurați depozite suplimentare. Pentru a face acest lucru:

1. Open the Settings tab in the Plugin Manager dialog

![Plugin Manager Settings](image)

2. Clic pe butonul Adăugare, pentru a găsi și a adăuga un nou depozit.


5. Puteți selecta, de asemenea, opțiunea de a afișa Plugin-urile Experimentale, prin alegerea Show also experimental plugins.

6. If you now switch back to the Not Installed tab, you will see that additional plugins are available for installation.

7. To install a plugin, click on it in the list and then on the Install plugin button.
9.1.4 In Conclusion

Installing plugins in QGIS should be straightforward and effective!

9.1.5 What’s Next?

Mai departe, vă vom prezenta câteva plugin-uri utile ca exemple.

9.2 Lesson: Plugin-uri QGIS Utile

Acum, că puteți instala, activa și dezactiva plugin-uri, să vedem cum vă poate ajuta în practică acest lucru, privind la câteva exemple de plugin-uri utile.

Scopul acestei lecții: De a vă familiariza cu interfata plugin-urilor și de a face cunoștință cu unele plugin-uri utile.

9.2.1 Follow Along: The QuickMapServices Plugin

The QuickMapServices plugin is a simple and easy to use plugin that adds base maps to your QGIS project. It has many different options and settings, let’s start to explore some of its features.

1. Start a new map and add the roads layer from the training_data Geopackage.
2. Install the QuickMapServices plugin.
3. Open the plugin’s search tab by clicking on Web ► QuickMapServices ► Search QMS. This option of the plugin allows you to filter the available base maps by the current extent of the map canvas.
4. Click on the Filter by extent and you should see one service available.
5. Click on the Add button next to the map to load it.
6. The base map will be loaded and you will have a satellite background for the map.

The QuickMapServices plugin makes a lot of base maps available.

1. Close the Search QMS panel we opened before
2. Click again on Web ► QuickMapServices. The first menu lists different map providers with available maps:
But there is more.

If the default maps are not enough for you, you can add other map providers.

1. Click on Web ► QuickMapServices ► Settings and go to the More services tab.
2. Read carefully the message of this tab and if you agree click on the Get Contributed pack button.

If you now open the Web ► QuickMapServices menu you will see that more providers are available. Choose the one that best fits your needs!

### 9.2.2 Follow Along: The QuickOSM Plugin

With an incredible simple interface, the QuickOSM plugin allows you to download OpenStreetMap data.

1. Start a new empty project and add the roads layer from the training_data GeoPackage.
2. Install the QuickOSM plugin. The plugin adds two new buttons in the QGIS Toolbar and is accessible in the Vector ► QuickOSM menu.
3. Open the QuickOSM dialog. The plugin has many different tabs: we will use the Quick Query one.
4. You can download specific features by selecting a generic Key or be more specific and choose a specific Key and Value pair.

**Sfat:** if you are not familiar with the Key and Value system, click on the Help with key/value button. It will open a web page with a complete description of this concept of OpenStreetMap.

5. Look for railway in the Key menu and let the Value be empty: so we are downloading all the railway features without specifying any values.
6. Select Layer Extent in the next drop-down menu and choose roads.
7. Click on the Run query button.
After some seconds the plugin will download all the features tagged in OpenStreetMap as `railway` and load them directly into the map.

Nothing more! All the layers are loaded in the legend and are shown in the map canvas.

**Atentionare:** QuickOSM creates temporary layer when downloading the data. If you want to save them permanently, click on the ⚱️ icon next to the layer and choose the options you prefer. Alternatively you can open the Advanced menu in QuickOSM and choose where to save the data in the Directory menu.

### 9.2.3 Follow Along: The QuickOSM Query engine

The quickest way to download data from QuickOSM plugin is using the *Quick query* tab and set some small parameters. But if you need some more specific data?

If you are an OpenStreetMap query master you can use QuickOSM plugin also with your personal queries. QuickOSM has an incredible data parser that, together with the amazing query engine of Overpass, lets you download data with your specific needs.

For example: we want to download the mountain peaks that belongs into a specific mountain area known as Dolomites. You cannot achieve this task with the *Quick query* tab, you have to be more specific and write your own query. Let’s try to do this.

1. Start a new project.
2. Open the QuickOSM plugin and click on the *Query* tab.
3. Copy and paste the following code into the query canvas:
This shows all mountains (peaks) in the Dolomites. You may want to use the "zoom onto data" button. =>

```xml
<osm-script output="json">
  <!-- search the area of the Dolomites -->
  <query type="area">
    <has-kv k="place" v="region"/>
    <has-kv k="region:type" v="mountain_area"/>
    <has-kv k="name:en" v="Dolomites"/>
  </query>
  <print mode="body" order="quadtile"/>
  <!-- get all peaks in the area -->
  <query type="node">
    <area-query/>
    <has-kv k="natural" v="peak"/>
  </query>
  <print mode="body" order="quadtile"/>
  <!-- additionally, show the outline of the area -->
  <query type="relation">
    <has-kv k="place" v="region"/>
    <has-kv k="region:type" v="mountain_area"/>
    <has-kv k="name:en" v="Dolomites"/>
  </query>
  <print mode="body" order="quadtile"/>
  <recurse type="down"/>
  <print mode="skeleton" order="quadtile"/>
</osm-script>
```

**Nota:** This query is written in a xml like language. If you are more used to the Overpass QL you can write the query in this language.

4. And click on **Run Query**:

The mountain peaks layer will be downloaded and shown in QGIS:
You can write complex queries using the Overpass Query language. Take a look at some example and try to explore the query language.

### 9.2.4 Follow Along: The DataPlotly Plugin

The DataPlotly plugin allows you to create D3 plots of vector attributes data thanks to the plotly library.

1. Start a new project
2. Load the sample_points layer from the exercise_data/plugins folder
3. Install the plugin following the guidelines described in Follow Along: Instalarea Noilor Plugin-urii searching Data Plotly
4. Open the plugin by clicking on the new icon in the toolbar or in the Plugins ➤ Data Plotly menu

In the following example we are creating a simple Scatter Plot of two fields of the sample_points layer. In the DataPlotly Panel:

1. Choose sample_points in the Layer filter, cl for the X Field and mg for the Y Field:
2. If you want you can change the colors, the marker type, the transparency and many other settings: try to change some parameters to create the plot below.
3. Once you have set all the parameters, click on the Create Plot button to create the plot.

The plot is interactive: this means you can use all the upper buttons to resize, move, or zoom in/out the plot canvas. Moreover, each element of the plot is interactive: by clicking or selecting one or more point on the plot, the corresponding point(s) will be selected in the plot canvas.

You can save the plot as a png static image or as an html file by clicking on the or on the button in the lower right corner of the plot.

There is more. Sometimes it can be useful to have two (or more) plots showing different plot types with different variables on the same page. Let’s do this!
1. Go back to the main plot settings tab by clicking on the button in the upper left corner of the plugin panel

2. Change the Plot Type to Box Plot

3. Choose group as Grouping Field and ph as Y Field

4. In the lower part of the panel, change the Type of Plot from SinglePlot to SubPlots and let the default option Plot in Rows selected.

5. Once done click on the Create Plot button to draw the plot
Now both scatter plot and box plot are shown in the same plot page. You still have the chance to click on each plot item and select the corresponding features in the map canvas.

**Sfat:** Each plot has its own manual page available in the tab. Try to explore all the plot types and see all the other settings available.
9.2.5 In Conclusion

Sunt disponibile multe plugin-uri utile pentru QGIS. Folosind instrumentele incorporate, pentru instalarea și gestionarea acestor plugin-uri, puteți găsi noi plugin-uri și să efectuați o utilizare optimă a acestora.

9.2.6 What’s Next?

Apoi, vom analiza modul de utilizare al straturilor care sunt găzduite pe servere aflate la distanță, în timp real.
Atunci când se analizează sursele de date pentru o hartă, nu este necesar să vă limitați la datele pe care le-ați salvat pe computerul la care lucrați. Există surse de date online, pe care le puteți încărca atât timp cât sunteți conectat la Internet.

În acest modul, vom acoperi cele două tipuri de servicii GIS bazate pe web: Serviciul Web Mapping (WMS) și Serviciul Web Feature (WFS).

10.1 Lesson: Serviciile Web Mapping

Un Serviciu de Cartografiere Web (WMS) este un serviciu găzduit pe un server aflat la distantă. Similar unui site web, îl puteți accesa, atât timp cât aveți o conexiune la server. Cu ajutorul QGIS, puteți încărca un WMS direct în harta existentă.

Din lecția despre plugin-uri, ne amintim că este posibilă încărcarea unei noi imagini raster, spre exemplu, de la Google. Totuși, aceasta este o tranzacție once-off: o dată ce ați descărcat imaginea, aceasta nu se mai schimbă. Un WMS este diferit prin faptul că este un serviciu live, care se va actualiza automat, la deplasarea sau mărirea hărții.

Scopul acestei lecții: De a folosi un WMS și de a-i înțelege limitările.

10.1.1 Follow Along: Încărcarea unui strat WMS

For this exercise, you can either use the basic map you made at the start of the course, or just start a new map and load some existing layers into it. For this example, we used a new map and loaded the original places, landuse and protected_areas layers and adjusted the symbology:
1. Încărcați aceste straturi într-o nouă harta, sau folosiți harta originală doar cu aceste straturi vizibile.

2. Before starting to add the WMS layer, deactivate „on the fly” projection (Project ➤ Properties… ➤ CRS tab, check No CRS (or unknown/non-Earth projection). This may cause the layers to no longer overlap properly, but don’t worry: we’ll fix that later.

3. To add WMS layers, click on the button to open the Data Source Manager dialog and enable the WMS/WMTS tab.
Remember how you connected to a SpatiaLite or GeoPackage database at the beginning of the course. The `landuse`, `buildings`, and `roads` layers are stored in a database. To use those layers, you first needed to connect to the database. Using a WMS is similar, with the exception that the layers are on a remote server.

4. Pentru a crea o nouă conexiune la un WMS, faceți clic pe butonul `New`.

   You’ll need a WMS address to continue. There are several free WMS servers available on the Internet. One of these is terrestris, which makes use of the OpenStreetMap dataset.

5. Pentru a face uz de acest WMS, setați-l în dialogul curent, astfel:
• The value of the \textit{Name} field should be \textit{terrestris}.

• The value of the \textit{URL} field should be \url{https://ows.terrestris.de/osm/service}.

6. Faceți clic pe \textit{Ok}. Ar trebui să vedeti listat noul server WMS:
7. Faceți clic pe Conectare. În lista de mai jos, ar trebui să vedeti încărcate acum, aceste noi intrări:

Acestea sunt toate straturile găzduite de acest server WMS.

8. Faceți clic o dată pe stratul OSM-WMS. Se va afișa Sistemul său de Coordonate de Referință:
Since we're not using WGS 84 for our map, let's see all the CRSs we have to choose from.

1. Click the Change… button. You will see a standard Coordinate Reference System Selector dialog.
2. Dorim un CRS protectat, așa că haideți să alegem WGS 84 / Pseudo Mercator.
   1. Enter the value pseudo in the Filter field:
   2. Choose WGS 84 / Pseudo Mercator (with epsg:3857) from the list.
3. Click OK. The Coordinate Reference System associated with the entry has changed.

9. Click Add and the new layer will appear in your map as OpenStreetMap WMS - by terrestris.

10. Close the Data Source Manager dialog if not done automatically.

11. In the Layers panel, click and drag it to the bottom of the list.

12. Zoom out in order to get a global view of the layers. You will notice that your layers aren’t located correctly (near west of Africa). This is because „on the fly” projection is disabled.
13. Let's enable the reprojection again, but using the same projection as the OpenStreetMap WMS layer, which is WGS 84 / Pseudo Mercator.

1. Open the Project ➤ Properties… ➤ CRS tab
2. Uncheck No CRS (or unknown/non-Earth projection)
3. Alegeti WGS 84 / Pseudo Mercator din listă.
4. Click OK

14. Now right-click on one of your own layers in the Layers panel and click **Zoom to layer extent**. You should see the Swellendam area:
By now you may have noticed that this WMS layer actually has many features in it. It has streets, rivers, nature reserves, and so on. What’s more, even though it looks like it’s made up of vectors, it seems to be a raster, but you can’t change its symbology. Why is that?

This is how a WMS works: it’s a map, similar to a normal map on paper, that you receive as an image. What usually happens is that you have vector layers, which QGIS renders as a map. But using a WMS, those vector layers are on the WMS server, which renders it as a map and sends that map to you as an image. QGIS can display this image, but can’t change its symbology, because all that is handled on the server.

This has several advantages, because you don’t need to worry about the symbology. It’s already worked out, and should be nice to look at on any competently designed WMS.

On the other hand, you can’t change the symbology if you don’t like it, and if things change on the WMS server, then they’ll change on your map as well. This is why you sometimes want to use a Web Feature Service (WFS) instead, which gives you vector layers separately, and not as part of a WMS-style map.

10.1.2 Try Yourself

1. Hide the OSM-WSM layer in the Layers panel.

2. Add the „ZAF CGS 1M Bedrock Lithostratigraphy” WMS server at this URL: http://196.33.85.22/cgi-bin/ZAF_CGS_Bedrock_Geology/wms

3. Load the BEDROCKGEOLOGY layer into the map (you can also use the Layer ► Add Layer ► Add WMS/WMTS Layer… button to open the Data Source Manager dialog). Remember to check that it’s in the same WGS 84 / World Mercator projection as the rest of your map!

4. You might want to set its Encoding to JPEG and its Tile size option to 200 by 200, so that it loads faster:
Check your results

10.1.3  Try Yourself

1. Hide all other WMS layers to prevent them from rendering unnecessarily in the background.
2. Add the „OGC“ WMS server at this URL: http://ogc.gbif.org:80/wms
3. Adăugați stratul bluemarine.

Check your results

10.1.4  Try Yourself

O parte din dificultatea de a folosi WMS, este de a găsi un server bun (și gratuit).

• Find a new WMS at directory.spatineo.com (or elsewhere online). It must not have associated fees or restrictions, and must have coverage over the Swellendam study area.

Amintiți-vă că pentru un WMS aveți nevoie doar de URL-ul său (și, de preferință, un fel de descriere).

Check your results

10.1.5  In Conclusion

Folosind un WMS, puteți adăuga hărți inactive ca fundaluri pentru datele hărților existente.

10.1.6  Further Reading

• Spatineo Directory
• OpenStreetMap.org list of WMS servers

10.1.7  What’s Next?

Now that you’ve added an inactive map as a backdrop, you’ll be glad to know that it’s also possible to add features (such as the other vector layers you added before). Adding features from remote servers is possible by using a Web Feature Service (WFS). That’s the topic of the next lesson.

10.2  Lesson: Serviciile Web Feature

Un Serviciu Web Feature (WFS) pune la dispoziție utilizatorilor date GIS în formate care pot fi încărcate direct în QGIS. Spre deosebire de un WMS, care oferă doar o hartă pe care nu o puteți edita, un WFS oferă acces direct la entități.

Scopul acestei lecții: De a folosi un WFS și de a-i înțelege cum diferă de un WMS.
10.2.1  Follow Along: Încărcarea unui Strat WFS

1. Începeți o nouă hârtă. Aceasta are scop demonstrativ și nu va fi salvată.

2. Click the Open Data Source Manager button.

3. Enable the WFS / OGC API - Features tab.


5. În caseta de dialog care apare, introduceti nsidc.org la Name și https://nsidc.org/cgi-bin/atlas_south?version=1.1.0 la URL.

6. Clic OK, apoi noua conexiune va apărea în Conexiunile serverului.

7. Clic pe Connect. Va apărea o listă a straturilor disponibile:
8. Uncheck the Only request features overlapping the view extent option below the layers list, since your current map canvas may not cover our area of interest: Antarctica.

9. Find the layer antarctica_country_border. You can use the Filter box at the top.

10. Facet clic pe strat pentru a-1 selecta.

11. Find and select also the layer south_poles_wfs. You might need to hold Ctrl.

12. Clic pe Add.
It may take a while to load the layers. When they are loaded, they will appear in the map, showing the outlines of Antarctica and a few points over.

How is this different from having a WMS layer?

13. Select any of the layers and you’ll notice that feature selection and attribute table tools are enabled. These are vector layers.

14. Select the `south_poles_wfs` layer and open its attribute table. You should see this:

De vreme ce punctele au atribut, putem să le punem etichete și să le schimbăm simbolistica. Iată un exemplu:
Diferențe între straturile WMS

Un Serviciu Web Feature întoarce stratul în sus, nu doar o hârtă redată pentru acesta. Asta vă dă acces direct la date, însemnând că puteți să schimbați simbologia și puteți rula funcții analitice. Cu toate acestea, costul este transmiserea unui volum mai mare de date. Asta va fi evident dacă straturile pe care le încărcați au forme complexe, multe atribută sau multe entități; sau chiar dacă doar încărcați multe straturi. Din această cauză straturile WFS au nevoie de regulă de mult timp pentru a se încărca.

10.2.2 Follow Along: Interogarea unui Strat WFS

Deși este posibil să interogați un strat WFS după încărcare, este de regulă mai eficient să îl interogați înainte de a-l încărca. În felul acesta cereți doar entitățile pe care le doriți, ceea ce înseamnă că utilizați o bandă mai mică.

De exemplu, pe serverul WFS pe care îl utilizăm în acest moment, există un strat numit countries (excluding Antarctica). Să spune că dorim să știm unde se află Africa de Sud față de stratul south_poles_wfs (și poate și față de antarctica_country_border layer) care a fost deja încărcat.

Există două metode. Puteți încărca tot stratul countries ..., după care să construiți o interogare ca în mod normal după ce acesta s-a încărcat. Dar, transmitând datele pentru toate țările lumii și utilizând pe urmă doar datele pentru Africa de Sud pare a fi o irosire a lățimii de bandă. În funcție de conexiune, acest set de date poate necesita mai multe minute pentru a se încărca.

Alternativa este de a construi o interogare ca pe un filtru, chiar înainte de încărcarea stratului de pe server.

1. Enable the WFS / OGC API Features tab in the Data Source Manager dialog
2. Connect to the server we used before and you should see the list of available layers.
3. Find and double-click the countries (excluding Antarctica) layer. The layer name is countryBordersExcludingAntarctica. You can also select the layer and press Build query button at the bottom of the dialog:
4. In the dialog that appears, type the following SQL query in the SQL Statement box:

```sql
SELECT * FROM country_borders_excluding_antarctica WHERE "Countryeng" = 'South Africa'
```

5. Press OK.

6. The expression used will appear as the SQL value of the target layer:
7. Click *Add* with the layer selected as above. Only the country with the *CountryEng* value of South Africa will load from that layer:

Did you notice the icon next to the *country_borders_excluding_antarctica* layer? It indicates that the loaded layer is filtered and does not display in the project all of its features.

8. Dacă ați încercat ambele metode, veți observa că această variantă este mult mai rapidă decât încărcarea tuturor țărilor înmantea filtrării!
Note cu privire la disponibilitatea WFS

Este o raritate să găsiți un WFS care să pună la dispoziție caracteristicile dorite dacă acestea sunt foarte specifice. Motivul pentru care cele mai multe servicii Web Feature sunt relativ rare este pentru că necesită transmiterea unui volum mare de date pentru a descrie complet o entitate. În concluzie nu este foarte rentabilă găzduirea unui WFS în comparație cu un WMS, care trimite doar imagini.

Cel mai comun tip de WFS pe care îl veți întâlni va fi deci probabil într-o rețea local sau chiar pe propriul calculator, mai degrabă decât în Internet.

10.2.3 In Conclusion

Straturile WFS sunt de preferat față de straturile WMS dacă aveți nevoie de acces direct la atributele și geometriile acestora. Cu toate acestea, ținând cont de volumul de date care trebuie descărcat (ceea ce duce la probleme de viteză și de asemenea la lipsa de servere WFS disponibile publicului larg) nu este întotdeauna posibil să folosiți un WFS în loc de un WMS.

10.2.4 What’s Next?

În continuare, vom vedea cum se utilizează QGIS Server pentru a furniza servicii OGC.
Acest modul a fost publicat de Tudor Bărăscu.
În acest capitol vom examina modul de instalare și utilizare a serverului QGIS.
To learn more about QGIS Server, read the QGIS-Server-manual.

11.1 Lesson: Instalarea Serverului QGIS

The goal for this lesson: To learn how to install QGIS Server on Debian Stretch. With negligible variations you can also follow it for any Debian based distribution like Ubuntu and its derivatives.

Notă: In Ubuntu you can use your regular user, prepending sudo to commands requiring admin permissions. In Debian you can work as admin (root), without using sudo.

11.1.1 Follow Along: Instalarea pachetelor

In this lesson we’re going to do only the install from packages as shown here.
Instalați Serverul QGIS cu:

```
apt install qgis-server --no-install-recommends --no-install-suggests
# if you want to install server plugins, also:
apt install python-qgis
```

QGIS Server should be used in production without QGIS Desktop (with the accompanying X Server) installed on the same machine.
11.1.2 Follow Along: Executabilul Serverului QGIS

The QGIS Server executable is `qgis_mapserv.fcgi`. You can check where it has been installed by running `find / -name 'qgis_mapserv.fcgi'` which should output something like `/usr/lib/cgi-bin/qgis_mapserv.fcgi`.

Optionally, if you want to do a command line test at this time you can run the `/usr/lib/cgi-bin/qgis_mapserv.fcgi` command which should output something like:

```
QFSFileEngine::open: No file name specified
Warning 1: Unable to find driver ECW to unload from GDAL_SKIP environment variable.
Warning 1: Unable to find driver ECW to unload from GDAL_SKIP environment variable.
Warning 1: Unable to find driver JP2ECW to unload from GDAL_SKIP environment variable.
Warning 1: Unable to find driver JP2ECW to unload from GDAL_SKIP environment variable.
Content-Length: 206
Content-Type: text/xml; charset=utf-8
<ServiceExceptionReport version="1.3.0" xmlns="https://www.opengis.net/ogc">
  <ServiceException code="Service configuration error">Service unknown or unsupported</ServiceException>
</ServiceExceptionReport>
```

This is a good thing, it tells you we’re on the right track as the server is saying that we haven’t asked for a supported service. We’ll see later on how to make WMS requests.

11.1.3 HTTP Server Configuration

In order to access on the installed QGIS server from an Internet Browser we need to use an HTTP server. The Apache HTTP Server installation process is detailed in httpserver section.

**Notă:** If you installed QGIS Server without running an X Server (included in Linux Desktop) and if you also want to use the `GetPrint` command then you should install a fake X Server and tell QGIS Server to use it. You can do that by following the Xvfb installation process.

11.1.4 |basic| Follow Along: Crearea unei gazde virtuale

Let’s create another Apache virtual host pointing to QGIS Server. You can choose whatever name you like (`coco`, `bango`, `super.duper.training.example.com`, etc.) but for simplicity sake we’re going to use `myhost`.

- Let’s set up the `myhost` name to point to the localhost IP by adding `127.0.0.1` x to the `/etc/hosts` with the following command: `sh -c "echo '127.0.0.1 myhost' >> /etc/hosts"` or by manually editing the file with `gedit /etc/hosts`.

- We can check that `myhost` points to the localhost by running in the terminal the `ping myhost` command which should output:

```
qgis@qgis:~$ ping myhost
PING myhost (127.0.0.1) 56(84) bytes of data.
64 bytes from localhost (127.0.0.1): icmp_seq=1 ttl=64 time=0.024 ms
64 bytes from localhost (127.0.0.1): icmp_seq=2 ttl=64 time=0.029 ms
```
Let's try if we can access QGIS Server from the myhost site by doing: curl http://myhost/cgi-bin/qgis_mapserv.fcgi or by accessing the url from your Debian box browser. You will probably get:

```html
<!DOCTYPE HTML PUBLIC "-//IETF//DTD HTML 2.0//EN">
<html><head>
<title>404 Not Found</title>
</head><body>
<h1>Not Found</h1>
<p>The requested URL /cgi-bin/qgis_mapserv.fcgi was not found on this server.</p>
</body></html>
```

Apache doesn’t know that he’s supposed to answer requests pointing to the server named myhost. In order to setup the virtual host the simplest way would be to make a myhost.conf file in the /etc/apache2/sites-available directory that has the same content as qgis.demo.conf except for the ServerName line that should be ServerName myhost. You could also change where the logs go as otherwise the logs for the two virtual hosts would be shared but this is optional.

Let's now enable the virtual host with a2ensite myhost.conf and then reload the Apache service with service apache2 reload.

If you try again to access the http://myhost/cgi-bin/qgis_mapserv.fcgi url you’ll notice everything is working now!

### 11.1.5 In Conclusion

You learned how to install different QGIS Server versions from packages, how to configure Apache with QGIS Server, on Debian based Linux distros.

### 11.1.6 What’s Next?

Now that you’ve installed QGIS Server and it’s accessible through the HTTP protocol, we need to learn how to access some of the services it can offer. The topic of the next lesson is to learn how to access QGIS Server WMS services.

### 11.2 Lesson: Serving WMS

The data used for this exercise are available in the qgis-server-tutorial-data subdirectory of the training data you downloaded. For convenience and to avoid possible permissions problems, we will assume that these files are stored in /home/qgis/projects directory. Hence, adapt the following instructions to your path.

Datele demo contin un proiect QGIS denumit world.qgs, care este pregătit deja pentru a fi expus de către serverul QGIS. Dacă doriti să utilizați propriul proiect sau să aflați cum se poate pregăti un proiect, consultați secțiunea Creatingwmsfromproject.

**Notă:** Acest modul prezintă adresele URL, astfel încât audiența să poată distinge cu ușurință parametri și valorile acestora. În timp ce formatul normal este:

```text
...&field1=value1&field2=value2&field3=value3
```

acest tutorial folosește:

```text
$field1=value1
$field2=value2
$field3=value3
```
Pasting them into Mozilla Firefox works properly but other web browsers like Chrome may add unwanted spaces between the field:parameter pairs. So, if you encounter this issue you can either use Firefox or modify the URLs so that they're in one line format.

Let’s make a WMS GetCapabilities request in the web browser or with curl:

```
http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetCapabilities
&map=/home/qgis/projects/world.qgs
```

In the Apache config from the previous lesson the QGIS_PROJECT_FILE variable sets the default project to /home/qgis/projects/world.qgs. However, in the above request we made use of the map parameter to be explicit and to show it can be used to point at any project. If you delete the map parameter from the above request QGIS Server will output the same response.

By pointing any WMS client to the GetCapabilities URL, the client gets in response an XML document with metadata of the Web Map Server’s information, e.g. what layers does it serve, the geographical coverage, in what format, what version of WMS etc.

As QGIS is also a ogc-wms you can create a new WMS server connection with the help of the above GetCapabilities url. See the Lesson: Serviciile Web Mapping or the ogc-wms-servers section on how to do it.

By adding the countries WMS layer to your QGIS project you should get an image like the one below:
QGIS Training Manual

Notă: QGIS Server serves layers that are defined in the world.qgs project. By opening the project with QGIS you can see there are multiple styles for the countries layer. QGIS Server is also aware of this and you can choose the style you want in your request. The classified_by_population style was chosen in the above image.

11.2.1 Jurnalizarea

When you’re setting up a server, the logs are always important as they show you what’s going on. We have setup in the *.conf file the following logs:

- QGIS Server log at /logs/qgisserver.log
- qgisplatform.demo Apache access log at qgisplatform.demo.access.log
- qgisplatform.demo Apache error log at qgisplatform.demo.error.log

The log files are simply text files so you can use a text editor to check them out. You can also use the tail command in a terminal: sudo tail -f /logs/qgisserver.log.
This will continuously output in the terminal what’s written in that log file. You can also have three terminals opened for each of the log files like so:

Fig. 11.2: Using the `tail` command to visualise QGIS Server logs output

When you use QGIS Desktop to consume the QGIS Server WMS services you will see all the requests QGIS sends to the Server in the access log, the errors of QGIS Server in the QGIS Server log etc.

**Nota:**

- If you look at the logs in the following sections you should get a better understanding on what’s happening.
- By restarting Apache while looking in the QGIS Server log you can find some extra pointers on how things work.
11.2.2 GetMap requests

In order to display the countries layer, QGIS Desktop, like any other WMS client, is using GetMap requests.

A simple request looks like:

```
http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?MAP=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&BBOX=-432786,4372992,3358959,7513746
&SRS=EPSG:3857
&WIDTH=665
&HEIGHT=551
&LAYERS=countries
&FORMAT=image/jpeg
```

The above request should output the following image:

**Figure: simple GetMap request to QGIS Server**

![Simple GetMap request to QGIS Server](image)

Fig. 11.3: Qgis Server response after a simple GetMap request
11.2.3 Try Yourself Change the Image and Layers parameters

Based on the request above, let's replace the countries layer with another.

In order to see what other layers are available you could open up the world.qgs project in QGIS and look at its contents. Keep in mind though that the WMS clients don’t have access to the QGIS project, they just look at the capabilities document contents.

Also, there’s a configuration option so that some of the layers existing in the QGIS project are ignored by QGIS when serving the WMS service.

So, you could look at the layer list when you point QGIS Desktop to the GetCapabilities URL or you could try yourself finding other layer names in the GetCapabilities XML response.

One of the layer names that you could find and works is countries_shapeburst. You may find others but keep in mind some may not be visible at such a small scale so you could get a blank image as response.

You can also play around with others parameters from above, like changing the returned image type to image/png.

11.2.4 Follow Along: Use Filter, Opacities and Styles parameters

Let's do another request that adds another layer, some of the extra-getmap-parameters, FILTER and OPACITIES, but also uses the standard STYLES parameter.

```
http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?MAP=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&BBOX=-432786,4372992,3358959,7513746
&SRS=EPSG:3857
&WIDTH=665
&HEIGHT=551
&FORMAT=image/jpeg
&LAYERS=countries,countries_shapeburst
&STYLES=classified_by_name,blue
&OPACITIES=255,30
&FILTER=countries: "name" IN ( 'Germany', 'Italy' )
```

The above request should output the following image:
As you can see from the above image, among other things, we told QGIS Server to render only Germany and Italy from the countries layer.

11.2.5 Follow Along: Use Redlining

Let's do another GetMap request that makes use of the qgisserver-redlining feature and of the SELECTION parameter detailed in the extra-getmap-parameters section:

```
http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?MAP=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&BBOX=-432786,4372992,3358959,7513746
&SRS=EPSG:3857
&WIDTH=665
&HEIGHT=551
&LAYERS=countries,countries_shapeburst
&FORMAT=image/jpeg
&HIGHLIGHT_GEOM=POLYGON((590000 6900000, 590000 7363000, 2500000 7363000, 2500000 -6900000, 590000 6900000))
&HIGHLIGHT_SYMBOL=<StyledLayerDescriptor><UserStyle><Name>Highlight</Name>
<FeatureTypeStyle><Rule><Name>Symbol</Name><LineSymbolizer><Stroke><SvgParameter name="stroke">%233a093a</SvgParameter><SvgParameter name="stroke-opacity">1</SvgParameter><SvgParameter name="stroke-width">1.6</SvgParameter></Stroke></LineSymbolizer></Rule></FeatureTypeStyle></UserStyle></StyledLayerDescriptor>
```
Pasting the above request in your web browser should output the following image:

![Map showing highlighted countries](image)

**Fig. 11.5:** Response to a request with the REDLINING feature and SELECTION parameter

You can see from the above image that the countries with the 171 and 65 ids were highlighted in yellow (Romania and France) by using the **SELECTION** parameter and we used the **REDLINING** feature to overlay a rectangle with the **QGIS Tutorial** label.
11.2.6 GetPrint requests

One very nice feature of QGIS Server is that it makes use of the QGIS Desktop print layouts. You can learn about it in the server_wms_getprint section.

If you open the world.qgs project with QGIS Desktop you will find a print layout named Population distribution. A simplified GetPrint request that exemplifies this amazing feature is:

```
http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?map=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.06
&REQUEST=GetPrint
&FORMAT=pdf
&TRANSPARENT=true
&SRS=EPSG:3857
&DPI=300
&TEMPLATE=Population distribution
&map0:extent=-432786,4372992,3358959,7513746
&LAYERS=countries
```

Fig. 11.6: Shows the pdf resulted from the above GetPrint request

Naturally, it’s hard to write your GetMap, GetPrint etc. requests.

QGIS Web Client or QWC is a Web client project that can work alongside QGIS Server so that you can publish your projects on the Web or help you create QGIS Server requests for a better understanding about the possibilities.

O puteți instala în felul următor:

- As user qgis go to the home directory with `cd /home/qgis`.
- Download the QWC project from here and unzip it.
- Make a symbolic link to the `/var/www/html` directory as it’s the DocumentRoot that we’ve setup in the virtual host configuration. If you unzipped the archive under `/home/qgis/Downloads/QGIS-Web-Client-master` we can do that with `sudo ln -s /home/qgis/Downloads/QGIS-Web-Client-master /var/www/html/`.

Now you should be able to see the Map as in the following figure:
If you click the Print button in QWC you can interactively create GetPrint requests. You can also click the ? icon in the QWC to access the available help so that you can better discover the QWC possibilities.

### 11.2.7 In Conclusion

You learned how use QGIS Server to provide WMS Services.

### 11.2.8 What’s Next?

În continuare, vom vedea cum se utilizează QGIS ca interfață pentru faimosul GIS GRASS.
GRASS (Sistem de Suport pentru Analiza Resurselor Geografice) este un GIS bine-cunoscut, cu sursă deschisă, și cu o gamă largă de funcții utile. Acesta a fost lansat în 1984, și a cunoscut multe îmbunătățiri și funcționalități suplimentare de atunci. QGIS vă permite să faceți uz direct de puternicile instrumente GIS din GRASS.

12.1 Lesson: Instalarea GRASS

Using GRASS in QGIS requires you to think of the interface in a slightly different way. Remember that you're not working in QGIS directly, but working in GRASS via QGIS. Hence, make sure you have installed QGIS Desktop with Grass support.

To open a QGIS session with GRASS available on Windows you have to click on the QGIS Desktop with GRASS icon.

Scopul acestei lecții: Pentru a începe un proiect GRASS în QGIS.

12.1.1 Follow Along: Start a New GRASS Session

To launch GRASS from within QGIS, you need to activate it as with any other plugin:

1. First, open a new QGIS project.
2. În Managerul de plugin-uri, activați GRASS din listă:
QGIS Training Manual

Chapter 12. Module: GRASS

The GRASS toolbar and the GRASS panel will appear:

Fig. 12.1: GRASS toolbar
The GRASS panel is not active because, before you can use GRASS, you need to create a Mapset. GRASS always works in a database environment, which means that you need to import all the data you want to use into a GRASS database.

The GRASS database has a straightforward structure, even if at a first look it seems very complicated. The most important thing you should know is that the upper level of the database is the Location. Each Location can contain different Mapset: in every Mapset you will find the PERMANENT Mapset because it is created by default by GRASS. Each Mapset contains the data (raster, vector, etc) in a particular structure, but don’t worry, GRASS will take care of this for you.

Just remember: Location contains Mapset that contains the data. For more information visit the GRASS website.
12.1.2 Follow Along: Începerea unui Nou Proiect GRASS

1. Click on the Plugins → GRASS → New Mapset menu:

You’ll be asked to choose the location of the GRASS database.

2. Setăți-l ca director care va fi utilizat de către GRASS pentru instalarea bazei de date:
3. Clic pe Next.

GRASS needs to create a Location, which describes the maximum extent of the geographic area you’ll be working in, also known as Grass Region.

**Nota:** the Region is extremely important for GRASS because it describes the area in which all layers will be taken.
into account for GRASS. Everything that is outside will not be considered. Don’t worry, you can always change the extent of the GRASS Region after the Location has been created.

1. Call the new location **SouthAfrica**:

![New Mapset](image)

2. Click **Next**.

3. We’ll be working with **WGS 84**, so search for and select this CRS:
4. Clic pe Next.

5. Acum selectați regiunea *Africii de Sud* din caseta cu derulare verticală și faceti clic pe *Set*.
6. Clic pe Next.

7. Creați un set de hărți, care este fișierul hărții cu care veți lucra.
Once you're done, you'll see a dialog asking with a summary of all the information entered.
8. Click Finish.

9. Click OK, in the dialog box to complete successfully.

You will see that the GRASS Panel will become active and you can start using all the GRASS tools.
12.1.3 Follow Along: Încărcarea Datelor Vectoriale în GRASS

You have now a blank map and before you can start to use all the GRASS tools you have to load data into the GRASS database, specifically into the Mapset. You cannot use GRASS tools with layer that are not loaded into a GRASS Mapset.

There are many different ways to load data in the GRASS database. Let’s start with the first one.

Follow Along: Load data using the QGIS Browser

In section Panoul Navigatorului we saw that the easiest and quickest way to load the data in QGIS is the Browser Panel.

GRASS data are recognized from the QGIS Browser as real GRASS data and you can notice it because you will see the GRASS icon next to the GRASS Mapset. Moreover you will see the icon next to the Mapset that is opened.

Notă: You will see a replication of the GRASS Location as normal folder: GRASS Mapset data are those within the folder.

You can easily drag and drop layers from a folder to the GRASS Mapset.

Let’s try to import the roads layer into the grass_mapset Mapset of the SouthAfrica Location.

Go to the Browser, and simply drag the roads layer from the training_data.gpkg GeoPackage file into the grass_mapset Mapset.
That’s it! If you expand the Mapset you will see the imported roads layer. You can now load in QGIS the imported layer like all the other layers.

Sfat: You can also load layers from the Layer Legend Panel to Mapset in the Browser Panel. This will speed up
incredibly your workflow!

Follow Along: Load data using the GRASS Panel

We will use now the *long* method to load the *rivers.shp* layer into the same Mapset.

1. Load data into QGIS as usual. Use the *rivers.shp* dataset (found in the *exercise_data/shapefile* folder)

2. As soon as it is loaded, click on the *Filter* box of the GRASS Panel and find the vector import tool by entering the term *v.in.ogr.qgis*:

```
Attentionare: There are 2 similar tools: v.in.ogr.qgis and v.in.ogr.qgis.loc. We are looking for the first one.
```

![GRASS Tools: SouthAfrica/grass_mapset](image)

The *v* stands for *vector*, *in* means a function to import data into the GRASS database, *ogr* is the software library used to read vector data, and *qgis* means that the tool will look for a vector from among the vectors already loaded into QGIS.

3. Once you’ve found this tool, click on it to bring up the tool itself. Choose the *rivers* layer in the *Loaded Layer* box and type and name it *g_rivers* to prevent confusion:
**Notă:** Remarcăți opțiunile suplimentare specificate la *Advanced Options*. Acestea includ facilitatea de a adăuga o clauză WHERE pentru interogarea SQL folosită la importul datelor.

4. Facet clic pe *Run* pentru a începe importul.
5. După finalizare, dată clic pe butonul *View output* pentru a vedea noul strat GRASS importat în hartă.
6. Închideți primul instrument de import (dată clic pe butonul *Close* imediat în dreapta de *View output*), după care închideți fereastra *GRASS Tools*.
7. Remove the original *rivers* layer.

Acum ați rămas doar cu stratul GRASS importat, așa cum este afişat în harta dvs. din QGIS.
12.1.4 Follow Along: Încărcarea Datelor Raster în GRASS

You can import a raster layer in the same ways we imported vector layers.

We are going to import in the GRASS Mapset the layer `srtm_41_19_4326.tif`.

**Notă:** the raster layer is already in the correct CRS, WGS 84. If you have layers in different CRS you must reproject them in the same CRS of the GRASS Mapset.

1. Load the `srtm_41_19_4326.tif` layer in QGIS.
2. Deschideți iarăși dialogul `Instrumentelor GRASS`.
3. Clic pe fila `Modules List`.
4. Search for `r.in.gdal.qgis` and double click the tool to open the tool's dialog.
5. Set it up so that the input layer is `srtm_41_19_4326.tif` and the output is `g_dem`. 
6. Clic pe Run
7. Când procesul s-a încheiat, faceți clic pe Vizualizare rezultat.
8. Închideți fila curentă, apoi închideți întregul dialog.
9. You may now remove the original srtm_41_19_4326.tif layer.

12.1.5 Try Yourself Add Layers to Mapset

Try to import in the GRASS Mapset the vector layers water.shp and places.shp from the exercise_data/shapefile/ folder. As we did for rivers rename the imported layer as g_water and g_places to avoid confusion.

Verificati-vă rezultatele

12.1.6 Open an existing GRASS Mapset

If you have an existing GRASS Mapset you can easily reopen it in another session of QGIS. You have several method to open a GRASS Mapset, let's explore some of them.

Let's close the Mapset by clicking on the Close Mapset button of the GRASS Tools window.

Follow Along: Using the GRASS plugin

1. Click on the Plugins -> GRASS -> Open Mapset menu next to the Plugins -> GRASS -> New Mapset menu that we saw in the previous section.

2. Browse to the GRASS database folder: be careful! You must choose the parent folder, not the GRASS Mapset one. Indeed GRASS will read all the Locations of the database and all the Mapsets of each Location.
3. Choose the Location SouthAfrica and the Mapset grass_mapset that we have created before. That's it! The GRASS Panel will become active meaning that the Mapset has been correctly opened.

Follow Along: Using the QGIS Browser

Even faster and easier is opening a Mapset using the QGIS Browser:

1. Close the Mapset (if it is open) by clicking on the Close Mapset button of the GRASS Tools window.
2. In the QGIS Browser, browse to the folder of the GRASS database.
3. Right click on the Mapset (remember, the Mapset has the GRASS icon next to it). You will see some options.
4. Click on Open mapset:
The Mapset is now open and ready to use!

**Sfar:** Right click on a GRASS Mapset offers you a lot of different settings. Try to explore them and see all the useful options.
12.1.7 In Conclusion

Fluxul de lucru GRASS pentru asimilarea datelor este ușor diferit de metoda QGIS pentru că GRASS încarcă datele într-o structură de bază de date spațială. Cu toate acestea, utilizând QGIS ca interfata, puteți ușura setarea unui mapset GRASS prin utilizarea straturilor existente QGIS ca surse de date pentru GRASS.

12.1.8 What’s Next?

Acum, o dată ce datele sunt importate în GRASS, ne putem uita la operațiunile avansate de analiză pe care le oferă GRASS.

12.2 Lesson: Instrumentele GRASS

În această lecție vom prezenta o selecție de instrumente pentru a vă oferi o idee despre capabilitățile GRASS.

12.2.1 Follow Along: Create an aspect map

1. Open the GRASS Tools tab
2. Load the g дем raster layer from the grass_mapset Mapset
3. Look for the r.aspect module by searching for it in the Filter field of the Modules List tab
4. Open the tool and set it up like this and click on the Run button:
5. When the process is finished click on View Output to load the resulting layer in the canvas:
The `g_aspect` layer is stored within the `grass_mapset` Mapset so you can remove the layer from the canvas and reload it whenever you want.

### 12.2.2 Follow Along: Get basic statistic of raster layer

We want to know some basic statistics of the `g_dem` raster layer.

1. Open the `GRASS Tools` tab
2. Load the `g_dem` raster layer from the `grass_mapset` Mapset
3. Look for the `r.info` module by searching for it in the `Filter` field of the `Modules List` tab
4. Set up the tool like this and click on `Run`:
5. Within the Output tab you will see some raster information printed, like the path of the file, the number of rows and columns and other useful information:
Reclassifying a raster layer is a very useful task. We just created the \textit{g_aspect} layer from the \textit{g_dem} one. The value range gets from 0 (North) passing through 90 (East), 180 (South), 270 (West) and finally to 360 (North again). We can reclassify the \textit{g_aspect} layer to have just 4 categories following specific rules (North = 1, East = 2, South = 3 and West = 4).

Grass reclassify tool accepts a \texttt{txt} file with the defined rules. Writing the rules is very simple and the GRASS Manual contains very good description.

\textbf{Sfat:} Each GRASS tool has its own Manual tab. Take the time to read the description of the tool you are using to don't miss some useful parameters.

1. Load the \textit{g_aspect} layer or, if you don't have it, go back to the \textbf{Follow Along: Create an aspect map}
section.

2. Look for the `r.reclass` module by searching for it in the Filter field of the Modules List tab.

3. Open the tool and set it up like the following picture. The file containing the rules is in the `exercise_data/grass/` folder, named `reclass_aspect.txt`.

4. Click on Run and wait until the process is finished:

5. Click on View Output to load the reclassified raster in the canvas.
The new layer is made up by just 4 values (1, 2, 3, and 4) and it is easier to manage and to process.

Sfat: Open the `reclass_aspect.txt` with a text editor to see the rules and to start becoming used to them. Moreover, take a deep look at the GRASS manual: a lot of different examples are pointed out.

**12.2.4 Try Yourself Reclassify with your rules**

Try to reclassify the `g_dem` layer into 3 new categories:
- from 0 to 1000, new value = 1
- from 1000 to 1400, new value = 2
- from 1400 to the maximum raster value, new value = 3

*Verificați-vă rezultatele*

**12.2.5 Follow Along: Instrumentul Mapcalc**

The Mapcalc tools is similar to the Raster Calculator of QGIS. You can perform mathematical operation on one or more raster layers and the final result will be a new layer with the calculated values.

The aim of the next exercise is to extract the values greater than 1000 from the `g_dem` raster layer.

1. Look for the `r.mapcalc` module by searching for it in the `Filter` field of the `Modules List` tab.
2. Startați instrumentul.

The Mapcalc dialog allows you to construct a sequence of analyses to be performed on a raster, or collection of rasters. You will use these tools to do so:
In ordine, acestea sunt:

- **Add map**: Add a raster file from your current GRASS mapset.
- **Add constant value**: Add a constant value to be used in functions, 1000 in this case
- **Add operator or function**: Add an operator or function to be connected to inputs and outputs, we will use the operator greater equals than
- **Add connection**: Connect elements. Using this tool, click and drag from the red dot on one item to the red dot on another item. Dots that are correctly connected to a connector line will turn gray. If the line or dot is red, it is not properly connected!
- **Select item**: Select an item and move selected items.
- **Delete selected item**: Removes the selected item from the current mapcalc sheet, but not from the mapset (if it is an existing raster)
- **Open**: Open an existing file with the operation defined
- **Save**: Save all the operation in a file
- **Save as**: Save all the operations as a new file on the disk.

3. Using these tools, construct the following algorithm:
4. Click on Run and then on View output to see the output displayed in your map:
This shows all the areas where the terrain is higher than 1000 meters.

**Sfat:** You can also save the formula you have created and load it in another QGIS project by clicking on the last button on the GRASS Mapcalc toolbar.

### 12.2.6 In Conclusion

În această lectie, am acoperit doar câteva dintre numeroasele instrumente GRASS. Pentru a explora capacitatiile GRASS, deschideți dialogul Instrumentelor GRASS, apoi derulați până la Lista Modulelor. Sau, pentru o abordare mai structurată, căutați în fila Modules Tree, care prezintă instrumentele organizate după tip.
Folosiți datele dvs pentru această secțiune. Veți avea nevoie de:

- un set de date vectoriale al punctelor de interes, cu numele punctelor și multiple categorii
- un set vectorial cu datele drumurilor
- un set vectorial cu date poligonale despre utilizarea terenurilor (folosind limitele de proprietate)
- o imagine a spectrului vizibil (cum ar fi o fotografie aeriană)
- a DEM (downloadable from the CGIAR-CSI if you don’t have your own)

13.1 Crearea unei hărți de bază

Înainte de a orice, aveți nevoie de o hartă de bază, care va asigura un context pentru rezultatele analizei dvs.

13.1.1 Adăugarea unui strat de tip punct

- Adăugați stratul de tip punct. În funcție de nivelul la care urmați cursul, efectuați doar ceea ce este listat în secțiunea corespunzătoare de mai jos:

  - Etichetați punctele în conformitate cu un atribut unic, cum ar fi numele locurilor. Utilizați un font mic pentru a nu scoate în evidență etichetele. Informațiile trebuie să fie disponibile, dar nu ar trebui să fie principalele entități de pe hartă.
  - Clasificați punctele în culori diferite, pe baza unei categorii. De exemplu, categoriile ar putea include „destinație turistică”, „secție de poliție” și „centrul orașului”.

---

353
• Procedează exact ca în secțiunea.

• Clasificați dimensiunea punctului după importanță: cu cât mai semnificativă e o entitate, cu atât mai mare este punctul. Cu toate acestea, nu depășiți o dimensiune a punctului de 2,00.

• Entităților care nu sunt localizate între un singur punct (cum ar fi un nume de provincie/raion, sau un nume de oraș, la o scară mai mare), nu le atribuiți nici un punct.

• Nu folosiți deloc simboluri punctiforme pentru a simboliza stratul. În schimb, folosiți etichetele centrate pe puncte; simbolurile punctiforme nu ar trebui să aibă o dimensiune.

• Folosiți Setări definite cu ajutorul datelor pentru a utiliza etichetele în categorii semnificative.

• Adăugațicoloanelecorespunzătoarepentru datele atributelor, dacă este necesar. Când faceți acest lucru, nu creați date fictive - mai degrabă, utilizați Calculator de Câmpuri pentru a popula noile coloane, pe baza valorilor existente în setul de date.

13.1.2 Adăugarea stratului de tip linie

• Adăugați stratul rutier și apoi schimbați-i simbolistica. Nu etichetați drumurile.

• Alegeți pentru simbolistica drumului o linie lată, de culoare deschisă. De asemenea, adăugați-o oarecare transparentă.

• Creati un simbol cu straturi multiple pentru simboluri. Simbolul rezultat ar trebui să arate ca un drum adevărat. Aveți posibilitatea să utilizați un simbol simplu pentru aceasta; de exemplu, o linie neagră, cu o linie solidă, albă și subțire în centru. Simbolul ar putea arăta chiar și mai elaborat, totuși, harta rezultată nu ar trebui să arate prea încârcată.

• Dacă setul dvs. de date are o densitate mare de drumuri la scară la care doriți să prezentați harta, atunci, ar trebui să aveți două straturi rutiere: unul cu un simbol mai complex, și altul cu un simbol mai simplu, pentru scară mai mici. (Utilizați vizibilitatea în funcție de scară, pentru a se face trecerea la scară adecvată.)

• Toate marcările ar trebui să aibă straturi multiple cu simboluri. Utilizați simbolurile pentru a le afișa corect.
• Procedați exact ca în secțiunea de mai sus.

• În plus, drumurile ar trebui să fie clasificate. Atunci când se utilizează simboluri de teren realiste, fiecare tip de drum ar trebui să aibă un simbol adecvat; de exemplu, o autostradă ar trebui să apară cu două benzi pentru fiecare sens.

13.1.3 Adăugarea stratului de tip poligon

• Adăugați stratul de folosință a terenurilor și schimbați simbolistica.

• Clasificați stratul conform utilizării terenului. Folosiți culori solide.

• Clasificați stratul conform utilizării terenurilor. Dacă este cazul, includeți straturi simbol, diferite tipuri de simboluri, etc. Aveți grija că rezultatele să aibă intensitate redusă și să arate uniform, cu toate acestea. Țineți minte că acesta va fi parte a unui fundal!

• Utilizați clasificarea bazată pe reguli pentru a clasifica utilizarea terenurilor în categorii generale, cum ar fi „urban”, „rural”, „rezervație naturală”, etc.

13.1.4 Crearea fundalului raster

• Creați o reliefare din DEM, și utilizați-o ca o suprapunere pentru o versiune clasificată a DEM-ului în sine. Ați putea folosi, de asemenea, plugin-ul Relief (după cum se arată în lecția despre plugin-uri).

13.1.5 Finalizarea hărții de bază

• Utilizând resursele de mai sus, creați o hartă de bază folosind unele straturi sau pe toate. Această hartă ar trebui să includă toate informațiile de bază necesare pentru a orienta utilizatorul, și să fie vizual unificată / „simplă”.

13.1. Crearea unei hărți de bază
13.2 Analiza datelor

- Căutați o proprietate care îndeplinește anumite criterii.
- Puteți decide cu privire la propriile criterii, pe care le trebuie să le documentați.
- Iată unele indicații pentru aceste criterii:
  - proprietatea țintă ar trebui să aibă (un) anumit tip(uri) de utilizare a terenului
  - ar trebui să fie la o anumită distanță de drumuri, sau să fie traversată de un drum
  - ar trebui să fie la o anumită distanță de unele categorii de puncte, cum ar fi un spital, de exemplu

13.2.1

- Includeți analiza raster în rezultatele dvs. Luați în considerare cel puțin o proprietate derivată din raster, cum ar fi aspectul sau panta acestuia.

13.3 Harta Finală

- Use the Print Layout to create a final map, which incorporates your analysis results.
- Includeți această hartă într-un document, împreună cu criteriile documentate. Dacă harta a devenit preaocupată vizual, datorită strat(ului) adăugat, deselectați straturile care vă sunt cel mai puțin necesare.
- Harta dvs. trebuie să includă un titlu și o legendă.
Module: O Aplicație pentru Silvicultură

În modulele 1 până la 13, ati învățat deja destul de multe despre lucrul în QGIS. Dacă vă interesează să aflați despre unele utilizări forestiere ale GIS, urmând acest modul veți avea posibilitatea de a aplica ceea ce ati învățat, și, în plus, vi se vor prezenta câteva noi instrumente utile.

Dezvoltarea acestui modul a fost sponsorizată de Uniunea Europeană.

14.1 Lesson: Prezentarea Modulului pentru Silvicultură

Utilizarea acestui modul pentru silvicultură necesită cunoștințele acumulate în modulele de la 1 la 11 din acest manual de formare. Exercițiile din următoarele lecții presupun că aveți abilitatea de a face multe dintre operațiunile de bază din QGIS, iar instrumentele care nu au mai fost utilizate înainte sunt prezentate acum în detaliu.

În plus, modulul urmează un nivel de bază de-a lungul lecțiilor, astfel încât, dacă aveți experiență anterioară cu QGIS, puteți urma instrucțiunile fără probleme.

Rețineți că trebuie să descărcați un pachet de date suplimentare pentru acest modul.
14.1.1 Datele Eșantion pentru Silvicultură

**Notă:** The sample data used in this module is part of the training manual data set and is available in the `exercise_data\forestry\` folder.

The forestry related sample data (forestry map, forest data), has been provided by the EVO-HAMK forestry school. The datasets have been modified to adapt to the lessons needs.

The general sample data (aerial images, LiDAR data, basic maps) has been obtained from the National Land Survey of Finland open data service, and adapted for the purposes of the exercises. The open data file download service can be accessed in English [here](#).

**Atenționare:** În ceea ce privește restul manualelor de instruire, acest modul include instrucțiuni privind adăugarea, stergerea și modificarea seturilor de date GIS. V-am furnizat seturile de date de instruire în acest scop. Înainte de a utiliza tehnicile descrise aici asupra datelor dvs., asigurați-vă întotdeauna că aveți copiile de rezervă corespunzătoare!

14.2 Lesson: Georeferențierea unei Hărți

O activitate silvică obisnuită constă în actualizarea informațiilor pentru zonele forestiere. Este posibil ca informațiile anterioare pentru acea zonă să aibă o vechime de mai multă ani, să fi fost colectate în mod analogic (adică, pe hârtie) sau poate că au fost digitizate, dar tot ce aveți reprezintă versiunea pe hârtie a datelor inventorului respectiv.

Cel mai probabil, v-ar dori să utilizați aceste informații în GIS, de exemplu, pentru a le compara mai târziu cu inventarele ulterioare. Acest lucru presupune că va trebui să digitizați manual informațiile, cu ajutorul softului GIS. Dar, înainte de a începe digitizarea, trebuie făcuți pași importanți, cum ar fi scanarea și georeferențierea hârti de hârtie.

*Scopul acestei lecții:* De a afla cum să utilizați instrumentul de Georeferențiere din QGIS.

14.2.1 Scanarea hârtii

Prima activitate constă în scanarea hârtii. Dacă harta dvs. este prea mare, atunci o puteți scana pe porțiuni, dar rețineți că pentru fiecare parte va trebui să reluați acțiunile de preprocesare și georeferențiere. Din acest motiv, este recomandabil să împărțiți harta în cel mai mic număr de porțiuni posibile.

If you are going to use a different map that the one provided with this manual, use your own scanner to scan the map as an image file, a resolution of 300 DPI will do. If your map has colors, scan the image in color so that you can later use those colors to separate information from your map into different layers (for ex., forest stands, contour lines, roads...).

Pentru acest exercițiul, veți utiliza o hartă scanată anterior, pe care o puteți găsi ca `rautjarvi_map.tif` în folderul de date `exercise_data/forestry`
14.2.2 Follow Along: Georeferențierea hărții scanate

Open QGIS and set the project’s CRS to `ETRS89 / ETRS-TM35FIN` in `Project ➤ Properties ➤ CRS`, which is the currently used CRS in Finland.

![Project Properties | CRS](image.png)

Salvați proiectul QGIS sub numele `map_digitizing.qgs`.

You will use the georeferencing plugin from QGIS, the plugin is already installed in QGIS. Activate the plugin using the plugin manager as you have done in previous modules. The plugin is named `Georeferencer GDAL`.

Pentru a georeferenția harta:

- Deschideți instrumentul de georeferențiere, `Raster ➤ Georeferencer ➤ Georeferencer`.
- Add the map image file, `rautjarvi_map.tif`, as the image to georeference, `File ➤ Open raster`.
- When prompted find and select the `KKJ / Finland zone 2` CRS, it is the CRS that was used in Finland back in 1994 when this map was created.
- Clic pe `OK`

Ulterior ar trebui să definiți setările de transformare pentru georeferențierea hărții:

- Deschideți `Settings ➤ Transformation settings`.
- Faceti clic pe pictograma de lângă caseta `Output raster`, mergeți și creați folderul `exercise_data\forestry\digitizing`, apoi denumiti fisierul `rautjarvi_georef.tif`.
- Setati restul parametrilor așa cum se arată mai jos.
The map contains several cross-hairs marking the coordinates in the map, we will use those to georeference this image. You can use the zooming and panning tools as you usually do in QGIS to inspect the image in the Georeferencer’s window.

- Zoom into the left lower corner of the map and note that there is a cross-hair with a coordinate pair, X and Y, that as mentioned before are in KJK / Finland zone 2 CRS. You will use this point as the first ground control point for the georeferencing your map.

- Selectați instrumentul Adăugare punct, apoi faceți clic pe intersecția firelor reticulare (deplasați și măriți după nevoie).

- În dialogul Enter map coordinates notați coordonatele care apar pe hartă (X: 2557000 si Y: 6786000).

- Clic pe OK

Prima coordonată de georeferențiat deja este gata.

Look for other cross-hairs in the black lines image, they are separated 1000 meters from each other both in North and East direction. You should be able to calculate the coordinates of those points in relation to the first one.

Zoom out in the image and move to the right until you find other cross-hair, and estimate how many kilometres you have moved. Try to get ground control points as far from each other as possible. Digitize at least three more ground
control points in the same way you did the first one. You should end up with something similar to this:

With already three digitized ground control points you will be able to see the georeferencing error as a red line coming out of the points. The error in pixels can be seen also in the GCP table in the $dX[\text{pixels}]$ and $dY[\text{pixels}]$ columns. The error in pixels should not be higher than 10 pixels, if it is you should review the points you have digitized and the coordinates you have entered to find what the problem is. You can use the image above as a guide.

Once you are happy with your control points, you can save them for later use:

- *File ➤ Save GCP points as…*
- În folderul exercise_data\forestry\digitizing, denumiți fisierul rautjarvi_map.tif. points.

În cele din urmă, georeferențiați harta dvs.:
• File ► Start georeferencing.
• Retineți că deja ați denumit fișierul rautjarvi_georef.tif, când ați editat setările Georeferențiatorului.

Now you can see the map in QGIS project as a georeferenced raster. Note that the raster seems to be slightly rotated, but that is simply because the data is KJ / Finland zone 2 and your project is in ETRS89 / ETRS-TM35FIN.

To check that your data is properly georeferenced you can open the aerial image in the exercise_data\forestry folder, named rautjarvi_aerial.tif. Your map and this image should match quite well. Set the map transparency to 50% and compare it to the aerial image.

Salvați modificările proiectului QGIS, apoi veți continua din acest punct cu lecția următoare.
14.2.3 In Conclusion

You have now georeferenced a paper map, making it possible to use it as a map layer in QGIS.

14.2.4 What’s Next?

In the next lesson, you will digitize the forest stands in your map as polygons and add the inventory data to them.

14.3 Lesson: Digitizarea Arboretului Forestier

Unless you are going to use your georeferenced map as a simple background image, the next natural step is to digitize elements from it. You have already done so in the exercises about creating vector data in Lesson: Crearea unui Nou Set de Date Vectoriale, when you digitized the school fields. In this lesson, you are going to digitize the forest stands’ borders that appear in the map as green lines but instead of doing it using an aerial image, you will use your georeferenced map.

Scopul acestei lecții: Învățarea unei tehnici pentru a ajuta activitatea de digitizare a arboretului forestier și, în cele din urmă, adunarea din acesta a datelor de inventar.

14.3.1 Follow Along: Extragerea Limitelor Arboretului Forestier

Deschideți în QGIS proiectul map_digitizing.qgs, pe care l-ati salvat în lecia anterioară.

O dată ce ați scanat și georeferențiat harta, ați putea începe digitizarea, folosind imaginea drept ghid. Acesta ar fi, probabil, cel mai potrivit mod de lucru, atunci când imaginea pe care trebuie să o digitizați reprezintă, de fapt, o fotografie aeriană.

If what you are using to digitize is a good map, as it is in our case, it is likely that the information is clearly displayed as lines with different colors for each type of element. Those colors can be relatively easy extracted as individual images using an image processing software like GIMP. Such separate images can be used to assist the digitizing, as you will see below.

Primul pas va fi de a utiliza GIMP la obținerea unei imagini care conține doar pâlcuri de pădure, reprezentate de toate acele linii verzi pe care le puteți vedea în harta originală, scanată:

• Deschideți GIMP (dacă nu l-ai instalat încă, descărcați-l de pe internet sau cereți-l profesorului dvs.).

• Deschideți imaginea hârtii origine, Fisier ➔ Deschidere, rautjarvi_map.tif din folderul exercise_data/forestry. Rețineți că arboretul forestier este reprezentat cu linii verzi (conținând numărul parcelei, de asemenea, în verde, în interiorul fiecărui poligon).
Acum puteți selecta pixelii din imagine, care reprezintă limitele parcelelor forestiere (pixelii verzi):

- Deschideți instrumentul Select ➤ By color.
- Cu instrumentul activ, măriți imaginea (Ctrl + roțița mouse-ului) astfel încât liniile dintre parcelele cu arboret forestier se fie suficient de clare, pentru a se diferenția pixelii care compun linia. A se vedea imaginea din stânga, de mai jos.
- Faceți clic și glisăți cursorul mouse-ului în partea din mijloc a liniei, astfel încât instrumentul va colecta valorile cătovă dintre culorile pixelilor.
- Eliberați butonul mouse-ului și așteptați câteva secunde. Din întreaga imagine vor fi selectați pixelii care se potriveșc culorilor colectate de către instrument.
- Micșorați, pentru a vedea cum au fost selectați pixelii verzi din întreaga imagine.
- Dacă rezultatul nu vă multumeste, repetați operațiunea de clic și glisare.
- Pixelii selectați de către dumneavoastră ar trebui să arate în genul imaginii din dreapta-jos.
O dată ce ați terminat selecția, trebuie să o copiați sub forma unui nou strat, care se va salva ulterior ca fișier de tip imagine:

- Copiați \( (Ctrl+C) \) pixelii selectați.
- Apoi lipiți direct pixelii \( (Ctrl+V) \), GIMP afișând pixelii sub forma unui nou strat temporar, din panoul *Straturi - Pensule* sub formă de *Selectie flotantă* (Stratul Lipit).
- Faceți clic dreapta pe stratul temporar, apoi selectați *Către Noul Strat*.
- Faceți clic pe pictograma „ochiului” de lângă stratul de imagine original pentru a-l dezactiva, astfel încât numai *Stratul Lipit* va fi vizibil.
• În cele din urmă, accesați Fișier ➤ Export..., la Selectarea Tipului Fișierului (După Extensie) alegeți Imagine TIFF, apoi selectați folderul de digitizare și denumiți-l rautjarvi_map_green.tif. Nu alegeți compresia, atunci când vi se va pune întrebarea.

Ati putea face același proces cu alte elemente din imagine, de exemplu, extragând linile negre care reprezintă drumurile, sau cele maro care reprezintă linii de contur ale terenului. Dar pentru noi, arborele forestier este suficient.

14.3.2 Try Yourself Georeferențiați Imaginea Pixelilor Verzi

Ca și în lecția anterioară, trebuie să georeferențiați această nouă imagine pentru a o putea folosi cu restul de date.
Observați că nu mai trebuie să digitizați punctele de control din teren, deoarece această imagine este, în principiu, aceeași ca și imaginea hârtii originale, în măsura în care instrumentul de Georeferențiere nu este afectat. Iată câteva lucruri pe care trebuie să le retineți:
   • Această imagine se află, desigur, în CRS-ul KKJ / Finland zone 2.
   • Ar trebui să utilizați punctele de control din teren salvate, Fișier ➤ Încărcare puncte GCP.
   • Amintiți-vă să revizuiți Setările de Transformare.
   • Denumiți stratul rezultat green_centroids.shp, din folderul digitizing.

Verificați dacă noul raster se potrivește cu harta originală.

14.3.3 Follow Along: Crearea Punctelor de Sprijin pentru Digitizare

Având în vedere instrumentele de digitizare din QGIS, v-ați putea gândi că ar fi de ajutor acrosarea la pixelii verzi, pe durata digitizării. Exact acest lucru îl veți face în continuare: veți crea puncte din acei pixeli, pentru a le folosi mai târziu ca ghidaje în digitizarea arborelor forestiere, când se vor utiliza instrumentele de acroșare disponibile în QGIS.
• Folosiți instrumentul Raster ➤ Conversie ➤ Poligonizare (Din Raster în Vector) pentru a vectoriza liniiile verzi în poligoane. Dacă nu vă mai amintiți cum se efectuează acest lucru, puteți să reexaminați Lesson: Conversia din Raster în Vector.
• Salvați rezultatul ca rautjarvi_green_polygon.shp, în interiorul folderului digitizing.

Măriți și analizați forma poligoanelor. Veți obține ceva de genul:
Următoarea opțiune de a scoate punctele din acele poligoane, este de a le obține centroizii:

- Deschideți Vector ► Geometry tools ► Polygon centroids.
- Setați stratul poligonal pe care tocmiai l-ați obținut, ca fișier de intrare pentru instrument.
- Denumiți rezultatul ca `green_centroids.shp`, în folderul `digitizing`.
- Bifați Adăugare rezultat în canevas.
- Folosiți instrumentul pentru a calcula centroizii poligoanelor.
Acum puteți elimina stratul `rautjarvi_green_polygon` din Cuprins.

Schimbați simbologia stratului centroizilor:

- Deschideți `Proprietățile Stratului` pentru `green_centroids`.
- Go to the `Symbology` tab.
- Setați `Unitățile` ca Unități de hartă.
- Setați `Dimensiunea` la 1.

It is not necessary to differentiate points from each other, you just need them to be there for the snapping tools to use them. You can use those points now to follow the original lines much easily than without them.

14.3.4  **Follow Along: Digitizarea Pâlcirilor de Pădure**

Now you are ready to start with the actual digitizing work. You would start by creating a vector file of `polygon type`, but for this exercise, there is a shapefile with part of the area of interest already digitized. You will just finish digitizing the half of the forest stands that are left between the main roads (wide pink lines) and the lake:
• Mergeți la folderul `digitizare` folosind exploratorul dvs. de fișiere.
• Glisați fișierul vectorial pe harta dvs. `forest_stands.shp`.

Schimbați simbologia noului strat, astfel încât să puteți identifica mai ușor ce poligoane au fost deja digitizate:
  • Umpleți poligonul cu verde.
  • Bordura poligonului va fi de 1 mm.
  • Setăți transparenta la 50%.

Acum, asa cum vă amintiți de la modulele din trecut, trebuie să confruntați și activați opțiunile de acrosare:

14.3. Lesson: Digitizarea Arboretului Forestier
• Go to Project ▶ Snapping options….

• Activate the snapping for the green_centroids and the forest_stands layers.

• Setati Tolerance la 5 unități de hartă.

• Bifati caseta Avoid Int., pentru stratul forest_stands.

• Bifati Enable topological editing.

• Clic pe Aplicare.

With these snapping settings, whenever you are digitizing and get close enough to one of the points in the centroids layer or any vertex of your digitized polygons, a pink cross will appear on the point that will be snapped to.

Finally, turn off the visibility of all the layers except forest_stands and rautjarvi_georef. Make sure that the map image has not transparency any more.

Câteva lucruri importante de reținut, înainte de a începe digitizarea:

• Nu încercați să fiți prea exacți în digitizarea frontierelor.

• If a border is a straight line, digitize it with just two nodes. In general, digitize using as few nodes as possible.

• Zoom in to close ranges only if you feel that you need to be accurate, for example, at some corners or when you want a polygon to connect with another polygon at a certain node.

• Folosiți butonul din mijloc al mouse-ului pentru a mări/micșora și deplasa, pe durata digitizării.

• Digitizați doar un singur poligon la un moment dat.

• După digitizarea unui poligon, scrieți id-ul pâlcului de pădure pe care îl puteți vedea în hartă.

Acum puteți începe digitizarea:

• Localizați numărul pâlcului forestier 357 în fereastra hârtii.

• Activăți editarea pentru stratul forest_stands.shp.

• Selectați instrumentul Add feature.

• Începeți digitizarea pâlcului 357 prin conectarea unora dintre puncte.

• Notați cruciilele roz care indică acroșarea.
• Când ati terminat, faceți clic-dreapta pentru a termina digitizarea aceluiai poligon.
• Introduceți pâlcul forestier id (în acest caz 357).
• Clic pe OK

If you were not prompted for the polygon id when you finished digitizing it, go to Settings » Options » Digitizing and make sure that the Suppress attribute form pop-up after feature creation is not checked.

Poligonul dvs. digitizat va arăta astfel:
Now for the second polygon, pick up the stand number 358. Make sure that the Avoid int. is checked for the forest_stands layer. This option does not allow intersecting polygons at digitizing, so that if you digitize over an existing polygon, the new polygon will be trimmed to meet the border of the already existing polygons. You can use this characteristic to automatically obtain a common border.

- Începeți digitizarea standului 358 la unul dintre colțurile comune cu pâlcul 357.
- Apoi continuați în mod normal, până când ajungeți la celălalt colț comun cu ambele pâlcuri.
- Finally, digitize a few points inside polygon 357 making sure that the common border is not intersected. See left image below.
- Clic-dreapta pentru a termina editarea pâlcului de pădure 358.
- Introduceți 358 ca și i.d.
- Click OK, your new polygon should show a common border with the stand 357 as you can see in the image on the right.
The part of the polygon that was overlapping the existing polygon has been automatically trimmed out and you are left with a common border, as you intended it to be.

14.3.5 Try Yourself Încheierea Digitizării Pâlcurilor de Pădure

Now you have two forest stands ready. And a good idea on how to proceed. Continue digitizing on your own until you have digitized all the forest stands that are limited by the main road and the lake.

It might look like a lot of work, but you will soon get used to digitizing the forest stands. It should take you about 15 minutes.

During the digitizing you might need to edit or delete nodes, split or merge polygons. You learned about the necessary tools in Lesson: Topologia Entității, now is probably a good moment to go read about them again.

Remember that having Enable topological editing activated, allows you to move nodes common to two polygons so that the common border is edited at the same time for both polygons.

Rezultatul dvs. va arăta în felul următor:
It is possible that the forest inventory data you have for your map is also written in paper. In that case, you would have to first write that data to a text file or a spreadsheet. For this exercise, the information from the inventory for 1994 (the same inventory as the map) is ready as a comma separated text (csv) file.

Open the \texttt{rautjarvi\_1994.csv} file from the exercise\_data\forestry directory in a text editor and note that the inventory data file has an attribute called \textit{ID} that has the numbers of the forest stands. Those numbers are the same as the forest stands ids you have entered for your polygons and can be used to link the data from the text file to your vector file. You can see the metadata for this inventory data in the file \texttt{rautjarvi\_1994\_legend.txt} in the same folder.

- Open the .csv in QGIS with the \textit{Layer} \textarrow{Add Delimited Text Layer…} tool. In the dialog, set it as follows:
Pentru a adăuga date din fisierul .csv:
- Deschideți proprietățile pentru stratul forest_stands.
- Mergeti la fila Îmbinări.
- Faceți clic pe semnul plus din partea de jos a casetei de dialog.
- Selectați rautjarvi_1994.csv ca Join layer și ID ca Join field.
- Asigurați-vă că, de asemenea, câmpul Target este setat pe id.
- Faceți clic pe Ok de două ori.

The data from the text file should be now linked to your vector file. To see what has happened, open the attribute table for the forest_stands layer. You can see that all the attributes from the inventory data file are now linked to your digitized vector layer.

14.3.7 Try Yourself Redenumirea Numelor pentru Atribut, și Adăugarea Suprafeței și a Perimetrului

The data from the .csv file is just linked to your vector file. To make this link permanent, so that the data is actually recorded to the vector file you need to save the forest_stands layer as a new vector file. Close the attribute table and right click the forest_stands layer to save it as forest_stands_1994.shp.

Open your new forest_stands_1994.shp in your map if you did not added yet. Then open the attribute table. You notice that the names of the columns that you just added are no very useful. To solve this:
- Adăugați plugin-ul Table Manager procedând la fel ca și in cazul altor plugin-uri.
• Asigurați-vă că plugin-ul este activat.
• În TOC selectați stratul forest_stands_1994.shp.
• Apoi, mergeti la Vector ➤ Table Manager ➤ Table manager.
• Utilizați caseta de dialog pentru a edita numele coloanelor, în așa fel încât să se potrivească cu cele din fișierul .csv.

• Clic pe Salvare.
• Selectați Yes pentru a păstra stilul stratului.
• Închideți dialogul Table Manager.

To finish gathering the information related to these forest stands, you might calculate the area and the perimeter of the stands. You calculated areas for polygons in Lesson: Exercițiul Suplimentar. Go back to that lesson if you need to and calculate the areas for the forest stands, name the new attribute Area and make sure that the values calculated are in hectares.

Now your forest_stands_1994.shp layer is ready and packed with all the available information.

Save your project to keep the current map presentation in case you need to come back later to it.
14.3.8 In Conclusion

It has taken a few clicks of the mouse but you now have your old inventory data in digital format and ready for use in QGIS.

14.3.9 What's Next?

You could start doing different analysis with your brand new dataset, but you might be more interested in performing analysis in a dataset more up to date. The topic of the next lesson will be the creation of forest stands using current aerial photos and the addition of some relevant information to your dataset.

14.4 Lesson: Actualizarea Pâlcilor de Pădure

Acum, că ați digitizat informațiile din hărțile de inventariere vechi și ați adăugat informațiile corespunzătoare pâlcilor de pădure, următorul pas ar fi crearea inventarului stării actuale a pădurii.

You will digitize new forest stands from scratch following an aerial photo from that forest area. The forestry map you digitized in the previous lesson was created from an aerial Color Infrared (CIR) photograph. This type of imagery, where the infrared light is recorded instead of the blue light, are widely used to study vegetated areas. You will also use a CIR photograph in this lesson.

După digitizarea pâlcilor de pădure, veți adăuga informațiile, cum ar fi noile constrângerii rezultate din reglementările de conservare.

Scopul acestei lectii: De a digitiza un nou set de standuri forestiere din fotografii CIR, aeriene, și de a adăuga informațiile din alte seturi de date.

14.4.1 Comparând Pâlcile Vechi de Pădure pentru Fotografiile Aeriene Actuale

The National Land Survey of Finland has an open data policy that allows you downloading a variety of geographical data like aerial imagery, traditional topographic maps, DEM, LiDAR data, etc. The service can be accessed also in English [here]. The aerial image used in this exercise has been created from two orthorectified CIR images downloaded from that service (M4134F_21062012 and M4143E_21062012).

• Open QGIS and set the project’s CRS to ETRS89 / ETRS-TM35FIN in Project ➤ Properties… ➤ CRS.
• From the exercise_dataorestry\ folder, add the CIR image rautjarvi_aerial.tif that is containing the digitized lakes.
• Then save the QGIS project as digitizing_2012.qgs.


• Adăugați stratul forest_stands_1994.shp.
• Setați stilul, astfel încât să puteți vedea prin poligoanele de fragmentation.
• Examinați modul în care vechiul păl de pădure poate fi interpretat vizual (sau nu) ca o pădure omogenă.

Focalizați și deplasați-vă în jurul zonei. Veți observa, probabil, că unele dintre pâlcile vechi de pădure ar putea corespunde încă cu imaginea, pe când altele nu.

This is a normal situation, as some 20 years have passed by and different forest operations have been done (harvesting, thinning…). It is also possible that the forest stands looked homogeneous back in 1992 to the person who digitized them but as time has passed some forest has developed in different ways. Or simply the priorities for the forest inventory were different that they are today.

Apoi, veți crea noi pâlcuri de pădure pentru această imagine, fără a le utiliza pe cele vechi. Mai târziu, le puteți compara pentru a vedea diferențele.
14.4.2 Interpretarea Imaginii CIR

Let’s digitize the same area that was covered by the old inventory, limited by the roads and the lake. You don’t have to digitize the whole area, as in the previous exercise you can start with a vector file that already contains most of the forest stands.

- Eliminați stratul `forest_stands_1994.shp`.
- Adăugați stratul `forest_stands_2012.shp` localizat în folderul `:kbd:`exercise_data\forestry\`.
- Setați stilul acestui strat, astfel încât poligoanele să fie umplute, iar granițele să fie vizibile.

Puteți vedea că o regiune din nordul zonei inventariate încă lipsese. Aceasta va fi sarcina dvs.: digitizarea pâlcilor
But before you start, spend some time reviewing the forest stands already digitized and the corresponding forest in the image. Try to get an idea about how the stands borders are decided, it helps if you have some forestry knowledge.

Unele idei despre ceea ce s-ar putea identifica din imagini:

- What forests are deciduous species (in Finland mostly birch forests) and which ones are conifers (in this region pine or spruce). In CIR images, deciduous species will often come as bright red color whereas conifers present dark green colors.

- When a forest stand age changes, by looking at the sizes of the tree crowns that can be identified in the imagery.

- The different forest stands' densities, for example forest stand were a thinning operation has recently been done would clearly show spaces between the tree crowns and should be easy to differentiate from other forest stands around it.

- Zonele albastre indică terenuri virane, drumuri și zone urbane, culturi care nu au ajuns să crească, etc.

- Don’t use zooms too close to the image when trying to identify forest stands. A scale between 1:3 000 and 1:5 000 should be enough for this imagery. See the image below (1:4000 scale):
14.4.3 **Try Yourself Încheierea Digitizării Pâlcurilor, pornind de la Imaginile CIR**

When digitizing the forest stands, you should try to get forest areas that are as homogeneous as possible in terms of tree species, forest age, stand density… Don’t be too detailed though, or you will end up making hundreds of small forest stands that would not be useful at all. You should try to get stands that are meaningful in the context of forestry, not too small (at least 0.5 ha) but not too big either (no more than 3 ha).

Tinând cont de aceste indicații, puteți digitiza de acum pâlcurile forestiere lipsă.

- Activati editarea pentru stratul `forest_stands_2012.shp`.
- Setati optiunile de topologie și de acroșare așa cum se arată în imagine.
- Amintiți-vă să faceți clic pe `Aplicare` sau `OK`.

Start digitizing as you did in the previous lesson, with the only difference that you don’t have any point layer that you are snapping to. For this area you should get around 14 new forest stands. While digitizing, fill in the `Stand_id` field with numbers starting at 901.

Când veți definitiva, stratul dvs. ar trebui să arate în felul următor:
Now you have a new set of polygons defining the different forest stands for the current situation as can be interpreted from the CIR images. But you are obviously still missing the forest inventory data, right? For that you will still need to visit the forest and get some sample data that you will use to estimate the forest attributes for each of the forest stands. You will see how to do that in the next lesson.

Pentru moment, încă mai puteți îmbunătăți stratul vectorial cu informațiile suplimentare pe care le aveți, cu privire la reglementarea conservării care trebuie luată în considerare pentru această zonă.

14.4.4 Follow Along: Actualizarea Pălcurilor de Pădure cu Informații de Conservare

For the area you are working with, it has been researched that the following conservation regulations must be taken into account while doing the forest planning:

- Two locations of a protected species of Siberian flying squirrel (Pteromys volans) have been identified. According to the regulation, an area of 15 meters around the spots must be left untouched.
- A riparian forest of special interest growing along a stream in the area must be protected. In a visit to the field, it was found that 20 meters to both sides of the stream must be protected.

You have one vector file containing the information about the squirrel locations and another containing the digitized stream running in the North area towards the lake. From the exercise_data\forestry\folder, add the vector files squirrel.shp and stream.shp.
For the protection of the squirrels locations, you are going to add a new attribute (column) to your new forest stands that will contain information about point locations that have to be protected. That information will later be available whenever a forest operation is planned, and the field team will be able to mark the area that has to be left untouched before the work starts.

- Deschideți tabela de atribut pentru stratul squirrel.
- You can see that there are two locations that are defined as Siberian flying squirrel, and that the area to be protected is indicated by a distance of 15 meters from the locations.

Pentru a atasa informatiile despre veveritele din suprafetele de probă, puteți utiliza Îmbinarea attributelor după locație:

- Deschideți Vector ➤ Management Datelor ➤ Îmbină attributele după locație.
- Stabiliți forest_stands_2012 ca și Strat Vectorial de Destinație.
- Ca și Strat vectorial de îmbinare selectați stratul de tip punct squirrel.shp.
- Denumiți fisierul rezultat stands_squirrel.shp.
- In Output table select Keep all records (including non-matching target records). So that you keep all the forest stands in the layer instead of only keeping those that are spatially related to the squirrel locations.
- Clic pe OK
- Selectați Yes când vi se cere să adăugați stratul în TOC.
- Închideți caseta de dialog.
Now you have a new forest stands layer, stands_squirrel where there are new attributes corresponding to the protection information related to the Siberian flying squirrel.

Open the table of the new layer and order it so that the forest stands with information for the Protection attribute are on top. You should have now two forest stands where the squirrel has been located:
Although this information might be enough, look at what areas related to the squirrels should be protected. You know that you have to leave a buffer of 15 meters around the squirrels location:

- Deschideți Vector ➤ Geoprocessing Tools ➤ Buffer.
- Creați un tampon de 15 metri pentru stratul squirrel.
- Denumiți rezultatul ca și squirrel_15m.shp.
You will notice that if you zoom in to the location in the Northern part of the area, the buffer area extends to the neighbouring stand as well. This means that whenever a forest operation would take place in that stand, the protected location should also be taken into account.

Din analizele anterioare, nu ați obținut pâlcui în care să înregistrați informațiile despre starea de protecție. Pentru a rezolva această problemă:

- Rulați iarăși instrumentul Îmbinare atribute după locație.
- De această dată, utilizați stratul squirrel_15m pentru îmbinare.
- Denumiți fișierul rezultat stands_squirrel_15m.shp.
Open the attribute table for the this new layer and note that now you have three forest stands that have the information about the protection locations. The information in the forest stands data will indicate to the forest manager that there are protection considerations to be taken into account. Then he or she can get the location from the squirrel dataset, and visit the area to mark the corresponding buffer around the location so that the operators in the field can avoid disturbing the squirrels environment.

14.4.5 Try Yourself Actualizarea Pâlcurilor de Pădure folosind Distanța până la Flux

Following the same approach as indicated for the protected squirrel locations you can now update your forest stands with protection information related to the stream identified in the field:

- Amintiți-vă că tamponul, în acest caz, este de 20 de metri în jurul său.
- You want to have all the protection information in the same vector file, so use the stands_squirrel_15m layer as the target.
- Denumiți rezultatul ca forest_stands_2012_protect.shp.
Open the attributes table for the new vector layer and confirm that you now have all the protection information for the stands that are affected by the protection measures to protect the riparian forest associated with the stream.

Salvată acum proiectul dvs. QGIS.

14.4.6 In Conclusion

You have seen how to interpret CIR images to digitize forest stands. Of course it would take some practice to make more accurate stands and usually using other information like soil maps would give better results, but you now know the basis for this type of task. And adding information from other datasets resulted to be quite a trivial task.

14.4.7 What’s Next?

The forest stands you digitized will be used for planning forestry operations in the future, but you still need to get more information about the forest. In the next lesson, you will see how to plan a set of sampling plots to inventory the forest area you just digitized, and get the overall estimate of forest parameters.

14.5 Lesson: Planul de Eșantionare Sistematică

Ati digitizat deja un set de poligone care reprezintă arboretul, totuși, încă nu aveți informații despre pădure. Pentru aceasta, puteți programa o achiziție de date pentru a inventaria întreaga pădure și pentru a-i estima parametrii. În această lecție veți crea un set sistematic de suprafețe de probă.

Atunci când începeți planificarea inventarului forestier, este important să vă definiți în mod clar obiectivele, tipurile de suprafețe de probă care vor fi utilizate, precum și datele care vor fi colectate în vederea atingerii obiectivelor. Pentru fiecare caz în parte, acestea vor depinde de tipul pădurii și de scopul managementului; ar trebui să fie planificate cu atenție de către cineva cu cunoștințe forestiere. În această lecție, veți crea un inventar teoretic, bazat pe un design sistematic al suprafețelor de probă.

Scopul acestei lecții: Crearea planului sistematic al suprafețelor de probă, pentru o vedere de ansamblu a zonei de pădure.

14.5.1 Inventarierea Pădurii

There are several methods to inventory forests, each of them suiting different purposes and conditions. For example, one very accurate way to inventory a forest (if you consider only tree species) would be to visit the forest and make a list of every tree and their characteristics. As you can imagine this is not commonly applicable except for some small areas or some special situations.

The most common way to find out about a forest is by sampling it, that is, taking measurements in different locations at the forest and generalizing that information to the whole forest. These measurements are often made in sample plots that are smaller forest areas that can be easily measured. The sample plots can be of any size (for ex. 50 m², 0.5 ha) and form (for ex. circular, rectangular, variable size), and can be located in the forest in different ways (for ex. randomly, systematically, along lines). The size, form and location of the sample plots are usually decided following statistical, economical and practical considerations. If you have no forestry knowledge, you might be interested in reading this Wikipedia article.
14.5.2 Lesson: Implementarea unui Plan Sistematic al Suprafețelor de Probă

For the forest you are working with, the manager has decided that a systematic sampling design is the most appropriate for this forest and has decided that a fixed distance of 80 meters between the sample plots and sampling lines will yield reliable results (for this case, +-5% average error at a probability of 68%). Variable size plots has been decided to be the most effective method for this inventory, for growing and mature stands, but a 4 meters fixed radius plots will be used for seedling stands.

În practică, trebuie pur și simplu să reprezentăm suprafețele de probă sub formă de puncte, care vor fi folosite ulterior de către echipa din teren:

- Deschideți proiectul digitizing_2012.qgs
- Eliminați toate straturile, cu excepția forest_stands_2012.
- Salvați proiectul dumneavoastră ca forest_inventory.qgs

Acum trebuie să creați o rețea dreptunghiulară de puncte separate, aflate la 80 de metri unul de altul:

- Deschideți Vector ➤ Research Tools ➤ Regular points.
- În definițiile Ariei, selectați Input Boundary Layer.
- Iar ca și strat de intrare aleați forest_stands_2012.
- În setările de Spatieri a Grilei, selectați Folosirea acestei spatieri între puncte și stabiliți-o la 80.
- Salvați rezultatul ca systematic_plots.shp, în folderul forestry\sampling\.
- Bifați caseta Add result to canvas.
- Clic pe OK

Notă: The suggested Regular points creates the systematic points starting in the corner upper-left corner of the extent of the selected polygon layer. If you want to add some randomness to this regular points, you could use a randomly calculated number between 0 and 80 (80 is the distance between our points), and then write it as the Initial inset from corner (LH side) parameter in the tool’s dialog.

Observați că instrumentul a folosit întreaga extindere a stratului de arboret, pentru a genera o grilă dreptunghiulară de puncte. Însă, vă interesează doar acele puncte care se află în interiorul suprafeței de pădure (a se vedea imaginile de mai jos):
• Deschideți Vector ➔ Geoprocessing Tools ➔ Clip.
• Selectați systematic_plots ca Strat vectorial de intrare.
• Setați forest_stands_2012 ca și Strat de decupare.
• Salvați rezultatul ca și systematic_plots_clip.shp.
• Bifați caseta Add result to canvas.
• Clic pe OK

You have now the points that the field teams will use to navigate to the designed sample plots locations. You can still prepare these points so that they are more useful for the field work. At the least you will have to add meaningful names for the points and export them to a format that can be used in their GPS devices.

Let’s start with the naming of the sample plots. If you check the Attribute table for the plots inside the forest area, you can see that you have the default id field automatically generated by the Regular points tool. Label the points to see them in the map and consider if you could use those numbers as part of your sample plot naming:
• Deschideți Layer Properties ➔ Labels pentru systematic_plots_clip.
• Bifați Label this layer with, apoi selectați câmpul ID.
• Mergeți la opțiunile Tamponului și bifați Desenare tampon în jurul textului, apoi setați Mărimea la 1.
• Clic pe OK

Acum, priviți etichetele de pe hartă. Puteți vedea că punctele au fost create și numerotate mai întâi de la vest înspre est și apoi de la nord înspre sud. Dacă priviți iarăși la tabela de atribute, veți observa că ordinea din tabel urmează, de asemenea, acest model. Numai dacă aveți un alt motiv pentru a denumi suprafețele de probă într-un mod diferit, modul de denumire Vest-Est/Nord-Sud urmează o ordine logică și reprezintă o opțiune bună.

Notă: În cazul în care doriți să le ordonați sau să le denumiți într-un mod diferit, ați putea folosi o foaie de calcul.
Nevertheless, the number values in the id field are not so good. It would be better if the naming would be something like p_1, p_2.... You can create a new column for the systematic_plots_clip layer:

- Deschideți Tabelul de atribute pentru systematic_plots_clip.
- Activati modul de editare.
- Deschideți Calculatorul de câmpuri, apoi denumiti noua coloana Plot_id.
- Setati Output field type la Text (string).
- In the Expression field, write, copy or construct this formula concat('P_', $rownum ). Remember that you can also double click on the elements inside the Function list. The concat function can be found under String and the $rownum parameter can be found under Record.
- Clic pe OK
- Dezactivati modul de editare si salvaati modificarile.

Now you have a new column with plot names that are meaningful to you. For the systematic_plots_clip layer, change the field used for labeling to your new Plot_id field.
14.5. Lesson: Planul de Eșantionare Sistematică
14.5.3  Follow Along: Exportati Suprafetele de Probă în format GPX

The field teams will be probably using a GPS device to locate the sample plots you planned. The next step is to export the points you created to a format that your GPS can read. QGIS allows you to save your point and line vector data in GPS eXchange Format (GPX)<https://en.wikipedia.org/wiki/GPS_Exchange_Format>, which is an standard GPS data format that can be read by most of the specialized software. You need to be careful with selecting the CRS when you save your data:

- Clic dreapta pe systematic_plots_clip, apoi selectati Save as.
- În Format selectati GPS eXchange Format [GPX].
- Salvați rezultatul ca plots_wgs84.gpx.
- În CRS aleși CRS-ul Selectat.
- Alegeți WGS 84 (EPSG:4326).

Notă: The GPX format accepts only this CRS, if you select a different one, QGIS will give no error but you will get an empty file.

- Clic pe OK
- In the dialog that opens, select only the waypoints layer (the rest of the layers are empty).
The inventory sample plots are now in a standard format that can be managed by most of the GPS software. The field teams can now upload the locations of the sample plots to their devices. That would be done by using the specific devices own software and the `plots_wgs84.gpx` file you just saved. Other option would be to use the GPS Tools plugin but it would most likely involve setting the tool to work with your specific GPS device. If you are working with your own data and want to see how the tool works you can find out information about it in the section working_gps in the QGIS User Manual.

Salvați acum proiectul dvs. QGIS.

**14.5.4 In Conclusion**

You just saw how easily you can create a systematic sampling design to be used in a forest inventory. Creating other types of sampling designs will involve the use of different tools within QGIS, spreadsheets or scripting to calculate the coordinates of the sample plots, but the general idea remains the same.

**14.5.5 What’s Next?**

In the next lesson you will see how to use the Atlas capabilities in QGIS to automatically generate detailed maps that the field teams will be using to navigate to the sample plots assigned to them.

**14.6 Lesson: Crearea hărților detaliate folosind instrumentul Atlas**

Proiectarea sistematică de eșantionare este gata, iar echipa de teren și-au încărcat coordonatele GPS în dispozitivele de navigare. Există, de asemenea, un formular pentru date, în care se vor colecta informațiile măsurate pentru fiecare schită. Pentru a găsi mai ușor drumul spre fiecare parcelă, s-au solicitat o serie de hărți detaliate, în cazul în care unele informații din teren pot fi văzute în mod clar, împreună cu un subset mic de schite și câteva informații despre zonă. Puteți utiliza instrumentul Atlas pentru a genera automat o serie de hărți, având un format comun.

**Scopul acestei lecții:** Aflați cum să utilizați instrumentul Atlas în QGIS, pentru a genera hărți tipăriabile detaliate, în scopul sprijinirii activității de inventariere în teren.

**14.6.1 Follow Along: Preparing the Print Layout**

Înainte de a putea automatiza hărțile detaliate ale zonei forestiere și schitele noastre de eșantionare, trebuie să creăm un săblon cu toate elementele pe care le considerăm utile în munca de teren. Desigur, cea mai importantă va fi o stilizare corectă, dar, după cum ați văzut mai înainte, va trebui să adăugați și o mulțime de alte elemente care completează harta tipărită.

Deschideți proiectul QGIS din lecția anterioară `forest_inventory.qgs`. Ar trebui să aveți cel puțin următoarele straturi:

- `forest_stands_2012` (cu o transparentă de 50%, umplere cu verde deschis și închis a liniiilor marginii).
- `systematic_plots_clip`. 
- `rautjarvi_aerial`.

Salvați proiectul cu un nume nou, `map_creation.qgs`.

To create a printable map, remember that you use the Layout Manager:

- **Open Project ➤ Layout Manager….**
- **In the Layout manager dialog.**
- **Click the Add button and name your print layout `forest_map`.**
- **Clic pe OK**
Clic pe butonul Afişare

Setaţi opţiunile imprimantei, astfel încât hărțile să se potrivească unei hârtii A4 şi marginilor acesteia:

- Open menu selection: Layout -> Page Setup….
- Dimensiunea este A4 (217 x 297 mm).
- Orientarea este Peisaj.
- Margins (millimeters) are all set to 5.

In the Print Layout window, go to the Composition tab (on the right panel) and make sure that these settings for Paper and quality are the same you defined for the printer:

- Mărimea: A4 (210x297mm).
- Orientarea: Peisaj.
- Calitatea: 300dpi.

Composing a map is easier if you make use of the canvas grid to position the different elements. Review the settings for the layout grid:

- În fila Compoziţiilor extindeţi regiunea Grid.
- Asiguraţi-vă că Spatierea este setată la 10 mm.
- Să că Toleranţa este setată la 2 mm.

Trebuie să activaţi folosirea grilei:

- Deschideţi meniul :menu selection: Vizualizare
- Bifaţi Afişarea grilei.
- Bifaţi Acroşare la grilă.
- Notice that options for using guides are checked by default, which allows you to see red guiding lines when you are moving elements in the layout.

Now you can start to add elements to your layout. Add first a map element so you can review how the map canvas looks as you will be making changes in the layers symbology:

- Click on the Add Map button.
- Țineţi apăsat butonul stâng al mouse-ului și trasați un dreptunghi în care să încadrați cea mai mare parte a hârtii.
Observați modul în care cursorul mouse-ului se acroșează la grila canevasului. Utilizați această funcție atunci când adăugati alte elemente. Dacă doriți să aveți mai multă acuratețe, schimbați setările de Spatire ale grilei. Dacă dintr-un motiv oarecare nu mai doriți acroșarea la grilă la un moment dat, puteți întotdeauna bifa sau debifa meniul Vizualizare.

14.6.2 Follow Along: Adăugarea Fundalului Hărții

Leave the layout open but go back to the map. Let’s add some background data and create some styling so that the map content is as clear as possible.

- Add the background raster basic_map.tif that you can find in the exercise_data\forestry\ folder.
- Când vi se solicită, selectați pentru raster CRS-ul ETRS89 / ETRS-TM35FIN.

După cum puteți vedea, harta de fundal este deja stilizată. Acest tip de raster cartografic gata de utilizare este foarte frecvent. El este creat din date vectoriale, stilizate într-un format standard și stocate ca un raster, așa că nu trebuie să vă îngrijoreze obținerea unui rezultat bun.

- Acum măriți schițele dvs., astfel încât să puteți vedea doar aproximativ patru sau cinci linii de parcele.

The current styling of the sample plots is not the best, but how does it look in the print layout?:
While during the last exercises, the white buffer was OK on top of the aerial image, now that the background image is mostly white you barely can see the labels. You can also check how it looks like on the layout:

- Go to the Print Layout window.
- Use the button to select the map element in the layout.
- Mergeți la fila Proprietățile itemului tab.
- Sub Extents faceți clic pe Set to map canvas extent.
- Dacă trebuie să actualizați elementul, sub Main properties faceți clic pe Update preview.

Evident, acest lucru nu este suficient de bun, atât timp cât doriți să afișați numerele, pe cât posibil, cât mai vizibil pentru echipele din teren.

### 14.6.3 Try Yourself Schimbarea Simbologiei Straturilor

Ati exersat simbologia cu Module: Creating and Exploring a Basic Map, și etichetarea cu Module: Clasificarea Datelor Vectoriale. Reveniti la aceste module dacă trebuie să vă reamintiți unele dintre opțiunile și instrumentele disponibile. Scopul dvs. este de a afișa locațiile loturilor și numele lor cât mai clar, dar întotdeauna să fie posibilă vizualizarea elementelor din fundalul hărții. Vă puteți orienta după această imagine:
Veți folosi mai târziu stilizarea cu verde a stratului `forest_stands_2012`. În scopul păstrării sale, și pentru a avea o vizualizare a acesteia care arată numai marginile masivului:

- Clic dreapta pe `forest_stands_2012`, apoi selectați `Duplicare`
- Veți obține un nou strat denumit `forest_stands_2012 copy`, pe care îl puteți folosi pentru a defini un stil diferit, de exemplu, fără umplere și cu marginile roșii.

Acum aveți două vizualizări diferite ale parcelelor împădurite și puteți decide pe care să o afișați pentru harta dvs. detaliată.

Go back to the Print Layout window often to see what the map would look like. For the purposes of creating detailed maps, you are looking for a symbology that looks good not at the scale of the whole forest area (left image below) but at a closer scale (right image below). Remember to use `Update preview` and `Set to map canvas extent` whenever you change the zoom in your map or the layout.
14.6.4  Try Yourself Crearea unui șablon pentru Harta de Bază

O dată ce aveți o simbolie care vă multumește, sunteți gata să adăugați alte câteva informații hărții dvs. Adăugați cel puțin următoarele elemente:

- Titlu.
- O scară grafică.
- Cadrul grilei pentru harta dvs.
- Coordonate situate pe părțile laterale ale grilei.

Ați creat deja o compoziție similară în Module: Laying out the Maps. Mergeți înapoi la acel modul pentru a vi-l reaminti. Pentru referință, puteți privi această imagine exemplu:

Exportați harta dvs. ca o imagine și priviți-o.

- Layout ► Export as Image…
- Utilizați, de exemplu, Formatul JPG.

Iată cum va arăta atunci la tipărire.
14.6.5 Follow Along: Adding More Elements to the Print Layout

Așa cum probabil ați observat în imaginea hârtii șablon propusă, există o multime de loc în partea dreaptă a canevasului. Haideti să vedem ce altceva ar putea merge acolo. Pentru scopul hârtii noastre, o legendă nu este cu adevărat necesară, dar o imagine de ansamblu a hârtii și niste casete de text ar putea adăuga valoare hârtii.

Harta de ansamblu va ajuta echipele de teren să plaseze harta detaliată în interiorul suprafeței generală a pădurii:

- Adăugați un alt element de hârtă pe canevas, chiar sub textul din titlu.
- În fila Proprietăților elementului, deschideți caseta cu derulare verticală Overview.
- Puneti Overview frame pe Map 0. Acest lucru creează un dreptunghi umbrit deasupra hârtii mici, care reprezintă extinderea vizibilă în harta mai mare.
- Selectați, de asemenea, pentru opțiunea Frame o culoare neagră, apoi 0.30 pentru Thickness.

![Image of QGIS Print Layout]

Notice that your overview map is not really giving an overview of the forest area which is what you want. You want this map to represent the whole forest area and you want it to show only the background map and the forest_stands_2012 layer, and not display the sample plots. And also you want to lock its view so it does not change anymore whenever you change the visibility or order of the layers.

- Go back to the map, but don’t close the Print Layout.
- Clic dreapta pe stratul forest_stands_2012, apoi pe Zoom to Layer Extent.
- Dezactivați toate straturile, cu excepția basic_map și forest_stands_2012.
- Go back to the Print Layout.
- Având selectată harta mică, faceti clic pe Set to map canvas extent, pentru a seta extinderile până la care se poarte vedea în fereastră hârtii.
- Blocați ecranul pentru harta generală prin bifarea Lock layers for map item sub Main properties.
Acum imaginea de ansamblu a hârtiei este mai apropiată de ceea ce dorim, și în plus, nu se va mai schimba. Însă, acum harta detaliată nu mai are margini și nici parcele esanțion. Haideți să le remediem:

- Merget din nou la fereastra hârtiei și selectați straturile pe care le doriti să fie vizibile (systematic_plots_clip, forest_stands_2012 copy și Basic_map).
- Transfocați iarăși, pentru a avea vizibile doar câteva linii ale parcelelor.
- Go back to the Print Layout window.
- Select the bigger map in your layout.
- În Proprietățile elementului faceți clic pe Update preview și pe Set to map canvas extent.

Observați că numai harta mai mare afișează vizualizarea curentă a hârtii, iar harta mai mică de ansamblu păstrează aceeași vedere pe care ati blocat-o.

Retineți, de asemenea, că o vedere de ansamblu afișează un cadru umbrat pentru extinderea prezentată în harta detaliată.

Șablonul hârtiei dvs. este aproape gata. Adăugați în hârtă cele două casele de text de mai jos, una conținând textul «Zona detaliată a hârtiei», iar cealaltă «Observații». Plasați-le așa cum se vede în imaginea de mai sus.

Puteți adăuga, de asemenea, o sâgeată a Nordului la harta generală:

- Folosiți instrumentul Add image.
- Faceți clic pe colțul din dreapta sus al hârtii imaginii de ansamblu.
- În fila Proprietăților elementului, deschideți Search directories și navigați la imaginea unei sâgeți.
- Sub Image rotation, bifați Sync with map și selectați Map 1 (vizualizarea hârtii).
- Degifați Fundalul.
The basic map layout is ready, now you want to make use of the Atlas tool to generate as many detail maps in this format as you consider necessary.

14.6.6 Follow Along: Crearea unei Acoperiri de Atlas

Acoperirea Atlasului reprezintă doar un strat vectorial care va fi folosit pentru a genera hărțile detaliate, o hartă pentru fiecare entitate din aria de acoperire. Pentru a vă face o idee despre aceasta, iată un set complet de hărți detaliate pentru zona de pădure:

Acoperirea poate fi orice strat existent, dar, de obicei, are mai mult sens crearea unuia în acest scop specific. Haideți să creăm o rețea de poligoane care acoperă zona de pădure:

- În vizualizarea hărții QGIS, deschideți Vector ➤ Research Tools ➤ Vector grid.
- Setați instrumentul așa cum se arată în această imagine:
• Salvați rezultatul ca atlas_coverage.shp.
• Stilizați noul strat atlas_coverage, astfel încât poligoanele să nu aibă umplere.

Noile poligoane acoperă întreaga zonă de pădure și vă conferă o idee despre ceea ce va conține fiecare hartă (creată din fiecare poligon).
14.6.7 **Follow Along: Configurarea Instrumentului Atlas**

Ultimul pas este de a crea instrumentul Atlas:

- Go back to the *Print Layout*.
- În panoul din dreapta, mergeți la fila *Atlas generation*.
- Setați opțiunile după cum urmează:
That tells the Atlas tool to use the features (polygons) inside atlas_coverage as the focus for every detail map. It will output one map for every feature in the layer. The Hidden coverage layer tells the Atlas to not show the polygons in the output maps.

Mai trebuie să fie făcut un lucru. Trebuie să indicați Atlasului care element va fi actualizat pentru fiecare hartă de ieșire. Până acum, probabil că ați ghicit că harta care urmează a fi schimbată pentru fiecare entitate, este cea pe care ați pregătit-o să conțină vederile detaliate ale parcelelor eșantion, ea reprezentând elementul cel mai mare de pe canevas:

- Selectați elementul cel mai mare din hartă.
- Mergeți la fila Proprietățile itemului tab.
- În listă, bifati Controlat de atlas.
- Apoi setați Marging around feature la 10%. Extinderea vederii va fi cu 10% mai mare decât poligoanele, ceea ce înseamnă că detaliile hârților vor avea o suprapunere de 10%.
Acum puteți utiliza instrumentul de vizualizare pentru Atlas, pentru a revizui ceea ce vor arăta hărțile:

- Puteți folosi săgețile din bara de instrumente a Atlasului, sau din meniul Atlas, pentru a vă deplasa printre hărțile care vor fi create.

Rețineți că unele dintre ele acoperă zone care nu sunt interesante. Haideți să facem ceva și să salvăm niște copaci, neimprimând aceste hărți inutil.

14.6.8 Follow Along: Editarea Stratului de Acoperire

Pe lângă eliminarea poligoanelor pentru acele zone care nu sunt interesante, puteți personaliza, de asemenea, etichetele din harta dvs., prin generarea conținutului acestora din Tabela de attribute a stratului de acoperire.

- Mergeti înapoi la vizualizarea hărții.
- Activăți editarea pentru stratul atlas_coverage.
- Selectați poligoanele care sunt evidențiate (în galben) în imaginea de mai jos.
- Eliminați poligoanele selectate.
- Dezactivați editarea și salvați modificările.
You can go back to the Print Layout and check that the previews of the Atlas use only the polygons you left in the layer.

Stratul de acoperire pe care îl utilizați, încă nu conține informații utile, pe care să le puteți folosi la personalizarea conținutului etichetelor din hartă. Primul pas este de a le crea; în acest scop puteți adăuga, de exemplu, un cod de zonă pentru zonele poligonale, și un câmp cu câteva observații pe care să le aibă în vedere echipele din teren:

- Deschideți Tabela de atribut pentru stratul atlas_coverage.
- Activează editarea.
- Folosiți calculatorul pentru a crea și popula următoarele două câmpuri.
- Creați un câmp denumit Zonă șiastați Număr întreg (integer).
- În caseta Expresiei scrieți/copiați/construiți $rownum.
- Creați un alt câmp denumit Observații, de tipul Text (șir) și cu dimensiunea de 255.
- În caseta Expression scrieți 'No remarks.'. Acest lucru va seta toate valorile implicate pentru toate poligoanele.

Managerul silvic va obține unele informații din zonă, care ar putea fi utile atunci când se va vizita suprafața respectivă. De exemplu, existența unui pod, a unei mlaștini, sau locația unei specii protejate. Deoarece stratul
atlas_coverage probabil că se află încă, în modul de editare, adăugați, în continuare, următorul text în câmpul Remarks poligoanelor corespunzătoare (dublu clic pe celulă pentru a o edita):

- **Pentru Zona 2:** Podul din Nordul planului 19. Veverită siberiană între p_13 și p_14.
- **Pentru Zona 6:** Dificil de tranzitat mlaștina, în nordul lacului.
- **Pentru Zona 7:** Veverită siberiană în Sud Estul p_94.
- Dezactivează editarea și salvează modificările.

Aproape de final, trebuie să-i spuneti instrumentului Atlas că doriti ca unele dintre etichetele de text să utilizeze informatiile din tabela de atribute a stratului atlas_coverage.

- Go back to the Print Layout.
- Selectați eticheta care conține textul Hartă detaliată....
- Setați dimensiunea Fontului la 12.
- Ducesi cursorul la sfârșitul textului din etichetă.
- In the Item properties tab, inside the Main properties click on Insert or Edit an Expression....
- În Lista functiilor faceți dublu clic pe câmpul Zonă de sub Câmpuri și Valori.
- Clic pe OK
- Textul din interiorul casetei Item properties ar trebui să prezinte *Detail map inventory zone: [% "Zone" %]*. Retineți că [% "Zona" %] va fi substituită de valoarea Zone, pentru entitatea corespunzătoare din stratul atlas_coverage.

Testați conținutul etichetei, prin vizualizarea unor diferite hărți din Atlas.

Do the same for the labels with the text Remarks: using the field with the zone information. You can leave a break line before you enter the expression. You can see the result for the preview of zone 2 in the image below:
Utilizați previzualizarea din Atlas pentru a naviga prin toate hărțile care vor fi create în curând!

### 14.6.9 Follow Along: Tipărirea Hărtilor


Hai de să exportăm hărțile într-un singur PDF pe care îl puteți trimite la biroul teritorial pentru imprimare:

- Mergeti la fila Atlas generation, în panoul din dreapta.
- Sub Output bifați Single file export when possible. Acest lucru va pune toate hărțile împreună într-un fișier PDF; în cazul în care această opțiune nu este bifată, veți obține câte un fișier pentru fiecare hartă.
- Open Layout ➤ Export as PDF….  
- Salvați fișierul PDF inventory_2012_maps.pdf în folderul exercise_data\forestry\samplig\map_creation\.

Deschideți fișierul PDF pentru a verifica dacă totul a mers cum era de așteptat.

Puteți crea la fel de ușor imagini separate pentru fiecare hartă (amintiți-vă să debifați crearea unui singur fișier), unde puteți vedea miniaturile imaginilor care vor fi create:

In the Print Layout, save your map as a layout template as forestry_atlas.qpt in your exercise_data\forestry\map_creation\ folder. Use Layout ➤ Save as Template. You will be able to use this template again and again.

Close the Print Layout and save your QGIS project.

### 14.6.10 In Conclusion

Ați reușit să creați o hartă șablon, care poate fi folosită pentru a genera automat hărți detaliate, în scopul ușurării utilizării în teren. După cum ați observat, acest lucru nu a fost o sarcină ușoară, dar beneficiul va veni atunci când va trebui să creați hărți similare pentru alte regiuni, unde puteți utiliza șablonul pe care tocmai l-ati salvat.
14.6.11 What’s Next?

În lectia următoare, veți vedea cum se pot utiliza datele LIDAR pentru a crea un DEM, pe care să-l utilizați la îmbunătățirea vizibilitatea datelor și hârtiilor dvs.

14.7 Lesson: Calcularea Parametrilor Forestieri

Estimarea parametrilor unei păduri reprezintă scopul inventarului forestier. Continuând exemplul din lecția precedentă, vom utiliza informațiile de inventar adunate din teren pentru a calcula parametrului, mai întâi pentru întreaga pădure, iar ulterior pentru pălcurile digitizate anterior.

Scopul acestei lecții: De a calcula parametrii forestieri la nivel general și la nivel de pâlc.

14.7.1 Follow Along: Adăugarea Rezultatelor Inventarului

Echipele din teren au vizitat pădurea și, cu ajutorul informațiilor pe care le-ă furnizate dvs., au adunate informațiile despre fiecare parcelă de pădure.

Most often the information will be collected into paper forms in the field, then typed to a spreadsheet. The sample plots information has been condensed into a .csv file that can be easily open in QGIS.

Continue with the QGIS project from the lesson about designing the inventory, you probably named it forest_inventory.qgs.

În primul rând, adăugați măsurătorile din suprafețele de probă în proiectul dvs. QGIS:

1. Mergeți la Layer ► Add Delimited Text Layer....
2. Browse to the file systematic_inventory_results.csv located in exercise_data/forestry/results/.
3. Asigurați-vă că este selectată opțiunea Point coordinates.
4. Set the fields for the coordinates to the X and Y fields.
5. Clic pe OK
6. When prompted, select ETRS89 / ETRS-TM35FIN as the CRS.
7. Deschideți noul Tabel de Atribute și aruncați o privire datelor.

You can read the type of data that is contained in the sample plots measurements in the text file legend_2012_inventorydata.txt located in the exercise_data/forestry/results/ folder.

The systematic_inventory_results layer you just added is actually just a virtual representation of the text information in the .csv file. Before you continue, convert the inventory results to a real spatial dataset:

1. Right click on the systematic_inventory_results layer.
2. Browse to exercise_data/forestry/results/ folder.
3. Name the file sample_plots_results.shp.
4. Bifati caseta Add saved file to map.
5. Remove the systematic_inventory_results layer from your project.
14.7.2  Follow Along: Parametri de Evaluare a Întregii Păduri

You can calculate the averages for this whole forest area from the inventory results for the some interesting parameters, like the volume and the number of stems per hectare. Since the systematic sample plots represent equal areas, you can directly calculate the averages of the volumes and number of stems per hectare from the sample_plots_results layer.

Puteți calcula media unui câmp dintr-un strat vectorial, folosind instrumentul Basic statistics:

2. Select sample_plots_results as the Input Vector Layer.
3. Select Vol as Target field.
4. Click on OK

The average volume in the forest is 135.2 m$^3$/ha.

You can calculate the average for the number of stems in the same way, 2745 stems/ha.

14.7.3  Follow Along: Estimarea Parametrilor Zonali

Puteți folosi același esantion de date pentru a calcula estimări pentru diferitele pălcuri de pădure digitizate anterior. Despre unele pălcuri nu există date și, de aceea, pentru ele nu se vor obține informații. S-ar fi putut prevedea o culegere de date suplimentară, la momentul planificării inventarului sistematic, în cadrul căreia echipele din teren să fi efectuat măsurători. Sau, ar putut fi trimisă ulterior o echipă în teren pentru a estima pălcurile omise, în scopul completării inventarului. Chiar și așa, veți obține informații pentru un număr bun de pălcuri folosind doar parcelele planificate.

Trebuie să obțineți media parcelelor care se încadrează în fiecare pâlc forestier. Atunci când doriți să combinați informațiile, în funcție de locațiile relative ale acestora, veți efectua o îmbinare spațială:

1. Deschideți instrumentul Vector ► Data Management ► Join attributes by location.
2. Set forest_stands_2012 as the Target vector layer. The layer you want the results for.
3. Set sample_plots_results as the Join vector layer. The layer you want to calculate estimates from.
4. Bifți Take summary of intersecting features.
5. Bifți pentru a calcula doar Media.

6. Name the result as `forest_stands_2012_results.shp` and save it in the `exercise_data/forestry/results/` folder.

7. La final, selectați `Keep all records…`, astfel încât să puteți verifica mai târziu care locație nu a primit informații.

8. Clic pe `OK`


10. Închideți instrumentul de `Îmbinare a atributelor după locație`.

Open the `Attribute table` for `forest_stands_2012_results` and review the results you got. Note that a number of forest stands have `NULL` as the value for the calculations, those are the ones having no sample plots. Select them all and view them in the map, they are some of the smaller stands:
Let's calculate now the same averages for the whole forest as you did before, only this time you will use the averages you got for the stands as the bases for the calculation. Remember that in the previous situation, each sample plot represented a theoretical stand of 80×80 m. Now you have to consider the area of each of the stands individually instead. That way, again, the average values of the parameters that are in, for example, m³/ha for the volumes are converted to total volumes for the stands.

Trebuie să calculați mai întâi ariile pentru locații, iar apoi volumele totale și numărul de tulpini pentru fiecare dintre acestea:

1. Activiți editarea în Tabela de Atribute.
2. Deschideți Calculatorul de câmpuri.
3. Create a new field called area.

4. Set the Output field type to Decimal number (real).

5. Set the Precision to 2.

6. In the Expression box, write $area / 10000$. This will calculate the area of the forest stands in ha.

7. Clic pe OK

Acum calculați un câmp cu volumele totale și numărul estimat de tulpini, pentru fiecare element:

1. Name the fields s_vol and s_stem.

2. Valorile numerice din câmpurile pot fi de tip întreg sau chiar și de tip real.

3. Use the expressions "area" * "MEANVol" and "area" * "MEANStems" for total volumes and total stems respectively.

4. Închideți editările, după ce ati încheiat.

5. Dezactivăți editarea.

În situația anterioară, zonele reprezentate de fiecare parcelă eșantion au fost aceleași, astfel încât a fost suficientă calcularea mediei parcelelor eșantion. Acum, pentru a calcula estimările, trebuie să împărțim suma volumelor pâlcurilor, sau numărul de tulpini, la suma suprafețelor acelor pâlcuri care conțin informații.

1. In the Attribute table for the forest_stands_2012_results layer, select all the stands containing information.

2. Open Vector ► Analysis Tools ► Basic statistics for fields.

3. Select the forest_stands_2012_results as the Input layer.

4. Select area as Field to calculate statistics on.

5. Check the Selected features only

6. Clic pe OK
As you can see, the total sum of the stands' areas is 66.04 ha. Note that the area of the missing forest stands is only about 7 ha.

In the same way, you can calculate that the total volume for these stands is 8908 m³/ha and the total number of stems is 179594 stems.

Folosind informațiile din pălcurile forestiere, în locul folosirii directe a celor din parcelele esanțion, rezultă următoarele estimări medii:

- 184.9 m³/ha and
- 2719 stems/ha.

Save your QGIS project, forest_inventory.qgs.

14.7.4 In Conclusion

Ați reușit să efectuați estimări pentru întreaga pădure, folosind informațiile din parcelele de probă, fără a ține seama de caracteristicile forestiere, precum și utilizând interpretarea imaginilor aeriene ale pălcurilor forestiere. De asemenea, ați primit informații valoroase despre anumite pălcuri, care pot fi utilizate pentru gestionarea pădurilor în anii următori.
14.7.5 What’s Next?

În lecția următoare, veți crea mai întâi un fundal reliefat, dintr-un set de date LiDAR, care va fi folosit pentru a pregăti prezentarea pe hartă a rezultatelor forestiere, pe care tocm și le-ți calculat.

14.8 Lesson: Crearea unui DEM din datele LiDAR

Puteți îmbunătăți aspectul hărți folosind diverse imagini de fundal. Ați putea folosi harta de bază sau imaginile aeriene pe care le-ți utilizat înainte, dar un raster cu relieful terenului va arata mai frumos în anumite situații.

Veți folosi LAStools pentru a extrage un DEM dintr-un set de date LIDAR, și apoi să creați un raster al reliefului pe care să-l folosiți mai târziu în prezentarea hărții dvs.

**Scopul acestei lecții:** Instalarea LAStools și calcularea unui DEM din datele LiDAR și dintr-un raster cu relief.

14.8.1 Follow Along: Instalarea Lastools

Managing LiDAR data within QGIS is possible using the Processing framework and the algorithms provided by LAStools.

Puteți obține un model de elevație digital (DEM), dintr-un nor de puncte LiDAR, iar ulterior se poate crea un raster al umbririi reliefului, care este vizual mai intuitiv în scopuri de prezentare. În primul rând, va trebui să configurați setările cadrului de lucru *Processing* pentru a lucra în mod corespunzător cu LAStools:

- Închideți QGIS, dacă ați început deja.
- Un plugin LiDAR vechi ar putea fi deja instalat în sistemul dvs., în dosarul C:/Program Files/QGIS Valmiera/apps/qgis/python/plugins/processing/.
- Dacă aveți un folder denumit lidar, ștergeți-l. Acest lucru este valabil pentru anumite instalări de QGIS 2.2 și 2.4.
• Go to the `exercise_data\forestry\lidar\` folder, there you can find the file `QGIS_2_2_toolbox.zip`. Open it and extract the `lidar` folder to replace the one you just deleted.

• If you are using a different QGIS version, you can see more installation instructions in this tutorial.

Now you need to install the LAStools to your computer. Get the newest `lastools` version [here](#) and extract the content of the `lastools.zip` file into a folder in your system, for example, `C:\lastools\`. The path to the `lastools` folder cannot have spaces or special characters.

**Nota:** Cititi fisierul LICENSE.txt din interiorul folderului lastools. Unele dintre aceste instrumente LAS sunt gratuite, pe cind altele nu, acestea necesitand licentiere pentru utilizare comerciala si guvernamental. In scopuri educationale sau de evaluare, puteți utiliza și testa LAStools oricat de mult doriți.

Plugin-ul și algoritmele curente sunt de acum instalat în computerul dvs., aproape gata de utilizare, fiind nevoie doar să confruntai cadrul de lucru Processing pentru a începe utilizarea lor:

• Deschideți un nou proiect în QGIS.

• Setați ETRS89 / ETRS-TM35FIN ca CRS al proiectului.

• Salvați proiectul ca `forest_lidar.qgs`.

Pentru a seta LAStools în QGIS:

• Mergeti la `Processing ▶ Options and configuration`.

• În dialogul `Opțiunilor de procesare`, mergeti la `Furnizori` și apoi la `Instrumente pentru datele LiDAR`.

• Bifati `Activare`.

• Pentru Folderul LAStools setati `c:\lastools\` (sau folderul în care ați extras LAStools).
14.8.2  

Follow Along: Calcularea unui DEM, cu ajutorul LAStools

Ați folosit deja bara de instrumente *Processing* din *Lesson: Statistici Spațiale* pentru a rula câțiva algoritmi SAGA. Acum o veți utiliza pentru a rula programele LAStools:

- Deschideți *Processing* → *Toolbox*.
- În meniu derulant din partea inferioară, selectați *Interfață avansată*.
- Ar trebui să vedeti categoria *Instrumentelor pentru datele LiDAR*.
• Extindeți-o pentru a vedea instrumentele disponibile, apoi extindeți, de asemenea, categorie LASTools (numărul de algoritmi poate varia).

• Derulați în jos până când găsiți algoritmul lasview, apoi faceți dublu-clic pentru a-l deschide.

• At Input LAS/LAZ file, browse to exercise_data\forestry\lidar\ și select the rautjarvi_lidar.laz file.

• Clic pe Run

Acum puteți vedea datele LiDAR în fereastra dialogului Doar un mic vizualizator LAS și LAZ:
Există multe alte lucruri pe care le puteți efectua în cadrul acestui vizualizator, dar pentru moment trebuie doar să faceți un clic și să glisați norul de puncte LiDAR, pentru a vedea cum arată.

**Notă:** If you want to know further details on how the LAStools work, you can read the README text files about each of the tools, in the C:\lastools\bin\ folder. Tutorials and other materials are available at the Rapidlasso webpage.

- Închideți vizualizatorul atunci când sunteti gata.

Crearea unui DEM cu LAStools se poate face în două etape, mai întâi pentru a clasifica norul de puncte în ground și no ground, iar apoi pentru a calcula DEM-ul folosind numai punctele ground.

- Mergeti înapoi la *Bara Instrumentelor de Procesare*.
- Notați *Search*... box, write *lasground*.
- Dublu clic pentru a deschide instrumentul *lasground*, apoi setați-l așa cum se arată în această imagine:
The output file is saved to the same folder where the `rautjarvi_lidar.laz` is located and it is named `rautjarvi_lidar_1.las`.

Puteti sa-l deschide cu `lasview`,

•
The brown points are the points classified as ground and the gray ones are the rest, you can click the letter g to visualize only the ground points or the letter u to see only the unclassified points. Click the letter a to see all the points again. Check the lasview_README.txt file for more commands. If you are interested, also this tutorial about editing LiDAR points manually will show you different operations within the viewer.

• Închideti iarăsi vizualizatorul.
• În Processing Toolbox, căutați las2dem.
• Deschideți instrumentul las2dem, apoi setați-l așa cum se arată în această imagine:
DEM-ul rezultat este adăugat la hartă cu numele generic **Output raster file**.

**Notă:** Instrumentele **lasground** și **las2dem** necesită licențiere. Le puteți utiliza chiar și în lipsa licenței, așa cum este indicat în fisierele licenței, dar veți obține diagonale în imaginile rezultate.

### 14.8.3 Follow Along: Crearea unui Teren Reliefat

For visualization purposes, a hillshade generated from a DEM gives a better visualization of the terrain:

- Deschideți **Raster ➤ Terrain analysis ➤ Hillshade**.
- As the **Output layer**, browse to `exercise_data\forestry\lidar\` and name the file `hillshade.tif`.
- Lasă restul parametrilor la setările implicite.
• Selectați ETRS89 / ETRS–TM35FIN ca și CRS, atunci când vi se solicită.

În ciuda liniilor diagonale rămase în relieful rasterului rezultat, puteți vedea în mod clar un relief exact al zonei. Puteți vedea chiar și diferite albii săpate de curgerea apelor prin pădure.
14.8.4 In Conclusion

Using LiDAR data to get a DEM, specially in forested areas, gives good results with not much effort. You could also use ready LiDAR derived DEMs or other sources like the SRTM 9m resolution DEMs. Either way, you can use them to create a hillshade raster to use in your map presentations.
14.8.5 What’s Next?

În următorul, și ultimul pas din acest modul, veți folosi un raster rezultat și rezultatele inventarului forestier pentru a crea o prezentare pentru harta rezultatelor.

14.9 Lesson: Prezentarea Hărții

În lecțiile anterioare ați importat, sub formă de proiect GIS, un vechi inventar de pădure, l-ați actualizat, ați proiectat un inventar, ați creat hărți pentru munca de teren și ați calculat parametrii pădurii folosind măsurătorile din teren.

Adesea, pentru a prezenta rezultatele, este importantă crearea de hărți, în cadrul unui proiect GIS. O hârtie care prezintă inventarul forestier va facilita înțelegerea acestuia dintr-o simplă privire, fără analiza detaliată a cifrelor.

Scopul acestei lecții: De a crea o hârtie care să prezinte rezultatele inventarerii, folosind ca fundal un raster al reliefului umbrăt.

14.9.1 Follow Along: Pregătirea Datelor Hărții

Deschideți proiectul QGIS din lecția de calculare a parametrilor, forest_inventory.qgs. Păstrați cel puțin următoarele straturi:

- forest_stands_2012_results.
- basic_map.
- rautjarvi_aerial.
- kbd:
  - lakes (dacă nu iți aveți, adăugați-l din exercise_data\forestry\folder).

You are going to present the average volumes of your forest stands in a map. If you open the Attribute table for the forest_stands_2012_results layer, you can see the NULL values for the stands without information. To be able to get also those stands into your symbology you should change the NULL values to, for example, -999, knowing that those negative numbers mean there is no data for those polygons.

Pentru stratul forest_stands_2012_results:

- Deschideți Tabela sa de Atribute și activați editarea.
- Selectați poligoanele cu valoarea NULL.
- Utilizați calculatorul pentru a actualiza valorile din câmpul MEANVol la -999, doar pentru entitățile selectate.
- Dezactivați editarea și salvați modificările.

Acum puteți un stil implicit pentru acest strat:

- Go to the Symbology tab.
- Click on Style ➤ Load Style....
- Selectați folderul forest_stands_2012_results.qml from the exercise_data\forestry\results\.
- Clic pe OK
Harta dvs. va arăta în felul următor:
14.9.2  Try Yourself Încercați Diferite Moduri de Amestecare

Stilul pe care l-ați încărcat:
is using the **Hard light** mode for the *Layer blending mode*. Note that the different modes apply different filters combining the underlying and overlying layers, in this case the hillshade raster and your forest stands are used. You can read about these modes in the User Guide.

Încercați în diverse moduri și observați diferențele în hartă. Apoi, stabiliți unul care vă place cel mai mult pentru harta finală.

### 14.9.3 Try Yourself Using a Layout Template to Create the Map result

Use a template prepared in advanced to present the results. The template `forest_map.qpt` is located in the `exercise_data\forestry\results\` folder. Load it using the *Project ➤ Layout Manager…* dialog.
Open the print layout and edit the final map to get a result you are happy with.

Șablonul hărții pe care îl utilizați vă va oferi o hârtă similară cu aceasta:
Rautjärvi Forest
- Inventory Results 2012 -

Stand Results
Stand volume (m³/ha)
- No data
- 0 - 15
- 15 - 25
- 25 - 50
- 50 - 100
- 100 - 150
- 150 - 300

- Results for the whole forest area -
Using Systematic Sample plots
Total area: 72.9
Total volume (m³): 9856
Average volume (m³/ha): 135.2
Using Stand Sample Plots Averages
Total area: 72.9
Total volume (m³): 13479
Average volume (m³/ha): 184.9

Salvați proiectul dumneavoastră QGIS ca referință pentru viitor.
14.9.4 In Conclusion

Prin intermediul acestui modul ați văzut cum poate fi planificat și prezentat un inventar forestier de bază în QGIS. Mult mai multe analize forestiere sunt posibile în varietatea de instrumente pe care le puteți accesa, dar sperăm că acest manual va oferi un bun punct de plecare pentru a explora noi modalități de obținere a rezultatelor dorite.
Noțiuni despre Bazele de date folosind PostgreSQL

Baze de date relaționale sunt o parte importantă a oricărui sistem GIS. În acest modul, veți învăța despre Sistemele de Gestionează Bazele de date Relaționale (RDBMS), utilizând PostgreSQL pentru a crea o nouă bază de date în scopul stocării datelor, și veți afla despre alte funcții tipice RDBMS.

15.1 Lesson: Introducere în Baze de date

Înainte de a utiliza PostgreSQL, să ne asigurăm de terenul nostru prin acoperirea teoriei generale a bazelor de date. Nu va fi nevoie să introduceți codul exemplificat; acesta este prezent doar în scopuri ilustrative.

Scopul acestei lecții: De a înțelege conceptele fundamentale ale bazelor de date.

15.1.1 Ce este o bază de date?

O bază de date constă într-o colecție organizată de date, pentru una sau mai multe utilizări, de obicei în formă digitală. - Wikipedia

Un sistem de management al bazelor de date (DBMS) este format din software care operează bazele de date, oferind depozitare, acces, securitate, backup și alte facilități. - Wikipedia

15.1.2 Tabele

În bazele de date tradiționale și în bazele de date tip fișier, o tabelă este un set de elemente de date (valori) care este organizat utilizând un model de coloane verticale (care sunt identificate prin numele lor) și de rânduri orizontale. O tabelă are un număr specificat de coloane, dar poate avea oricâte rânduri. Fiecare rând este identificat prin valorile unui anumit subset de coloane care a fost identificat ca o potențială cheie. - Wikipedia

<table>
<thead>
<tr>
<th>id</th>
<th>name</th>
<th>age</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Tim</td>
<td>20</td>
</tr>
<tr>
<td>2</td>
<td>Horst</td>
<td>88</td>
</tr>
</tbody>
</table>

În bazele de date SQL, o tabelă este, de asemenea, cunoscută ca relație.
15.1.3 Coloane / Câmpuri

O coloană este un set de valori de date având un anume tip simplu, câte una pentru fiecare rând din tabel. Coloanele\nfunizează structura pe baza căreia se compune fiecare rând. Termenul de câmp este utilizat interschimbabil cu\coloană, deși mulți consideră că este mai corect să se utilizeze câmp (sau valoare a câmpului) când este vorba de\elementul care există la intersecția dintre o coloană și un rând. - Wikipedia

O coloană:

```
<table>
<thead>
<tr>
<th>name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tim</td>
</tr>
<tr>
<td>Horst</td>
</tr>
</tbody>
</table>
```

Un câmp:

```
| Horst |
```

15.1.4 Înregistrări

O înregistrare reprezintă informația stocată într-un rând din tabelă. Fiecare înregistrare va avea câte un câmp pentru\fiecare dintre coloanele tabelei.

```
2 | Horst | 88  --- one record
```

15.1.5 Tipuri de date

Tipurile de date restrâng tipurile de informații care pot fi stocate într-o coloană. - Tim and Horst

Există mai multe feluri de tipuri de date. Să ne concentrăm pe cele mai comune:

- **String** - to store free-form text data
- **Integer** - to store whole numbers
- **Real** - to store decimal numbers
- **Date** - to store Horst’s birthday so no one forgets
- **Boolean** - to store simple true/false values

You can tell the database to allow you to also store nothing in a field. If there is nothing in a field, then the field\content is referred to as a «null» value:

```
insert into person (age) values (40);

select * from person;
```

Rezultat:

```
id | name | age
-------+-------+-----
1  | Tim  | 20  
2  | Horst| 88  
4  |      | 40  <--- null for name
(3 rows)
```

There are many more datatypes you can use - check the PostgreSQL manual!
15.1.6 Modelarea unei Baze de Date cu Adreze

Să folosim un studiu de caz simplu, pentru a vedea cum este construită o bază de date. Dorim să creăm o bază de date cu adrese.

**Try Yourself**

Notăți proprietățile care alcătuiesc o adresă simplă și pe care am dori să le stocăm în baza noastră de date.

*Check your results*

**Structura Adresei**

Proprietățile care descriu o adresă sunt coloanele. Tipul de informație stocat în fiecare coloană este tipul de date al acesteia. În secțiunea următoare vom analiza tabela noastră conceptuală de adrese pentru a vedea cum o putem îmbunătăți!

15.1.7 Teoria Bazelor de Date

Procesul de creare a unei baze de date presupune crearea unui model al lumii reale; luând concepte din lumea reală și reprezentându-le, ca entități, în baza de date.

15.1.8 Normalizarea

Un concept de bază al bazelor de date este evitarea duplicării / redundanței datelor. Procesul eliminării redundanței dintr-o bază de date este numit Normalizare.

Normalizarea este o metodă sistemică de garantare că structura bazei de date este potrivită pentru interogări de uz general și nu prezintă anumite caracteristici - anumii de inserare, modificare sau ștergere - care ar putea duce la pierderea integrității datelor. - *Wikipedia*

Există diferite tipuri de «forme» de normalizare.

Let’s take a look at a simple example:

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>integer</td>
<td>not null default, nextval('people_id_seq'::regclass)</td>
</tr>
<tr>
<td>name</td>
<td>character varying(50)</td>
<td></td>
</tr>
<tr>
<td>address</td>
<td>character varying(200)</td>
<td>not null</td>
</tr>
<tr>
<td>phone_no</td>
<td>character varying</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:

"people_pkey" PRIMARY KEY, btree (id)

```sql
select * from people;
```

<table>
<thead>
<tr>
<th>id</th>
<th>name</th>
<th>address</th>
<th>phone_no</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Tim Sutton</td>
<td>3 Buirski Plein, Swellendam</td>
<td>071 123 123</td>
</tr>
<tr>
<td>2</td>
<td>Horst Duester</td>
<td>4 Avenue du Roix, Geneva</td>
<td>072 121 122</td>
</tr>
</tbody>
</table>

(2 rows)
Imaginați-vă că aveți mulți prieteni cu același nume de stradă sau oraș. Fiecare dintre aceste date sunt duplicate, consumând spațiu. Mai rau, dacă un nume de oraș se schimbă, trebuie să depuneți mult efort pentru a actualiza baza de date.

15.1.9 Try Yourself

Reproiectați tabelă people de mai sus pentru a reduce duplicarea și pentru a normaliza structura de date.

You can read more about database normalisation here

Check your results

15.1.10 Indecși

Un index în baza de date este o structură de date care îmbunătățește viteză operațiilor de extragere de date dintr-o tabelă a bazelor de date. - Wikipedia

Imagine you are reading a textbook and looking for the explanation of a concept - and the textbook has no index! You will have to start reading at one cover and work your way through the entire book until you find the information you need. The index at the back of a book helps you to jump quickly to the page with the relevant information:

```
cREATE INDEX person_name_idx ON people (name);
```

Now searches on name will be faster:

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>integer</td>
<td>not null default</td>
</tr>
<tr>
<td></td>
<td></td>
<td>nextval('people_id_seq '::regclass)</td>
</tr>
<tr>
<td>name</td>
<td>character varying(50)</td>
<td></td>
</tr>
<tr>
<td>address</td>
<td>character varying(200)</td>
<td>not null</td>
</tr>
<tr>
<td>phone_no</td>
<td>character varying</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:

"people_pkey" PRIMARY KEY, btree (id)
"person_name_idx" btree (name)

15.1.11 Secvențe

O secvență este un generator de numere unice. Este utilizat în mod normal pentru a crea un identificator unic pentru o coloană a unei tabele.

In this example, id is a sequence - the number is incremented each time a record is added to the table:

```
<table>
<thead>
<tr>
<th>id</th>
<th>name</th>
<th>address</th>
<th>phone_no</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Tim Sutton</td>
<td>3 Buirkis Plein, Swellendam</td>
<td>071 123 123</td>
</tr>
<tr>
<td>2</td>
<td>Horst Duster</td>
<td>4 Avenue du Roix, Geneva</td>
<td>072 121 122</td>
</tr>
</tbody>
</table>
```
15.1.12 Diagrama Relațiilor dintre Entități

Într-o bază de date normalizată, există în mod uzual multe relații (tabel). Diagrama relațiilor între entități (Diagrama ER) este utilizată pentru stabilirea dependențelor logice între relații. Să examinăm tabelă noastră nenormalizată people, utilizată anterior în cadrul lecției:

```sql
select * from people;
```

<table>
<thead>
<tr>
<th>id</th>
<th>name</th>
<th>address</th>
<th>phone_no</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Tim Sutton</td>
<td>3 Buirski Plein, Swellendam</td>
<td>071 123 123</td>
</tr>
<tr>
<td>2</td>
<td>Horst Duster</td>
<td>4 Avenue du Roix, Geneva</td>
<td>072 121 122</td>
</tr>
</tbody>
</table>

(2 rows)

With a little work we can split it into two tables, removing the need to repeat the street name for individuals who live in the same street:

```sql
select * from streets;
```

<table>
<thead>
<tr>
<th>id</th>
<th>name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Plein Street</td>
</tr>
</tbody>
</table>

(1 row)

and:

```sql
select * from people;
```

<table>
<thead>
<tr>
<th>id</th>
<th>name</th>
<th>house_no</th>
<th>street_id</th>
<th>phone_no</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Horst Duster</td>
<td>4</td>
<td>1</td>
<td>072 121 122</td>
</tr>
</tbody>
</table>

(1 row)

Putem apoi lega cele două tabele utilizând «keys» streets.id si people.street_id.

Dacă desenăm o Diagramă ER pentru aceste două tabele ar arăta cam așa:

![Diagrama ER people-streets](image)

Diagrama ER ne ajută să exprimăm relații «unul la mulți». În acest caz simbolul săgeată spune că pe o stradă pot locui mai mulți oameni.

**Try Yourself**

Modelul nostru people are încă niște probleme de normalizare - încercați să îl normalizați în continuare și ilustrați-vă ideile prin-o Diagramă ER.

*Check your results*
15.1.13 Constrângeri, Chei Primare și Chei Externe

O constrângere într-o bază de date este utilizată pentru a garanta că o relație se potrivește cu viziunea celui care a modelat baza de date despre cum ar trebui stocate datele. De exemplu o constrângere pentru codul postal ar putea garanta că numărul trebuie să se afle între 1000 și 9999.

O cheie Primară este compusă din unul sau mai multe câmpuri care fac o înregistrare unică. În mod uzual cheia primară se numește id și este o secvență.

O cheie Externă este utilizată pentru a face legătura unei înregistrări cu o altă tabelă (folosind cheia primară a acelui tabel).

În Diagramele ER, legăturile dintre tabele sunt în mod normal bazate pe chei Externe legate de chei Primare.

If we look at our people example, the table definition shows that the street column is a foreign key that references the primary key on the streets table:

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>integer</td>
<td>not null default</td>
</tr>
<tr>
<td>name</td>
<td>character varying</td>
<td></td>
</tr>
<tr>
<td>house_no</td>
<td>integer</td>
<td>not null</td>
</tr>
<tr>
<td>street_id</td>
<td>integer</td>
<td>not null</td>
</tr>
<tr>
<td>phone_no</td>
<td>character varying</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
"people_pkey" PRIMARY KEY, btree (id)

Foreign key constraints:
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

15.1.14 Tranzacții

La adăugarea, modificarea sau ștergerea datelor într-o bază de date, este important ca de fiecare dată baza de dată să rămână într-o stare bună în cazul în care ceva nu merge bine. Cele mai multe baze de date pun la dispoziție o facilitate numită tranzacție. Tranzacțiile permit crearea unui moment de revenire la care vă puteți întoarce dacă modificările bazei de date nu au funcționat conform planului.

Să considerăm un scenariu în care aveți un sistem contabil. Trebuie să transferați fonduri dintr-un cont și să le adăugați în altul. Secvența de pași ar fi:

- eliminați R20 din Joe
- adăugați R20 la Anne

Dacă ceva nu merge bine în cadrul procesului (ex. pană de curent), tranzacția va reveni.

15.1.15 In Conclusion

Bazele de date permit administrarea datelor într-un mod structurat utilizând structuri de cod simple.
15.1.16 What’s Next?

Acum că am văzut cum funcționează teoretic bazele de date, să creăm o bază de date nouă pentru a implementa partea teoretică prezentată.

15.2 Lesson: Implementarea Modelului de Date

Acum, că am acoperit toată teoria, haideti să creăm o bază de date nouă. Această bază de date va fi utilizată în exercițiile noastre din lectiile care vor urma.

Scopul acestei lecții: De a instala soft-ul necesar și de a-l utiliza la implementarea bazei de date exemplu.

15.2.1 Instalare PostgreSQL

Notă: You can find PostGreSQL packages and installation instructions for your operating system at https://www.postgresql.org/download/. Please note that the documentation will assume users are running QGIS under Ubuntu.

Pe Ubuntu:

```
sudo apt install postgresql-9.1
```

Veți obține un mesaj de genul ăsta:

```
[sudo] password for qgis:
Reading package lists... Done
Building dependency tree
Reading state information... Done
The following extra packages will be installed:
postgresql-client-9.1 postgresql-client-common postgresql-common
Suggested packages:
oidentd ident-server postgresql-doc-9.1
The following NEW packages will be installed:
postgresql-9.1 postgresql-client-9.1 postgresql-client-common postgresql-common
0 upgraded, 4 newly installed, 0 to remove and 5 not upgraded.
Need to get 5,012kB of archives.
After this operation, 19.0MB of additional disk space will be used.
Do you want to continue [Y/n]?
```

Apăsați Y și Enter apoi așteptati ca descărcarea și instalarea să se încheie.

15.2.2 Ajutor

PostgreSQL has very good online documentation.
15.2.3 Crearea unui utilizator pentru baza de date

Pe Ubuntu:

After the installation is complete, run this command to become the postgres user and then create a new database user:

```
sudo su - postgres
```

Introducți parola când vi se solicită (aveți nevoie de drepturi sudo).

Now, at the postgres user’s bash prompt, create the database user. Make sure the user name matches your unix login name: it will make your life much easier, as postgres will automatically authenticate you when you are logged in as that user:

```
createuser -d -E -i -l -P -r -s qgis
```

Introduceti o parolă când vi se solicită. Ar trebui să utilizați o parolă diferită pentru parola contului dumneavoastră.

Ce reprezintă aceste opțiuni?

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-d, --createdb</td>
<td>role can create new databases</td>
</tr>
<tr>
<td>-E, --encrypted</td>
<td>encrypt stored password</td>
</tr>
<tr>
<td>-i, --inherit</td>
<td>role inherits privileges of roles it is a member of (default)</td>
</tr>
<tr>
<td>-l, --login</td>
<td>role can login (default)</td>
</tr>
<tr>
<td>-P, --pwprompt</td>
<td>assign a password to new role</td>
</tr>
<tr>
<td>-r, --createrole</td>
<td>role can create new roles</td>
</tr>
<tr>
<td>-s, --superuser</td>
<td>role will be superuser</td>
</tr>
</tbody>
</table>

Now you should leave the postgres user’s bash shell environment by typing:

```
exit
```

15.2.4 Verificați noul cont

```
psql -l
```

Ar trebui să returneze ceva de genul următor:

```
<table>
<thead>
<tr>
<th>Name</th>
<th>Owner</th>
<th>Encoding</th>
<th>Collation</th>
<th>Ctype</th>
</tr>
</thead>
<tbody>
<tr>
<td>postgres</td>
<td>postgres</td>
<td>UTF8</td>
<td>en_ZA.utf8</td>
<td>en_ZA.utf8</td>
</tr>
<tr>
<td>template0</td>
<td>postgres</td>
<td>UTF8</td>
<td>en_ZA.utf8</td>
<td>en_ZA.utf8</td>
</tr>
<tr>
<td>template1</td>
<td>postgres</td>
<td>UTF8</td>
<td>en_ZA.utf8</td>
<td>en_ZA.utf8</td>
</tr>
<tr>
<td>(3 rows)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Type Q to exit.

15.2.5 Crearea unei baze de date

The `createdb` command is used to create a new database. It should be run from the bash shell prompt:

```
createdb address -O qgis
```

You can verify the existence of your new database by using this command:

```
psql -l
```

Which should return something like this:
15.2.6 Pornirea unei sesiuni către baza de date, din linia de comandă

Vă puteți conecta usur la baza de date, procedând astfel:

```
psql address
```

Pentru a ieși din mediul bazei de date psql, tastați:

```
\q
```

Pentru ajutor în utilizarea liniei de comandă, tastați:

```
\?
```

Pentru ajutor în utilizarea comenzii SQL, tastați:

```
\help
```

Pentru a obține ajutor pentru o anumită comandă, tastați (de exemplu):

```
\help create table
```

See also the Psql cheat sheet.

15.2.7 Crearea Tablelor SQL

Let’s start making some tables! We will use our ER Diagram as a guide. First, connect to the address db:

```
psql address
```

Apoi creați o tabelă a străzilor:

```
create table streets (id serial not null primary key, name varchar(50));
```

serial și varchar sunt tipuri de date. serial îi spune lui PostgreSQL să pornească o secvență (generator automat) pentru completarea automată a id pentru fiecare înregistrare nouă. varchar(50) îi spune lui PostgreSQL să creeze un câmp de caractere de lungime 50.

Veți remarca faptul că comanda se termină cu ; - toate comenzile SQL trebuie terminate în acest fel. Când apăsați Enter, psql va raporta ceva de genul:

```
NOTICE: CREATE TABLE will create implicit sequence "streets_id_seq" for serial column "streets.id"
NOTICE: CREATE TABLE / PRIMARY KEY will create implicit index "streets_pkey" for table "streets"
CREATE TABLE
```

---

QGIS Training Manual
Asta înseamnă că tabelul a fost creat cu succes, având cheia primară `streets_pkey` care folosește `streets.id`.

Notă: Dacă apăsați enter fără a introduce ;, veți obține un prompt de tipul: `address-#`. Aceasta deoarece PG așteaptă să mai introduceți ceva. Introduceți ; pentru a executa comanda.

To view your table schema, you can do this:

```
\d streets
```

Which should show something like this:

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>integer</td>
<td>not null default</td>
</tr>
<tr>
<td>name</td>
<td>character varying(50)</td>
<td>nextval('streets_id_seq'::regclass)</td>
</tr>
</tbody>
</table>

Indexes:
- "streets_pkey" PRIMARY KEY, btree (id)

To view your table contents, you can do this:

```
select * from streets;
```

Which should show something like this:

```
<table>
<thead>
<tr>
<th>id</th>
<th>name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>(0 rows)</td>
<td></td>
</tr>
</tbody>
</table>
```

După cum puteți vedea, tabela noastră este vidă, în mod curent.

**Try Yourself**

Folosiți abordarea de mai sus pentru a crea un tabel numit `people`:

Adăugați câmpuri ca număr de telefon, adresa de acasă, nume etc. (acestea nu sunt toate nume valide: schimbați-le pentru a deveni valide). Asigurați-vă că îi adăugați tabelului o coloană ID cu același tip de date ca și mai sus.

**Check your results**

### 15.2.8 Crearea Cheilor în SQL

Problema cu soluția noastră de mai sus este că baza de date nu știe că oamenii și străzile au o relație logică. Pentru a exprima această relație va trebui să definim o cheie externă care face legătura cu cheia primară a tabelului de străzi.

Sunt două moduri de a face asta:

- Adăugați cheia după crearea tabelului
- Definiți cheia la momentul creării tabelului

Our table has already been created, so let’s do it the first way:
**QGIS Training Manual**

```sql
alter table people
   add constraint people_streets_fk foreign key (street_id) references streets(id);
```

Asta spune tabelului `people` că valoarea câmpurilor `street_id` trebuie să fie o valoare validă `id` din tabelul `streets`.

The more usual way to create a constraint is to do it when you create the table:

```sql
create table people (id serial not null primary key,
   name varchar(50),
   house_no int not null,
   street_id int references streets(id) not null,
   phone_no varchar null);
```

After adding the constraint, our table schema looks like this now:

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>integer</td>
<td>not null default nextval</td>
</tr>
<tr>
<td></td>
<td></td>
<td>({'people_id_seq'::regclass)</td>
</tr>
<tr>
<td>name</td>
<td>character varying(50)</td>
<td></td>
</tr>
<tr>
<td>house_no</td>
<td>integer</td>
<td>not null</td>
</tr>
<tr>
<td>street_id</td>
<td>integer</td>
<td>not null</td>
</tr>
<tr>
<td>phone_no</td>
<td>character varying</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
"people_pkey" PRIMARY KEY, btree (id)

Foreign key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets(id)

15.2.9 Crearea de indecși în SQL

We want lightning fast searches on peoples names. To provide for this, we can create an index on the name column of our people table:

```sql
create index people_name_idx on people(name);
```

Which results in:

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>integer</td>
<td>not null default nextval</td>
</tr>
<tr>
<td></td>
<td></td>
<td>({'people_id_seq'::regclass)</td>
</tr>
<tr>
<td>name</td>
<td>character varying(50)</td>
<td></td>
</tr>
<tr>
<td>house_no</td>
<td>integer</td>
<td>not null</td>
</tr>
<tr>
<td>street_id</td>
<td>integer</td>
<td>not null</td>
</tr>
<tr>
<td>phone_no</td>
<td>character varying</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_name_idx" btree (name)  "-- new index added!"

Foreign key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets(id)
15.2.10 Ștergerea Tabelelor în SQL

If you want to get rid of a table you can use the drop command:

```
drop table streets;
```

**Notă:** În exemplul curent, comanda de mai sus nu va funcționa. De ce? *See why*

If you used the same `drop table` command on the `people` table, it would be successful:

```
drop table people;
```

**Notă:** Dacă ați introdus acea comandă și ați șters tabelul `people`, ar fi un moment bun să îl refaceti, deoarece îl veți folosi în exercițiile următoare.

15.2.11 Câteva cuvinte despre pgAdmin III

Prezentăm comenzile SQL de la promptul `psql` pentru că este un mod foarte util de a învăța despre bazele de date. Cu toate acestea, există metode mai rapide și mai ușoare de a face ce am prezentat. Instalați pgAdmin III și veți putea crea, șterge, modifica etc. tabele utilizând operații «point and click» într-un GUI.

Under Ubuntu, you can install it like this:

```
sudo apt install pgadmin3
```

gAdmin III va fi acoperit mai detaliat în alt modul.

15.2.12 In Conclusion

Ați văzut cum să creați o bază de date complet nouă, pornind de la zero.

15.2.13 What’s Next?

În continuare veți învăța cum să folosiți DBMS-ul pentru adăugarea datelor.

15.3 Lesson: Adăugarea de date în Model

Modelele pe care le-am creat vor trebui să fie populate de acum cu datele pe care trebuie să le conțină.

**Scopul acestei lecții:** De a afla cum se pot insera noi date în baza de date a modelelor.
15.3.1 Inserarea instrucțiunilor

Cum adăugați date într-o tabelă? Instrucțiunea SQL INSERT oferă funcționalitatea necesară:

```
insert into streets (name) values ('High street');
```

Mai multe lucruri de reținut:

- După numele tabelului (streets), veți lista numele coloanelor pe care le veți popula (în acest caz, doar coloana name).
- După cuvântul cheie values, plasați lista valorilor de câmp.
- Șirurile de caractere ar trebui să fie citate cu ajutorul ghilimelelor simple.
- Rețineți că nu vom introduce o valoare pentru coloana id; acest lucru se datorează faptului că este o secvență, ea fiind generată în mod automat.
- Dacă setați manual id-ul, pot apărea probleme grave cu integritatea bazei de date.

Ar trebui să vedeti INSERT 0 1 dacă a avut succes.

You can see the result of your insert action by selecting all the data in the table:

```
select * from streets;
```

Rezultat:

```
select * from streets;
<table>
<thead>
<tr>
<th>id</th>
<th>name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>High street</td>
</tr>
</tbody>
</table>
(1 row)
```

**Try Yourself**

Folosiți comanda INSERT pentru a adăuga o nouă stradă în tabelul streets.

*Check your results*

15.3.2 Secvențierea Adăugării Datelor, Conform Constrângerilor

15.3.3 Try Yourself

Încercați să adăugați un obiect persoană în tabela people cu următoarele detalii:

```
Name: Joe Smith
House Number: 55
Street: Main Street
Phone: 072 882 33 21
```

**Notă:** Reamintim că, în acest exemplu, am definit numerele de telefon ca șiruri de caractere, și nu ca numere întregi.

În acest moment, ar trebui să întâmpinați un raport de eroare, dacă încercați să faceți acest lucru fără a crea mai întâi o înregistrare pentru Main Street din tabela streets.

Ar trebui să rețineți, de asemenea, că:
- Nu puteți adăuga strada folosind-ului numele
- Nu puteți adăuga o stradă folosind un id, fără a crea mai întâi o înregistrare a străzii în tabela străzilor

Amintiți-vă că cele două tabele sunt legate printr-o pereche de chei: primară/externă. Aceasta înseamnă că nici o persoană validă nu pot fi creată fără a exista, de asemenea, o înregistrare de stradă validă, corespunzătoare.

Folosind cunoștințele de mai sus, adăugați noua persoană în baza de date.

**Check your results**

### 15.3.4 Selectarea datelor

We have already shown you the syntax for selecting records. Let’s look at a few more examples:

```sql
select name from streets;
```

```sql
select * from streets;
```

```sql
select * from streets where name='Main Road';
```

În sesiunile ulterioare vom intra în mai multe detalii cu privire la modul de selectare și de filtrare a datelor.

### 15.3.5 Actualizarea datelor

What if you want to make a change to some existing data? For example, a street name is changed:

```sql
update streets set name='New Main Road' where name='Main Road';
```

Fiți foarte atenți la folosirea acestor declarații de actualizare - în cazul în care mai mult de o înregistrare se potrivesc clauzei WHERE, toate vor fi actualizate!

O soluție mai bună este de a folosi cheia primară a tabelului, pentru a referenția înregistrarea care trebuie schimbată:

```sql
update streets set name='New Main Road' where id=2;
```

Ar trebui să returneze UPDATE 1.

**Notă:** Criteriile instrucțiunii WHERE sunt sensibile la majuscule, astfel Main Road nu este similar cu Main road

### 15.3.6 Ștergere Dată

In order to delete an object from a table, use the DELETE command:

```sql
delete from people where name = 'Joe Smith';
```

Let’s look at our people table now:

```sql
address=# select * from people;

 id | name  | house_no | street_id | phone_no
-----+--------+----------+-----------+----------
(0 rows)
```
15.3.7 Try Yourself

Use the skills you have learned to add some new friends to your database:

<table>
<thead>
<tr>
<th>name</th>
<th>house_no</th>
<th>street_id</th>
<th>phone_no</th>
</tr>
</thead>
<tbody>
<tr>
<td>Joe Bloggs</td>
<td>3</td>
<td>2</td>
<td>072 887 23 45</td>
</tr>
<tr>
<td>Jane Smith</td>
<td>55</td>
<td>3</td>
<td>072 837 33 35</td>
</tr>
<tr>
<td>Roger Jones</td>
<td>33</td>
<td>1</td>
<td>072 832 31 38</td>
</tr>
<tr>
<td>Sally Norman</td>
<td>83</td>
<td>1</td>
<td>072 932 31 32</td>
</tr>
</tbody>
</table>

15.3.8 In Conclusion

Acum știți cum să adăugați date noi modelelor existente, pe care le-ați creat anterior. Amintiți-vă că, dacă doriți să adăugați noi tipuri de date, poate doriți să modificați și/sau să creați noi modele, care să conțină aceste date.

15.3.9 What’s Next?

Acum, că ați adăugat câteva date, veți învăța cum să folosiți interogări, pentru a accesa aceste date în diferite moduri.

15.4 Lesson: Interogări

Când scrieți o comandă SELECT ... intero gați baza de date pentru informații.

Scopul acestei lecții: De a afla cum să creați interogări, care vor returna informații utile.

Notă: Dacă nu ați făcut asta în lecția precedentă, adăugați următoarele obiecte persoană în tabela people. Dacă primiți erori legate de constrângerile de cheie externă, va trebui să adăugați mai întâi obiectul «Main Road» în tabela de străzi.

```sql
insert into people (name, house_no, street_id, phone_no) values ('Joe Bloggs', 3, 2, '072 887 23 45');
insert into people (name, house_no, street_id, phone_no) values ('Jane Smith', 55, 3, '072 837 33 35');
insert into people (name, house_no, street_id, phone_no) values ('Roger Jones', 33, 1, '072 832 31 38');
insert into people (name, house_no, street_id, phone_no) values ('Sally Norman', 83, 1, '072 932 31 32');
```

15.4.1 Ordonarea Rezultatelor

Haideți să obținem o listă de persoane ordonate după numerele caselor lor:

```sql
select name, house_no from people order by house_no;
```

Rezultat:

<table>
<thead>
<tr>
<th>name</th>
<th>house_no</th>
</tr>
</thead>
<tbody>
<tr>
<td>Joe Bloggs</td>
<td>3</td>
</tr>
<tr>
<td>Roger Jones</td>
<td>33</td>
</tr>
<tr>
<td>Jane Smith</td>
<td>55</td>
</tr>
</tbody>
</table>

(continues on next page)
Sally Norman | 83
(4 rows)

Puteti sorta rezultatele dupa valorile a mai mult de o coloana:

```
select name, house_no from people order by name, house_no;
```

Rezultat:

<table>
<thead>
<tr>
<th>name</th>
<th>house_no</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jane Smith</td>
<td>55</td>
</tr>
<tr>
<td>Joe Bloggs</td>
<td>3</td>
</tr>
<tr>
<td>Roger Jones</td>
<td>33</td>
</tr>
<tr>
<td>Sally Norman</td>
<td>83</td>
</tr>
</tbody>
</table>
(4 rows)

15.4.2 Filtrare

Foarte des nu va vedea fiecare inregistrare din baza de date - in mod special exista mii de inregistrari si suntei interesat doar de una sau doua.

Iata un exemplu de filtru numeric care intoarce doar obiecte ale carei house_no este mai mic de 50:

```
select name, house_no from people where house_no < 50;
```

<table>
<thead>
<tr>
<th>name</th>
<th>house_no</th>
</tr>
</thead>
<tbody>
<tr>
<td>Joe Bloggs</td>
<td>3</td>
</tr>
<tr>
<td>Roger Jones</td>
<td>33</td>
</tr>
</tbody>
</table>
(2 rows)

Puteti combina filtre (definez utilizand clauza WHERE) cu sortare (definita folosind clauza ORDER BY):

```
select name, house_no from people where house_no < 50 order by house_no;
```

<table>
<thead>
<tr>
<th>name</th>
<th>house_no</th>
</tr>
</thead>
<tbody>
<tr>
<td>Joe Bloggs</td>
<td>3</td>
</tr>
<tr>
<td>Roger Jones</td>
<td>33</td>
</tr>
</tbody>
</table>
(2 rows)

Puteti filtra, de asemenea, pe baza datelor de text:

```
select name, house_no from people where name like '%s%';
```

<table>
<thead>
<tr>
<th>name</th>
<th>house_no</th>
</tr>
</thead>
<tbody>
<tr>
<td>Joe Bloggs</td>
<td>3</td>
</tr>
<tr>
<td>Roger Jones</td>
<td>33</td>
</tr>
</tbody>
</table>
(2 rows)

Am folosit clauza LIKE pentru a gasi toate numele care contin un s. De remarcat ca aceasta interrogare dinte cont de capitalizare, deci inregistrarea Sally Norman nu a fost intoarsa.

Dacă doriți să căutați un sir de caractere indiferent de capitalizare, puteți executa o căutare care nu ține cont de capitalizare folosind clauza ILIKE:
Această interogare a returnat fiecare obiect `people` care conține un `r` sau un `R` în nume.

### 15.4.3 Îmbinări

Dar dacă doriți să vedeti detalii ale persoanei și numele străzii în loc de ID-ul acesteia? Pentru a face asta, trebuie să legați cele două tabele într-o singură interogare. Să vedem un exemplu:

```sql
select people.name, house_no, streets.name
from people, streets
where people.street_id = streets.id;
```

**Notă:** Cu legături, veți spune întotdeauna din ce tabele se extrage informația, în acest caz persoane și străzi. De asemenea va trebui să precizați care cheia trebuie să corespundă (cheia externă și cheia primară). Dacă nu faceți această precizare, veți obține o listă cu toate combinațiile posibile de persoane și străzi, dar nu veți putea ști de fapt cine pe ce stradă locuiește!

Așa ar trebui să arate rezultatul SQL corect:

<table>
<thead>
<tr>
<th>name</th>
<th>house_no</th>
<th>street</th>
</tr>
</thead>
<tbody>
<tr>
<td>Joe Bloggs</td>
<td>3</td>
<td>Low Street</td>
</tr>
<tr>
<td>Roger Jones</td>
<td>33</td>
<td>High street</td>
</tr>
<tr>
<td>Sally Norman</td>
<td>83</td>
<td>High street</td>
</tr>
<tr>
<td>Jane Smith</td>
<td>55</td>
<td>Main Road</td>
</tr>
</tbody>
</table>

(4 rows)

Vom reveni la legături când vom crea interogări mai complexe în continuare. Pentru moment rețineți că permit o metodă simplă de a combina informații din două sau mai multe tabele.

### 15.4.4 Sub-Selectarea

Sub-selectiile permit selectarea obiectelor dintr-un tabel, pe baza datelor dintr-un alt tabel de care este legat printr-o relație la cheia sa externă. În cazul nostru, dorim să găsim persoanele care locuiesc pe o anumită stradă.

În primul rând, să facem un pic de reglare a datelor noastre:

```sql
insert into streets (name) values('QGIS Road');
insert into streets (name) values('OGR Corner');
insert into streets (name) values('Goodle Square');
update people set street_id = 2 where id=2;
update people set street_id = 3 where id=3;
```

Haideți să aruncăm o privire rapidă la datele noastre în urma modificărilor: putem refolosi interogarea din secțiunea anterioră:

```sql
select people.name, house_no, streets.name
from people, streets
where people.street_id=streets.id;
```

Rezultat:
Acum, vom efectua o sub-selecție asupra acestor date. Vrem să arătăm doar persoanele care locuiesc în street_id numărul 1:

```sql
select people.name
from people, (select * from streets where id=1) as streets_subset
where people.street_id = streets_subset.id;
```

Rezultat:

```
<table>
<thead>
<tr>
<th>name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roger Jones</td>
</tr>
<tr>
<td>Sally Norman</td>
</tr>
</tbody>
</table>
```

(2 rows)

Deși acesta este un exemplu foarte simplu și inutil pentru seturile de date restrâns, el ilustrează utilitatea și importanța sub-selecțiilor în cazul interogărilor efectuate asupra seturilor de date mari și complexe.

### 15.4.5 Agregarea Îmbinărilor

Una dintre cele mai puternice caracteristici ale unei baze de date o reprezintă capacitatea sa de a sintetiza datele din tabelele pe care le conține. Aceste sinteze sunt denumite interogări agregate. Iată un exemplu tipic, care ne spune cât de multe obiecte de tipul om sunt în tabela de personal:

```sql
select count(*) from people;
```

Rezultat:

```
count-------
        4
```

(1 row)

Dacă dorim un rezumat după numele străzii, putem proceda astfel:

```sql
select count(name), street_id
from people
group by street_id;
```

Rezultat:

```
count | street_id
--------
      2 |      1
      1 |      3
      1 |      2
```

(3 rows)
Notă: Pentru că nu am folosit clauza `ORDER BY`, ordinea rezultatelor dvs. ar putea să nu se potrivescă cea ce este prezentată aici.

Try Yourself

Rezumați persoanele după numele străzii și afișați numele reale ale străzilor în loc de `street_ids`.

*Check your results*

15.4.6 In Conclusion

Ați văzut cum se utilizează interogările pentru a returna datele din baza de date într-un mod care permite extragerea de informații utile.

15.4.7 What’s Next?

Mai departe veți vedea cum să creați vizualizări, pornind de la interogările scrisă.

15.5 Vederile Lesson:

De fiecare dată când scriei o interogare, cheltuiți o mulțime de timp și efort pentru a o formula. Cu ajutorul vederilor, puteți salva definitia unei interogări SQL într-o „tabelă virtuală” reutilizabilă.

**Scopul acestei lectii:** De a salva o interogare sub formă de vedere.

15.5.1 Crearea unei Vederi

Puteți trata o vedere la fel ca pe o tabelă, însă datele sale provin dintr-o interogare. Haideti să efectuăm o vedere simplă, bazată pe cele de mai sus:

```sql
create view roads_count_v as
  select count(people.name), streets.name
  from people, streets where people.street_id=streets.id
  group by people.street_id, streets.name;
```

După cum se poate vedea, singura schimbare este crearea vederii `roads_count_v` ca parte de început. Acum, putem selecta datele din această vedere:

```sql
select * from roads_count_v;
```

Rezultatul:

```
count | name
------|---------
1     | Main Road
2     | High street
1     | Low Street
(3 rows)
```
15.5.2 Modificarea unei Vederi

A view is not fixed, and it contains no «real data». This means you can easily change it without impacting on any data in your database:

```
CREATE OR REPLACE VIEW roads_count_v AS
 SELECT count(people.name), streets.name
 FROM people, streets WHERE people.street_id=streets.id
 GROUP BY people.street_id, streets.name
 ORDER BY streets.name;
```

(Acest exemplu demonstrează, de asemenea, că cea mai bună practică este de a folosi MAJUSCULE pentru toate cuvintele cheie SQL.)

You will see that we have added an ORDER BY clause so that our view rows are nicely sorted:

```
select * from roads_count_v;

+--------+----------+
| count  | name     |
|--------+----------|
|       2 | High street|
|       1 | Low Street |
|       1 | Main Road  |
+--------+----------+
(3 rows)
```

15.5.3 Eliminarea unei Vederi

Dacă nu mai aveți nevoie de vedere, o puteți șterge astfel:

```
drop view roads_count_v;
```

15.5.4 In Conclusion

Vederile constau în salvarea unei interogări, urmată de accesarea rezultatelor acesteia similar ca și în cazul tabelelor.

15.5.5 What’s Next?

Uneori, atunci când are loc o schimbare asupra datelor, veți dori ca modificările să aibă efecte în altă parte din baza de date. Următoarea lecție vă arată cum să faceți acest lucru.

15.6 Regulile Lesson:

Regulile permit „arborelui de interogare” rescrierea interogărilor primate. O utilizare comună o reprezintă implementarea vederilor, inclusiv a celor actualizabile. - Wikipedia

**Scopul acestei lecții:** De a afla cum se pot crea noi reguli pentru baza de date.
15.6.1 Creating a logging rule

Presupunem că doriți să înregistrați fiecare schimbare de număr_de_telefon în tabelul jurnalul_personalului. Astfel, veți configura un tabel nou:

```sql
create table people_log (name text, time timestamp default NOW());
```

În etapa următoare, creați o regulă care înregistrează fiecare schimbare de număr_de_telefon în tabelul jurnalul_personalului:

```sql
create rule people_log as on update to people
where NEW.phone_no <> OLD.phone_no
do insert into people_log values (OLD.name);
```

Pentru a testa funcționarea regulii, haideti să modificăm un număr de telefon:

```sql
update people set phone_no = '082 555 1234' where id = 2;
```

Asigurați-vă că tabela people a fost actualizată corect:

```sql
select * from people where id=2;
```

```
id | name     | house_no | street_id | phone_no
---+----------+----------+-----------+---------
 2 | Joe Bloggs | 3        | 2         | 082 555 1234
(1 row)
```

Now, thanks to the rule we created, the people_log table will look like this:

```sql
select * from people_log;
```

```
name | time
---+-------
Joe Bloggs | 2014-01-11 14:15:11.953141
(1 row)
```

**Notă:** Valoarea câmpului time va depinde de data și ora curente.

15.6.2 In Conclusion

Reguli vă permit adăugarea sau modificarea automată a datelor din baza de date, pentru a reflecta modificările din alte părți ale bazei de date.

15.6.3 What’s Next?

Modulul următor vă va introduce în Baza de Date Spațiale cu ajutorul PostGIS, care ia aceste conceptele bazelor de date și le aplică datelor GIS.
Module: Noțiuni despre Bazele de date folosind PostgreSQL

Spatial Databases allow the storage of the geometries of records inside a Database as well as providing functionality for querying and retrieving the records using these Geometries. In this module we will use PostGIS, an extension to PostgreSQL, to learn how to setup a spatial database, import data into the database and make use of the geographic functions that PostGIS offers.

While working through this section, you may want to keep a copy of the PostGIS cheat sheet available from Boston GIS user group. Another useful resource is the online PostGIS documentation.

Sunt disponibile, de asemenea, mai multe tutoriale ample cu privire la PostGIS și Bazele de date Spațiale, de la Boundless Geo:
  * Introducere în PostGIS
  * Sfaturi și trucuri despre Bazele de date Spațiale

See also PostGIS In Action.

16.1 Lesson: Instalare PostGIS

Instalând funcțiile PostGIS vom putea accesa funcțiile spațiale din interiorul PostgreSQL.

Scopul acestei lecții: De a instala funcțiile spațiale, și pentru scurte demonstrații a aplicării lor.

Notă: We will assume the use of PostGIS version 2.1 or newer in this exercise. The installation and database configuration are different for older versions, but the rest of this material in this module will still work. Consult the documentation for your platform for help with installation and database configuration.
16.1.1 Instalarea sub Ubuntu

PostGIS este ușor de instalat din apt.

```
$ sudo apt install postgresql
$ sudo apt install postgis
```

Într-adevăr, este atât de ușor …

**Notă:** The exact versions that will be installed depend on which version of Ubuntu you are using and which repositories you have configured. After installing you can check the version by issuing a `select PostGIS_full_version();` query with psql or another tool.

To install a specific version (e.g., PostgreSQL version 13 and PostGIS 3), you can use the following commands.

```
$ sudo apt install wget ca-certificates
$ sudo lsb_release -a
$ wget --quiet -O - https://www.postgresql.org/media/keys/ACCC4CF8.asc | sudo apt-key add -
$ sudo sh -c 'echo "deb http://apt.postgresql.org/pub/repos/apt/ `lsb_release -cs`-pgdg main" >> /etc/apt/sources.list.d/pgdg.list'
$ sudo apt-get update
$ sudo apt install postgis postgresql-13-postgis-3
```

16.1.2 Instalare sub Windows

Installing on Windows can be done from binary packages using a normal Windows installation dialogs.

First Visit the download page. Then follow this guide.

More information about installing on Windows can be found on the PostGIS website.

16.1.3 Instalarea pe Alte Platforme

The PostGIS website download has information about installing on other platforms including macOS and on other Linux distributions

16.1.4 Configurarea Bazei de Date pentru a utiliza PostGIS

După ce PostGIS este instalat, va trebui să configurați baza de date pentru a utiliza extensiile. Dacă ați instalat versiunea PostGIS > 2.0, aceasta este la fel de simplu ca și execuția următoarei comenzi în psql, folosind baza de date de adesea din exercițiul nostru anterior.

```
$ psql -d address -c "CREATE EXTENSION postgis;"
```

**Notă:** Depending on your version, you could find more instructions on how to spatially enable a database at https://postgis.net/docs/postgis_administration.html#create_spatial_db.
16.1.5 Funcțiile PostGIS instalate

PostGIS poate fi considerat ca o colecție de funcții din baza de date, care extind capabilitățile de bază ale PostgreSQL, astfel încât să poată datele spatiale. Prin «a face față», înțelegem stocarea, prelucrarea, interogarea și manipularea. Pentru a face acest lucru, sunt instalate o serie de funcții în baza de date.

Our PostgreSQL address database is now geospatially enabled, thanks to PostGIS. We are going to delve a lot deeper into this in the coming sections, but let’s give you a quick little taster. Let’s say we want to create a point from text. First we use the psql command to find functions relating to point. If you are not already connected to the address database, do so now. Then run:

```
\df *point*
```

This is the command we’re looking for: \texttt{st点fromtext}. To page through the list, use the down arrow, then press \texttt{Q} to quit back to the psql shell.

Try running this command:

```
select st_pointfromtext('POINT(1 1)');
```

Rezultat:

```
st_pointfromtext
-----------------------------
0101000000000000000000000000F03F0000000000000000F03F
(1 row)
```

Trei lucruri de reținut:

- Am definit un punct la poziția 1,1 (EPSG:4326 se presupune), folosind \texttt{POINT(1 1)},
- Am rulat o instrucțiune SQL, dar nu pe orice tabelă, doar pe datele introduse din promptul SQL,
- Rândul rezultat nu preia are sens.

Rândul rezultat se află în formatul OGC denumit «Well Known Binary» (WKB). Vom analiza în detaliu acest format în secțiunea următoare.

To get the results back as text, we can do a quick scan through the function list for something that returns text:

```
\df *text*
```

The query we’re looking for now is \texttt{st_astext}. Let’s combine it with the previous query:

```
select st_astext(st_pointfromtext('POINT(1 1)'));
```

Rezultat:

```
st_astext
----------
POINT(1 1)
(1 row)
```

Aici, am intrat în sirul \texttt{POINT(1,1)}, transformându-l într-un punct folosind \texttt{st_pointfromtext()}, și aducându-l înapoi într-o formă ușor de înțeles de către utilizator cu \texttt{st_astext()}, care returează sirul de caractere inițial.

One last example before we really get into the detail of using PostGIS:

```
select st_astext(st_buffer(st_pointfromtext('POINT(1 1)'),1.0));
```

Care este rezultatul acestuia? S-a creat un tampon de 1 grad în jurul punctului nostru, și s-a returnat un rezultat sub formă de text.
16.1.6 Sistemele de Referință Spațială

În plus față de funcțiile PostGIS, extensia conține o colecție cu definiții ale sistemelor de referință spațială (SRS), așa cum au fost stabilite de către European Petroleum Survey Group (EPSG). Acestea sunt utilizate pentru operațiuni de conversie a sistemelor de coordonate de referință (CRS).

Putem inspecta aceste definiții SRS din baza noastră de date, pe măsură ce acestea sunt stocate în tabelele normale ale bazelor de date.

First, let’s look at the schema of the table by entering the following command in the psql prompt:

```
\d spatial_ref_sys
```

The result should be this:

```
Table "public.spatial_ref_sys"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>srid</td>
<td>integer</td>
<td>not null</td>
</tr>
<tr>
<td>auth_name</td>
<td>character varying(256)</td>
<td></td>
</tr>
<tr>
<td>auth_srid</td>
<td>integer</td>
<td></td>
</tr>
<tr>
<td>srtext</td>
<td>character varying(2048)</td>
<td></td>
</tr>
<tr>
<td>proj4text</td>
<td>character varying(2048)</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
"spatial_ref_sys_pkey" PRIMARY KEY, btree (srid)
```

Puteți utiliza interogări SQL standard (asă cum am învățat din secțiunile introductive), pentru a vizualiza și manipula acest tabel - totuși, actualizarea sau ștergerea înregistrărilor nu reprezintă o idee bună dacă nu știți ce faceți.

One SRID you may be interested in is EPSG:4326 - the geographic / lat lon reference system using the WGS 84 ellipsoid. Let’s take a look at it:

```
select * from spatial_ref_sys where srid=4326;
```

Rezultat:

```
srid | 4326
auth_name | EPSG
auth_srid | 4326
srtext | GEOGCS["WGS 84",DATUM["WGS_1984",SPHEROID["WGS 84",6378137,298.257223563,AUTHORITY["EPSG","7030"]],TOWGS84[0,0,0,0,0,0,0],AUTHORITY["EPSG","6326"],PRIMEM["Greenwich",0,AUTHORITY["EPSG","8901"]],UNIT["degree",0.01745329251994328,AUTHORITY["EPSG","9122"]],AUTHORITY["EPSG","4326"]]
proj4text | +proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs
```

srtext: reprezintă definiția proiecției în well known text (puteți recunoaște acest lucru din fisierele .prj din colecția dvs. de fisiere shape).

16.1.7 In Conclusion

Acum aveți funcțiile PostGIS instalate în copia dvs. de PostgreSQL. Astfel, veți putea să faceți uz de funcțiile spațiale extinse ale PostGIS.
16.1.8 What’s Next?

Mai departe, veți învăța cum se reprezintă entitățile spațiale într-o bază de date.

16.2 Lesson: Modelul Entității Simple

Cum putem să stocăm și să reprezentăm entitățile geografice într-o bază de date? În această lecție vom detalia una dintre abordări, Simple Feature Model, așa cum este definită de către OGC.

**Scopul acestei lecții:** De a afla ce este Modelul SFS și cum să-l folosiți.

16.2.1 Ce este OGC

Open Geospatial Consortium (OGC), o organizație internațională de voluntariat, dedicată stabilirii unor standarde, înființată în 1994. În OGC, mai mult de 370+ organizații comerciale, guvernamentale, non-profit și de cercetare la nivel mondial, colaboră într-un proces consensual deschis, încurajând dezvoltarea și implementarea standardelor pentru conținut și servicii geospațiale, prelucrarea și schimbul de date GIS. - Wikipedia

16.2.2 Ce este Modelul SFS

The Simple Feature for SQL (SFS) Model is a non-topological way to store geospatial data in a database and defines functions for accessing, operating, and constructing these data.

Modelul definește date geospațiale din tipurile Point, LineString, și Polygon (și agregări ale acestora în obiecte Multi). For further information, have a look at the OGC Simple Feature for SQL standard.
16.2.3 Adăugați un câmp geometric la tabelă

Let’s add a point field to our people table:

```
alter table people add column the_geom geometry;
```

16.2.4 Adăugați o constrângere bazată pe tipul geometriei

You will notice that the geometry field type does not implicitly specify what type of geometry for the field - for that we need a constraint:

```
alter table people
add constraint people_geom_point_chk
    check(st_geometrytype(the_geom) = 'ST_Point'::text
    OR the_geom IS NULL);
```

Aceasta adaugă o constrângere la tabelă, astfel încât ea va accepta doar o geometrie de tip punct sau o valoare nulă.

16.2.5 Try Yourself

Create a new table called cities and give it some appropriate columns, including a geometry field for storing polygons (the city boundaries). Make sure it has a constraint enforcing geometries to be polygons.

`Check your results`

16.2.6 Popularea tabelei geometry_columns

At this point you should also add an entry into the geometry_columns table:

```
insert into geometry_columns values
    ('', 'public', 'people', 'the_geom', 2, 4326, 'POINT');
```

Why? geometry_columns is used by certain applications to be aware of which tables in the database contain geometry data.

Notă: If the above INSERT statement causes an error, run this query first:

```
select * from geometry_columns;
```

If the column f_table_name contains the value people, then this table has already been registered and you don’t need to do anything more.

The value 2 refers to the number of dimensions; in this case, two: X and Y.

The value 4326 refers to the projection we are using; in this case, WGS 84, which is referred to by the number 4326 (refer to the earlier discussion about the EPSG).
Try Yourself

Adăugați o intrare `geometry_columns` adecvată pentru noul strat al orașelor

*Check your results*

### 16.2.7 Adăugați o înregistrare geometrică la tabelă, utilizând SQL

Now that our tables are geo-enabled, we can store geometries in them:

```sql
insert into people (name, house_no, street_id, phone_no, the_geom)
values ('Fault Towers',
        34,
        3,
        '072 812 31 28',
        'SRID=4326;POINT(33 -33)');
```

**Notă:** In the new entry above, you will need to specify which projection (SRID) you want to use. This is because you entered the geometry of the new point using a plain string of text, which does not automatically add the correct projection information. Obviously, the new point needs to use the same SRID as the data-set it is being added to, so you need to specify it.

If at this point you were using a graphical interface, for example, specifying the projection for each point would be automatic. In other words, you usually won’t need to worry about using the correct projection for every point you want to add if you’ve already specified it for that data-set, as we did earlier.

Now is probably a good time to open QGIS and try to view your `people` table. Also, we should try editing / adding / deleting records and then performing select queries in the database to see how the data has changed.

Pentru a încărca un strat PostGIS în QGIS, utilizați opțiunea de meniu `Layer ➤ Add PostGIS Layers` sau butonul corespunzător din bara de instrumente:

Se va deschide acest dialog:
Clic pe butonul *New* pentru a deschide acest dialog:
Apoi definiți o nouă conexiune, de exemplu:

```
Name: myPG
Service: 
Host: localhost
Port: 5432
Database: address
User: 
Password: 
```

To see whether QGIS has found the `address` database and that your username and password are correct, click `Test Connect`. If it works, check the boxes next to `Save Username` and `Save Password`. Then click `OK` to create this connection.

Înapoi în dialogul `Add PostGIS Layers`, faceti clic pe `Connect`, apoi adăugați straturile pentru proiectul dumneavoastră, ca de obicei.

**16.2. Lesson: Modelul Entității Simple**
Formulăți o interogare care arată numele unei persoane, numele străzii și poziția (din coloana the_geom) sub formă de text simplu.

Check your results

16.2.8 In Conclusion

Ați văzut cum să adăugați obiecte spațiale în baza de date, și cum să le puteți viziona în aplicația GIS.

16.2.9 What’s Next?

Mai departe, veți vedea cum se importă și se exportă datele în/din baza de date.

16.3 Lesson: Importul și Exportul

Desigur, o bază de date care nu dispune de o modalitate de a migra facil datele, în interiorul și în afara ei, nu ar fi de mare folos. Din fericire, există o serie de instrumente care vă permit mutarea cu ușurință a datelor în interiorul și în afara PostGIS.

16.3.1 shp2pgsql

shp2pgsql is a commandline tool to import ESRI Shapefile to the database. Under Unix, you can use the following command for importing a new PostGIS table:

```
shp2pgsql -s <SRID> -c -D -I <path to shapefile> <schema>.<table> | \
  psql -d <databasename> -h <hostname> -U <username>
```

Sub Windows, procesul de import trebuie efectuat în două etape:

```
shp2pgsql -s <SRID> -c -D -I <path to shapefile> <schema>.<table> > import.sql
psql psql -d <databasename> -h <hostname> -U <username> -f import.sql
```

Este posibil să întâlniți această eroare:

```
ERROR:  operator class "gist_geometry_ops" does not exist for access method "gist"
```

This is a known issue regarding the creation in situ of a spatial index for the data you’re importing. To avoid the error, exclude the -I parameter. This will mean that no spatial index is being created directly, and you’ll need to create it in the database after the data have been imported. (The creation of a spatial index will be covered in the next lesson.)
16.3.2 psql2shp

psql2shp is a commandline tool to export PostGIS Tables, Views or SQL select queries. To do this under Unix:

```
psql2shp -f <path to new shapefile> -g <geometry column name> \\
   -h <hostname> -U <username> <databasename> <table | view>
```

Pentru a exporta datele folositi o interogare:

```
psql2shp -f <path to new shapefile> -g <geometry column name> \\
   -h <hostname> -U <username> "<query>"
```

16.3.3 ogr2ogr

ogr2ogr is a very powerful tool to convert data into and from postgis to many data formats. ogr2ogr is part of the GDAL/OGR Software and has to be installed separately. To export a table from PostGIS to GML, you can use this command:

```
ogr2ogr -f GML export.gml PG:'dbname=<databasename> user=<username> \
   host=<hostname>;' <Name of PostGIS-Table>
```

16.3.4 DB Manager

You may have noticed another option in the Database menu labeled DB Manager. This is a tool that provides a unified interface for interacting with spatial databases including PostGIS. It also allows you to import and export from databases to other formats. Since the next module is largely devoted to using this tool, we will only briefly mention it here.

16.3.5 In Conclusion

Importing and exporting data to and from the database can be done in many various ways. Especially when using disparate data sources, you will probably use these functions (or others like them) on a regular basis.

16.3.6 What’s Next?

Apoi, vom vedea cum se interoghează datele pe care le-am creat mai înainte.

16.4 Lesson: Interogări Spațiale

Interogările spațiale nu sunt diferite de alte interogări de baze de date. Puteți utiliza coloana de geometrie la fel ca pe orice altă coloană de baze de date. O dată cu instalarea PostGIS în baza noastră de date, avem la dispoziție funcțiii suplimentare pentru a interoga baza de date.

**Scopul acestei lecții:** De a afla cum sunt implementate funcțiile spațiale similare cu funcțiile non-spațiale „normale”.
16.4.1 Operatori Spațiali

Când doriti să știți care puncte se află la o distanță de 2 grade față de un punct (X,Y), puteți proceda astfel cu:

```sql
select *
from people
where st_distance(the_geom,'SRID=4326;POINT(33 -34)') < 2;
```

Rezultat:

<table>
<thead>
<tr>
<th>id</th>
<th>name</th>
<th>house_no</th>
<th>street_id</th>
<th>phone_no</th>
<th>the_geom</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Fault Towers</td>
<td>34</td>
<td>3</td>
<td>072 812 31 28</td>
<td>01010008040C0</td>
</tr>
</tbody>
</table>

Notă: Valoarea the_geom de mai sus a fost trunchiată datorită spațiului de pe această pagină. În cazul în care doriti să vedeti punctul în coordonate clare, încercați ceva similar cu cea ce ați efectuat în secțiunea „Vizualizează un punct sub forma WKT”, de mai sus.

De unde știm că interogarea de mai sus returnează toate punctele incluse în cadrul a 2 grade? De ce nu 2 metri? Sau oricare altă unitate?

*Check your results*

16.4.2 Indecși Spațiali

We also can define spatial indexes. A spatial index makes your spatial queries much faster. To create a spatial index on the geometry column use:

```sql
CREATE INDEX people_geo_idx
ON people
USING gist
(the_geom);
```

Rezultat:

<table>
<thead>
<tr>
<th>Table &quot;public.people&quot;</th>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>id</td>
<td>integer</td>
<td>not null default</td>
</tr>
<tr>
<td></td>
<td>name</td>
<td>character varying(50)</td>
<td>nextval('people_id_seq'::regclass)</td>
</tr>
<tr>
<td></td>
<td>house_no</td>
<td>integer</td>
<td>not null</td>
</tr>
<tr>
<td></td>
<td>street_id</td>
<td>integer</td>
<td>not null</td>
</tr>
<tr>
<td></td>
<td>phone_no</td>
<td>character varying</td>
<td></td>
</tr>
<tr>
<td></td>
<td>the_geom</td>
<td>geometry</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "people_pkey" PRIMARY KEY, btree (id)
- "people_geo_idx" gist (the_geom) <= new spatial key added
- "people_name_idx" btree (name)

Check constraints:
- "people_geom_point_chk" CHECK (st_geometrytype(the_geom) = 'ST_Point':::text
  OR the_geom IS NULL)

Foreign-key constraints:
- "people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)
16.4.3 Try Yourself

Modificați tabelul orășelor, astfel încât coloana de geometrie să fie indexată spațial.

Check your results

16.4.4 Demo Funcțiile Spațiale PostGIS

În scopul demonstrării funcțiilor spațiale PostGIS, vom crea o nouă bază de date care conține câteva date (factice). To start, create a new database (exit the psql shell first):

```sql
createdb postgis_demo
```

Remember to install the postgis extensions:

```sql
psql -d postgis_demo -c "CREATE EXTENSION postgis;"
```

Next, import the data provided in the `exercise_data/postgis/` directory. Refer back to the previous lesson for instructions, but remember that you’ll need to create a new PostGIS connection to the new database. You can import from the terminal or via DB Manager. Import the files into the following database tables:

- `points.shp` in `building`
- `lines.shp` in `road`
- `polygons.shp` in `region`

Încărcați aceste trei straturi ale bazei de date în QGIS ca de obicei, prin intermediul Adăugării Straturilor PostGIS. Atunci când deschideți tabelele lor cu attribute, veți observa că ambele dețin atât un camp id cât și unul gid, create în urma importului PostGIS.

Acum, că tabelele sunt importate, putem folosi PostGIS pentru a interoga datele. Mergeți înapoi în ferestra terminalului (linia de comandă) și introduceți promptul psql astfel:

```sql
psql postgis_demo
```

Vom demonstra unele dintre aceste expresii de selectare prin crearea unor vederi, pentru a le deschide apoi în QGIS și pentru a le observa rezultatele.

Selectare după locație

Get all the buildings in the KwaZulu region:

```sql
SELECT a.id, a.name, st_astext(a.the_geom) as point
FROM building a, region b
WHERE st_within(a.the_geom, b.the_geom)
AND b.name = 'KwaZulu';
```

Rezultat:

<table>
<thead>
<tr>
<th>id</th>
<th>name</th>
<th>point</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td>York</td>
<td>POINT(1622345.23785063 6940490.65844485)</td>
</tr>
<tr>
<td>33</td>
<td>York</td>
<td>POINT(1622495.65620524 6940403.87862489)</td>
</tr>
<tr>
<td>35</td>
<td>York</td>
<td>POINT(1622043.09106394 6940212.96302097)</td>
</tr>
<tr>
<td>36</td>
<td>York</td>
<td>POINT(162287.38463732 6940357.59605424)</td>
</tr>
<tr>
<td>40</td>
<td>York</td>
<td>POINT(1621888.19746548 6940508.01440885)</td>
</tr>
</tbody>
</table>

(5 rows)

Or, if we create a view from it:
CREATE VIEW vw_select_location AS
SELECT a.gid, a.name, a.the_geom
FROM building a, region b
WHERE st_within(a.the_geom, b.the_geom)
AND b.name = 'KwaZulu';

Adăugați vederea sub formă de strat, apoi vizualizăți-o în QGIS:

Selectați vecinii

Show a list of all the names of regions adjoining the Hokkaido region:

SELECT b.name
FROM region a, region b
WHERE st_touches(a.the_geom, b.the_geom)
AND a.name = 'Hokkaido';

Rezultat:

<table>
<thead>
<tr>
<th>name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Missouri</td>
</tr>
<tr>
<td>Saskatchewan</td>
</tr>
<tr>
<td>Wales</td>
</tr>
</tbody>
</table>
(3 rows)

As a view:

CREATE VIEW vw_regions_adjoining_hokkaido AS
SELECT b.gid, b.name, b.the_geom
FROM region a, region b
WHERE TOUCHES(a.the_geom, b.the_geom)
AND a.name = 'Hokkaido';

În QGIS:
Note the missing region (Queensland). This may be due to a topology error. Artifacts such as this can alert us to potential problems in the data. To solve this enigma without getting caught up in the anomalies the data may have, we could use a buffer intersect instead:

```sql
CREATE VIEW vw_hokkaido_buffer AS
    SELECT gid, ST_BUFFER(the_geom, 100) as the_geom
    FROM region
    WHERE name = 'Hokkaido';
```

Aceasta va crea o zonă tampon de 100 de metri în jurul regiunii Hokkaido.

Zona mai închisă este tamponul:
Select using the buffer:

```
CREATE VIEW vw_hokkaido_buffer_select AS
  SELECT b.gid, b.name, b.the_geom
  FROM
    (SELECT * FROM vw_hokkaido_buffer) a,
    region b
  WHERE ST_INTERSECTS(a.the_geom, b.the_geom)
    AND b.name != 'Hokkaido';
```

În această interogare, vizualizarea originală a tamponului se face similar oricărui alt tabel. Acesta primește aliasul a iar câmpul de geometrie a.the_geom este folosit la selectarea oricărui poligon din tabela :kbd:`region` (alias b) cu care se intersectează. Totusi, Hokkaido este exclusă din această expresie de selectare, nefiind dorită; vrem să obținem doar regiunile din vecinătate.

În QGIS:
It is also possible to select all objects within a given distance, without the extra step of creating a buffer:

```sql
CREATE VIEW vw_hokkaido_distance_select AS
SELECT b.gid, b.name, b.the_geom
FROM region a, region b
WHERE ST_DISTANCE (a.the_geom, b.the_geom) < 100
AND a.name = 'Hokkaido'
AND b.name != 'Hokkaido';
```

Prin aceasta se obține același rezultat, fără a fi necesar pasul tamponului intermediar:
Selectați valorile unice

Show a list of unique town names for all buildings in the Queensland region:

```sql
SELECT DISTINCT a.name
  FROM building a, region b
  WHERE st_within(a.the_geom, b.the_geom)
    AND b.name = 'Queensland';
```

Rezultat:

<table>
<thead>
<tr>
<th>name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beijing</td>
</tr>
<tr>
<td>Berlin</td>
</tr>
<tr>
<td>Atlanta</td>
</tr>
</tbody>
</table>

(3 rows)

Trimiteri suplimentare

```sql
CREATE VIEW vw_shortestline AS
  SELECT b.gid AS gid,
    ST_ASTEXT(ST_SHORTESTLINE(a.the_geom, b.the_geom)) AS text,
    ST_SHORTESTLINE(a.the_geom, b.the_geom) AS the_geom
  FROM road a, building b
  WHERE a.id=5 AND b.id=22;

CREATE VIEW vw_longestline AS
  SELECT b.gid AS gid,
    ST_ASTEXT(ST_LONGESTLINE(a.the_geom, b.the_geom)) AS text,
    ST_LONGESTLINE(a.the_geom, b.the_geom) AS the_geom
  FROM road a, building b
  WHERE a.id=5 AND b.id=22;

CREATE VIEW vw_road_centroid AS
  SELECT a.gid AS gid, ST_CENTROID(a.the_geom) AS the_geom
  FROM road a
  WHERE a.id = 1;

CREATE VIEW vw_region_centroid AS
  SELECT a.gid AS gid, ST_CENTROID(a.the_geom) AS the_geom
  FROM region a
  WHERE a.name = 'Saskatchewan';

SELECT ST_PERIMETER(a.the_geom)
  FROM region a
  WHERE a.name='Queensland';

SELECT ST_AREA(a.the_geom)
  FROM region a
  WHERE a.name='Queensland';

CREATE VIEW vw_simplify AS
  SELECT gid, ST_Simplify(the_geom, 20) AS the_geom
  FROM road;

CREATE VIEW vw_simplify_more AS
  SELECT gid, ST_Simplify(the_geom, 50) AS the_geom
  FROM road;
```
16.4.5 In Conclusion

Ati vazut cum se pot interoga obiectele spatiale, cu ajutorul noilor functii de bază de date din PostGIS.

16.4.6 What’s Next?

Mai departe vom investiga structurile geometriilor complexe si cum sa le creati cu ajutorul PostGIS.

16.5 Lesson: Construirea Geometriei

In aceasta sectiune vom intra in detaliu despre cum sunt construite geometriile in SQL. In realitate, probabil veti utiliza un GIS cum ar fi QGIS pentru crearea geometriilor complexe folosind instrumentele acestora; cu toate acestea, intelegerea modului cum sunt stocate poate fi utila pentru scrierea de interogari si intelegerea modului cum este alcatuita baza de date.

Scopul acestei lectii: De a intelege mai bine cum sa creati entitati spatiale direct in PostgreSQL/PostGIS.

16.5.1 Crearea Șirurilor de Linii

Intrucandu-ne la baza de date address, sa facem tabelul de strazi sa se potrivesc cu celelalte; de ex., sa aiba o constrangeri pentru geometrie, un index si o intrare in tabelul geometry_columns.

16.5.2 Try Yourself

- Modifica tabela streets, astfel incat ea sa aiba o coloana de geometrie de tipul ST_LineString.
- Nu uitati sa faceti actualizarea coloanelor de geometrie!
- De asemenea, adaugaati o constrangeri pentru a preveni adaugarea geometriii care nu sunt null sau de tip LINESTRINGS.
- Creadi un index spatial in noua coloana de geometrie

Check your results

Now let’s insert a linestring into our streets table. In this case we will update an existing street record:

```
update streets
set the_geom = 'SRID=4326;LINESTRING(20 -33, 21 -34, 24 -33)'
where streets.id=2;
```

Aruncati o privire la rezultatele din QGIS. (Poate fi necesar sa faceiti clic-dreapta pe stratul strazilor din panoul «Straturilor», apoi alegeti «Transfocare la extinderea stratului».)

Acum, creati mai multe intrari de strazi - unele in QGIS, iar altele din linia de comanda.
16.5.3 Crearea Poligoanelor

Creating polygons is just as easy. One thing to remember is that by definition, polygons have at least four vertices, with the last and first being co-located:

```sql
insert into cities (name, the_geom)
values ('Tokyo', 'SRID=4326;POLYGON((10 -10, 5 -32, 30 -27, 10 -10))');
```

**Nota:** Un poligon necesită acolade duble în jurul listei sale de coordonate; aceasta pentru a permite poligoane complexe având multiple zone neconectate. De exemplu

```sql
insert into cities (name, the_geom)
values ('Tokyo Outer Wards',
    'SRID=4326;POLYGON((20 10, 20 20, 35 20, 20 10),
    (-10 -30, -5 0, -15 -15, -10 -30))');
```

Dacă ați urmat acest pas, puteți verifica rezultatul prin încărcarea setului de date orașe în QGIS, deschizând tabelul de atribută al acestuia, și selectând noua intrare. Remarcați cum cele două noi poligoane se comportă ca un singur.

16.5.4 Exercițiul: Learea Orașelor de Persoane

Pentru acest exercițiu ar trebui să faceți următoarele:

- Ștergeți toate datele din tabela de personal.
- Adăugați o coloană de cheie strânsă în tabela de personal, care face referire la cheia primară a tabelei oraselor.
- Utilizați QGIS pentru a captura unele orașe.
- Utilizați SQL pentru a introduce câteva înregistrări de personal, verificând că fiecare are asociate o stradă și un oraș.

Your updated people schema should look something like this:

```sql
\d people
Table "public.people"
Column | Type | Modifiers
-----------+-----------------------+--------------------------------------------
id | integer | not null
| | default nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
the_geom | geometry |
city_id | integer | not null
Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_name_idx" btree (name)
Check constraints:
"people_geom_point_chk" CHECK (st_geometrytype(the_geom) = 'ST_Point '::text OR the_geom IS NULL)
Foreign-key constraints:
"people_city_id_fkey" FOREIGN KEY (city_id) REFERENCES cities(id)
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)
```

*Check your results*
16.5.5 Analizați Schema Noastră

Acum, schimba noastră ar trebui să arate în felul următor:

![Diagrama schemelor]({images}/diagram.png)

16.5.6 Try Yourself

Crează marginile orașelor prin calcularea înfășurătorii convexe pentru toate adresele din acel oraș și calcularea unei zone tampon în jurul acesteia.

16.5.7 Accesul la Sub-Obiecte

Folosind funcțiile SFS-Model, aveți la dispoziție o largă gamă de opțiuni pentru accesarea sub-obiectelor geometriilor SFS. Când doriti să selectați primul punct vertex al fiecărei geometrii poligon în tabelul myPolygonTable, trebuie să o faceți în felul acesta:

- Transform the polygon boundary to a linestring:

```sql
select st_boundary(geometry) from myPolygonTable;
```

- Select the first vertex point of the resultant linestring:

```sql
select st_startpoint(myGeometry) from (select st_boundary(geometry) as myGeometry from myPolygonTable) as foo;
```

16.5.8 Procesarea Datelor

PostGIS suportă toate funcțiile conforme standardelor OGC SFS/MM. Toate aceste funcții încep cu ST_.

16.5. Lesson: Construirea Geometriei 475
16.5.9 Decuparea

To clip a subpart of your data you can use the `ST_INTERSECT()` function. To avoid empty geometries, use:

```sql
where not st_isempty(st_intersection(a.the_geom, b.the_geom))
```

```sql
select st_intersection(a.the_geom, b.the_geom), b.*
from clip as a, road_lines as b
where not st_isempty(st_intersection(st_setsrid(a.the_geom, 32734),
                                 b.the_geom));
```
16.5.10 Construirea de Geometrii pornind de la Alte Geometrii

Plecând de la un tabel de puncte dat, doriti să generați un linestring. Ordinea punctelor este dată de valoarea id. O altă metodă de ordonare ar putea fi marca de timp, cum ar fi cea pe care o primit când capturiați puncte cu un receptor GPS.
To create a linestring from a new point layer called «points», you can run the following command:

```sql
select ST_LineFromMultiPoint(st_collect(the_geom)), 1 as id
from ( select the_geom from points order by id ) as foo;
```

Pentru a vedea cum funcționează fără a crea un nou strat, puteți executa această comandă în stratul «people», deși desigur nu ar avea prea mult sens în lumea reală.
16.5.11 Curăţarea Geometriilor

You can get more information for this topic in this blog entry.

16.5.12 Diferenţele dintre tabele

To detect the difference between two tables with the same structure, you can use the PostgreSQL keyword `EXCEPT`:

```sql
select * from table_a
except
select * from table_b;
```

Ca rezultat, veți obține toate acele înregistrări din table_a care nu se regăsesc și în table_b.
16.5.13 Spatiiile tabelelor

You can define where postgres should store its data on disk by creating tablespaces:

```
CREATE TABLESPACE homespace LOCATION '/home/pg';
```

Atunci cand creați o bază de date, aveți posibilitatea să specificați care spațiu de tabelă să fie utilizat, de exemplu:

```
createdb --tablespace-homespace t4a
```

16.5.14 In Conclusion

Ati învătat cum să creați geometrii mai complexe folosind instrucțiuni PostGIS. Retineți că aceasta folosește la îmbunătățirea cunostințelor pentru lucru cu o bază de date spațială printr-o interfață GIS. În mod curent nu veți avea nevoie să folosiți aceste instrucțiuni manual, dar o înțelegere generală vă va ajuta la utilizarea unui GIS, în special dacă întâlniți erori care ar putea să pară altfel criptice.
Aceast modul a fost publicat de Victor Olaya și Paolo Cavallini.

Cuprins:

17.1 Introducere

This guide describes how to use the QGIS processing framework. It assumes no previous knowledge of the Processing framework or any of the applications that it rely on. It assumes basic knowledge of QGIS. The chapters about scripting assume you have some basic knowledge of Python and maybe the QGIS Python API.

Aceast ghid este conceput pentru studiu individual sau pentru utilizarea într-o sesiune de instruire.

Examples in this guide use QGIS 3.4. They might not work or not be available in versions other than that one.

This guide is comprised of a set of small exercises of progressive complexity. If you have never used the processing framework, you should start from the very beginning. If you have some previous experience, feel free to skip lessons. They are more or less independent of each other, and each one introduces some new concept or some new element, as indicated in the chapter title and the short introduction at the beginning of each chapter. That should make it easy to locate lessons dealing with a particular topic.

For a more systematic description of all the framework components and their usage, it is recommended to check the corresponding chapter in the user manual. Use it as a support text along with this guide.

All the exercises in this guide use the same free dataset used throughout the training manual and referenced at section Data. The zip file to download contains several folders corresponding to each one of the lessons in this guide. In each of them you will find a QGIS project file. Just open it and you will be ready to start the lesson.

Utilizare plăcută!
17.2 Câteva lucruri importante de reținut, înainte de a începe

Just like the manual of a word processor doesn’t teach you how to write a novel or a poem, or a CAD tutorial doesn’t show you how to calculate the size of a beam for a building, this guide will not teach you spatial analysis. Instead, it will show you how to use the QGIS Processing framework, a powerful tool for performing spatial analysis. It is up to you to learn the required concepts that are needed to understand that type of analysis. Without them, there is no point in using the framework and its algorithms, although you might be tempted to try.

Haideți să vedem, pentru mai multă claritate, un exemplu.

Având în vedere un set de puncte și, pentru fiecare punct, o anumită valoare, cu ajutorul geoalgoritmului Kriging se poate calcula un strat raster. Caseta de dialog a parametrilor pentru acel modul este similară celei de mai jos.

It looks complex, right?

By reading this manual, you will learn things such as how to use that module, how to run it in a batch process to create raster layers from hundreds of points layers in a single run, or what happens if the input layer has some points selected. However, the parameters themselves are not explained. A seasoned analyst with a good knowledge of geostatistics will have no problem understanding those parameters. If you are not one of them and sill, range, or nugget are not familiar concepts to you, then you should not use the Kriging module. More than that, you are far from being ready to use the Kriging module, since it requires learning about concepts such as spatial autocorrelation or semivariograms,
which probably you also haven’t heard before, or at least haven’t studied long enough. You should first study and understand them, and then come back to QGIS to actually run it and perform the analysis. Ignoring this will result in wrong results and poor (and most likely useless) analysis.

Desi nu toți algoritmul sunt la fel de complecși ca și algoritmul kriging (unii dintre ei având o complexitate chiar mai mare!), aproape toți necesită o bună înțelegere a metodelor fundamentale de analiză, pe care se bază. Fără acea cunoaștere, folosirea lor va conduce, cel mai probabil, la rezultate slabe.

Using geoalgorithms without having a good foundation of spatial analysis is like trying to write a novel without knowing anything about grammar or syntax, and having no knowledge about storytelling. You might get a result, but it is likely to have no value at all. Please, don’t fool yourself and think that after reading this guide you are already capable of performing spatial analysis and get sound results. You need to study spatial analysis as well.

În continuare, este indicat un bun punct de referință, la care vă puteți raporta pentru a afla mai multe despre analiza datelor spațiale.

_Analize geospatiale (a 3-a Editie): Un Ghid Cuprinzător de Principii, Tehnici și Instrumente Software, Michael John De Smith, Michael F. Goodchild, Paul A. Longley_

It is available online [here](#)

### 17.3 Inițierea cadrului de procesare

Primul lucru de făcut, ținând de a utiliza cadrul de prelucrare, este să-l configurați. Nu este mult de configurat, astfel încât aceasta este o sarcină ușoară.

Ulterior, vom vedea cum se configurează aplicațiile externe, care folosesc la extinderea listei algoritmilor disponibili, însă pentru moment vom lucra cu cadrul de lucru propriu-zis.

The processing framework is a core QGIS plugin, which means that it should already be installed in your system, since it is included with QGIS. In case it is active, you should see a menu called Processing in your menu bar. There you can access all the framework components.

<table>
<thead>
<tr>
<th>Toolbox</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎨 Graphical Modeler...</td>
<td>Ctrl+Alt+M</td>
</tr>
<tr>
<td>🕐 History...</td>
<td>Ctrl+Alt+H</td>
</tr>
<tr>
<td>📚 Results Viewer</td>
<td>Ctrl+Alt+R</td>
</tr>
<tr>
<td>📖 Edit Features In-Place</td>
<td></td>
</tr>
</tbody>
</table>

Dacă nu puteți găsi acel meniu, trebuie să activați plugin-ul, din managerul de plugin-uri, și să-l activați.
Elementul principal cu care vom lucra este setul de instrumente. Faceți clic pe intrarea de meniu corespunzătoare, apoi veți vedea bara de instrumente andocată în partea dreaptă a ferestrei QGIS.
The toolbox contains a list of all the available algorithms, divided in groups called Providers. Providers can be (de)activated in the Settings ► Options ► Processing. We will discuss that dialog later in this manual.

By default, only providers that do not rely on third-party applications (that is, those that only require QGIS elements to be run) are active. Algorithms requiring external applications might need additional configuration. Configuring providers is explained in a later chapter in this manual.

Dacă ati ajuns la acest punct, acum sunteți gata de utilizare a geoalgoritmilor. Nu este nevoie să configurați nimic altceva. Putem rula deja primul nostru algoritm, lucrul pe care îl vom face în lectia următoare.

### 17.4 Rularea primului nostru algoritm. Setul de instrumente

**Notă:** În această lectie vom rula primul nostru algoritm pentru a obtine un prim rezultat.

Aşa cum am menţionat deja, cadrul de procesare poate rula algoritmi ai altor aplicaţii, dar conţine, de asemenea, algoritmi nativi care nu au nevoie de nici un software extern pentru a rula. Pentru a începe explorarea cadrului de procesare, vom rula unul dintre algoritmii nativi. În particular, vom calcula centroizii setului de poligoane.

În primul rând, deschideţi proiectul QGIS corespondator acestei lectii. Acesta conţine doar un singur strat, cu două poligoane.
Now go to the text box at the top of the toolbox. That is the search box, and if you type text in it, it will filter the list of algorithms so just those ones containing the entered text are shown. If there are algorithms that match your search but belong to a provider that is not active, an additional label will be shown in the lower part of the toolbox.

Introduceti centroids, după care ar trebui să vedeti ceva de genul următor:

The search box is a very practical way of finding the algorithm you are looking for. At the bottom of the dialog, an additional label shows that there are algorithms that match your search but belong to a provider that is not active. If you click on the link in that label, the list of algorithms will also include results from those inactive providers, which will be shown in light gray. A link to activate each inactive provider is also shown. We’ll see later how to activate other providers.
To execute an algorithm, you just have to double-click on its name in the toolbox. When you double-click on the *Polygon centroids* algorithm, you will see the following dialog.

![Polygon centroids dialog](image)

Toți algoritmii au o interfață similară, care conține practic parametrii de intrare pe care trebuie să îi completai, și iesirile pentru care trebuie să specifice unde se păstrează. În acest caz, singura intrare pe care o avem este un strat vectorial cu poligoane.

Selectați stratul *Poligoanelor* ca intrare. Algoritmul are o singură iesire, care este stratul centroizilor. Există două opțiuni pentru a defini locul de salvare a datelor de iesire: introduceți o cale pentru fișier sau salvați-l sub numele unui fișier temporar.
In case you want to set a destination and not save the result in a temporary file, the format of the output is defined by the filename extension. To select a format, just select the corresponding file extension (or add it if you are directly typing the filepath instead). If the extension of the filepath you entered does not match any of the supported ones, a default extension (usually .dbf for tables, .tif for raster layers and .shp for vector ones) will be appended to the filepath and the file format corresponding to that extension will be used to save the layer or table.

In all the exercises in this guide, we will be saving results to a temporary file, since there is no need to save them for a later use. Feel free to save them to a permanent location if you want to.

**Atentionare:** O dată ce se închide QGIS, fisierele temporare vor fi șterse. În cazul unui proiect cu o iesire generată temporar, la deschiderea ulterioară a proiectului, QGIS va semnala acest lucru, din moment ce fisierul nu mai există.

Once you have configured the algorithm dialog, press Run to run the algorithm.

Veți obține rezultatul următor.

Ieșirea are același CRS ca și intrarea. Geoalgoritmii presupun că toate straturile de intrare au același CRS și, de aceea, nu vor efectua nici o reproiectare. Cu excepția cazului unor algoritmi speciali (cum ar fi cei de reproiectare), ieșirile vor avea același CRS. Vom vedea în curând mai multe despre acest lucru.

Try yourself saving it using different file formats (use, for instance, shp and geojson as extensions). Also, if you do not want the layer to be loaded in QGIS after it is generated, you can check off the checkbox that is found below the output path box.
17.5 Mai multe tipuri de date și algoritmi

Notă: În această lecție vom rula mai mult de trei algoritmi, veți învăța cum să folosiți alte tipuri de intrări, și cum să configurați rezultatele pentru a fi salvate automat într-un anumit folder.

Pentru aceste lectii vom avea nevoie de o tabelă și de un strat poligonal. Vom crea un strat de puncte bazat pe coordonatele din tabel, și apoi vom contoriza numărul de puncte din fiecare poligon. Dacă deschideți proiectul QGIS corespunzător acestei lectii, veți găsi un tabel cu coordonatele X și Y, dar veți identifica nici un strat poligonal. Nu vă faceti grijii, il vom crea folosind un geoalgoritm de procesare.

Primul lucru pe care îl vom face este de a crea un strat de puncte din coordonatele din tabel, utilizând algoritmul *Stratului de puncte din tabelă*. O dată ce știți cum se folosește caseta de căutare, nu vă va fi greu să-l găsiți. Efectuați un dublu-clic pe ea pentru a o rula și pentru a ajunge la următorul său dialog.

Acest algoritm, la fel ca și cel din lecția precedentă, generează doar o singură ieșire, având trei intrări:

- **Tabela**: tabel cu coordonate. Ar trebui să selectați aici tabela corespunzătoare lecției.
- **X and Y fields**: these two parameters are linked to the first one. The corresponding selector will show the name of those fields that are available in the selected table. Select the XCOORD field for the X parameter, and the YCOORD field for the Y parameter.
- **CRS**: Since this algorithm takes no input layers, it cannot assign a CRS to the output layer based on them. Instead, it asks you to manually select the CRS that the coordinates in the table use. Click on the button on the left-hand side to open the QGIS CRS selector, and select EPSG:4326 as the output CRS. We are using this CRS because the coordinates in the table are in that CRS.

Dialogul dvs. ar trebui să arate astfel.

![Screenshot of the Points layer from table dialog](image)

Now press the **Run** button to get the following layer (you may need to zoom full to reenter the map around the newly
Următorul lucru de care avem nevoie este stratul poligonaț. Vom crea o grilă obișnuită de poligoane, folosind algoritmul *Creare grilă*, care are următoarea fereastră cu parametri.
Atentionare: The options are simpler in recent versions of QGIS; you just need to enter min and max for X and Y (suggested values: -5.696226, -5.695122, 40.24742, 40.248171)

The inputs required to create the grid are all numbers. When you have to enter a numerical value, you have two options: typing it directly on the corresponding box or clicking the button on the right-hand side to get to a dialog like the one shown next.
The dialog contains a simple calculator, so you can type expressions such as $11 \times 34.7 + 4.6$, and the result will be computed and put in the corresponding text box in the parameters dialog. Also, it contains constants that you can use, and values from other layers available.

In this case, we want to create a grid that covers the extent of the input points layer, so we should use its coordinates to calculate the center coordinate of the grid and its width and height, since those are the parameters that the algorithm takes to create the grid. With a little bit of math, try to do that yourself using the calculator dialog and the constants from the input points layer.

Select **Dreptunghiuri (poligoane)** în câmpul **Tip**.

As in the case of the last algorithm, we have to enter the CRS here as well. Select EPSG:4326 as the target CRS, as we did before.

În cele din urmă, ar trebui să aveți un dialog pentru parametri de genul următor:
(Better add one spacing on the width and height: Horizontal spacing: 0.0001, Vertical spacing: 0.0001, Width: 0.001004, Height: 0.000651, Center X: -5.695222, Center Y: 40.247795) The case of X center is a bit tricky, see: -5.696126 +((-5.695222+ 5.696126)/2)

Apăsați Run pentru a obține stratul de graticule.
The last step is to count the points in each one of the rectangles of that graticule. We will use the *Count points in polygons* algorithm.

Acum avem rezultatul dorit.
Before finishing this lesson, here is a quick tip to make your life easier in case you want to persistently save your data. If you want all your output files to be saved in a given folder, you do not have to type the folder name each time. Instead, go to the processing menu and select the *Options and configuration* item. It will open the configuration dialog.

![SEXTANTE options dialog](image)

In the *Output folder* entry that you will find in the *General* group, type the path to your destination folder.
Now when you run an algorithm, just use the filename instead of the full path. For instance, with the configuration shown above, if you enter `graticule.shp` as the output path for the algorithm that we have just used, the result will be saved in `D:\processing_output\graticule.shp`. You can still enter a full path in case you want a result to be saved in a different folder.

Încercați să rulați algoritmul Creare grilă folosind diferite mărimi ale grilei, și, totodată, utilizând diverse tipuri de grilă.

### 17.6 Reproiectarea CRS-urilor

**Notă:** În această lecție, vom discuta despre modul în care Processing utilizează CRS-urile. Vom vedea, de asemenea, un algoritmul foarte util: reproiectarea.

CRS-urile sunt o mare sursă de confuzie pentru utilizatorii QGIS Processing, așa că aici sunt câteva reguli generale cu privire la modul în care pot fi gestionate de către geoalgoritmi, la crearea unui nou strat.

- Dacă există straturi de intrare, se va utiliza CRS-ul primului strat. Acesta este presupus a fi CRS-ul tuturor straturilor de intrare, atât timp cât este necesar ca acestea să-l aibă pe același. În cazul în care utilizați straturi cu un CRS diferit, QGIS va emite un avertisment. Observați că CRS-ul straturilor de intrare este afișat alături de numele său, în dialogul parametrilor.
• If there are no input layer, it will use the project CRS, unless the algorithm contains a specific CRS field (as it happened in the last lesson with the graticule algorithm).

Deschideți proiectul corespunzător acestei lecții, și veți vedea două straturi denumite 23030 și 4326. Ambele conțin același număr de puncte, dar au fost introduse în diferite CRS-uri (EPSG:23030 și EPSG:4326). Ele apar în același loc, deoarece QGIS este reproiectat „din zbor” în CRS-ul proiectului (EPSG:4326), ele nefiind, de fapt, unul și același strat.

Deschide algoritmul Export/Adăugare coloane de geometrie.

---

Acest algoritm adaugă coloane noi în tabela de atribut de un strat vectorial. Continuulul coloanelor depinde de tipul geometriei stratului. În cazul punctelor, se vor adăuga coloane noi, conținând coordonatele X și Y ale fiecărei puncte. În lista de straturi disponibile, pe care le veți găsi în câmpul stratului de intrare, le veți vedea pe fiecare, alături de CRS-ul corespunzător. Astfel, deși apar în același loc pe caneva, ele vor fi tratate în mod diferit. Selectați stratul 4326.

Celălalt parametru al algoritmului permite setarea modului în care algoritmul folosește coordonatele, pentru a calcula noua valoare care se va adăuga la straturile rezultate. Cei mai mulți algoritmi nu au o opțiune de acest gen, și vor folosi în mod direct coordonatele. Selectați opțiunea CRS-ul Stratului pentru a folosi coordonatele așa cum sunt. Acesta este modul în care lucrează aproape toți geo-algoritmi.

Ar trebui să obțineți un nou strat, cu exact aceleași puncte ca și celelalte două. Dacă faceți clic dreapta pe numele stratului și îi deschideți proprietățile, veți vedea că folosește CRS-ul stratului de intrare, adică, EPSG:4326. Atunci când stratul este încarcat în QGIS, nu vi se va cere să introduceți CRS-ul stratului, atât timp cât QGIS îl cunoaște.

Dacă deschideți tabelul de atributte a noului strat, veți vedea că ea conține două noi câmpuri, cu coordonatele X și Y ale fiecărei puncte.

---

17.6. Reproiectarea CRS-urilor 497
Those coordinate values are given in the layer CRS, since we chose that option. However, even if you choose another option, the output CRS of the layer would have been the same, since the input CRS is used to set the CRS of the output layer. Choosing another option will cause the values to be different, but not the resulting point to change or the CRS of the output layer to be different to the CRS of the input one.

Acum, efectuați același calcul, utilizând celălalt strat. Ar trebui să găsiți stratul rezultat, randat exact în același loc ca și celelalte, având același CRS, EPSG:23030, acesta fiind CRS-ul stratului de intrare.

Dacă mergeți la tabela sa de attributе, veți vedea valori care sunt diferite de cele din primul strat pe care l-am creat.

<table>
<thead>
<tr>
<th>ID</th>
<th>PT_NUM_A</th>
<th>PT_ST_A</th>
<th>xcoord</th>
<th>ycoord</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>a</td>
<td>-5.695426</td>
<td>40.248071</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>b</td>
<td>-5.695885</td>
<td>40.247622</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>c</td>
<td>-5.695466</td>
<td>40.247520</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>a</td>
<td>-5.695222</td>
<td>40.247694</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>b</td>
<td>-5.695652</td>
<td>40.248030</td>
</tr>
<tr>
<td>5</td>
<td>6</td>
<td>a</td>
<td>-5.695855</td>
<td>40.248067</td>
</tr>
<tr>
<td>6</td>
<td>7</td>
<td>b</td>
<td>-5.696049</td>
<td>40.248028</td>
</tr>
<tr>
<td>7</td>
<td>8</td>
<td>c</td>
<td>-5.696126</td>
<td>40.247629</td>
</tr>
<tr>
<td>8</td>
<td>9</td>
<td>a</td>
<td>-5.695961</td>
<td>40.247786</td>
</tr>
<tr>
<td>9</td>
<td>10</td>
<td>b</td>
<td>-5.695353</td>
<td>40.247929</td>
</tr>
<tr>
<td>10</td>
<td>11</td>
<td>a</td>
<td>-5.695595</td>
<td>40.247739</td>
</tr>
<tr>
<td>11</td>
<td>12</td>
<td>b</td>
<td>-5.695779</td>
<td>40.247896</td>
</tr>
</tbody>
</table>

Acest lucru se datorează faptului că datele originale sunt diferite (se folosește un alt CRS), și acele coordonate sunt preluate din ea.

Ce ar trebui să învățați din asta? Idea principală din spatele acestor exemple este aceea că geoalgoritmi folosesc stratul așa cum se află în sursa sa de date originală, ignorând complet reproiectările pe care QGIS le-ar putea efectua înainte de randare. Cu alte cuvinte, nu aveți încărcere în ceea ce veți vedea pe pânză, dar aveți întotdeauna în vedere faptul că vor fi utilizate datele originale. Acest lucru nu este atât de important în acest caz, din moment ce folosim doar un singur strat la un moment dat, dar într-un algoritm care are nevoie de mai multe (cum ar fi un algoritm de decupare), straturile care par să se potrivească sau să se suprapună, ar putea fi foarte departa unul față de celălalt, atât timp cât pot avea diferite CRS-uri.

Algoritmi ne realizează nici o reproiectare (cu excepția algoritmului de reproiectare pe care îl vom vedea în continuare), de aceea, trebuie ca dvs. să vă asigurați că straturile au același CRS.
Un modul interesant, care are de-a face cu CRS-ul, este cel de reproiectare. Acesta reprezintă un caz particular, deoarece are un strat de intrare (cel de reproiectat), însă nu îi va folosi CRS-ul pentru stratul de ieşire.

Deschide algoritmul de *Reproiectare a stratului*.

Selectați oricare dintre straturile ca intrare, și alegeți EPSG:23029 ca CRS destinație. Rulați algoritmul și veți obține un nou strat, identic cu cel de intrare, dar cu un alt CRS. Acesta va apărea în aceeași regiune a canevasului, ca și celelalte, din moment ce QGIS îl va reproiecta din zbor, dar coordonatele sale originale sunt diferite. Puteți vedea acest lucru, prin rularea algoritmului de *Exportare/Adăugare coloane de geometrie* asupra acestui nou strat de intrare, și prin verificarea diferențelor dintre coordonatele adăugate și cele din tabelele de atribute ale ambelor straturi, calculate anterior.

### 17.7 Selecția

*Notă:* În această lecție vom vedea cum gestionează selecțiile algoritmii de procesare din straturile vectoriale care sunt utilizate ca intrare, și cum se poate crea o selecție, folosindu-se un anumit tip de algoritm.

Spre deosebire de alte plugin-uri de analiză din QGIS, geoalgoritmii de procesare nu dispun de caseta de bifare pentru „Utilizare doar a entităților selectate” sau ceva similar acesteia. Comportamentul privitor la selectare este stabilit pentru întreg plugin-ul și pentru toți algoritmii, și nu pentru fiecare rulare a algoritmului. Algoritmul poate următoarele reguli simple, atunci când se utilizează un strat vectorial.

- Dacă stratul are o selecție, vor fi utilizate numai entitățile selectate.
- Dacă nu există nici o selecție, atunci vor fi utilizate toate entitățile.

Vă rugăm să rețineți că puteți schimba acest comportament prin deselectarea meniului opțiunii relevante *Processing ➤ Options ➤ General*.
You can test that yourself by selecting a few points in any of the layers that we used in the last chapter, and running the reprojection algorithm on them. The reprojected layer that you will obtain will contain only those points that were selected, unless there was no selection, which will cause the resulting layer to contain all points from the original layer.

To make a selection, you can use any of the available methods and tools in QGIS. However, you can also use a geoalgorithm to do so. Algorithms for creating a selection are found in the toolbox under **Vector/Selection**.

![Select algorithm](image)

Deschideți algoritmul de *Selectie aleatoare*.

Lăsând valorile implicate, se vor selecta 10 puncte din stratul curent.
Veți observa că acest algoritm nu produce nici o iesire, dar modifică stratul de intrare (nu stratul în sine, ci selecția sa). Acesta este un comportament mai puțin frecvent, deoarece toți ceilalți algoritmi vor produce noi straturi și nu vor modifica straturile de intrare.

Since the selection is not part of the data itself, but something that only exist within QGIS, these selection algorithms only must be used selecting a layer that is open in QGIS, and not with the file selection option that you can find in the corresponding parameter value box.

The selection we have just made, like most of the ones created by the rest of the selection algorithms, can also be done manually from QGIS, so you might be wondering what is the point on using an algorithm for that. Although now this might not make much sense to you, we will later see how to create models and scripts. If you want to make a selection in the middle of a model (which defines a processing workflow), only a geoalgorithm can be added to a model, and other QGIS elements and operations cannot be added. That is the reason why some processing algorithms duplicate functionality that is also available in other QGIS elements.

By now, just remember that selections can be made using processing geoalgorithms, and that algorithms will only use the selected features if a selection exists, or all features otherwise.

17.8 Rularea unui algoritm extern

Notă: În această lecție vom vedea cum să folosim algoritmi care depind de o terță aplicație, în spatea SAGA, care este unul dintre principalii furnizori de algoritmi.

All the algorithms that we have run so far are part of processing framework. That is, they are native algorithms implemented in the plugin and run by QGIS just like the plugin itself is run. However, one of the greatest features of the processing framework is that it can use algorithms from external applications and extend the possibilities of those applications. Such algorithms are wrapped and included in the toolbox, so you can easily use them from QGIS, and use QGIS data to run them.

Pentru a rula, unii dintre algoritmului pe care îi vedeti în vizualizarea simplificată necesită, în prealabil, instalarea unor aplicatii terce în sistemul dumneavoastră. Un furnizor de algoritmi de interes special este SAGA (Sistem de Analize Geospatiale Automate). Pentru a apela în mod corect SAGA, QGIS trebuie să fie configurat în mod corespunzător. Acest lucru nu este dificil, dacă înțelegem principiul de funcționare. Fiecare aplicație externă are propria sa configurație, iar mai târziu, în același manual vom vorbi despre altele, însă acum vom discuta despre SAGA.

În cazul în care vă aflați pe Windows, cel mai bun mod de a lucra cu algoritmului externi este de a instala QGIS cu ajutorul programului de instalare. Acesta va avea grijă de instalarea dependențelor necesare, inclusiv SAGA, astfel că, dacă l-ai folosit, nu mai trebuie să întreprindeți altceva. Puteti deschide dialogul setarilor, apoi să mergeți la grupul Furnizorilor/SAGA.
Calea către SAGA trebuie să fie deja configurată și să indice folderul în care este instalat SAGA.

Dacă ați instalat QGIS fără să folosiți programul autonom de instalare, atunci trebuie să introduceți calea către SAGA (care trebuie să fie deja instalată). Versiunea necesară este SAGA 2.1 [aceasta se schimbă în funcție de versiunile de SAGA].

In case you are using Linux, you do not have to set the path to your SAGA installation in the processing configuration. Instead, you must install SAGA and make sure that the SAGA folder is in PATH, so it can be called from the console (just open a console and type saga_cmd to check it). Under Linux, the target version for SAGA is also 2.1, but in some installations (such as the OSGeo Live DVD) you might have just 2.0.8 available. There are some 2.1 packages available, but they are not commonly installed and might have some issues, so if you prefer to use the more common and stable 2.0.8, you can do it by enabling 2.0.8 compatibility in the configuration dialog, under the SAGA group.
O dată ce SAGA este instalat, puteți lansa un algoritm SAGA printr-un dublu clic pe numele său, similar celorlalți algoritmi. Din moment ce folosim interfața simplificată, nu știm care dintre algoritmi se bazează pe SAGA sau pe o altă aplicație externă, dar dacă se întâmplă să rulați unul pentru care aplicația corespunzătoare nu este instalată, vi se va indica acest lucru.

În cazul nostru, presupunând că aplicația SAGA este instalată și configurată corect, nu ar trebui să vedeti această fereastră ci, în schimb, vă obține parametrii dialogului.
Să încercăm cu un algoritm bazat pe SAGA, cel denumit *Split shapes layer randomly*.

The input layer has been split in two layers, each one with the same number of points. This result has been computed by SAGA, and later taken by QGIS and added to the QGIS project.

If all goes fine, you will not notice any difference between this SAGA–based algorithm and one of the others that we have previously run. However, SAGA might, for some reason, not be able to produce a result and not generate the...
file that QGIS is expecting. In that case, there will be problems adding the result to the QGIS project, and an error message like this will be shown.

This kind of problems might happen, even if SAGA (or any other application that we are calling from the processing framework) is correctly installed, and it is important to know how to deal with them. Let's produce one of those error messages.

Deschideți algoritmul Creare graticule, și folosiți-l cu următoarele valori.
We are using width and height values that is larger than the specified extent, so SAGA cannot produce any output. In other words, the parameter values are wrong, but they are not checked until SAGA gets them and tries to create the graticule. Since it cannot create it, it will not produce the expected layer, and you will see the error message shown above.

**Nota:** În SAGA >= 2.2.3, comanda va ajusta în mod automat datele de intrare gresite, aşa că nu veți obţine o eroare. Pentru a provoca o eroare, utilizați valori negative la divizare.

Understanding this kind of problems will help you solve them and find an explanation to what is happening. As you can see in the error message, a test is performed to check that the connection with SAGA is working correctly, indicating you that there might be a problem in how the algorithm was executed. This applies not only to SAGA, but also to other external applications as well.

In the next lesson we will introduce the processing log, where information about commands run by geoalgorithms is kept, and you will see how to get more detail when issues like this appear.

### 17.9 Procesarea jurnalului

**Nota:** Această lecție descrie procesarea jurnalului.

Toate analizele efectuate de cadrul de procesare se înregistrează în sistemul de jurnalizare al aplicației QGIS. Acest lucru vă permite să aflați mai multe despre istoricul utilizării uneltelelor de procesare, pentru a putea depăși problemele atunci când acestea apar și, de asemenea, vă facilitează repetarea operațiunilor anterioare, întrucât sistemul de jurnalizare dispune de o anumită interactivitate.
Pentru a deschide jurnalul, faceți clic pe balonul din dreapta jos, pe bara de stare a QGIS. Unii algoritmi ar putea nota aici informații cu privire la execuția lor. De exemplu, acei algoritmi care apeleză o aplicație externă, dirijeză orice mesaj către această ieșire. Dacă priviți cu atenție, veți observa că ieșirea algoritmului SAGA pe care tocmai l-am rulat (și a căruia execuție nu a reusit, deoarece datele de intrare nu au fost corecte) se află aici.

Aceste informații v-ar putea fi utile, pentru a înțelege ce se întâmplă. Utilizatorii avansați vor putea să analizeze o ieșire, pentru a afla de ce a eșuat algoritmul. Dacă nu sunteți un utilizator avansat, informațiile respective vor fi utile celor care vă ajuta la diagnosticarea unei probleme, pentru a determina dacă a fost cauzată de instalarea unei aplicații externe sau de datele pe care le-ați introdus.

Chiar dacă un algoritm poate fi executat, în unele cazuri acestia ar putea emite avertizmente dacă rezultatul s-ar putea să nu fie corect. Un exemplu ar fi execuția unui algoritm de interpolare pe baza unui număr foarte mic de puncte, care, deși se poate desfășura, poate genera un rezultat incorect, atât timp cât ar fi trebuit să fie folosite mai multe puncte. Este foarte bine să verificiți în mod regulat acest tip de avertizmente, dacă nu vă sunt clare anumite aspecte ale unui algoritm.

În meniul Processing, din secțiunea Istoricului, veți găsi Algoritmi. Toți algoritmul care sunt executați, chiar dacă sunt lansați din cadrul GUI și nu de la consolă (care va fi descrisă mai târziu în acest manual) sunt stocați în această parte a jurnalului ca și apel din consolă. Acest lucru înseamnă că de fiecare dată când executați un algoritm, se va adăuga o comandă de consolă în jurnal, păstrându-se istoricul complet al sesiunii dvs. de lucru. Iată cum arată istoricul:

```
INFO
[Sun Aug 25 2013 13:22:20] processing.runalg("saga.splitshapeslayerrandomly", "C:\User...
[Sun Aug 25 2013 13:22:11] processing.runalg("saga.splitshapeslayerrandomly", "D:\githe...
[Sun Aug 25 2013 13:21:41] processing.runalg("saga.splitshapeslayerrandomly", "G:\githe...
[Sun Aug 25 2013 13:16:36] processing.runalg("saga.splitshapeslayerrandomly", "D:\githe...
[Sun Aug 25 2013 13:41:51] processing.runalg("saga.splitshapeslayerrandomly", "D:\githe...

processing.runalg("saga.splitshapeslayerrandomly", "D:\github\sextante-manual\data\first_saga_alq\points.shp", 51, None, None)
```

Acest lucru poate fi foarte util atunci când începe lucru cu consola, pentru a afla mai multe despre sintaxa algoritmulor. Îl vom folosi când vom discuta despre modul în care se pot rula comenzile de analiză din consolă.

Istoricul este, de asemenea, interactiv, de aceea veți putea relansa orice algoritm printr-un simplu dublu-clic pe denumirea sa. Aceasta este o modalitate ușoară de a reproduce comenzii pe care le-ati mai executat.

De exemplu, încercați următoarele. Deschideți datele corespunzătoare primului capitol din acest manual și rulați
algoritmul descris acolo. Apoi mergeti la fereastra jurnalului și localizați ultimul algoritm din listă, care corespunde algoritmului pe care abia l-ăți rulat. Efectuând un dublu-clic pe el se va obține un nou rezultat, la fel ca și atunci când l-ăți rulat utilizând dialogul normal, apelându-l din caseta de instrumente.

17.9.1 Avansat

De asemenea, puteți modifica algoritmul. Trebuie doar să-l copiați, să deschideți Plugin-uri ➤ Consola Python, să faceți clic pe Importare clasă ➤ Importare clasă de Processing, apoi să-l lăpiți pentru a reexecuta analiza; schimbați textul după dorință. Pentru a afișa fișierul rezultat, introduceți iface.addVectorLayer('/path/ filename.shp', 'Numele stratului din legendă', 'ogr'). În caz contrar, puteți utiliza processing.runandload.

17.10 Calculatorul raster. Valorile fără-date

Nota: În această lecție vom vedea cum se utilizează calculatorul raster pentru a efectua unele operații asupra straturilor raster. Vom explica, de asemenea, ce sunt valorile fără-date și modul în care lucrează cu ele calculatorul și alți algoritmi

Calculatorul raster reprezintă unul dintre cei mai puternici algoritmi. Este un algoritm foarte flexibil și versatil, care poate fi folosit în diverse calcule, și care va deveni în curând o parte importantă a setului dvs. cu instrumente.

În această lecție vom efectua unele calcule, majoritatea simple, cu ajutorul calculatorului raster. Acest lucru ne va permite să observăm modul de gestionare a unor situații particulare cu care ne-am putea confrunta. Întelegerea acestor aspecte este importantă pentru obținerea ulterioră a rezultatelor așteptate și, de asemenea, pentru deprinderea tehnicilor comune care se pot aplica.

Deschideți proiectul QGIS corespunzător acestei lecții și veți vedea că ea conține mai multe straturi raster.

Acum deschideți caseta de instrumente și caseta de dialog corespunzătoare calculatorului raster.
Notă: Interfata diferă pentru versiunile recente.

Dialogul conține 2 parametri.

- The layers to use for the analysis. This is a multiple input, that meaning that you can select as many layers as you want. Click on the button on the right–hand side and then select the layers that you want to use in the dialog that will appear.

- The formula to apply. The formula uses the layers selected in the above parameter, which are named using alphabet letters (a, b, c...) or g1, g2, g3... as variable names. That is, the formula \( a + 2 \times b \) is the same as \( g1 + 2 \times g2 \) and will compute the sum of the value in the first layer plus two times the value in the second layer. The ordering of the layers is the same ordering that you see in the selection dialog.

Atenționare: Calculator tine cont de majuscule/minuscule.

Pentru a începe, vom schimba unitățile DEM-ului din metri în picioare. Formula de care avem nevoie este:

\[
h' = h \times 3.28084
\]

Selectați DEM-ul din câmpul straturilor și introduceți \( a \times 3.28084 \) în câmpul formulei.

Atenționare: Pentru utilizatorii care nu sunt englezi: folosiți întotdeauna „.”, nu „,”.

Click Run to run the algorithm. You will get a layer that has the same appearance of the input layer, but with different values. The input layer that we used has valid values in all its cells, so the last parameter has no effect at all.
Let’s now perform another calculation, this time on the accflow layer. This layer contains values of accumulated flow, a hydrological parameter. It contains those values only within the area of a given watershed, with no-data values outside of it. As you can see, the rendering is not very informative, due to the way values are distributed. Using the logarithm of that flow accumulation will yield a much more informative representation. We can calculate that using the raster calculator.

Open the algorithm dialog again, select the accflow layer as the only input layer, and enter the following formula: $\log(a)$.

Acesta este stratul pe care îl veți obține.

If you select the Identify tool to know the value of a layer at a given point, select the layer that we have just created, and click on a point outside of the basin, you will see that it contains a no-data value.
For the next exercise we are going to use two layers instead of one, and we are going to get a DEM with valid elevation values only within the basin defined in the second layer. Open the calculator dialog and select both layers of the project in the input layers field. Enter the following formula in the corresponding field:

\[ \frac{a}{a} \cdot b \]

\( a \) refers to the accumulated flow layer (since it is the first one to appear in the list) and \( b \) refers to the DEM. What we are doing in the first part of the formula here is to divide the accumulated flow layer by itself, which will result in a value of 1 inside the basin, and a no-data value outside. Then we multiply by the DEM, to get the elevation value in those cells inside the basin (\( DEM \times 1 = DEM \)) and the no-data value outside (\( DEM \times no\_data = no\_data \)).

Acesta este stratul rezultat.

This technique is used frequently to mask values in a raster layer, and is useful whenever you want to perform calculations for a region other than the arbitrary rectangular region that is used by raster layer. For instance, an elevation histogram of a raster layer doesn’t have much meaning. If it is instead computed using only values
corresponding to a basin (as in he case above), the result that we obtain is a meaningful one that actually gives information about the configuration of the basin.

There are other interesting things about this algorithm that we have just run, apart from the no–data values and how they are handled. If you have a look at the extents of the layers that we have multiplied (you can do it double–clicking on their names of the layer in the table of contents and looking at their properties), you will see that they are not the same, since the extent covered by the flow accumulation layer is smaller that the extent of the full DEM.

That means that those layers do not match, and that they cannot be multiplied directly without homogenizing those sizes and extents by resampling one or both layers. However, we did not do anything. QGIS takes care of this situation and automatically resamples input layers when needed. The output extent is the minimum covering extent calculated from the input layers, and the minimum cell size of their cellsizes.

In this case (and in most cases), this produces the desired results, but you should always be aware of the additional operations that are taking place, since they might affect the result. In cases when this behaviour might not be the desired, manual resampling should be applied in advance. In later chapters, we will see more about the behaviour of algorithms when using multiple raster layers.

Let’s finish this lesson with another masking exercise. We are going to calculate the slope in all areas with an elevation between 1000 and 1500 meters.

În acest caz, nu dispunem de un strat pentru a-l utiliza drept mască, dar îl putem crea cu ajutorul calculatorului. Pornește calculatorul folosind DEM-ul doar ca pe un strat de intrare, și următoarea formulă

\[
\text{ifelse}(\text{abs}(a-1250) < 250, 1, 0/0)
\]

As you can see, we can use the calculator not only to do simple algebraic operations, but also to run more complex calculation involving conditional sentences, like the one above.

Rezultatul are o valoare de 1 în interiorul gamei în care dorim să lucrăm, și valori fără-date în celulele din exterior.

The no-data value comes from the 0/0 expression. Since that is an undetermined value, SAGA will add a NaN (Not a Number) value, which is actually handled as a no-data value. With this little trick you can set a no-data value without needing to know what the no–data value of the cell is.

Now you just have to multiply it by the slope layer included in the project, and you will get the desired result.

All that can be done in a single operation with the calculator. We leave that as an exercise for the reader.
17.11 Calculatorul vectorial

Notă: În această lecție vom vedea cum se vor adăuga noi atribute în stratul vectorial, pe baza unei expresii matematice, cu ajutorul calculatorului vectorial.

Cunoaștem deja cum să utilizăm calculatorul raster pentru a crea noi straturi raster cu ajutorul expresiilor matematice. Un algoritm similar este disponibil pentru straturi vectoriale, și generează un nou strat cu aceleași atribute ale stratului de intrare, plus unul suplimentar cu rezultatul expresiei introduse. Algoritmul este denumit *Calculator de câmpuri* și are următoarea fereastră de dialog cu parametri.

![Field calculator dialog](image)

Notă: În versiunile mai noi de Processing, interfața s-a schimbat considerabil, fiind mult mai puternică și mai ușor de utilizat.

Aici sunt câteva exemple de utilizare ale acestui algoritm.

First, let’s calculate the population density of white people in each polygon, which represents a census. We have two fields in the attributes table that we can use for that, namely \texttt{WHITE} and \texttt{SHAPE\_AREA}. We just have to divide them and multiply by one million (to have density per square km), so we can use the following formula in the corresponding field

\[
\left( \frac{\texttt{WHITE}}{\texttt{SHAPE\_AREA}} \right) \times 1000000
\]

Dialogul parametrilor trebuie completat așa cum se arată mai jos.
Acest lucru va genera un nou câmp denumit WHITE_DENS.

Now let’s calculate the ratio between the MALES and FEMALES fields to create a new one that indicates if male population is numerically predominant over female population.

Introduceți următoarea formulă:

"MALES" / "FEMALES"

Fereastra parametrilor ar trebui să arate acest lucru, înainte de a apăsa pe butonul OK.
In earlier version, since both fields are of type integer, the result would be truncated to an integer. In this case the formula should be: 1.0 * "MALES" / "FEMALES", to indicate that we want floating point number a result.

We can use conditional functions to have a new field with male or female text strings instead of those ratio value, using the following formula:

```
CASE WHEN "MALES" > "FEMALES" THEN 'male' ELSE 'female' END
```

Fereastra parametrilor ar trebui să arate acest lucru.
Un calculator de câmpuri python este disponibil în *Advanced Python field calculator*, care nu va fi detaliat aici.
Notă: În această lecție vom vedea cum se definesc extinderile, acest lucru fiind necesar unor algoritmi, mai ales cele pentru rastere.

Unii algoritmi au nevoie de o extindere, pentru a defini zona care urmează să fie acoperită de analiză și, de obicei, pentru a defini extinderea stratului rezultat.

Atunci când este cerută o anumită extindere, aceasta poate fi definită manual, prin introducerea celor patru valori care o definesc (min X, min Y, max X, max Y), dar există și alte modalități, mai practice și mai interesante, care pot face la fel de bine acest lucru. Vom vedea toate acestea în cadrul lecției.

Mai întâi, haideți să deschidem un algoritm care necesită definirea unei extinderi. Deschideți algoritmul de Rasterizare, care creează un strat raster dintr-un strat vectorial.
All the parameters, except for the last two ones, are used to define which layer is to be rasterized, and configure how the rasterization process should work. The two last parameters, on the other hand, define the characteristics of the output layer. That means that they define the area that is covered (which is not necessarily the same area covered by the input vector layer), and the resolution/cellsize (which cannot be inferred from the vector layer, since vector layers do not have a cellsize).

That doesn’t need any extra explanation. While this is the most flexible option, it is also the less practical in some cases, and that’s why other options are implemented. To access them, you have to click on the button on the right–hand side of the extent text box.

Să vedem ce poate face fiecare. 
Prima opțiune este *Use layer/canvas extent*, care va afișa dialogul de selecție de mai jos.
Here you can select the extent of the canvas (the extent covered by the current zoom), or the extension any of the available layers. Select it and click on OK, and the text box will be automatically filled with the corresponding values.

The second option is Select extent on canvas. In this case, the algorithm dialog disappears and you can click and drag on the QGIS canvas to define the desired extent.

După ce eliberați butonul mouse-ului, dialogul va reapărea iar caseta de text va conține deja valorile corespunzătoare în extinderea definită.

The last option is Use min covering extent from input layers, which is the default option. This will compute the min covering extent of all layers used to run the algorithm, and there is no need to enter any value in the text box. In the case of a single input layer, as in the algorithm we are running, the same extent can be obtained by selecting that same input layer in the Use layer/canvas extent that we already saw. However, when there are several input layers, the min covering extent does not correspond to any of the input layer extent, since it is computed from all of them together.

Vom folosi această ultimă metodă pentru a executa algoritmul nostru de rasterizare.

Completați dialogul parametrilor după cum se arată în continuare, apoi apăsați OK.
Nota: In this case, better use an Integer (1 byte) instead of a Floating point (4 byte), since the NAME is an integer with maximum value=64. This will result in a smaller file size and faster computations.

Veți primi un strat raster care acoperă exact zona acoperită de stratul vectorial inițial.
In some cases, the last option, *Use min covering extent from input layers*, might not be available. This will happen in those algorithms that do not have input layers, but just parameters of other types. In that case, you will have to enter the value manually or use any of the other options.

Notice that, when a selection exists, the extent of the layer is that of the whole set of features, and the selection is not used to compute the extent, even though the rasterization is executed on the selected items only. In that case, you might want to actually create a new layer from the selection, and then use it as input.

### 17.13 Ieșiri HTML

**Nota:** În această lecție învățăm cum administrează QGIS ieșirile în format HTML, care sunt utilizate pentru a produce text și grafică.

Toate rezultatele obținute până în prezent au fost sub formă de straturi (vectoriale sau raster). Cu toate acestea, unii algoritmi generează ieșiri sub formă de text și grafică. Acestea sunt încapsulate în fișiere HTML și afișate în asa-numitul *Vizualizator de rezultate*, care reprezintă un alt element al cadrului de procesare.

Să vedem unul dintre acești algoritmi pentru a înțelege cum funcționează.

Deschideți proiectul cu datele de utilizat în această lecție, apoi deschideți algoritmul *Statistici de bază pentru câmpurile numerice.*
Algoritmul este destul de simplu, trebuind să selectați doar stratul de utilizat și unul din câmpurile sale (unul numeric). Iesirea este de tip HTML, dar caseta corespunzătoare funcționează similar cu cea pentru o ieșire de tip vectorial sau raster. Puțeti introduce o cale de fișier sau să o lăsați neîncompletată, pentru ca salvarea să aibă loc într-un fișier temporar. Totuși, în acest caz sunt acceptate doar extensiile .html și .htm, nefiind nici o modalitate de a modifica formatul de ieșire.

Rulați algoritmul, selectând ca intrare singurul strat din proiect și câmpul POP2000, după care va apărea un nou dialog, similar celui prezentat anterior, iar o dată ce algoritmul este executat dialogul parametrilor se va închide.
Acesta este Vizualizatorul de rezultate. Aici se păstrează tot rezultatul HTML generat în timpul sesiunii curente, într-o formă ușor accesibilă, astfel încât să-l puteți verifica rapid, ori de câte ori este nevoie. Orice modificare adusă stratului se va pierde la închiderea QGIS, dacă ati ales iesirea într-un fisier temporar. Dacă ati efectuat salvarea într-o cale permanentă, fisierul se va păstra, dar nu va apărea în Vizualizatorul de rezultate la următoarea deschidere a aplicației QGIS.

Unii algoritmi generează text care nu poate fi subdivizat. Acesta este, de exemplu, cazul algoritmulor care capturează textul generat de către un proces extern. În alte cazuri, rezultatul este prezentat sub formă de text, dar în mod intern el este împărțit în mai multe secțiuni, de obicei sub formă de valori numerice. Algoritmul pe care tocmai l-am executat este unul dintre acestea. Fiecare dintre valori este tratată ca o singură iesire, stocată într-o variabilă. Deși nu sunt relevante acum, o dată ce vom trece la modelatorul grafic, aceste valori vor fi utilizate ca intrări numerice pentru alte algoritmi.

### 17.14 Un prim exemplu de analiză

**Notă:** În această lecție, vom efectua o analiză reală, folosind doar bara de instrumente, astfel încât să vă familiarizați cu elementele cadrului de prelucrare.

O dată ce totul este configurat, iar algoritmi externi sunt gata de utilizare, dispuneți de un instrument foarte puternic pentru efectuarea analizelor spațiale. Este timpul să elaborăm un exercițiu mai amplu, folosind date din lumea reală.

We will be using the well-known dataset that John Snow used in 1854, in his groundbreaking work ([https://en.])
wikipedia.org/wiki/John_Snow_%28physician%29), and we will get some interesting results. The analysis of this dataset is pretty obvious and there is no need for sophisticated GIS techniques to end up with good results and conclusions, but it is a good way of showing how these spatial problems can be analyzed and solved by using different processing tools.

Setul de date conține fisierul shape cu decesele cauzate de holeră și locațiile pompelor, precum și o hartă OSM rândată în format TIFF. Deschideți proiectul QGIS corespunzător acestei lecții.

The first thing to do is to calculate the Voronoi diagram (a.k.a. Thiessen polygons) of the pumps layer, to get the influence zone of each pump. The Voronoi Diagram algorithm can be used for that.
Destul de ușor, dar ne va oferi deja informații interesante.
În mod evident, cele mai multe cazuri se încadrează într-unul dintre poligoane

To get a more quantitative result, we can count the number of deaths in each polygon. Since each point represents a building where deaths occurred, and the number of deaths is stored in an attribute, we cannot just count the points. We need a weighted count, so we will use the *Count points in polygon (weighted)* tool.
The new field will be called *DEATHS*, and we use the *COUNT* field as weighting field. The resulting table clearly reflects that the number of deaths in the polygon corresponding to the first pump is much larger than the other ones.
Another good way of visualizing the dependence of each point in the Cholera_deaths layer with a point in the Pumps layer is to draw a line to the closest one. This can be done with the Distance to nearest hub tool, and using the configuration shown next.
Rezultatul arată în felul următor:
Although the number of lines is larger in the case of the central pump, do not forget that this does not represent the number of deaths, but the number of locations where cholera cases were found. It is a representative parameter, but it is not considering that some locations might have more cases than other.

A density layer will also give us a very clear view of what is happening. We can create it with the Kernel density algorithm. Using the Cholera_deaths layer, its COUNT field as weight field, with a radius of 100, the extent and cells size of the streets raster layer, we get something like this.
Amintiți-vă că, pentru a obține întinderea rezultatului, nu trebuie să o introduceți. Faceți clic pe butonul din partea dreaptă și selectați *Use layer/canvas extent.*
Selectați stratul străzilor raster iar întinderea sa va fi adăugată automat în câmpul de text. Trebuie să faceți același lucru cu dimensiunea celulei, selectând-o, de asemenea, din acel strat.

Prin combinairea cu stratul de pompe, vom vedea că există o pompă în mod clar în punctul fierbinte, în care se constată densitatea maximă a cazurilor de deces.

17.15 Decuparea și îmbinarea straturilor raster

**Notă:** În această lecție vom vedea un alt exemplu de pregătire a datelor spațiale, pentru a continua utilizarea geoalgoritmilor în scenarii din lumea reală.

În această lecție, vom calcula un strat de pantă pentru suprafața care înconjoară o zonă dată a orașului, dintr-un strat vectorial cu un singur poligon. DEM-ul de bază este împărțit în două straturi raster care, împreună, acoperă o suprafață mult mai mare decât cea din jurul orașului în care ne dorim să lucrăm. Dacă deschideți proiectul corespunzător acestei lectii, veți vedea ceva de genul următor.
Acesta este un manual de instruire care are două probleme:

- Aceasta acoperă o zonă care este prea mare pentru ceea ce dorim (suntem interesați de o regiune mai mică din jurul centrului orașului)

- Ele se află în două fișiere diferite (limitele orașului se încadrează doar într-un singur strat raster, dar, așa cum s-a mai zis, dorim o anumită suprafață adițională în jurul acestuia).

Ambele sunt ușor rezolvabile cu geoolgoritmi care corespund.

În primul rând, vom crea un dreptunghi care definește zona dorită. Pentru aceasta, vom crea un strat care conține caseta de încadrare a stratului, împreună cu limitele suprafeței orașului, apoi vom crea un tampon, astfel încât să existe un strat raster care îl acoperă un pic mai mult decât este necesar.

Pentru a calcula caseta de încadrare, putem folosi algoritmul *Polygonului din extinderea stratului*.
Pentru a-l tampona, vom folosi algoritmul *Fixed distance buffer*, cu următoarele valori pentru parametri.
Atenționare: Sintaxa s-a schimbat în versiunile recente; setați atât Distanță cât și vertexul Arcului la .25

Aici se află caseta de încadrare obținută, utilizând parametrii de mai sus

Este o casetă rotundă, dar putem obține cu ușurință o casetă echivalentă, cu unghiuri drepte, prin rularea algoritmului *Poligon din extinderea stratului* asupra ei. Am putea să tamponăm mai întâi limitele orașului, iar apoi să calculăm extinderea dreptunghiului, economisind un pas.

Veți observa că rasterele au o proiecție diferită față de vector. Prin urmare, ar trebui să le reproiectăm înainte de a trece mai departe, folosind instrumentul *Warp (reproiectare)*.
Notă: Versiunile recente au o interfață mai complexă. Asigurați-vă că cel puțin o metodă de compresie este selectată.

Cu ajutorul acestui strat, care conține caseta de încadrare a stratului raster pe care dorim să-l obtinem, putem decupa ambele straturi raster, utilizând algoritmul de Decupare grilă după un poligon.
Once the layers have been cropped, they can be merged using the SAGA Mosaic raster layers algorithm.
Notă: Puteți economisi timp prin efectuarea mai întâi a îmbinării, și abia mai apoi a decupării, evitându-se astfel apelarea de două ori a algoritmului de decupare. Totuși, în cazul în care mai multe straturi cu o dimensiune apreciabilă trebuie îmbinate, vă veți alege cu un strat voluminos, care poate fi dificil de prelucrat ulterior. În acest caz, s-ar putea avea să apelați algoritmul de tăiere de mai multe ori, operație consumatoare de timp, însă nu vă îngrijorați pentru că veți vedea că există unele instrumente adiționale, dedicate automatizării acestui proces. Pentru exemplul următor nu este cazul să vă faceți grijă, deoarece folosim numai două straturi.

Cu asta, vom obține DEM-ul final pe care ni-l dorim.

![Image](image.png)

Acum este timpul să calculăm stratul pantei.

Stratul pantei poate fi calculat cu ajutorul algoritmului Pantă, Aspect, Curbură, însă DEM-ul obținut în ultima etapă nu este potrivit ca intrare, deoarece valorile altitudinii sunt exprimate în metri, iar mărimea celulei nu este exprimată în metri (stratul folosește un CRS cu coordonate geografice). De aceea, este nevoie de o reproiectare. Pentru a reproiecta stratul raster, se poate utiliza iarăși algoritmul Warp (reproiectare). Vom efectua reproiectarea într-un CRS având metrul ca unitate (cum ar fi 3857), astfel încât vom putea calcula corect panta, fie cu SAGA, ori cu GDAL.

Panta poate fi de acum calculată, cu ajutorul noului DEM.
Iar aici este stratul pantei rezultate.
Panta produsă de algoritmul Pantă, Aspect, Curbură este exprimată în radiani, deși gradele reprezintă o unitate mai practică și mai comună. Algoritmul de Conversii metrice ne va ajuta să facem conversia (dar în cazul în care nu ați fi știut că acest algoritm există, ați fi putut utiliza calculatorul raster, pe care le-am folosit deja).
Reproiectând stratului pantă convertit, cu ajutorul Reproiectării stratului raster, obținem stratul final pe care l-am dorit.

**Atenționare:** todo: De adăugat imaginea

Datorită proceselor de reproiectare, stratul final ar putea conține datele din afara casetei de încadrare, pe care am calculat-o într-unul dintre primii pași. Acest lucru poate fi rezolvat prin reluarea decupării, așa cum am procedat la obținerea DEM-ului de bază.

**17.16 Analize hidrologice**

**Notă:** În această lecție, vom efectua unele analize hidrologice. Această analiză va fi utilizată în unele din următoarele lecții, deoarece constituie un exemplu foarte bun de analiză a fluxului de lucru, pe care o vom folosi pentru a demonstra unele caracteristici avansate.

Objectives: Starting with a DEM, we are going to extract a channel network, delineate watersheds and calculate some statistics.

1. Primul lucru este de a încărca proiectul cu datele lecției, care conține doar un DEM.
2. The first module to execute is *Catchment area* (in some SAGA versions it is called *Flow accumulation (Top Down)*). You can use any of the others named *Catchment area*. They have different algorithms underneath, but the results are basically the same.

3. Select the DEM in the *Elevation* field, and leave the default values for the rest of the parameters.
Some algorithms calculate many layers, but the *Catchment Area* layer is the only one we will be using. You can get rid of the other ones if you want.

Randarea stratului nu este foarte informativă.
To know why, you can have a look at the histogram and you will see that values are not evenly distributed (there are a few cells with very high value, those corresponding to the channel network). Use the Raster calculator algorithm to calculate the logarithm of the catchment value area and you will get a layer with much more information.
4. The catchment area (also known as flow accumulation) can be used to set a threshold for channel initiation. This can be done using the Channel network algorithm.

- **Initiation grid**: use the catchment area layer and not the logarithm one.
- **Initiation threshold**: 10,000,000
- **Initiation type**: Greater than

If you increase the **Initiation threshold** value, you will get a more sparse channel network. If you decrease it, you will get a denser one. With the proposed value, this is what you get.
The image above shows just the resulting vector layer and the DEM, but there should be also a raster layer with the same channel network. That raster will be, in fact, the layer we will be using.

5. Now, we will use the Watersheds basins algorithm to delineate the subbasins corresponding to that channel network, using as outlet points all the junctions in it. Here is how you have to set the corresponding parameters dialog.
Acesta veți obține.
6. This is a raster result. You can vectorise it using the Vectorising grid classes algorithm.
Acum, să încercăm să calculăm statistici referitoare la valorile elevației dintr-unul din sub-bazine. Ideea este de a avea un strat cu altitudinile din cadrul acelui sub-bazin pe care, ulterior, să-l transmitem modului care calculează aceste statistici.

1. First, let’s clip the original DEM with the polygon representing a subbasin. We will use the Clip raster with polygon algorithm. If we select a single subbasin polygon and then call the clipping algorithm, we can clip the DEM to the area covered by that polygon, since the algorithm is aware of the selection.

   1. Select a polygon
2. Call the clipping algorithm with the following parameters:
The element selected in the input field is, of course, the DEM we want to clip.
Veți obține ceva de genul acesta.

2. This layer is ready to be used in the Raster layer statistics algorithm.
Statisticile rezultate sunt următoarele.

Vom folosi și în alte lecții atât procedura de calcule a bazinului, cât și calcularea statisticilor, pentru a afla cum ne pot
ajuta alte elemente la automatizarea amândurora, cât și pentru a lucra mai eficient.

### 17.17 Lucrul cu modelatorul grafic

**Notă:** În această lecție vom folosi modelatorul grafic, o componentă puternică, pe care o putem folosi pentru a defini un flux de lucru, și pentru a rula o înălțuire de algoritmi.

O sesiune normală cu uneltele de procesare include mai mult decât rularea unui singur algoritm. De obicei, multe dintre ele sunt rulate pentru a obține o ieșire, unele dintre aceste rezultate fiind folosite ca intrare pentru alți algoritmi.

Cu ajutorul modelatorului grafic, fluxul de lucru poate fi definit într-un model, care va rula toți algoritmii necesari într-o singură execuție, simplificând și automatizând astfel întregul proces.

To start this lesson, we are going to calculate a parameter named Topographic Wetness Index. The algorithm that computes it is called *Topographic wetness index (twi)*.

![Topographic Wetness Index](diagram.png)

As you can see, there are two mandatory inputs: *Slope* and *Catchment area*. There is also an optional input, but we will not be using it, so we can ignore it.

The data for this lesson contains just a DEM, so we do not have any of the required inputs. However, we know how to calculate both of them from that DEM, since we have already seen the algorithms to compute slope and catchment area. So we can first compute those layers and then use them for the TWI algorithm.

Aici sunt dialogurile pentru parametrizii care ar trebui să fie utilizați în calculul a 2 straturi intermediare.

**Notă:** Panta trebuie să fie calculată în radiani, nu în grade.
Acesta este modul în care va trebui să setați parametrii dialogului pentru algoritmul TWI.
This is the result that you will obtain (the default singleband pseudocolor inverted palette has been used for rendering). You can use the twi.qml style provided.
What we will try to do now is to create an algorithm that calculates the TWI from a DEM in just one single step. That will save us work in case we later have to compute a TWI layer from another DEM, since we will need just one single step to do it instead of the three above. All the processes that we need are found in the toolbox, so what we have to do is to define the workflow to wrap them. This is where the graphical modeler comes in.

1. Deschideți modelatorul, prin selectarea intrării sale din meniul de prelucrare.

Two things are needed to create a model: setting the inputs that it will need, and defining the algorithm that it contains. Both of them are done by adding elements from the two tabs in the left-hand side of the modeler window: Inputs and Algorithms.

2. Let’s start with the inputs. In this case we do not have much to add. We just need a raster layer with the DEM, and that will be our only input data.

3. Double click on the Raster layer input and you will see the following dialog.

4. Here we will have to define the input we want:
1. Since we expect this raster layer to be a DEM, we will call it DEM. That’s the name that the user of the model will see when running it.

2. Since we need that layer to work, we will define it as a mandatory layer.

3. Iată cum ar trebui să fie configurat dialogul.

4. Click on OK and the input will appear in the modeler canvas.

5. Now let’s move to the Algorithms tab.

6. The first algorithm we have to run is the Slope, aspect, curvature algorithm. Locate it in the algorithm list, double-click on it and you will see the dialog shown below.
This dialog is very similar to the one that you can find when running the algorithm from the toolbox, but
the element that you can use as parameter values are not taken from the current QGIS project, but from
the model itself. That means that, in this case, we will not have all the raster layers of our project available for the
Elevation field, but just the ones defined in our model. Since we have added just one single raster input named
DEM, that will be the only raster layer that we will see in the list corresponding to the Elevation parameter.

Output generated by an algorithm are handled a bit differently when the algorithm is used as a part of a model.
Instead of selecting the filepath where you want to save each output, you just have to specify if that output is
an intermediate layer (and you do not want it to be preserved after the model has been executed), or it is a final
one. In this case, all layers produced by this algorithm are intermediate. We will only use one of them (the
slope layer), but we do not want to keep it, since we just need it to calculate the TWI layer, which is the final
result that we want to obtain.

When layers are not a final result, you should just leave the corresponding field. Otherwise, you have to enter a
name that will be used to identify the layer in the parameters dialog that will be shown when you run the model
later.

8. There is not much to select in this first dialog, since we do not have but just one layer in our model (The DEM
input that we created). Actually, the default configuration of the dialog is the correct one in this case, so you
just have to press OK. This is what you will now have in the modeler canvas.
9. The second algorithm we have to add to our model is the catchment area algorithm. We will use the algorithm named *Catchment area (Parallel)*. We will use the DEM layer again as input, and none of the outputs it produces are final, so here is how you have to fill the corresponding dialog.
Acum, modelul dvs. ar trebui să arate în felul următor:
10. The last step is to add the Topographic wetness index algorithm, with the following configuration.

In this case, we will not be using the DEM as input, but instead, we will use the slope and catchment area layers that are calculated by the algorithms that we previously added. As you add new algorithms, the outputs they
produce become available for other algorithms, and using them you link the algorithms, creating the workflow.

11. In this case, the output TWI layer is a final layer, so we have to indicate so. In the corresponding textbox, enter the name that you want to be shown for this output.

Acum, modelul dvs. este finalizat, și ar trebui să arate în felul următor:

12. Enter a name and a group name in the upper part of the model window.

13. Save it clicking on the `Save` button. You can save it anywhere you want and open it later, but if you save it in the models folder (which is the folder that you will see when the save file dialog appears), your model will also be available in the toolbox as well. So stay on that folder and save the model with the filename that you prefer.

14. Now close the modeler dialog and go to the toolbox. In the `Models` entry you will find your model.
15. You can run it just like any normal algorithm, double-clicking on it.

![TWI from DEM](image)

După cum puteți vedea, dialogul parametrilor, conține intrarea pe care ați adăugat-o modelului, împreună cu ieșirile pe care le stabiliți ca fiind finale, atunci când adăugați algoritmii corespunzători.


### 17.18 Modele mai complexe

**Notă:** În această lectie vom lucra cu un model mai complex în modelatorul grafic.

The first model that we created in the previous chapter was a very simple one, with just one input and three algorithms. More complex models can be created, with different types of inputs and containing more steps. For this chapter we will work with a model that creates a vector layer with watersheds, based on a DEM and a threshold value. That will be very useful for calculating several vector layers corresponding to different thresholds, without having to repeat each single step each time.

This lesson does not contain instructions about how to create your model. You already know the necessary steps (we saw them in a previous lesson) and you have already seen the basic ideas about the modeler, so you should try it yourself. Spend a few minutes trying to create your model, and don’t worry about making mistakes. Remember: first add the inputs and then add the algorithms that use them to create the workflow.

**Notă:** In case you could not create the full model yourself and you need some extra help, the data folder corresponding to this lesson contains an «almost» finished version of it. Open the modeler and then open the model file that you will find in the data folder. You should see something like this.
This model contains all the steps needed to complete the calculation, but it just has one input: the DEM. That means that the threshold for channel definition uses a fixed value, which makes the model not as useful as it could be. That is not a problem, since we can edit the model, and that is exactly what we will do.

1. First, let’s add a numerical input. That will ask the user for a numerical input that we can use when such a value is needed in any of the algorithms included in our model.

2. Click on the Number entry in the Inputs tree, and you will see the corresponding dialog.

3. Fill it with the following values.
   - **Parameter name**: Threshold for channel definition
   - **Default value**: 1,000,000

Acum, modelul dvs. ar trebui să arate în felul următor:
The input that we have just added is not used, so the model hasn’t actually changed. We have to link that input to the algorithm that uses it, in this case the *Channel network* one. To edit an algorithm that already exists in the modeler, just click on the pen icon on the corresponding box in the canvas.

4. Click on the *Channel network* algorithm and you will see something like this.
The dialog is filled with the current values used by the algorithm. You can see that the *Initiation threshold* parameter has a fixed value of 1,000,000 (this is also the default value of the algorithm, but any other value could be put in there). However, you might notice that the parameter is not entered in a common text box, but in a drop-down menu.

5. Unfold the threshold parameter menu and you will see something like this.

![Threshold parameter menu](image)

The input that we added is there and we can select it. Whenever an algorithm in a model requires a numerical value, you can hardcode it and directly type it, or you can use any of the available inputs and values (remember that some algorithms generate single numerical values. We will see more about this soon). In the case of a string parameter, you will also see string inputs and you will be able to select one of them or type the desired fixed value.

6. Select the *Threshold for channel definition* input in the *Initiation threshold* parameter.

7. Click on OK to apply the changes to your model. Now the design of the model should look like this.
8. The model is now complete. Run it using the DEM that we have used in previous lessons, and with different threshold values.

Below you have a sample of the result obtained for different values. You can compare with the result for the default value, which is the one we obtained in the hydrological analysis lesson.

Fig. 17.1: Prag = 100,000
17.19  Calculele numerice din modelator

Notă: În această lecție vom vedea cum se generează ieșirile numerice din modelator

Pentru această lecție, vă modifică modelul hidrologic pe care l-am creat în ultimul capitol (deschideți-l în modelator înainte de a începe), astfel încât să putem automatiza calcularea unei valori valide de prag, nefiind nevoie să cerem utilizatorului să o introducă. Deoarece această valoare se referă la variabila din pragul stratului raster, o vom extrage din acest strat, pe baza unor analize statistice simple.

Începând cu modelul menționat mai înainte, haideți să facem următoarele modificări:

În primul rând, se calculează statisticile stratului de acumulare a fluxului, utilizând algoritmul Statisticile stratului raster.
Acest lucru va genera un set de valori statistice, care vor fi de acum disponibile pentru toate câmpurile numerice ai altor algoritmi.

Dacă editați algoritmul Rețelei de canale, așa cum am făcut în ultima lecție, veți vedea că acum aveți și alte opțiuni în afară de intrarea numerică pe care ati adăugat-o.
Cu toate acestea, nici una dintre aceste valori nu este adecvată pentru a fi utilizată ca și prag valid, atât timp cât acestea vor produce rețele de canale nu prea realiste. Putem obține, în schimb, un nou parametru pe baza lor, pentru a obține un rezultat mai bun. De exemplu, putem folosi media, la care se va adăuga de 2 ori deviația standard.

Pentru a adăuga această operațiune aritmetică, putem folosi calculatorul, pe care îl veți găsi în grupul Geoalgorithms/modeler/modeler-tools. Acest grup conține algoritmi care nu sunt foarte utili în afara modelatorului, dar care oferă funcționalități utile la crearea unui model.

Dialogul parametrilor pentru algoritmul calculatorului arată astfel:
După cum puteți vedea, dialogul este diferit față de celelalte pe care le-am văzut, dar aveti acolo aceleași variabile care au fost disponibile în câmpul *Threshold* din algoritmul *Channel network*. Introduceți formula de mai sus, apoi apăsați pe *OK*, pentru a adăuga algoritmul.

Dacă extindeți intrarea rezultatului, așa cum se arată mai sus, veți vedea că modelul este conectat la două dintre valori, și anume media și abatera standard, care sunt cele pe care le-am folosit în formulă.

Adăugarea acestui nou algoritm va aduce o nouă valoare numerică. Dacă mergeți iarăși în algoritmul *Channel network*,...
puteți selecta acea valoare din parametrul *Threshold*.

Faceți clic pe *OK*, după care modelul dvs. ar trebui să arate în felul următor:
Nu vom folosi intrarea numerică pe care am adăugat-o modelului, astfel încât ea poate fi eliminată. Faceți clic-dreapta pe ea și selectați Remove.

**Atenționare:** todo: De adăugat imaginea

De acum, noul nostru model este terminat.

## 17.20 Un model în cadrul unui model

**Atenționare:** Atenție, deoarece acest capitol nu este bine testat, vă rugăm să raportați orice problemă; imaginiile lipsesc.

**Notă:** În această lecție vom vedea cum să folosim un model într-un alt model, mai mare.

Am creat deja câteva modele, iar în această lecție vom vedea cum le putem combina într-unul singur, mai mare. Un model se comportă la fel ca oricare alt algoritm, ceea ce înseamnă că puteți adăuga un model pe care îl aveți deja, ca parte a altuia, pe care urmează să-l creați.

În acest caz, vom extinde modelul nostru hidrologic, prin adăugarea valorii medii TWI în fiecare dintre bazinele pe care le generăm ca rezultat. Pentru aceasta, avem nevoie de calculul LST și a unor statistici. Din moment ce am creat deja un model pentru a calcula LST dintr-un DEM, este o idee bună să refolositi acel model, în locul adăugării algoritmulor pe care îi conține în mod individual.

Să începem cu modelul folosit ca punct de plecare pentru ultima lecție.
Atenționare: todo: De adăugat imaginea

În primul rând, vom adăuga modelul LST. Pentru ca acesta să fie la îndemână, ar fi trebuit să fie salvat în dosarul modelelor, în caz contrar el nefiind afisat în caseta de instrumente sau în lista de algoritmi din modelator. Asigurați-vă că este disponibil.

Adăugați-l la modelul actual și folosiți DEM-ul de intrare ca și ieșire. Ieșirea este una temporară, din moment ce vrem să obținem doar stratul TWI, pentru a-l folosi la calculul statisticilor. Singura ieșire a acestui model va fi, în continuare, stratul vectorial al bazinelor hidrografice.

Iată dialogul parametrilor corespunzători:

Atenționare: todo: De adăugat imaginea

Acum avem un strat TWI, pe care îl putem folosi împreună cu stratul vectorial al bazinelor hidrologice, pentru a genera un strat nou, care conține valorile TWI corespunzătoare fiecărui bazin hidrografic.

Acest calcul se face cu ajutorul algoritmului *Statisticilor pentru grila acoperită de poligoane*. Utilizați straturile menționate mai sus ca intrare, pentru a crea rezultatul final.

Atenționare: todo: De adăugat imaginea

Rezultatul algoritmului de *Vectorizare a claselor grilei* a reprezentat inițial produsul nostru final, însă acum dorim doar un rezultat intermediar. Pentru a schimba acest lucru, trebuie să editați algoritmul. Efectuați dublu-clic pe acesta pentru a deschide dialogul parametrilor săi, apoi ștergeți numele ieșirii. Astfel, va rezulta o ieșire temporară, așa cum este în mod implicit.

Atenționare: todo: De adăugat imaginea

Iată cum ar trebui să arate modelul final:

Atențioane: todo: De adăugat imaginea

După cum vedeti, utilizarea unui model într-un alt model nu reprezintă nimic special, putând fi adăugat la fel ca oricare alt algoritm, atât timp cât modelul este salvat în dosarul de modele și este disponibil în caseta de instrumente.

**17.21 Utilizarea pentru crearea unui model doar a instrumentelor modelatorului**

Notă: Această lecție vă arată cum să utilizați niște algoritmi disponibili doar în modelator, pentru a oferi funcționalitate adițională modelelor.

Scopul acestei lecții este de a folosi modelatorul la crearea unui algoritm de interpolare, care să țină cont de selecția curentă, nu doar să folosească numai entitățile selectate, dar și să utilizeze extinderea acelei selecții pentru a crea stratul raster interpolat.

The interpolation process involves two steps, as it has been already explained in previous lessons: rasterizing the points layer and fill the no-data values that appear in the rasterized layer. In case the points layer has a selection, only selected points will be used, but if the output extent is set to be automatically adjusted, the full extent of the layer will
be used. That is, the extent of the layer is always considered to be the full extent of all features, not the one computed from just the selected ones. We will try to fix that by using some additional tools into our model.

Open the modeler and start the model by adding the required inputs. In this case we need a vector layer (restricted to points) and an attribute from it, with the values that we will use for rasterizing.

The next step is to compute the extent of the selected features. That’s where we can use the model-only tool called *Vector layer bounds*. First, we will have to create a layer that has the extent of those selected features. Then, we can use this tool on that layer.

An easy way of creating a layer with the extent of the selected features is to compute a convex hull of the input points layer. It will use only the selected point, so the convex hull will have the same bounding box as the selection. Then we can add the *Vector layer bounds* algorithm, and use the convex hull layer as input. It should look this in the modeler canvas:
The result from the *Vector layer bounds* is a set of four numeric values and a extent object. We will use both the numeric outputs and the extent for this exercise.

We can now add the algorithm that rasterizes the vector layer, using the extent from the *Vector layer bounds* algorithm as input.

Completăți parametrii după cum se arată în continuare:
Canevasul ar trebui să arate astfel:
Finally, fill the no-data values of the raster layer using the *Close gaps* algorithm.

The algorithm is now ready to be saved and added to the toolbox. You can run it and it will generate a raster layer from interpolating the selected points in the input layer, and the layer will have the same extent as the selection.

Here’s an improvement to the algorithm. We have used a hardcoded value for the cellsize when rasterizing. This value is fine for our test input layer, but might not be for other cases. We could add a new parameter, so the user enters the desired value, but a much better approach would be to have that value automatically computed.

We can use the modeler-only calculator, and compute that value from the extent coordinates. For instance, to create a layer with a fixed width of 100 pixels, we can use the following formula in the calculator.
Now we have to edit the rasterize algorithm, so it uses the output of the calculator instead of the hardcoded value.

The final algorithm should look like this:
17.22 Interpolarea

Notă: Acest capitol prezintă cum se pot interpola datele punctuale, și vi se arată un alt exemplu real de efectuare de analize spațiale.

În această lecție, vom interpola datele punctelor pentru a obține un strat raster. Înainte de a face aceasta, va trebui să realizăm o anumită pregătire a datelor, iar după interpolare vom efectua o procesare suplimentară, pentru a modifica stratul rezultat, obținând în acest fel o rutină de analiză completă.

Deschideți datele exemplu pentru această lecție, care ar trebui să arate astfel.

The data correspond to crop yield data, as produced by a modern harvester, and we will use it to get a raster layer of crop yield. We do not plan to do any further analysis with that layer, but just to use it as a background layer for easily identifying the most productive areas and also those where productivity can be improved.

The first thing to do is to clean-up the layer, since it contains redundant points. These are caused by the movement of the harvester, in places where it has to do a turn or it changes its speed for some reason. The Points filter algorithm will be useful for this. We will use it twice, to remove points that can be considered outliers both in the upper and lower part of the distribution.

Pentru prima execuție, folosiți următoarele valori ale parametrilor.
Pentru următoarea execuție, folosiți configurația prezentată mai jos.
Observați că nu utilizăm stratul original ca intrare, ci rezultatul execuției anterioare în loc. Stratul de filtrare final, cu un set redus de puncte, ar trebui să arate similar cu cel original, dar conține un număr mai mic de puncte. Puteți verifica acest lucru, prin compararea tabelelor de attribute.

Acum, hăideți să rasterizăm stratul folosind algoritmul Rasterizare.
The *Filtered points* layer refers to the resulting one of the second filter. It has the same name as the one produced by the first filter, since the name is assigned by the algorithm, but you should not use the first one. Since we will not be using it for anything else, you can safely remove it from your project to avoid confusion, and leave just the last filtered layer.

Rezultatul raster arată în felul următor.
It is already a raster layer, but it is missing data in some of its cells. It only contain valid values in those cells that contained a point from the vector layer that we have just rasterized, and a no-data value in all the other ones. To fill the missing values, we can use the *Close gaps* algorithm.
Stratul din care lipsesc valorile fără date arată în felul următor.
To restrict the area covered by the data to just the region where crop yield was measured, we can clip the raster layer with the provided limits layer.
And for a smoother result (less accurate but better for rendering in the background as a support layer), we can apply a Gaussian filter to the layer.
Cu parametrii de mai sus, veți primi următorul rezultat
17.23 Mai multe despre interpolare

Notă: Acest capitol prezintă alte cazuri practice de folosire a algoritmilor de interpolare.

Interpolarea este o tehnică obișnuită, acesta putând fi folosită pentru a demonstra mai multe tehnici care pot fi aplicate cu ajutorul cadrului de lucru Processing din QGIS. Această lecție utilizează unii algoritmi de interpolare care au fost deja prezentat, dar care utilizează o abordare diferită.

Datele pentru această lecție conțin, de asemenea, un strat de puncte, în acest caz, cu date de elevație. În general, îl vom interpola în același mod ca și în lecția anterioră, însă, de data aceasta, vom salva o parte din datele originale, pe care o vom utiliza în evaluarea calității procesului de interpolare.

First, we have to rasterize the points layer and fill the resulting no–data cells, but using just a fraction of the points in the layer. We will save 10% of the points for a later check, so we need to have 90% of the points ready for the interpolation. To do so, we could use the Split shapes layer randomly algorithm, which we have already used in a previous lesson, but there is a better way to do that, without having to create any new intermediate layer. Instead of that, we can just select the points we want to use for the interpolation (the 90% fraction), and then run the algorithm. As we have already seen, the rasterizing algorithm will use only those selected points and ignore the rest. The selection can be done using the Random selection algorithm. Run it with the following parameters.
Se vor selecta 90% dintre punctele din stratul de rasterizat
Selectia este aleatoare, astfel incat selectia dvs. ar putea diferi de selectia aratat in imaginea de mai sus.

Now run the Rasterize algorithm to get the first raster layer, and then run the Close gaps algorithm to fill the no-data cells [Cell resolution: 100 m].

To check the quality of the interpolation, we can now use the points that are not selected. At this point, we know the real elevation (the value in the points layer) and the interpolated elevation (the value in the interpolated raster layer). We can compare the two by computing the differences between those values.

Din moment ce vom folosi punctele care nu sunt selectate, in primul rand, haideți să inversăm selectia.
The points contain the original values, but not the interpolated ones. To add them in a new field, we can use the *Add raster values to points* algorithm.
The raster layer to select (the algorithm supports multiple raster, but we just need one) is the resulting one from the interpolation. We have renamed it to `interpolate` and that layer name is the one that will be used for the name of the field to add.

Acum avem un strat vectorial care conține ambele valori, cu punctele care nu au fost utilizate pentru interpolare.

<table>
<thead>
<tr>
<th>ID</th>
<th>VALUE</th>
<th>interpolate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1516.000000000000</td>
<td>1452.504150400000</td>
</tr>
<tr>
<td>3</td>
<td>2096.000000000000</td>
<td>2073.764892600000</td>
</tr>
<tr>
<td>4</td>
<td>582.000000000000</td>
<td>555.315426900000</td>
</tr>
<tr>
<td>8</td>
<td>843.000000000000</td>
<td>863.375000000000</td>
</tr>
<tr>
<td>21</td>
<td>2224.000000000000</td>
<td>2136.848388700000</td>
</tr>
<tr>
<td>24</td>
<td>749.000000000000</td>
<td>753.282226560000</td>
</tr>
<tr>
<td>28</td>
<td>1635.000000000000</td>
<td>1644.061522400000</td>
</tr>
<tr>
<td>31</td>
<td>726.000000000000</td>
<td>704.658813400000</td>
</tr>
<tr>
<td>36</td>
<td>927.000000000000</td>
<td>936.950504900000</td>
</tr>
<tr>
<td>38</td>
<td>1320.000000000000</td>
<td>1305.308349600000</td>
</tr>
<tr>
<td>39</td>
<td>2170.000000000000</td>
<td>2155.540391000000</td>
</tr>
<tr>
<td>40</td>
<td>549.000000000000</td>
<td>544.867675700000</td>
</tr>
<tr>
<td>42</td>
<td>641.000000000000</td>
<td>648.396118160000</td>
</tr>
<tr>
<td>47</td>
<td>1534.000000000000</td>
<td>1525.260742000000</td>
</tr>
<tr>
<td>54</td>
<td>175.000000000000</td>
<td>175.420349120000</td>
</tr>
<tr>
<td>52</td>
<td>1915.000000000000</td>
<td>1924.127441400000</td>
</tr>
</tbody>
</table>

Acum, vom folosi calculatorul de câmpuri pentru această sarcină. Deschideți algoritmul `Calculatorului de câmpuri` și-l vom rula cu următorii parametri.
If your field with the values from the raster layer has a different name, you should modify the above formula accordingly. Running this algorithm, you will get a new layer with just the points that we haven’t used for the interpolation, each of them containing the difference between the two elevation values.

Reprezentând stratul în conformitate cu acea valoare, vom avea o primă idee despre locația celor mai mari discrepante.
Interpolând acel strat veți obține un strat raster cu eroarea estimată în toate punctele din zona interpolată.
You can also get the same information (difference between original point values and interpolated ones) directly with GRASS `v.sample`.

Your results might differ from these ones, since there is a random component introduced when running the random selection, at the beginning of this lesson.

### 17.24 Execuția iterativă a algoritmilor

**Notă:** Această lecție prezintă un mod diferit de a executa algoritmii care folosesc straturi vectoriale, prin rularea lor în mod repetat, iterând entitățile dintr-un strat vectorial de intrare.

Cunoaștem deja modelatorul grafic, care reprezintă o modalitate de automatizare a sarcinilor de procesare. Cu toate acestea, în unele situații, modelatorul ar putea să nu fie chiar ceea ce ne trebuie pentru a automatiza o anumită sarcină. Vom vedea una dintre acele situații, și cum să o rezolvăm cu ușurință, folosind o funcționalitate diferită: executarea iterativă a algoritmilor.

Deschideți datele corespunzătoare acestui capitol. Acesta ar trebui să arate astfel.

---

Veți recunoaște DEM-ul nostru bine-cunoscut din capitolele anterioare, și un set de bazine hidrografice extrase din el. Imaginai-ți că trebuie să reducem DEM-ul în mai multe straturi mici, fiecare dintre ele conținând doar datele de elevație corespunzătoare unui singur bazin hidrografic. Acest lucru va fi util dacă doriti mai târziu să calculați unii parametri ce țin de fiecare bazin hidrografic, cum ar fi cota de elevație sau curba hipsografică.

Acest lucru reprezintă o sarcină lungă durată și plăcuită, mai ales în cazul în care numărul bazinelor hidrografice este mare. Cu toate acestea, este o sarcină care poate fi ușor automatizată, așa cum vom vedea.

Algoritmul utilizat pentru decuparea stratului raster după un strat poligonal este denumit *Decuparea grilei cu ajutorul poligoanelor*, și are următorul dialog cu parametri.
Puteți să-l executați folosind stratul bazinelor hidrografice și DEM-ul ca intrare, apoi veți obține următorul rezultat.
După cum puteți vedea, se utilizează aria acoperită de toate poligoanele bazinelor hidrografice.
Puteți decupa DEM-ul după un singur bazin hidrografic, prin selectarea bazinului dorit, și apoi prin rularea algoritmului așa cum am făcut-o mai înainte.

Deoarece numai entitățile selectate sunt folosite, numai poligonul selectat va fi folosit pentru a decupa stratul raster.
Făcând acest lucru pentru toate bazinele, se va produce rezultatul pe care îl căutăm, dar aceasta nu arată ca un mod foarte practic de lucru. În schimb, să vedem cum automatizăm rutina selectare și decupare.

Mai întâi de toate, eliminați selecția anterioară, astfel încât toate poligoanele să fie utilizate din nou. Deschideți algoritmul Decupare grilă după un poligon, apoi selectați aceleasi surse ca și înainte, dar de data aceasta faceți clic pe butonul pe care le veți regăsi în partea dreaptă a intrării stratului vectorial, în care ați selectat stratul bazinelor hidrografice.

Acest buton va cauza divizarea stratului de intrare selectat în mai multe straturi, pe măsură ce se descoperă entitățile, fiecare dintre ele conținând câte un singur poligon. Algoritmul va fi solicitat în mod repetat, câte o dată pentru fiecare dintre aceste straturi cu un singur poligon. Rezultatul, în loc de un singur strat raster, va consta într-un set de straturi raster, fiecare dintre ele correspunzând câte unei execuții a algoritmului.

Iată rezultatul pe care îl veți obține, dacă ați rulat algoritmul de tăiere așa cum s-a explicat.
Pentru fiecare strat, paletă de culori alb-negru, (sau orice paletă pe care o utilizați), este ajustată în mod diferit, de la minim până la valorile sale maxime. Acesta este motivul pentru care puteți vedea diferite piese, iar culorile nu par a se potrivi la granița dintre straturi. Valorile, cu toate acestea, se potrivesc.

Dacă introduceți un nume pentru fișierul de iesire, fișierele rezultate vor fi denumite folosind ca nume de fișier și, ca sufis, un număr corespunzător pentru fiecare iterare.

17.25 Mai multe utilizări ale execuției iterative a algoritmilor

Notă: Această lecție vă arată cum să combinați execuția iterativă a algoritmilor cu modelatorul, pentru a extinde automatizarea.

Execuția iterativă a algoritmilor este disponibilă nu doar pentru algoritmul închiriazi, ci, de asemenea, și pentru algoritmul pe care îi puteți crea, cum ar fi modelele. Vom vedea cum putem combina un model cu execuția iterativă a algoritmilor, astfel încât să putem obține cu ușurință rezultate mai complexe.

Datele pe care le vom folosi sunt aceleași pe care le-am folosit deja în ultima lecție. În acest caz, în afara de decuparea DEM-ului în funcție de poligonul fiecărui bazin hidrografic, vom adăuga câteva pasi, în care vom calcula o curbă hipsometrică pentru fiecare bazin, pentru a studia modul în care este distribuită elevația în cadrul bazinelor hidrografice.

Din moment ce avem un flux de lucru care implică mai multe etape (decupare + calcul curbă hipsometrică), ar trebui să mergem la modelator și să creăm modelul corespunzător fluxului respectiv.

You can find the model already created in the data folder for this lesson, but it would be good if you first try to create it yourself. The clipped layer is not a final result in this case, since we are just interested in the curves, so this model will not generated any layers, but just a table with the curve data.

Modelul ar trebui să arate astfel:
Add the model to your models folder, so it is available in the toolbox, and execute it.

Select the DEM and watersheds basins.

The algorithm will generate tables for all the basins and place them in the output directory.

We can make this example more complex by extending the model and computing some slope statistics. Add the \textit{Slope} algorithm to the model, and then the \textit{Raster statistics} algorithm, which should use the slope output as its only input.

Dacă rulați acum modelul, în afară de tabele, veți obține un set de pagini cu statistici. Aceste pagini vor fi disponibile în caseta de dialog a rezultatelor.
17.26 Interfața de prelucrare în serie

Notă: Această lectie introduce interfața de prelucrare în serie, care permite executarea unui singur algoritm, cu un set de valori de intrare diferite.

Sometimes a given algorithm has to be executed repeatedly with different inputs. This is, for instance, the case when a set of input files have to be converted from one format to another, or when several layers in a given projection must be converted into another projection.

În acest caz, apelarea repetată a algoritmului din bara de instrumente nu este cea mai bună opțiune. În schimb, ar trebui folosită interfața de prelucrare în serie, care simplifică foarte mult efectuarea unei execuții multiple a unui algoritm dat. Pentru a rula un algoritm ca un proces în serie, identificați-l în bara de instrumente, și în loc de dublu-clic pe el, faceți clic pe el și alegeti *Rulare ca proces în serie*.


Dacă aruncați o privire la datele acestei lectii, veți vedea că acestea conțin un set de trei fișiere shape, dar nici un fișier de proiect QGIS. Aceasta se datorează faptului că, atunci când un algoritm este rulat ca un proces în serie, intrările stratului pot fi selectate fie din proiectul QGIS curent, fie din fișiere. Asta face mai ușoară procesarea unei cantități mari de straturi, cum ar fi, de exemplu, toate straturile dintr-un folder dat.
Fiecare rând din tabelul dialogului de prelucrare în serie, reprezintă o singură execuție a algoritmului. Celulele dintr-un rând corespund parametrului necesar algoritmului, ele neînd dispuse unele deasupra celelalte, la fel ca într-un dialog normal de execuție singulară, ci orizontal în acel rând.

Definirea procesului care va rula în serie, constă în completarea tabelului cu valorile corespunzătoare, iar dialogul în sine conține multe instrumente care fac această sarcină mai ușoară.

Să începem completarea, unul câte unul, a câmpurilor. Prima coloană de umplut este *Stratul de intrare*. În loc să introducem numele fiecăruia dintre straturile pe care vrem să le procesăm, le puteți selecta pe toate, și să lasăm dialogul să le ordoneze câte unul în fiecare rând. Faceți clic pe butonul din celula din stânga-sus, iar în dialogul care se va deschide, de selectie a fisierului, selectați trei dosare pentru a fi reproiectate. Din moment ce numai unul dintre ele este necesar pentru fiecare rând, cele rămase vor fi folosite pentru a umple rândurile de dedesubt.

Numărul implicit de rânduri este de 3, care este exact numărul de straturi pe care le avem de convertit, dar dacă selectați mai multe straturi, noi rânduri vor fi adăugate automat. Dacă doriti să completeți manua intrărilele, puteți adăuga mai multe rânduri folosind butonul *Adăugare rând*.

Vom converti toate acele straturi la CRS-ul EPSG:23029, așa că vom selecta acest CRS în al doilea câmp. Ne dorim același lucru pentru toate rândurile, dar nu trebuie să repetăm aceeași pași pentru fiecare rând. În schimb, stabilim CRS-ul pentru primul rând (cel din partea de sus), folosind butonul din celula corespunzătoare, și efectuând dublu clic pe antetul de coloană. Asta va face ca toate celulele din coloană să se completeze utilizând valoarea celulei superioare.
În cele din urmă, trebuie să selectați un fisier de ieșire pentru fiecare execuție, care va conține stratul reproiectat corespunzător. În caz că doriti, vom face acest lucru doar pentru primul rând. Faceți clic pe butonul din celula de sus, iar în folderul în care doriți să puneti fisierul de ieșire, introduceți un nume de fisier (de exemplu, *reprojected.shp*).

Acum, când faceți clic pe *OK* pe dialogul de selecție a fisierului, denumirea fisierului nu va fi automat înscrisă în celulă, dar o casetă de intrare, similară cu următoarea, va fi afișată în loc.

![Batch Processing - Reproject layer](image)

Dacă selectați prima opțiune, atunci doar celula curentă va fi umplută. Dacă o selectați pe oricare dintre celelalte, toate rândurile vor fi umplute cu un anumit model. În acest caz, vom selecta opțiunea *Umplere cu valoarea parametrului*, iar apoi valoarea *Stratului de intrare* din meniul derulant. Acest lucru va determina ca valoarea din *Stratul de intrare* (adică, numele stratului) să fie adăugat la numele fisierului pe care l-am adaugat, făcând diferit fiecare nume de fisier de ieșire. Tabelul de prelucrare în serie ar trebui să arate astfel.

---

**17.26. Interfața de prelucrare în serie**

605
Ultima coloană stabilește dacă, sau nu, se vor adăuga straturile rezultate la proiectul QGIS curent. Lăsat implicită opțiunea Da, astfel încât să puteți vedea rezultatele, în acest caz.

Faceți clic pe OK pentru a rula procesarea în serie. Dacă totul a mers bine, toate straturile vor fi procesate, și vor fi create 3 straturi noi.

### 17.27 Modelele în interfața de prelucrare a loturilor

**Atenționare:** Atenție, deoarece acest capitol nu este bine testat, vă rugăm să raportați orice problemă; imaginile lipsesc

**Notă:** Această lecție prezintă un alt exemplu de interfață de prelucrare a loturilor, dar de data aceasta cu ajutorul unui model înlocuind un algoritm incorporat

Modelele sunt similare oricărui alt algoritm, ele putând fi utilizate în interfața de prelucrare a loturilor. Pentru a demonstra aceasta, iată un scurtă exemplu în care folosim modelul nostru hidrologic, bine-cunoscut deja.

Asigurati-vă că aveți modelul adăugat la setul de instrumente, apoi rulați-l ca lot. Iată cum ar trebui sa arate dialogul de prelucrare a lotului:

**Atenționare:** todo: De adăugat imaginea

Adăugați un total de 5 rânduri. Selectați fișierul DEM corespunzător acestei lecții ca intrare pentru ele. Apoi introduceți 5 valori de prag diferite, așa cum se arată în continuare.
După cum vedeti, interfața de prelucrare a lotului poate funcționa nu doar la rularea aceluiași proces pe diferite seturi de date, dar, de asemenea, și pe același set de date cu parametrii diferiți.

Faceti clic pe OK, după care ar trebui să obtineți 5 noi straturi, cu bazinele corespunzătoare celor 5 valoril de prag specificate.

### 17.28 Script de interceptare a pre- și post-execuției

**Notă:** Această lectie vă arată cum se utilizează scripturile de interceptare a pre- și post-execuției, permitând astfel efectuarea unor operații adiționale înainte și după procesarea efectivă.

Script-urile Processing de interceptare a pre și post-execuției se execută înainte și după prelucrarea datelor efective. Ele pot fi folosite pentru a automatiza sarcinile care ar trebui să fie efectuate, ori de câte ori un algoritm este executat.

The syntax of the hooks is identical to the syntax of Processing scripts, see the corresponding chapter in the QGIS User Guide for more details.

În plus față de toate caracteristicile scripturilor, în codurile de interceptare puteți utiliza o variabilă globală specială denumită `alg`, care reprezintă algoritmul care tocmai a fost (sau urmează să fie) executat.

Here is an example post-execution script. By default, Processing stores analysis results in temporary files. This script will copy outputs to a specific directory, so they won’t be deleted after closing QGIS.

```python
import os
import shutil
from processing.core.outputs import OutputVector, OutputRaster, OutputFile

MY_DIRECTORY = '/home/alex/outputs'

for output in alg.outputs:
    if isinstance(output, (OutputVector, OutputRaster, OutputFile)):
        dirname = os.path.split(output.value)[0]
        shutil.copytree(dirname, MY_DIRECTORY)
```

In the first two lines we import the required Python packages: os — for path manipulations, e.g. extracting file name, and shutil — for various filesystem operations like copying files. In the third line we import Processing outputs. This will be explained in more detail later in this lesson.

Then we define a `MY_DIRECTORY` constant, which is the path to the directory where we want to copy analysis results.

La sfârșitul scriptului, avem codul principal de interceptare. În cadrul unei bucle vom itera toate iesirile algoritmulor și vom verifica dacă ele reprezintă iesiri și dacă pot fi copiate. Dacă da, determinăm directorul de nivel superior în care sunt localizate iesirile de iesire, apoi le copiem în directorul nostru.

To activate this hook we need to open the Processing options, find the entry named Post-execution script file in the General group, and specify the filename of the hook script there. The specified hook will be executed after each Processing algorithm.

In a similar way, we can implement pre-execution hooks. For example, let’s create a hook to check input vectors for geometry errors.

```python
from qgis.core import QgsGeometry, QgsFeatureRequest
from processing.core.parameters import ParameterVector

for param in alg.parameters:
```

(continues on next page)
As in the previous example, first we import required QGIS and Processing packages.

Then we iterate over all the algorithm parameters and if a ParameterVector parameter is found, we get the corresponding vector layer object from it. We loop over all the features of the layer and check them for geometry errors. If at least one feature contains an invalid geometry, we print a warning message.

To activate this hook we need enter its filename in the **Pre-execution script file** option in the Processing configuration dialog. The hook will be executed before running any Processing algorithm.

### 17.29 Alte programe

Modulul a fost dezvoltat de Paolo Cavallini - Faunalia

**Notă:** Acest capitol vă arată cum să utilizați programe suplimentare din interiorul Procesării. Pentru a finaliza, trebuie să aveți instalate pachetele relevante, cu ajutorul instrumentelor specifice sistemului de operare.

#### 17.29.1 GRASS

GRASS este o suită GIS gratuită, cu sursă deschisă, pentru managementul și analiza datelor geospațiale, pentru prelucrare de imagini și grafică, producție de hărți, modelare și vizualizare spatială.

Acesta este instalat în mod implicit în Windows, cu ajutorul pachetului de instalare independent OSGeo4W (32 și 64 biți), existând pachete și pentru toate distribuțiile majore de Linux.

#### 17.29.2 R

R este un mediu software cu sursă liberă și deschisă, pentru calcul statistic și grafică.

It has to be installed separately, together with a few necessary libraries (**LIST**). To enable the use of R in QGIS, the **Processing R Provider** plugin must also be installed.

Frumusețea implementării Processing este că puteți adăuga propriile script-uri, fie simple sau complexe, acestea pputând fi apoi utilizate ca orice alt modul, conectate în fluxuri de lucru mai complexe, etc.

Testați unele dintre exemplele preinstalate, dacă aveți R deja instalat (amintiți-vă să activați modulele R din interfața de configurare generală a Processing).
17.29.3 Altele

LASTools reprezintă un set de comenzi mixte, libere și proprietare, pentru a procesa și analiza datele Lidar. Disponibilitatea în diferite sisteme de operare este variabilă.

Mai multe instrumente sunt disponibile, prin intermediul plugin-urilor suplimentare, cum ar fi:

- **LecoS**: o suită de statistici de acoperire a terenului și de ecologie a peisajului
- **lwgeom**: fostă parte din PostGIS, această bibliotecă aduce câteva instrumente utile pentru curățarea geometriei
- **Animove**: instrumente de analiză a unei serii de animale domestice.

Mai multe vor urma.

17.29.4 Comparație între backend-uri.

Distanțe și tampoane

Hai de să încarcăm points.shp și să scriem `"buf"` în filtrul instrumentului din bara de instrumente, apoi fați dublu clic pe el:

- **Tamponul cu distanță fixă**: Distanța 10000
- **Tamponul cu distanță variabilă**: MĂRIMEA câmpului distanță
- **v.buffer.distance**: distanța 10000
- **v.buffer.column**: MĂRIMEA bufcolum
- **Shapes Buffer**: valoarea fixă 10000 (dissolve și not), câmpul atribut (cu scalare)

Vedeți câtă viteză diferă, și câte opțiuni sunt disponibile.

**Exercițiul pentru cititor**: găsiți diferențele din geometria rezultată prin metodele diferite.

Acum, tampoanele și distanțele:

- în primul rând, încărcați și rasterizați vectorul rivers.shp cu GRASS ➤ v.to.rast.value; **atenție**: mărimea celulelor trebuie să fie setată la 100 m, în caz contrar timpul de calcul va fi enorm; harta rezultată va conține 1 și NULL-uri
- la fel, cu SAGA ➤ Shapes to Grid ➤ COUNT (harta rezultată: de la 6 la 60)
- apoi, *proximitatea* (valoarea= 1 pentru GRASS, o listă de ID-uri de râuri pentru SAGA), *r.buffer* cu parametrii 1000,2000,3000, *r.grow.distance* (prima din cele două hărți; a doua va arăta suprafețele ce țin de fiecare râu, dacă se aplică pe un raster SAGA).

Dizolvare

Dizolvare entități pe baza unui atribut comun:

- **GRASS ➤ v.dissolve municipalities.shp pe PROVINCIE**
- **QGIS ➤ Dissolve municipalities.shp pe PROVINCIE**
- **OGR ➤ Dizolvă municipalities.shp pe PROVINCIE**
- **SAGA ➤ Polygon Dissolve municipalities.shp pe PROVINCIE (NB: Păstrare granițe interioare trebuie să fie neselectat)**

**Notă**: Ultima nu funcționează în SAGA <= 2.10

**Exercițiul pentru cititor**: găsiți diferențele (de geometrie și de atribute) prin metode diferite.
17.30 Interpolarea și conturarea

Modulul a fost dezvoltat de Paolo Cavallini - Faunalia

Notă: Acest capitol prezintă folosirea diferitelor variante de calcule a interpolărilor.

17.30.1 Interpolarea

Proiectul prezintă un gradient de precipitații, de la sud la nord. Să folosim metode diferite pentru interpolare, toate bazate pe vectorul points.shp, parametrul RAIN:

**Afiționare:** Setează dimensiunea celulei la 500 pentru toate analizele.

- **GRASS ►** v.surf.rst
- **SAGA ►** interpolare B-Spline Multinivel
- **SAGA ►** Distanța Inversă Ponderată [Distanța inversă până la o putere; Puterea: 4; Raza de căutare: globală; Intervalul de căutare: toate punctele]
- **GDAL ►** Grilă (Distanța inversă către o putere) [Putere:4]
- **GDAL ►** Grilă (Deplasări medii) [Raza1&2: 50000]

Apoi măsurați variația dintre metode și corelații-o cu distanța până la puncte:

- **GRASS ►** r.series [Deselectare NULL-uri Propagate, Operația de Agregare: stddev]
- **GRASS ►** v.to.rast.value asupra points.shp
- **GDAL ►** Proximitatea
- **GRASS ►** r.covar pentru a arăta matricea de corelație; verificati semnificația corelației, de exemplu, cu [http://vassarstats.net/rsig.html](http://vassarstats.net/rsig.html).

Astfel, zonele de puncte îndepărtate vor avea o interpolare mai puţin precisă.

17.30.2 Curbe de nivel

Diverse metode pentru a desena linii de contur [întotdeauna pasul= 10] în rasterul stddev:

- **GRASS ►** r.contour.step
- **GDAL ►** Curbe de nivel
- **SAGA ►** Contour lines from grid [NB: in some older SAGA versions, output shp is not valid, known bug]

17.31 Simplificarea și netezirea vectorilor

Modulul a fost dezvoltat de Paolo Cavallini - Faunalia

Notă: Acest capitol prezintă modalitățile de simplificare a vectorilor, precum și de netezire a colțurilor ascuțite.

Uneori avem nevoie de o versiune simplificată a unui vector, pentru a avea o dimensiune mai mică de fisier și pentru a scăpa de detaliiile inutile. Multe instrumente fac acest lucru într-un mod foarte brut, omitând uneori corectitudinea topologică și adiacența poligoanelor. GRASS este instrumentul ideal pentru acest lucru; fiind un GIS topologic, adiacența și corectitudinea sunt păstrate chiar și la niveluri foarte ridicate de simplificare. În cazul nostru, avem un
vector rezultat dintr-un raster, fapt indicat de modelul „zimţilor” de la frontiere. Aplicarea simplificării va produce linii drepte:

- **GRASS ► v.generalize** [Valoarea toleranţei maxime: 30 m]

De asemenea, putem proceda şi invers, făcând un strat mai complex, prin netezirea colturilor ascuţite:

- **GRASS ► v.generalize** [methoda: chaiken]

Încercaţi să aplicaţi această a doua comandă atât vectorului iniţial, cât şi celui de la prima analiză, pentru a vedea diferenţa. Retineţi că adiacenţa nu este pierdută.

Această a doua opţiune se poate aplica, de exemplu, curbelor de nivel care rezultă dintr-o raster grosier, la traseele GPS cu noduri rare, etc.

### 17.32 Planificarea unei ferme solare

Modulul a fost dezvoltat de Paolo Cavallini - *Faunalia*

**Notă:** Acest capitol arată cum să utilizaţi diverse criterii, în scopul localizării zonelor potrivite pentru instalarea unei centrale fotovoltaice

Mai întâi de toate, creaţi o hartă a aspectului dintr-un DTM:

- **GRASS ► r.aspect** [Tipul datei: int; cell size: 100]

În GRASS, aspectul este calculat în grade, în sens invers acelor de ceasornic, pornind de la Est. Pentru a extrage numai pantele orientate spre Sud (270 de grade ± 45), putem să-l reclassificăm:

- **GRASS ► r.reclass**

cu următoarele reguli:

```
225 thru 315 = 1 south
* = NULL
```

Puteţi utiliza fisierul text furnizat, reclass_south.txt. De asemenea, reţineţi că, folosind aceste fişiere text simple, putem crea reclassificări foarte complexe.

Dorim să construim o fermă mare, astfel încât vom selecta doar zonele învecinate mari (> 100 ha):

- **GRASS ► r.reclass.greater**

În final, le convertim într-un vector:

- **GRASS ► r.to.vect** [Tipul entităţii: arie; Colţuri netede: da]

**Exerciţiul pentru cititor:** repetati analiza, inlocuind comenzile GRASS cu unele similare cu ale altor programe.

### 17.33 Utilizarea script-urilor R în cadrul procesării

Module contributed by Matteo Ghetta - funded by *Scuola Superiore Sant’Anna*

Processing (with the Processing R Provider plugin) makes it possible to write and run R scripts inside QGIS.

**Atenţionare:** R has to be installed on your computer and the PATH has to be correctly set up. Moreover Processing just calls the external R packages, it is not able to install them. So be sure to install external packages directly in R. See the related chapter in the user manual.
Notă: If you have package problems, it may be related to missing mandatory packages required by Processing, like sp, rgdal and raster.

17.33.1 Adăugarea script-urilor

Adding a script is simple. The easiest way is to open the Processing toolbox and choose Create new R script… from the R menu (labelled with an R icon) at the top of the Processing Toolbox. You can also create the script in for instance a text editor and save it in your R scripts folder (processing/rscripts). When it has been saved there, it will be available for editing by right-clicking on the script name in the processing toolbox and then choose Edit Script…).

Notă: Dacă nu puteți vizualiza R în Processing, trebuie să îl activați din Processing ► Optiuni ► Furnizori

Se va deschide o fereastră de editare a scriptului în care va trebui să specificați o serie de parametri, înainte de a putea adăuga corpul scriptului.
17.33.2 Crearea diagramelor

În cadrul acestui tutorial vom crea o diagramă de tip boxplot pentru un câmp al unui strat vectorial.

Open the r_intro.qgs QGIS project under the exercise_data/processing/r_intro/ folder.

Parametrii scriptului

Deschideți editorul și începeți să scrieți.

Va trebui să specificați câțiva parametri înaintea editării scriptului:

1. The name of the group (plots in this case) in which you want to put your script (if the group does not exist, it will be created):

   ```
   ##plots=group
   ```

   You will find your script in the plots R group in the Processing toolbox.

2. You have to tell Processing that you want to display a plot (in this example):

   ```
   ##showplots
   ```

   You will then find a link to the plot in the Result Viewer panel (can be turned on / off in View ► Panels and with Processing ► Results Viewer).

3. You also need to tell Processing about your input data. In this example we want to create a plot from a field of a vector layer:

   ```
   ##Layer=vector
   ```

   Processing now knows that the input is a vector. The name Layer is not important, what matters is the vector parameter.

4. Finally, you have to specify the input field of the vector layer (using the name you have provided above - Layer):

   ```
   ##X=Field Layer
   ```

   Processing now knows that you need a field of Layer, and that you will call it X.

5. It is also possible to define the name of your script using name:

   ```
   ##My box plot script=name
   ```

   If not defined, the file name will be used as the name of the script.

Corpus scriptului

O dată ce partea introductivă a scriptului a fost setată, puteți adăuga o funcție:

```r
boxplot(Layer[['X']])
```

*boxplot* is the name of the R function, the parameter *Layer* is the name that you have defined for the input dataset and *X* is the name you have defined for the field of that dataset.

**Atenționare:** The parameter X has to be within double square brackets ([[ ]]).

Scriptul final va trebui să arate astfel:
Save the script in the default path suggested by Processing (processing/rscripts). If you have not defined a name in the script heading, the file name you choose will become the name of the script in the Processing toolbox.

**Notă:** You can save the script wherever you like, but Processing will then not be able to include it in the processing toolbox automatically, so you have to upload it manually.

Acum, doar rulați-l, folosind butonul din partea sus a ferestrei editorului:

Once the editor window has been closed, use the text box of Processing to find your script:
You can now fill the parameters required in the Processing algorithm window:

- for **Layer** choose `sample_points`
- for the **X** field choose `value`

Efectuați clic pe **Executare**.

Fereastra rezultatelor ar trebui să fie deschisă în mod automat, dacă nu, doar faceți clic pe **Processing ► Result Viewer**...
Click on the link in the viewer and you will see:

Notă: You can open, copy and save the image by right clicking on the plot.

### 17.33.3 Crearea unui vector

You can also create a vector layer and have it automatically loaded into QGIS.

The following example has been taken from the Random sampling grid script that can be found in the online collection of R scripts (the scripts in this online collection can be found in [https://github.com/qgis/QGIS-Processing/tree/master/rscripts](https://github.com/qgis/QGIS-Processing/tree/master/rscripts)).

The aim of this exercise is to create a random point vector layer using an input vector layer to restrict the extent using the `spsample` function of the `sp` package.
Parametrii scriptului

Ca și mai înainte, avem de stabilit câțiva parametri la începutul script-ului:

1. Specify the name of the group in which you want to put your script, in this case *Point pattern analysis*:
   ```
   ##Point pattern analysis=group
   ```

2. Define an input parameter (a vector layer) that will constrain the placement of the random points:
   ```
   ##Layer=vector
   ```

3. Set an input parameter for the number of points that are going to be created (*Size*, with a default value of 10):
   ```
   ##Size=number 10
   ```

   Notă: Since a default value (10) is defined, the user can change this number or can leave the parameter without a number.

4. Specify that there is an output vector layer (called *Output*):
   ```
   ##Output=output vector
   ```

Corpul scriptului

Acum puteți adăuga corpul funcției:

1. Use the `spsample` function:
   ```
   pts=spsample(Layer, Size, type="random")
   ```

   The function uses the *Layer* to constrain the placement of the points (if it is a line layer, a points will have to be on one of the lines in the layer, if it is a polygon layer, a point will have to be within a polygon). The number of points is taken from the *Size* parameter. The sampling method is *random*.

2. Generate the output (the *Output* parameter):
   ```
   Output=SpatialPointsDataFrame(pts, as.data.frame(pts))
   ```

Scriptul final va trebui să arate astfel:

```
##Point pattern analysis=group
##Layer=vector
##Size=number 10
##Output=output vector
pts=spsample(Layer, Size, type="random")
Output=SpatialPointsDataFrame(pts, as.data.frame(pts))
```
Save it and run it, clicking on the run button.

În noul tip de fereastră scriți parametrii potriviti:

```r
# Point pattern analysis = group
# Layer = vector
# Size = number 10
# Output = output vector
pts = spsample(Layer, Size, type = "random")
Output = SpatialPointsDataFrame(pts, as.data.frame(pts))
```

apoi faceți clic pe rulare.

The result layer will be added to the table of contents and its points will be displayed on the map canvas:
17.33.4 Text and graph output from R - syntax

Processing (with the Processing R Provider plugin) uses special syntax to get the results out of R:

- > înainte de comanda dvs., ca în >lillie.test(Layer[[Field]]) denotă că rezultatul ar trebui să fie trimis la ieșirea R (Vizualizatorul de rezultate)
- + after a plot enables overlay plots. For example `plot(Layer[[X]], Layer[[Y]]) + abline(h=mean(Layer[[X]]))`

17.34 Prezicerea alunecărilor de teren

Modulul a fost dezvoltat de Paolo Cavallini - Faunalia

Notă: Acest capitol vă arată cum să creați un model simplificat pentru a prezice probabilitatea alunecărilor de teren.

În primul rând, vom calcula panta (aleasă dintre diferite variante; cititorul interesat poate calcula diferență dintre rezultate):

- **GRASS ► r.slope**
- **SAGA ► Pantă, Aspect, Curbură**
- **Panta GDAL**

Apoi vom crea un model de predicție a precipitațiilor, pe baza interpolării valorilor precipitațiilor de la stațiile meteo:

- **GRASS ► v.surf.rst** (rezoluția: 500 m)

Probabilitatea unei alunecări de teren va fi afectată atât de precipitații cât și de panta (desigur, un model la scară reală va folosi mai multe straturi, și parametri mai potrivit), rezultând formula \( \frac{\text{precipitații} \times \text{pantă}}{100} \):

- **SAGA ► Calculator raster precipitații, pantă: \( (a \times b) / 100 \) (sau: **GRASS ► r.mapcalc**)

- apoi vom calcula care sunt municipalitățile cu un mai mare risc de precipitații: SAGA ► Statistici pentru raster cu poligoane (parametrii de interes fiind Maximum și Medie)
Module: Folosirea Bazelor de Date Spațiale în QGIS

In this module you will learn about how to use Spatial Databases with QGIS to manage, display and manipulate data in the database as well as performing analysis by querying. We will primarily use PostgreSQL and PostGIS (which were covered in previous sections), but the same concepts are applicable to other spatial database implementations including SpatiaLite.

18.1 Lesson: Lucrul cu Baze de Date în Navigatorul QGIS

În cele 2 module anterioare am atins concepte de bază, facilități și funcții de bază ale bazelor de date relaționale și extensii care permit stocarea, administrarea, interrogarea și manipularea datelor spațiale într-o bază de date relațională. Această secțiune va intra în detaliu pentru utilizarea eficientă a bazelor de date spațiale în QGIS.

Scopul acestei lecții: Să învățați cum să interacționați cu bazele de date spațiale utilizând interfața QGIS.

18.1.1 Follow Along: Adăugarea Tabelelor Bazei de Date în QGIS folosind Navigatorul

Am văzut, pe scurt, cum pot fi adăugate, sub formă de straturi QGIS, tabelele dintr-o bază de date; hăideți acum să intrăm în mai multe detalii și să vedem diferite moduri de a face acest lucru în QGIS. Să aruncăm, mai întâi, o privire la noua interfață a Navigatorului.

- Începeți o nouă hartă goală în QGIS.
- Deschideți Navigatorul efectuând un clic pe fila Browser, din partea de jos a Panoului Straturilor
- Deschideți portiunea PostGIS a arborelui, pentru a găsi conexiunea configurată anterior (poate fi necesar să faceți clic pe butonul Refresh, din partea de sus a fereastră navigatorului).
• Un clic dublu pe oricare din tabelele/straturile listate aici, îl va adăuga la Canevasul Hărții.

• Făcând clic dreapta pe o tabelă/strat în această vizualizare vă va oferi câteva opțiuni. Faceți clic Proprietăți, pentru a vedea proprietățile stratului.
**Notă:** Of course you can also use this interface to connect to PostGIS databases hosted on a server external to your workstation. Right clicking on the PostGIS entry in the tree will allow you to specify connection parameters for a new connection.

### 18.1.2 Follow Along: Adăugarea unui set filtrat de înregistrări sub formă unui Strat

Acum, că am văzut cum puteți adăuga în QGIS un întreg tabel, sub formă de strat, ar fi bine să învățati cum puteți adăuga, sub formă de strat, un set de înregistrări filtrate dintr-un tabel, utilizând interogările învățate în secțiunile anterioare.

- Începeți o nouă hartă goală, fără straturi
- Click the *Add PostGIS Layers* button or select *Layer ➤ Add PostGIS Layers* from the menu.
- În dialogul de *Adăugare Tabel(e) PostGIS*, care se deschide, folosiți conexiunea *postgis_demo*.
- Extindeți schema public și găsiți cele trei tabele cu care am lucrat anterior.
- Faceți clic pe stratul *lines* pentru a-l selecta, dar în loc să-l adăugați, apăsați butonul *Setare Filtru*, pentru a deschide dialogul *Constructorului de Interogări*.
- Construiți următoarea expresie, utilizând butoanele sau prin introducerea directă:

  ```
  *roadtype* = 'major'
  ```
• Faceti clic pe OK pentru a incheia editarea filtrului, apoi pe Adăugare, pentru a adauga pe hartă stratul filtrat.
• Redenumire strat lines din arborele roads_primary.
Veți observa că numai Drumurile Primare au fost adăugate pe hartă, și nu întregul strat.

18.1.3 In Conclusion

Ați văzut cum se poate interacționa cu bazele de date spațiale, folosind QGIS Browser, și modul în care se pot adăuga straturi pe hartă, în funcție de un filtru de interogare.

18.1.4 What’s Next?

În continuare, este prezentat lucrul cu interfața Managerului DB din QGIS, pentru o serie mai amplă de sarcini de gestiune a bazelor de date.
18.2 Lesson: Utilizarea DB Manager din QGIS, în lucrul cu bazele de date spațiale

Am văzut deja cum se pot efectua în QGIS multe operații cu bazele de date, la fel de simplu ca și cu celelalte instrumente, dar acum este timpul să ne uităm la instrumentul DB Manager, care oferă o mare parte din aceeași funcționalitate, similar cu alte instrumente dedicate managementului.

**Scopul acestei lecții:** De a se învăța interacțiunea cu bazele de date raster, folosind interfața DB Manager din QGIS.

18.2.1 Follow Along: Gestionarea Bazelor de date PostGIS cu ajutorul DB Manager

Ar trebui să deschideți, mai întâi, interfața DB Manager, mergând la Baza de date –> DB Manager –> DB Manager din meniu sau prin selectarea pictogramei DB Manager de pe bara de instrumente.

You should already see the previous connections we have configured and be able to expand the myPG section and its public schema to see the tables we have worked with in previous sections.

Primul lucru care se remarcă este faptul că, de acum, puteți vedea unele metadate ale Schemelor contine în baza de date.

Schemas are a way of grouping data tables and other objects in a PostgreSQL database and a container for permissions and other constraints. Managing PostgreSQL schemas is beyond the scope of this manual, but you can find more information about them in the PostgreSQL documentation on Schemas. You can use the DB Manager to create new Schemas, but will need to use a tool like pgAdmin III or the command line interface to manage them effectively.
De asemenea, DB Manager se poate folosi pentru a administra tabelele din baza de date. Am analizat deja diferite moduri de creare și gestionare a tabelelor din linia de comandă, dar acum dorim să vedem cum se poate face acest lucru în DB Manager.

First, it’s useful to just look at a table’s metadata by clicking on its name in tree and looking in the *Info* tab.

In this panel you can see the *General Info* about the table as well the information that the PostGIS extension maintains about the geometry and spatial reference system.

If you scroll down in the *Info* tab, you can see more information about the *Fields, Constraints and Indexes* for the table you are viewing.
Its also very useful to use DB Manager to simply look at the records in the database in much the same way you might do this by viewing the attribute table of a layer in the Layer Tree. You can browse the data by selecting the Table tab.

18.2. Lesson: Utilizarea DB Manager din QGIS, în lucrul cu bazele de date spațiale
Există, de asemenea o filă *Preview*, care vă va arăta datele stratului într-o hartă de previzualizare.

Click-dreapta pe unul dintre straturi și, făcând clic pe *Add to Canvas*, acesta se va adăuga pe hartă.

So far we have only been viewing the database its schemas and tables and their metadata, but what if we wanted to alter the table to add an additional column perhaps? DB Manager allows you to do this directly.

1. Selectați din arbore tabela pe care doriți să o editați

2. Select *Table ➤ Edit Table* from the menu, to open the *Table Properties* dialog.

![Table Properties dialog](image)

Puteți folosi acest dialog pentru a Adăuga Coloane, Coloane pentru geometrii, pentru a edita coloanele existente sau pentru a elimina complet o coloană.

Using the *Constraints* tab, you can manage which fields are used as the primary key or to drop existing constraints.
Fila *Indecșilor* poate fi folosită pentru a adăuga și șterge atât indicii spațiali, cât și cei normali.
18.2.2 **hard** Follow Along: Crearea unei Noi Tabele

Acum, că am trecut prin procesul de lucru cu tabelele existente în baza noastră de date, haideți să folosim DB Manager pentru a crea o nouă tabelă.

1. Dacă nu este deja deschis, deschideți fereastra DB Manager, și expanda arborele până când veți vedea lista de tabele deja în baza de date.
2. Selectați meniul `Table -> Create Table` pentru a deschide dialogul de Creare a Tabelei.
3. Utilizați schema Public implicită și denumește tabelul `places`.
4. Adăugați câmpurile `id`, `place_name`, și `elevation` așa cum este afișat mai jos.
5. Asigurați-vă că câmpul `id` este setat ca cheie primară.
6. Faceți clic pe caseta pentru `Create geometry column` și asigurați-vă că este setat la tipul `POINT` și îl lasați numit `geom` și specificați 4326 ca `SRID`.
7. Faceți clic pe butonul `Create` pentru a crea tabelă.
8. Închideți dialogul care vă informează că tabela s-a creat cu succes, apoi faceți clic pe Close pentru a închide Dialogul de Crearea Tabelei.

You can now inspect your table in the DB Manager and you will of course find that there is no data in it. From here you can Toggle Editing on the layer menu and begin to add places to your table.

18.2.3 Follow Along: Tehnici de bază pentru administrarea bazei de date

The DB Manager will also let you do some basic database administration tasks. It is certainly not a substitute for a more complete database administration tool, but it does provide some functionality that you can use to maintain your database.

Database tables can often become quite large and tables which are being modified frequently can end up leaving around remnants of records that are no longer needed by PostgreSQL. The VACUUM command takes care of doing a kind of garbage collection to compact and optional analyze your tables for better performance.

Let us take a look at how we can perform a VACUUM ANALYZE command from within DB Manager.

1. Select one of your tables in the DB Manager Tree
2. Select Table ➤ Run Vacuum Analyze from the menu

PostgreSQL will now perform the operation. Depending on how big your table is, this may take some time to complete.
You can find more information about the VACUUM ANALYZE process in the PostgreSQL Documentation on VACUUM ANALYZE.

18.2.4 Follow Along: Executarea Interogărilor SQL cu ajutorul DB Manager

DB Manager also provides a way for you to write queries against your database tables and to view the results. We have already seen this type of functionality in the Browser panel, but let's look at it again here with DB Manager.

1. Select the lines table in the tree.
2. Select the button SQL window din bara de instrumente DB Manager.

3. Compose the next SQL query in the designated space:

   ```sql
   select * from lines where roadtype = 'major';
   ```

4. Click the button Execute (F5) to run the query.
5. You should now view all the results that correspond to the panel Results.

6. Click the box to select Load as new layer to add the results to your map.
7. Select the id column as the Column with unique integer values and the geom column as the Geometry column.
8. Enter roads_primary as the Layer name (prefix).
9. Faceți clic pe Load now! pentru a încărca rezultatele ca un nou strat în harta dvs.

The layers that matched your query are now displayed on your map. You can of course use this query tool to execute any arbitrary SQL command including many of the ones we looked at in previous modules and sections.

18.2.5 Importarea datelor dintr-o Bază de date cu ajutorul DB Manager

We have already looked at how to import data into a spatial database using command line tools, so now let’s learn how to use DB Manager to do imports.

1. Clic pe butonul Import layer/file din Bara de Instrumente a dialogului DB Manager.

2. Select the urban_33S.shp file from exercise_data/projected_data as the input dataset
3. Clic pe butonul Opțiunilor de actualizare pentru a pre-completa unele din valorile formularului.
4. Asigurați-vă că este selectată opțiunea Creare tabelă nouă.
5. Specify the Source SRID as 32722 and the Target SRID as 4326
6. Activate the check box for creating the **Create index Spatial**

7. Click **OK** to perform the import

8. Close the dialog window which informs that the import has been successful

9. Click the **Refresh** button on the DB Manager Toolbar
You can now inspect the table in your database by clicking on it in the Tree. Verify that the data has been reprojected by checking that the Spatial ref: is listed as WGS 84 (4326).

Click-dreapta pe unul dintre straturile din Arbore și apoi, făcând clic pe Adăugare la Caneva, tabela se va adăuga pe hartă, sub formă de strat.

### 18.2.6 Exportul datelor cu DB Manager dintr-o Bază de date

De asemenea, DB Manager se poate utiliza pentru exportul datelor din bazele de date spațiale, așa că haideți să aruncăm o privire la modul în care se face aceasta.

1. Select the lines layer in the Tree and click the Export to File button on the toolbar to open the Export to vector file dialog.
2. Click the … button to select the Output file and save the data to your exercise_data directory as urban_4326.
3. Set the Target SRID as 4326.
4. Clic OK pentru a inițializa exportul.
5. Închideți dialogul care vă informează că exportul a avut loc cu succes, apoi închideți DB Manager. Puteți inspecta de acum fișierul shape pe care l-ai creat cu panoul de Răsfoire.
18.2.7 In Conclusion

You have now seen how to use the DB Manager interface in QGIS to manage your spatial databases, to execute SQL queries against your data and how to import and export data.

18.2.8 What’s Next?

Next, we will look at how to use many of these same techniques with SpatiaLite databases.

18.3 Lesson: Working with SpatiaLite databases in QGIS

While PostGIS is generally used on a server to provide spatial database capabilities to multiple users at the same time, QGIS also supports the use of a file format called SpatiaLite that is a lightweight, portable way to store an entire spatial database in a single file. Obviously, these 2 types of spatial databases should be used for different purposes, but the same basic principles and techniques apply to both. Let’s create a new SpatiaLite database and explore the functionality provided to work with these databases in QGIS.

The goal for this lesson: To learn how to interact with SpatiaLite databases using the QGIS Browser interface.

18.3.1 Follow Along: Creating a SpatiaLite database with the Browser

Using the Browser panel, we can create a new SpatiaLite database and get it setup for use in QGIS.

1. Right click on the SpatiaLite entry in the Browser tree and select Create Database.
2. Specify where on your filesystem you want to store the file and name it qgis-sl.db.
3. Again right click on the SpatiaLite entry in the Browser tree and now select the New Connection item. Find the file you created in the last step and open it.

Acum, că v-ați configurat noua bază de date, veți descoperi că intrarea din arborele Navigațorului nu are nimic sub ea, iar singurul lucru pe care îl puteți face în acest moment este de a șterge conexiunea. Acest lucru se datorează faptului că, desigur, noi nu am adăugat nici un tabel în această bază de date. Haideți să mergem mai departe și să facem asta.

1. Find the button to create a new layer and use the dropdown to create a new SpatiaLite layer, or select Layer ➤ New ➤ New SpatiaLite Layer.
2. Selectați baza de date pe care am creat-o în pașii anteriori în meniul derulant.
3. Give the layer the name places.
4. Bifăți caseta de lângă Create an auto-incrementing primary key.
5. Add two attributes as shown in below
6. Clic pe OK, pentru a crea tabela.
7. Click the refresh button at the top of the Browser and you should now see your `places` table listed.
Puteți să faceți clic dreapta pe tabelă și să-i vizualizați proprietățile, așa cum am făcut-o în exercițiul precedent. De aici puteți începe o sesiune de editare și să adăugați date direct la noua bază de date.

We also learned about how to import data into a database using the DB Manager and you can use this same technique to import data into your new SpatiaLite DB.

### 18.3.2 In Conclusion

You have seen how to create SpatiaLite databases, add tables to them and use these tables as layers in QGIS.
Pentru a adăuga material în acest curs este necesar de urmărit ghidul din anexă. Nu aveți voie să alterați condițiile din Anexă dar puteți extinde cu clarificații. Acest lucru este necesar pentru siguranța calității și consistentei acestui manual.

### 19.1 Descărcare resurse.

Sursa acestui document se poate găsi la GitHub. Consultați GitHub.com pentru instrucțiunile de folosire a sistemului de versionare git.

### 19.2 Formatul Manualului

This manual is written using Sphinx, a Python document generator using the reStructuredText markup language. Instructions on how to use these tools are available on their respective sites.

### 19.3 Adăugarea unui Modul

- Pentru a adăuga un nou modul, mai întâi creați un nou director (direct sub nivelul superior al directorului qgis-training-manual) având numele noului modul.
- În cadrul acestui nou director, creați un fișier denumit index.rst. Lăsați acest fișier gol pentru moment.
- Deschideți fișierul index.rst de sub directorul de nivel superior. Primele linii sunt:

```
.. toctree::
   :maxdepth: 2

   foreword/index
   introduction/index
```

Retineți că aceasta este o listă a numelor de director, urmată de denumirea index. Ea direcționează fișierul index de nivel superior spre fișierele index din fiecare director. Ordinea în care sunt listate determină ordinea pe care o vor avea în document.
• Adăugați numele noului modul (adică, numele dat noului director), urmat de `index`, în această listă, ori de câte ori dorți să apără modulul.

• Amintiți-vă să mențineți ordinea modulelor logice, astfel încât modulele ulterioare se construiesc pe cunostințele prezentate în modulele anterioare.

• Deschideți propriul fișier index al noului modul ([module name]/index.rst).

• În partea de sus a paginii, adăugați o linie de 80 de asteriscuri (*). Aceasta reprezintă un antet de modul.

• Follow this with a line containing the markup phrase `|MOD|` (which stands for „module”), followed by the name of your module.

• Încheiați cu o altă linie de 80 de asteriscuri.

• Scrieți un scurt paragraf, explicând scopul și conținutul modulului.

• Lăsați o linie deschisă, apoi adăugați următorul text:

```
.. toctree::
:maxdepth: 2

lesson1
lesson2
```

... unde lesson1, lesson2, etc., sunt numele lecțiilor planificate.

Fisierul index la nivel de modul va arăta astfel:

```
|MOD| Module Name

Short paragraph describing the module.

.. toctree::
:maxdepth: 2

lesson1
lesson2
```

19.4 Adăugarea unei Lecții

Pentru a adăuga o lecție pentru un modul nou sau existent:

• Deschideți directorul modulului

• Deschideți fișierul `index.rst` (creat mai sus, în cazul noilor module).

• Asigurați-vă că numele lecției planificate este listat sub directiva `toctree`, aşa cum se arată mai sus.

• Creați un nou fișier în directorul modulului.

• Folosiți pentru acest fișier exact același nume pe care l-ați specificat în fișierul modulului `index.rst`, apoi adăugați extensia `.rst`.

**Notă:** În scopuri de editare, un fișier `.rst` funcționează exact ca un fișier text obișnuit (.txt).

• Pentru a începe scrierea lecției, scrieți fraza de marcare `|LS|`, urmată de numele lecției.
• În următoarea linie, adăugați 80 de semne egal (=).
• Lăsați o linie deschisă după aceasta.
• Scrieți o scurtă descriere asupra scopului lectiei.
• Includeți o introducere generală în subiect. Parcurgeți lecțiile existente în acest manual, pentru exemple.
• Sub aceasta, începeți un nou alineat, începând cu această frază:

```
**The goal for this lesson:**
```

• Explicați pe scurt rezultatul intenționat al completării acestei lecții.
• În cazul în care obiectivul lectiei nu se poate descrie într-o sau două propoziții, luați în considerare împărțirea subiectului în mai multe lecții.

Fiecare lecție va fi împărțită în mai multe secțiuni, care vor fi abordate în continuare.

### 19.5 Adăugarea unei Secțiuni

Există două tipuri de secțiuni: „procedați în mod similar” și „încercați singuri”.

• A „follow along” section is a detailed set of directions intended to teach the reader how to use a given aspect of QGIS. This is typically done by giving click-by-click directions as clearly as possible, interspersed with screenshots.
• A „try yourself” section gives the reader a short assignment to try by themselves. It is usually associated with an entry in the answer sheet at the end of the documentation, which will show or explain how to complete the assignment, and will show the expected outcome if possible.

Every section comes with a difficulty level. An easy section is denoted by |basic|, moderate by |moderate|, and advanced by |hard|.

#### 19.5.1 Adăugați o secțiune „procedați în mod similar”

• Pentru a începe această secțiune, scrieți fraza de marcare a nivelului de dificultate intenționat (după cum se arată mai sus).
• Lăsați un spațiu și apoi scrieți |FA| (pentru „procedați în mod similar”).
• Lăsați un alt spațiu și scrieți numele secțiunii (folosiți doar o literă mare, precum și majuscule pentru substantive proprii).
• În linia următoare, introduceți 80 de minusuri/liniițe (\textemdash). Asigurați-vă că editorul de text nu înlocuiește caracterul implicit pentru minus/liniuită, cu o linie mai lungă sau un alt caracter.
• Scrieți o scurtă introducere a secțiunii, explicându-i scopul. Apoi oferiți instrucțiuni detaliate (clic-după-clic) privind procedura care trebuie demonstrată.
• În fiecare secțiune, includeți link-uri interne, link-uri externe și capturi de ecran după cum este necesar.
• Încercați să terminați fiecare secțiune cu un scurt paragraf, care să se încheie și să conducă în mod natural la secțiunea următoare, dacă este posibil.
19.5.2 Adăugați o secțiune „încercați singuri”

- Pentru a începe această secțiune, scrieți fraza de marcare a nivelului de dificultate intenționat (după cum se arată mai sus).
- Lăsați un spațiu și apoi scrieți |TY| (pentru „încercați singuri”).
- În linia următoare, introduceți 80 de minusuri/liniute (—). Asigurați-vă că editorul de text nu înlocuiește caracterul implicit pentru minus/liniuță, cu o linie mai lungă sau un alt caracter.
- Explicați exercițiul pe care doriti ca cititorul să-l finalizeze. Consultați secțiunile anterioare, lectiile sau modulele, dacă este necesar.
- Includeți capturi de ecran pentru a clarifica cerințele, în cazul în care o descriere textuală simplă nu este de ajuns.

In most cases, you will want to provide an answer regarding how to complete the assignment given in this section. To do so, you will need to add an entry in the answer sheet.

- First, decide on a unique name for the answer. Ideally, this name will include the name of the lesson and an incrementing number.
- Creați o legătură pentru acest răspuns:

```latex
:ref:`Check your results <answer-name>`
```

- Deschideți pagina răspunsului (answers/answers.rst).
- Creați o legătură către secțiunea „încercați singuri”, prin scrierea acestei linii:

```latex
.. _answer-
```

- Scrieți instrucțiunile despre modul de completare a sarcinii, folosind link-uri și imagini acolo unde este nevoie.
- Pentru a încheia, includeți o legătură către secțiunea „încercați singuri”, prin scrierea acestei linii:

```latex
:ref:`Back to text <backlink-answer-name>`
```

- Pentru a face această linie să funcționeze, includeți linia următoare deasupra antetului secțiunii „încercați singuri”:

```latex
.. _backlink-answer-name:
```

Remember that each of these lines shown above must have a blank line above and below it, otherwise it could cause errors while creating the document.

19.6 Adăugarea unei Concluzii

- To end a lesson, write the phrase |IC| for „in conclusion”, followed by a new line of 80 minuses/dashes (—).
- Write a conclusion for the lesson, explaining which concepts have been covered in the lesson.
19.7 Adăugarea unei Secțiuni de Lecturi suplimentare

- Această secțiune este optională.
- Folosiți acronimul FR în loc de „lecturi suplimentare”, urmat de o linie nouă cu 80 de minusuri/liniute (–).
- Includeți trimiteri către site-urile externe corespunzătoare.

19.8 Adăugarea Secțiunii „Ce Urmează”

- Folosiți acronimul |WN| pentru „ce urmează”, urmat de o linie nouă cu 80 de minusuri/liniute (–).
- Explicați modul în care a pregătit această lecție studenții pentru lecția sau modulul următor.
- Remember to change the „what’s next” section of the previous lesson if necessary, so that it refers to your new lesson. This will be necessary if you have inserted a new lesson among existing lessons, or after an existing lesson.

19.9 Utilizarea Marcajelor

Pentru a adera la standardele acestui document, va trebui să adăugați marcajul standard textului dvs.

19.9.1 Noi concepte

- If you are explaining a new concept, you will need to write the new concept’s name in italics by enclosing it in asterisks (*).

This sample text shows how to introduce a ‘new concept’.

19.9.2 Atenție specială

- Pentru a evidenția un termen esențial, care nu reprezintă un concept nou, scrieți termenul cu caractere aldine, încadrându-l între asteriscuri duble (**).
- Folosiți-le cu moderație! Dacă utilizați prea multe, cititorul ar putea avea impresia că strigăți sau ca aveți un aer de superioritate.

This sample text shows how to use **emphasis** in a sentence. Include the punctuation mark if it is followed by a **comma,** or at the **end of the sentence.**

19.9.3 Imagini

- Când adăugați o imagine, salvați-o în folderul _static/lesson_name/.
- Includeți-l în document, în felul următor:

```
.. figure:: img/image_file.extension
    :align: center
```

- Nu uitați să lăsați o linie, deasupra și dedesubtul marcajului imaginii.
19.9.4 Legături interne

- Pentru a crea o legătură, adăugați această linie:

```
.. _link-name:
```

- Pentru a crea o legătură, adăugați această linie:

```
:ref:`Descriptive link text <link-name>`
```

- Nu uitați să lasați o linie, deasupra și dedesubtul acestei linii.

19.9.5 Legături externe

- Pentru a crea o legătură externă, scrieți astfel:

```
`Descriptive link text <link-url>`
```

- Nu uitați să lasați o linie, deasupra și dedesubtul acestei linii.

19.9.6 Utilizați text monospațiat

- Atunci când trebuie să introduceți un text care să fie folosit ca o anotema sau pentru detalii suplimentare, puteți utiliza acesta:

```
[Normal paragraph.]
.. note:: Note text.
   New line within note.
```

(continues on next page)
19.9.10 Adăugarea o notă de sponsorizare/drepturi de autor

Dacă scrieți un nou modul, o lecție sau o secțiune în numele unui sponsor, trebuie să includă un scurt mesaj, la alegerea sponsorului. Acesta trebuie să informeze cititorul despre numele sponsorului și trebuie să apară sub titlul modulului, lecției sau secțiunii sponsorizate. Totuși, mesajul nu poate consta într-o reclamă pentru compania sponsorului.

If you have volunteered to write a module, lesson or section in your own capacity, and not on behalf of a sponsor, you may include an authorship note below the heading of the module, lesson or section that you authored. This must take the form This [module/lesson/section] contributed by [author name]. Do not add further text, contact details, etc. Such details are to be added in the „Contributors” section of the Foreword, along with the name(s) of the part(s) you added. If you only made enhancements, corrections and/or additions, list yourself as an editor.

19.10 Mulțumiri!

Vă mulțumim pentru contribuția la acest proiect! Procedând astfel, faceți QGIS mai accesibil pentru utilizatori și adăugați valoare întregului proiect QGIS.
Pregătirea Datelor pentru Exerciții

Notă: Acest proces este destinatprofesorilor sau utilizatorilor de QGIS experimentați care doresc să creeze seturi cu
esanțioane de date localizate pentru cursurile lor. Seturile de date implicite sunt furnizate cu Manualul de instruire,
dar este posibilă utilizarea acestor instrucțiuni dacă doriți să înlocuiți seturile de date implicate.

The sample data provided with the Training Manual refers to the town of Swellendam and its surroundings.
Swellendam is located about 2 hours east of Cape Town in the Western Cape of South Africa. The dataset contains
feature names in both English and Afrikaans.

Oricine poate utiliza, fără dificultate, acest set de date, dar este posibil să preferați să utilizați date din propria țară
sau din orașul natal. În cazul în care alegeți să faceți acest lucru, datele dvs. localizate vor fi utilizate în toate lectiile,
de la Modulul 3 până la modulul 7.2. Modulele ulterioare folosesc surse de date mai complexe, care pot fi valabile,
sau nu, pentru regiunea dumneavoastră.

Notă: Aceste instrucțiuni presupun că aveți o bună cunoaștere a QGIS, nefiind destinate utilizării ca material didactic.

20.1 Try Yourself Create OSM based vector Files

If you wish to replace the default data set with localised data for your course, this can easily be done with tools
built into QGIS. The region you choose to use should have a good mix of urban and rural areas, containing roads
of differing significance, area boundaries (such as nature reserves or farms) and surface water, such as streams and
rivers.

1. Deschideți un nou proiect QGIS
2. Select Layer ➤ Data Source Manager to open the Data Source Manager dialog
3. In the Browser tab, expand the XYZ Tiles drop-down menu and double-click the OpenStreetMap item.
A map of the world is now visible on the map canvas.

4. Close the Data Source Manager dialog

5. Move to the area you’d like to use as study area

Now that we have the area we’ll extract the data from, let’s enable the extraction tools.

1. Go to Plugins ➤ Manage/Install Plugins…
2. In the All tab, type QuickOSM in the search box
3. Select the QuickOSM plugin, press Install Plugin and then Close the dialog.
4. Execute the new plugin from Vector ➤ QuickOSM ➤ QuickOSM… menu
5. In the Quick query tab, select building in the Key drop-down menu
6. Leave the Value field empty, meaning that you are querying all buildings.
7. Select Canvas Extent in the next drop-down menu
8. Expand the Advanced group below and uncheck all geometry types on the right except Multipolygons.
9. Press Run query

A new building layer is added to the Layers panel, showing buildings in the selected extent.
10. Proceed as above to extract other data:
    1. Key = landuse and Multipolygons geometry type.
    2. Key = boundary, Value = protected_area and Multipolygons geometry type.
    3. Key = natural, Value = water and Multipolygons geometry type.
    4. Key = highway and check Lines and Multilines geometry types.
5. Key = waterway, Value = river and check Lines and Multilines geometry types.
6. Key = place and Points geometry type.

This process adds the layers as temporary files (indicated by the icon next to their name).

You can sample the data your region contains in order to see what kind of results your region will yield.

We now need to save the resulting data to use during your course. We’ll be using ESRI Shapefile, GeoPackage and SpatiaLite formats depending on the data.

To convert the place temporary layer to another format:

1. Click the icon next to the place layer to open the Save Scratch Layer dialog.
   
   **Nota:** If you need to change any of the temporary layer’s properties (CRS, extent, fields…), use the Export ► Save Features as… contextual menu instead, and ensure the Add saved file to map option is checked. This adds a new layer.

2. Select the ESRI Shapefile format

3. Use the … button to browse to the exercise_data/shapefile/ folder and save the file as places.shp.
4. Press **OK**

   In the *Layers* panel, the temporary *place* layer is replaced with the saved *places* shapefile layer and the temporary icon next to it removed.

5. Double-click the layer to open its *Layer Properties* ➤ *Source* tab and update the *Layer name* property to match the file name.

6. Repeat the process for other layers, renaming them as follows:
   - `natural_water` into `water`
   - `waterway_river` into `rivers`
   - `boundary_protected_area` into `protected_areas`

   Each resulting data set should be saved in the `exercise_data/shapefile/` directory.

The next step is to create a GeoPackage file from the *building* layer to use during the course:

1. Click the icon next to the *building* layer
2. Select the *GeoPackage* format
3. Save the file as `training_data.gpkg` under the `exercise_data/` folder
4. By default, the *Layer name* is filled as the file name. Replace it with `buildings`.  

---

**20.1. Try Yourself Create OSM based vector Files**
5. Press **OK**

6. Rename the layer in its properties dialog

7. Repeat the process with the *highway* layer, saving it as *roads* in the same GeoPackage database.

The last step is to save the remaining temporary file as a SpatiaLite file.

1. Click the icon next to the *landuse* layer

2. Select the *SpatiaLite* format

3. Save the file as **landuse.sqlite** under the *exercise_data/* folder. By default, the *Layer name* is filled as the file name. Do not change it.
4. Press OK

You should now have a map which looks something like this (the symbology will certainly be very different, because QGIS randomly assigns colors when layers are added to the map):

The important thing is that you have 7 vector layers matching those shown above and that all those layers have some data.
20.2 Try Yourself Crearea Fișierelor SRTM DEM tiff

For modules **Module: Crearea Datelor Vectoriale** and **Module: Rastere**, you'll also need raster images (SRTM DEM) which cover the region you have selected for your course.

The CGIAR-CGI provides some SRTM DEM you can download from [https://srtm.csi.cgiar.org/srtmdata/](https://srtm.csi.cgiar.org/srtmdata/).

You’ll need images which cover the entire region you have chosen to use. To find the extent coordinates, in QGIS, zoom to the extent of the largest layer and pick the values in the `Extents` box of the status bar. Keep the GeoTiff format. Once the form is filled, click on the `Click here to Begin Search` button and download the file(s).

Once you have downloaded the required file(s), they should be saved in the `exercise_data` directory, under `raster/SRTM` subfolders.

20.3 Try Yourself Crearea Fișierelor tiff

In **Module: Crearea Datelor Vectoriale, Follow Along: Sursele de Date** lesson shows close-up images of three school sports fields which students are asked to digitize. You'll therefore need to reproduce these images using your new SRTM DEM tiff file(s). There is no obligation to use school sports fields: any three school land-use types can be used (e.g. different school buildings, playgrounds or car parks).

For reference, the image in the example data is:
20.4 Try Yourself Replace Tokens

Having created your localised dataset, the final step is to replace the tokens in the `substitutions.txt` file so that the appropriate names will appear in your localised version of the Training Manual.

The tokens you need to replace are as follows:

- **majorUrbanName**: this defaults to „Swellendam“. Replace with the name of the major town in your region.
- **schoolAreaType1**: this defaults to „athletics field“. Replace with the name of the largest school area type in your region.
- **largeLandUseArea**: this defaults to „Bontebok National Park“. Replace with the name of a large landuse polygon in your region.
- **srtmFileName**: this defaults to `srtm_41_19.tif`. Replace this with the filename of your SRTM DEM file.
- **localCRS**: this defaults to WGS 84 / UTM 34S. You should replace this with the correct CRS for your region.
Fișă de răspunsuri

21.1 Results For O privire de ansamblu asupra interfeței

21.1.1 Vedere Generală (Partea 1)

Consultă iarăși imaginea care prezintă aspectul interfeței și verificați dacă vă amintiți numele și funcțiile elementelor de pe ecran.

21.1.2 Vedere Generală (Partea a 2-a)

1. Salvare ca
2. Transfocare pe Strat
3. Invert selection
4. `guilabel:` Randare activată/dezactivată
5. Măsurare Linie

21.2 Results For Adăugarea Primului Dvs. Strat

21.2.1 Pregătire

In the main area of the dialog you should see many shapes with different colors. Each shape belongs to a layer you can identify by its color in the left panel (your colors may be different from the ones below):
21.2.2 Data loading

Your map should have seven layers:

- `protected_areas`
- `location`
- `rivers`
- `roads`
- `landuse`
- `buildings` (taken from `training_data.gpkg`) and
- `water` (taken from `exercise_data/shapefile`).

21.3 Results For Symbology

21.3.1 Colors

- Verify if you can change the colors as desired.

- It is enough to select the `water` layer in the legend and then click on the Open the Layer Styling panel button. Change the color to one that fits the water layer.
Nota: If you want to work on only one layer at a time and don’t want the other layers to distract you, you can hide a layer by clicking in the checkbox next to its name in the layers list. If the box is blank, then the layer is hidden.

Back to text

21.3.2 Structura Simbolului

Harta ar trebui să arate așa:

Dacă sunteți la nivelul de Utilizator Începător, v-ați putea opri aici.

• Utilizați metoda de mai sus pentru a schimba culorile și stilurile pentru toate straturile rămase.
• Încercați să folosiți culori naturale pentru obiecte. De exemplu, un drum nu ar trebui să fie de culoare roșie sau albastră, dar poate fi de culoare gri sau neagră.
• Also feel free to experiment with different Fill style and Stroke style settings for the polygons.

21.3.3 **Straturile Simbolului**

Personalizați-vă stratul de clădiri așa cum doriți, dar nu uitați că trebuie să fie ușor să distingeti diferitele straturi de pe harta.

Iată un exemplu:
21.3.4  Nivelurile Simbolului

To make the required symbol, you need three symbol layers:

The lowest symbol layer is a broad, solid gray line. On top of it there is a slightly thinner solid yellow line and finally another thinner solid black line.

If your symbol layers resemble the above but you're not getting the result you want:

1. Check that your symbol levels look something like this:

2. Acum, harta ar trebui să arate în felul următor:
21.3.5 Nivelurile Simbolului

1. Ajustați nivelurile simbolurilor la aceste valori:

2. Experimentați cu valori diferite, pentru a obține rezultate diferite.

3. Deschideți iarăși harta originală, înainte de a continua cu exercițiul următor.
Here are examples of the symbol structure:
21.4.1 Geometry generator symbology

- Click on the button to add another Symbol level.
- Move the new symbol at the bottom of the list clicking the button.
- Choose a good color to fill the water polygons.
- Click on Marker of the Geometry generator symbology and change the circle with another shape as your wish.
- Try experimenting other options to get more useful results.
21.5 Results For Vector Attribute Data

21.5.1 Exploring Vector Data Attributes

- There should be 9 fields in the rivers layer:
  1. Select the layer in the Layers panel.
  2. Right-click and choose Open Attribute Table, or press the button on the Attributes Toolbar.
  3. Count the number of columns.

Sfat: A quicker approach could be to double-click the rivers layer, open the Layer properties ➤ Fields tab, where you will find a numbered list of the table’s fields.

- Information about towns is available in the places layer. Open its attribute table as you did with the rivers layer: there are two features whose place attribute is set to town: Swellendam and Buffeljagsrivier. You can add comment on other fields from these two records, if you like.

- The name field is the most useful to show as labels. This is because all its values are unique for every object and are very unlikely to contain NULL values. If your data contains some NULL values, do not worry as long as most of your places have names.

Înapoi la text

21.6 Results For Labels

21.6.1 Personalizarea Etichetelor (Partea 1)

Your map should now show the marker points and the labels should be offset by 2mm. The style of the markers and labels should allow both to be clearly visible on the map:
21.6.2  **Personalizarea Etichetelor (Partea a 2-a)**

O soluție posibilă o reprezintă acest produs final:
Pentru a ajunge la acest rezultat:

- Use a font size of 10
- Use an around point placement distance of 1.5 mm
- Use a marker size of 3.0 mm
- In addition, this example uses the *Wrap on character* option:
• Enter a space in this field and click Apply to achieve the same effect. In our case, some of the place names are very long, resulting in names with multiple lines which is not very user friendly. You might find this setting to be more appropriate for your map.
21.6.3 Utilizarea Setărilor Definite cu ajutorul Datelor

1. Stay in edit mode, set the `FONT_SIZE` values to whatever you prefer. The example uses 16 for towns, 14 for suburbs, 12 for localities, and 10 for hamlets.

2. Remember to save changes and exit edit mode.

3. Return to the Text formatting options for the places layer and select `FONT_SIZE` in the Attribute field of the font size data defined override dropdown:

   Rezultatele, dacă se utilizează valorile de mai sus, ar trebui să fie următoarele:
21.7 Results For Clasificare

21.7.1 Rafinarea Clasificării

The settings you used might not be the same, but with the values \textit{Classes} = 6 and \textit{Mode} = \textit{Natural Breaks (Jenks)} (and using the same colors, of course), the map will look like this:
21.8 Results For Crearea unui Nou Set de Date Vectoriale

21.8.1 Digitizare

Simbolistica nu contează, dar rezultatele ar trebui să arate mai mult sau mai puțin ca acesta:
21.8.2 **Topologia: Adăugarea Instrumentului Inel**

Forma exactă nu contează, dar ar trebui să fie obținută o gaură în mijlocul entității dvs., ca aceasta:

- Anulați editările dumneavoastră înainte de a continua exercițiul pentru instrumentul următor.
21.8.3 Topologia: Adăugarea Instrumentului Parte

- Mai întâi selectați Bontebok National Park:

- Acum, adăugați noua parte:
• Anulați editările dumneavoastră înainte de a continua exercițiul pentru instrumentul următor.

21.8.4 Îmbinare Entități

• Folosiți instrumentul de Îmbinare a Entităților Selectate, asigurându-vă că ați selectat mai întâi ambele poligoane pe care doriți să le îmbinați.
• Utilizați entitatea cu OGC_FID-ul 1 ca sursă pentru atributele dvs. (clic pe intrările sale din dialog, apoi faceți clic pe butonul Preia atributele din entitatea selectată):

```
Notă: If you're using a different dataset, it is highly likely that your original polygon's OGC_FID will not be 1. Just choose the feature which has an OGC_FID.
```

Notă: Folosind instrumentul de Îmbinare a Entităților Selectate, vom păstra geometriile distinctive, dar le vom acorda aceleași atribute.

21.8.5 Formulare

Pentru TIP există, în mod evident, o cantitate limitată de tipuri de drumuri, iar dacă veti verifica tabela de atribut pentru acest strat, veti vedea că acestea sunt predefinite.
• Setati widget-ul la Valorile Hărții apoi faceți clic pe Încărcare Date din Strat.
• Selectați drumurile din caseta cu derulare verticală a Etichetelor și autostrăzi pentru opțiunile Valoare și Descriere.
• Click OK three times.

• Dacă veți folosi instrumentul Identificare asupra unei străzi, în timp ce modul de editare este activ, dialogul ar trebui să arate astfel:
21.9 Results For Analiza Vectorială

21.9.1 Distanța față de Licee

- Dialogul tamponului dvs. ar trebui să arate astfel:

![Buffer buffer distance](image)

The **Buffer distance** is 1 kilometer.
- The **Segments to approximate** value is set to 20. This is optional, but it’s recommended, because it makes the output buffers look smoother. Compare this:
Cu aceasta:
The first image shows the buffer with the *Segments to approximate* value set to 5 and the second shows the value set to 20. In our example, the difference is subtle, but you can see that the buffer’s edges are smoother with the higher value.

Back to text

21.9.2 *Distanța față de Restaurante*

To create the new *houses_restaurants_500m* layer, we go through a two step process:

- În primul rând, creați un tampon de 500 de metri în jurul restaurantelor și adăugați stratul la hârtă:
Next, extract buildings within that buffer area:
Harta dvs. ar trebui să arate acum numai acele clădiri care sunt la 50 m față de drum, la 1 km de o școală și la 500 m de un restaurant:
21.10 Results For Network Analysis

21.11 Fastest path

Open Network Analysis ➤ Shortest Path (Point to Point) and fill the dialog as:

![Shortest Path (Point to Point) dialog]

Make sure that the Path type to calculate is Fastest.

Click on Run and close the dialog.

Open now the attribute table of the output layer. The cost field contains the travel time between the two points (as fraction of hours):
21.12 Results For *Analiza Raster*

21.12.1 *Calculare Aspect*

- Set your *Aspect* dialog up like this:

![Aspect dialog](image)

Rezultatul dvs.:
21.12.2 **Calculează Panta (mai puțin de 2 sau de 5 grade)**

- Set your *Raster calculator* dialog up with:
  - the following expression: `slopes1 <= 2`
  - the *slopes* layer as the *Reference layer(s)*
• For the 5 degree version, replace the 2 in the expression and file name with 5.

Rezultatele dvs.:
• 2 grade:
• 5 grade:
21.13 Results For Completarea Analizei

21.13.1 *Din Raster în Vector*

1. Open the Query Builder by right-clicking on the all_terrain layer in the Layers panel, and selecting the Properties ► Source tab.
2. Then build the query "suitable" = 1.
3. Clic pe OK pentru a filtra toate poligoanele în care această condiție nu este îndeplinită.
   Atunci când sunt puse deasupra rasterului original, zonele trebuie să se suprapună perfect:
4. You can save this layer by right-clicking on the all_terrain layer in the Layers panel and choosing Save As..., then continue as per the instructions.

Back to text

21.13.2 Inspectarea Rezultatelor

You may notice that some of the buildings in your new_solution layer have been „sliced” by the Intersection tool. This shows that only part of the building - and therefore only part of the property - lies on suitable terrain. We can therefore sensibly eliminate those buildings from our dataset.

Back to text
21.13.3 Rafinarea Anlizei

Pentru moment, analiza dvs. ar trebui să arate în felul următor:

Luați în considerare o zonă circulară, continuă pentru 100 de metri, în toate directiile.

În cazul în care raza este mai mare de 100 de metri, prin scăderea a 100 de metri din dimensiunea sa (din toate directiile) va rezulta o parte care rămâne în mijloc.
Prin urmare, puteți rula un tampon interior de 100 de metri pe stratul vectorial existent suitable terrain. În rezultatul funcției tampon, indiferent de ceea ce a mai rămas din stratul original, se vor reprezenta zonele în care există teren potrivit pentru 100 de metri în orice direcție.

Pentru demonstrație:

1. Mergeti la Vector ➤ Geoprocessing Tools ➤ Buffer(s) pentru a deschide diaolgul Tampo(anelor).
2. Setați-l astfel:
3. Use the suitable_terrain layer with 10 segments and a buffer distance of -100. (The distance is automatically in meters because your map is using a projected CRS.)

4. Save the output in exercise_data/residential_development/ as suitable_terrain_continuous100m.shp.

5. If necessary, move the new layer above your original suitable_terrain layer.

   Rezultatele dvs. vor arăta în felul următor:
6. Acum, folositi instrumentul Selectare după by Locație (Vector ► Research Tools ► Select by location).

7. Setati-l astfel:

8. Selectati entitatiile din new_solution care le intersectează pe cele din suitableTerrain_continuous100m.shp.

Acesta este rezultatul:
The yellow buildings are selected. Although some of the buildings fall partly outside the new `suitable_terrain_continuous100m` layer, they lie well within the original `suitable_terrain` layer and therefore meet all of our requirements.

9. Save the selection under `exercise_data/residential_development/` as `final_answer.shp`.

21.14 Results For WMS

21.14.1 Adăugarea Altui Strat WMS

Harta dvs. ar trebui să arate astfel (este posibil să fie necesară reordonarea straturilor):
21.14.2 Adăugarea unui Nou Server WMS

- Utilizați aceeași abordare ca și mai înainte pentru a adăuga noul server, și stratul corespunzător, așa cum este găzduit pe acel server:
Dacă ati transfocat în zona majorUrbanName, veți observa că acest set de date are o rezoluție mică:

Prin urmăre, este mai bine să nu utilizați aceste date pentru harta curentă. Datele Blue Marble sunt mult mai potrivite la scări globale sau naționale.

*Back to text*
21.14.3 Găsirea unui Server WMS

You may notice that many WMS servers are not always available. Sometimes this is temporary, sometimes it is permanent. An example of a WMS server that worked at the time of writing is the World Mineral Deposits WMS at http://apps1.gdr.nrcan.gc.ca/cgi-bin/worldmin_en-ca_ows. It does not require fees or have access constraints, and it is global. Therefore, it does satisfy the requirements. Keep in mind, however, that this is merely an example. There are many other WMS servers to choose from.

Back to text

21.15 Results For GRASS Integration

21.15.1 Add Layers to Mapset

You can add layers (both vector and raster) into a GRASS Mapset by drag and drop them in the Browser (see Follow Along: Load data using the QGIS Browser) or by using the v.in.gdal.qgis for vector and r.in.gdal.qgis for raster layers.

Înapoi la text

21.15.2 Reclassify raster layer

To discover the maximum value of the raster run the r.info tool: in the console you will see that the maximum value is 1699.

You are now ready to write the rules. Open a text editor and add the following rules:

| 0 thru 1000  | 1          |
| 1000 thru 1400 | 2          |
| 1400 thru 1699 | 3          |

Save the file as my_rules.txt file and close the text editor.

Run the r.reclass tool, choose the g_dem layer and load the file containing the rules you just have saved.

Click on Run and then on View Output. You can change the colors and the final result should look like the following picture:
21.16 Results For Noțiuni despre Bazele de date

21.16.1 Adresarea Tabelei de Proprietăți

Pentru tabela noastră teoretică de adresa, am putea dori să stocheze următoarele proprietăți:

<table>
<thead>
<tr>
<th>House Number</th>
<th>Street Name</th>
<th>Suburb Name</th>
<th>City Name</th>
<th>Postcode</th>
<th>Country</th>
</tr>
</thead>
</table>

La crearea tabelului pentru reprezentarea unui obiect adresă, vom crea coloane pentru a reprezenta fiecare dintre aceste proprietăți și le vom denumi cu nume acceptate de SQL și, eventual, scurte:

<table>
<thead>
<tr>
<th>house_number</th>
<th>street_name</th>
<th>suburb</th>
<th>city</th>
<th>postcode</th>
<th>country</th>
</tr>
</thead>
</table>

Back to text
21.16.2 Normalizarea Tabelei de Personal

Problema majoră a tabelei people rezidă în inexistența unui câmp de adresă singular, care să contină întreaga adresă a unei persoane. Gândindu-ne la tabela noastră teoretică address de la începutul acestei lecții, știm că o adresă este formată din mai multe proprietăți diferite. Prin stocarea tuturor acestor proprietăți într-un singur câmp, am îngreunat mult actualizarea și interrogarea datelor noastre. Prin urmare, trebuie să dividăm câmpul de adresă în diferite proprietăți. Va rezulta, astfel, un tabel cu următoarea structură:

<table>
<thead>
<tr>
<th>id</th>
<th>name</th>
<th>house_no</th>
<th>street_name</th>
<th>city</th>
<th>phone_no</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Tim Sutton</td>
<td>3</td>
<td>Buirski Plein</td>
<td>Swellendam</td>
<td>071 123 123</td>
</tr>
<tr>
<td>2</td>
<td>Horst Duester</td>
<td>4</td>
<td>Avenue du Roix</td>
<td>Geneva</td>
<td>072 121 122</td>
</tr>
</tbody>
</table>

Notă: În secțiunea următoare, veți învăța despre relațiile cheilor externe, care ar putea fi utilizate în acest exemplu, pentru a îmbunătăți în continuare structura bazei noastre de date.

Back to text

21.16.3 Normalizarea Suplimentară a Tabelei de Personal

Tabela noastră de personal arată, în mod curent, astfel:

<table>
<thead>
<tr>
<th>id</th>
<th>name</th>
<th>house_no</th>
<th>street_id</th>
<th>phone_no</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Horst Duster</td>
<td>4</td>
<td>1</td>
<td>072 121 122</td>
</tr>
</tbody>
</table>

Coloana street_id reprezintă o relație «una la mai multe» între obiectul people și obiectul street, care este în tabela streets.

O modalitate de a normaliza și mai mult tabla este de a împărți câmpul în prenume și nume:

<table>
<thead>
<tr>
<th>id</th>
<th>first_name</th>
<th>last_name</th>
<th>house_no</th>
<th>street_id</th>
<th>phone_no</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Horst</td>
<td>Duster</td>
<td>4</td>
<td>1</td>
<td>072 121 122</td>
</tr>
</tbody>
</table>

Putem crea, de asemenea, tabele separate pentru numele orașului și al țării, corelându-le cu tabla noastră people, prin intermediul relațiilor «una la multe»:

<table>
<thead>
<tr>
<th>id</th>
<th>first_name</th>
<th>last_name</th>
<th>house_no</th>
<th>street_id</th>
<th>town_id</th>
<th>country_id</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Horst</td>
<td>Duster</td>
<td>4</td>
<td>1</td>
<td>2</td>
<td>1</td>
</tr>
</tbody>
</table>

O diagramă ER care reprezintă acest lucru ar putea arăta astfel:
21.16.4 Crearea Tabelei de Personal

SQL-ul necesar creării tabelei de personal corect este:

```sql
create table people (id serial not null primary key,
    name varchar(50),
    house_no int not null,
    street_id int not null,
    phone_no varchar null);
```

Schema pentru tabel (introduceți \d personal) arată astfel:

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>integer</td>
<td>not null default</td>
</tr>
<tr>
<td></td>
<td></td>
<td>nextval('people_id_seq'::regclass)</td>
</tr>
<tr>
<td>name</td>
<td>character varying</td>
<td></td>
</tr>
<tr>
<td>house_no</td>
<td>integer</td>
<td>not null</td>
</tr>
<tr>
<td>street_id</td>
<td>integer</td>
<td>not null</td>
</tr>
<tr>
<td>phone_no</td>
<td>character varying</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:

"people_pkey" PRIMARY KEY, btree (id)

Notă: În scop ilustrativ, intenționat am omis constrângerea fkey.
21.16.5 Commanda DROP

Motivul pentru care comanda DROP nu ar funcționa în acest caz se datorează faptului că tabela people are o constrângere de Cheie Externă în tabela streets. Acest lucru înseamnă că eliminarea (sau ștergerea) tabelei streets ar lăsa tabela people cu referințe către date inexistente despre străzi.

Notă: Este posibil să «fortăm» ștergerea tabelului streets cu ajutorul comenzi CASCADE, dar acest lucru ar elimina, de asemenea, tabela people și oricare alta care a avut o relație cu tabela `streets`. Utilizați-o cu prudență!

Back to text

21.16.6 Inserarea unei Noi Străzi

Comanda SQL pe care ar trebui să o utilizați arată astfel (puteți înlocui numele străzii cu altul, la alegere):

```
insert into streets (name) values ('Low Road');
```

Back to text

21.16.7 Adăugarea unei Noi Persoane Cu Relația Cheii Externe

Aici este instrucțiunea SQL corectă:

```
insert into streets (name) values('Main Road');
insert into people (name,house_no, street_id, phone_no) 
values ('Joe Smith',55,'072 882 33 21');
```

Dacă priviti iarăşi la tabela străzilor (folosind o instrucțiune SELECT ca mai înainte), veți vedea că id-ul pentru intrarea Drumului Principal este 2.

De aceea, am putea mai degrabă doar să introducem numărul 2 de mai sus. Chiar dacă nu vedem Main Road scris integral în intrarea de mai sus, baza de date va fi capabilă să se asociiez valoarea street_id cu 2.

Notă: Dacă ati adăugat deja un nou obiect street, ati putea descoperi că noul Drum Principal are ID-ul 3 nu 2.

Back to text

21.16.8 Returnează Numele Străzilor

Aici este instrucțiunea SQL corectă, pe care ar trebui să o folosiți:

```
select count(people.name), streets.name 
from people, streets 
where people.street_id=streets.id 
group by streets.name;
```

Rezultatul:
### 21.17 Results For Interogări spațiale

#### 21.17.1 Unitățile Folosite în Interogările Spațiale

Unitățile utilizate de interogarea din exemplu sunt în grade, deoarece CRS-ul pe care îl folosește stratul este WGS 84. Aceasta este un CRS Geografic, ceea ce înseamnă că unitățile sale sunt în grade. Un CRS proiectat, similar proiecțiilor UTM, este în metri.

Amințiți-vă că, atunci când scrieți o interogare, trebuie să cunoașteți CRS-ul stratului. Acest lucru vă va permite să scrieți o interogare care va returna rezultatele pe care le așteptați.

#### 21.17.2 Crearea unui Index Spațial

```
CREATE INDEX cities_geo_idx
ON cities
USING gist (the_geom);
```

### 21.18 Results For Construirea Geometriei

#### 21.18.1 Crearea Șirurilor de Linii

```
alter table streets add column the_geom geometry;
alter table streets add constraint streets_geom_point_chk check
   (st_geometrytype(the_geom) = 'ST_LineString':text OR the_geom IS NULL);
insert into geometry_columns values ('', 'public', 'streets', 'the_geom', 2, 4326,
   'LINESTRING');
create index streets_geo_idx
on streets
using gist
(the_geom);
```
21.18.2 **Legarea Tabelelor**

```sql
delete from people;
alter table people add column city_id int not null references cities(id);
```

(captură orașelor în QGIS)

```sql
insert into people (name, house_no, street_id, phone_no, city_id, the_geom)
values ('Faulty Towers',
  34,
  3,
  '072 812 31 28',
  1,
  'SRID=4326;POINT(33 33)');

insert into people (name, house_no, street_id, phone_no, city_id, the_geom)
values ('IP Knightly',
  32,
  1,
  '071 812 31 28',
  1,'SRID=4326;POINT(32 -34)');

insert into people (name, house_no, street_id, phone_no, city_id, the_geom)
values ('Rusty Bedsprings',
  39,
  1,
  '071 822 31 28',
  1,'SRID=4326;POINT(34 -34)');
```

Dacă ați obținut următorul mesaj de eroare:

```sql
ERROR: insert or update on table "people" violates foreign key constraint "people_city_id_fkey"
DETAIL: Key (city_id)=(1) is not present in table "cities".
```

atunci înseamnă că în timp ce experimentați crearea poligoanelor pentru tabela orașelor, trebuie să fi sters unele dintre ele și să fi reînceput. Doar verificăți întrările din tabelul de orașe și folosiți orice id care există.

*Back to text*

### 21.19 Results For Modelul Entității Simple

#### 21.19.1 **Popularea Tabelelor**

```sql
create table cities (id serial not null primary key,
  name varchar(50),
  the_geom geometry not null);
alter table cities
  add constraint cities_geom_point_chk
  check (st_geometrytype(the_geom) = 'ST_Polygon'::text );
```

*Back to text*
21.19.2 Populaarea Tabelei `Geometry_Columns`

```sql
insert into geometry_columns values
('', 'public', 'cities', 'the_geom', 2, 4326, 'POLYGON');
```

21.19.3 Adăugarea Geometriei

```sql
select people.name,
       streets.name as street_name,
       st_astext(people.the_geom) as geometry
from streets, people
where people.street_id=streets.id;
```

Rezultatul:

<table>
<thead>
<tr>
<th>name</th>
<th>street_name</th>
<th>geometry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roger Jones</td>
<td>High street</td>
<td></td>
</tr>
<tr>
<td>Sally Norman</td>
<td>High street</td>
<td></td>
</tr>
<tr>
<td>Jane Smith</td>
<td>Main Road</td>
<td></td>
</tr>
<tr>
<td>Joe Bloggs</td>
<td>Low Street</td>
<td></td>
</tr>
<tr>
<td>Fault Towers</td>
<td>Main Road</td>
<td>POINT(33, -33)</td>
</tr>
</tbody>
</table>

(5 rows)

După cum puteți vedea, constrângerea noastră permite null-uri care urmează să fie adăugate în baza de date.